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Conventions Used in this Document

By default, when you install the DDM Inventory Server software, all the components will be in one of the
locations specified in the following table. The placeholders are used to represent the DDM Inventory program
and data folders referenced in this document:

Table 1
Folder Placeholder Platform Default Location
Program Files | <InstallDir> Windows Server 2008 | C:\Program Files (x86) \Hewlett-
Packard\DDMI\7.70
All others C:\Program Files\Hewlett-
Packard\DDMI\7.70
Data Files <DataDir> Windows Server 2008 | C:\ProgramData\Hewlett-Packard\DDMI
All others C:\Documents and Settings\All
Users\Application Data\Hewlett-
Packard\DDMI

You can customize both of these locations when you install the DDM Inventory Server.
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1 Introduction

DDM InventoryTM has a number of tools to help you analyze your scan data.
¢ Analysis Workbench
e Viewer

e SAI Editor

Analysis Workbench

Analysis Workbench is one of the key components in the inventory process. This is where
results are consolidated and quality tested, various analysis tasks are performed and exports
of the inventory data are produced.

The basic analysis of data usually consists of viewing and querying three types of information:
e Software files that are recognized as belonging to a particular application.

¢ Unidentified software and files that may belong to unrecognized applications.

e Hardware and asset data.

Analysis Workbench uses a Software Application Index (SAI) containing application and
version descriptions to identify the files found during the inventory. When scan results are
loaded, each file is checked against this database and this is how DDM Inventory performs
software identification. Any unrecognized files can be tagged for further investigation, and
when identified, their details can be added to the SAI file so they will be correctly identified in
the future.

Analysis Workbench provides several ways of viewing the data, using a series of different
views of results, that is, by machine, applications, file or directories.

All the information required for the analysis and consolidation of data collected for a
computer population is contained in the population of scan files created when every computer
is scanned.

Viewer

The Viewer is a stand-alone program aimed at technical support and Help Desk staff who
need detailed configuration analysis and diagnostics. (There is also the Scan Data Viewer,
available through the web user interface.)

Viewer provides a convenient way of displaying all of the software, hardware and asset
information collected for an individual computer, and allows a detailed comparison of two scan
files to be performed.
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The Viewer quickly and conveniently displays:

e Details of all software scanned, presented in an explorer style view.
e User entered asset information.

e Detailed and summarized hardware and configuration information.

¢ The contents of key files collected during the inventory, such as system configuration files
(Config.sys and Autoexec.bat).

e Details of all logical drives scanned.
e Details of any applications recognized.

Each scan file is loaded into a new window, enabling multiple scan files to be viewed at the
same time. This allows for a direct comparison between two scan files to be made.

Application Recognition

Application recognition is the process of determining what software is installed on a machine.
The process takes place after scanning, when a scan file is loaded into the Viewer or Analysis
Workbench components, or when it is processed by the XML Enricher.

The recognition process is driven by a Recognition Engine built into the components
mentioned previously, which makes use of the Application Library supplied with the product.
The Application Library stores the information required by the Recognition Engine to
determine which applications are installed on a machine. It is updated on a regular basis.

Application Recognition is always done using one or more SAI (Software Application Index)
files. DDM Inventory ships with 5 Master SAI files (containing libraries for English/
International, French and German applications, UNIX® applications, and a rule-based SAI
containing rules for base UNIX/Linux OS packages), as well as an empty User SAL

To extend the application library, the simplest way is to use Analysis Workbench or SAI
Editor to add entries to the User SAIL

SAl Editor

The SAI Editor presents a view of Software Application Index (SAI) files. It enables you to:

e View and edit a collection of SAI files

® C(Create new User SAls

e Move and Copy items between SAIs (you can only edit User SAIs)

¢ Delete items in SAIs

e Export the contents of an SAI to XML format, either as a summary or the entire contents.
¢ Display license relationships.

¢ Add and edit existing license relationships.

The SAI Editor is available as a standalone tool from the Start menu or from Analysis
Workbench, where it can be used to review and edit work on SAIs during a teaching session.

Chapter 1
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If the SAIs change on the DDM Inventory server, the Administrator must update the SAIs on
all systems that have the client tools installed.
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2 Analysis Workbench

The Analysis Workbench enables you to consolidate results, perform analysis and produce

exports.
Scan Files XSF H
'y
v
Analysis
State . Workbench
images " E t Dat
Analyze and QA Data > toxgtérv aa
Run Manage your User SAls
script files
y'y yy
L ' 1
' . Read Only
User SAI Files JJ Master SAI files u

The basic analysis of data usually consists of viewing and querying three types of information:
e Software files that are recognized. These are usually designated as applications.

e Unidentified software and files that may be unrecognized applications.

e Hardware and asset data.

Analysis Workbench uses a database called the Software Application Index (SAl). The SAI
contains application and version descriptions that are used to identify files found during the
inventory. When scan results are loaded, each one is checked against this database, and this is
how DDM Inventory performs software identification. Any files that are unrecognized can be
tagged for further investigation; when identified, their details can be added to the database.

Refer to Chapter 5, Application Recognition for further information about software
management and application recognition.

Analysis Workbench provides a series of different views of results: by machine, by directory,
by application, or by file.

All the information required for the analysis and consolidation of data collected for a
computer population, is contained in the group of scans created when each computer is
inventoried.
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System Requirements

The minimum resolution required to run Analysis Workbench is 1024x768.

Starting Analysis Workbench

To start Analysis Workbench:

From the Windows Start menu, select:
Programs > Hewlett-Packard > DDM Inventory 7.70 > Analysis Workbench

When Analysis Workbench is started for the first time, the Analysis Workbench Quick Config
Dialog Box is displayed automatically.

Analysis Workbench Quick Contig Dialog Box

>»

The Analysis Workbench Quick Config dialog box is displayed when you start Analysis
Workbench. It provides four Preset Analysis Modes that are optimized for common analysis
tasks.

Each of these modes is described in the dialog box (and later in this chapter). Select the mode
that you want to use, and click OK. If you do not want to start Analysis Workbench with any of
these settings, click Cancel.

An error message is displayed if the age limit on the Master SAI you are using has been
exceeded. You can obtain the latest Master SAI (updated monthly) by contacting HP
Customer Support.

Starting the Analysis Workbench Quick Config Dialog Box

There are two ways to start the Analysis Workbench Quick Config dialog box:

1 Automatically on starting Analysis Workbench. To disable this feature, clear the Show at
startup check box.

2 In Analysis Workbench, by selecting File > Quick Config.

Preset Analysis Modes

The four preset analysis modes are:

e Executive Summary from Enriched Scan Files
e Summary Reports

e Application Teaching

e Detailed Analysis
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Executive Summary from Enriched Scan Files

This setting enables you to use enriched application data and disables loading of file data.
This method is extremely fast.

It is assumed that you want to load xsf scan files that have already been processed by the

XML Enricher.

Table 1 Executive Summary Preset Analysis Mode Settings

Load Option Settings Used
Load Filter
No files are loaded
No directories are excluded
Recognition
Uses Installed applications recognition
Asset Fields
No asset fields loaded
Display Filter
Recognized Main files are shown
Uncertain files are shown as “I'reat as unidentified”
The Business view is loaded
Memory

The following file data is loaded:
e Signatures

e Modified time

e Type

The following Machine data is loaded:
Asset and hardware data

No directory data is loaded

File Version Data

No file version data is loaded

Analysis Workbench
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Summary Reports

This setting loads only summary information about each machine. This is useful for quickly
obtaining an overview of a large population.

Table 2 Summary Reports Preset Analysis Mode Settings

Load Option Settings Used

Load Filter
Only executable files are loaded
No directories are excluded
Recognition
SAI recognition is used
Asset Fields
No asset fields loaded
Display Filter
Recognized Main files are shown
Uncertain files are shown as Treat as unidentified
The Business view is loaded
Memory

The following file data is loaded:
e Signatures

e Modified time

e Accessed time

e Type

e Attributes

The following Machine data is loaded:
Asset and hardware data

No directory data is loaded

File Version Data

No file version data is loaded

Application Teaching

This setting loads all data necessary for application recognition and adding custom
applications to the Software Application Index.

Executable and command files are loaded
No analysis asset fields are defined
No file version data is loaded

Only those directories that contain loaded files are loaded

Chapter 2



e No SMBIOS machine data is loaded
Table 3  Application Teaching Preset Analysis Mode Settings

Load Option

Settings Used

Load Filter

Files with the following extension are loaded:
exe
com
dll

ocx

Executable files are loaded

No directories are excluded

Recognition

SAI recognition is used

Asset Fields

No Asset Fields loaded

Display Filter

The following Recognized files are shown:
e Main
e Associated

e 3rd party files

Uncertain files are shown as CheckVer

The following Unrecognized file types are shown:

¢ Unidentified
e Unprocessed
e Auto-identified

The Operational View is loaded

Memory

The following file data is loaded:
e Signatures

¢ Modified time

* Type

e Attributes

The following Machine data is loaded:
Asset and Hardware data

Analysis Workbench
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Table 3  Application Teaching Preset Analysis Mode Settings

Load Option Settings Used

Only those directories that contain loaded files are displayed

File Version Data

The following file version data is shown:
e Company Name
¢ Product Name

¢ Product Version

Detailed Analysis

This setting is appropriate for populations of fewer than 100 machines. All available data for
each machine is loaded. This allows powerful detailed analysis to be performed, but requires
significant memory for large numbers of machines.

e All files are loaded
e No file version data is loaded
e All directories are loaded

e All machine data is loaded

Table 4 Detailed Analysis Preset Analysis Mode Settings

Load Option Settings Used

Load Filter

All files are loaded

No directories are excluded

Recognition

SAI recognition is used
Asset Fields

No Asset Fields are loaded
Display Filter

The following Recognized files are shown:
e Main

¢ Associated

¢ 3rd party files

Uncertain files are shown as CheckVer

The following Unrecognized file types are shown:
¢ Unidentified

e Unprocessed

e Auto-identified

The Operational View is shown
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Table 4 Detailed Analysis Preset Analysis Mode Settings

Load Option Settings Used

Memory

The following file data is loaded:
e Signatures

e Modified time

e Accessed time

* Type

e Attributes

The following Machine data is loaded:
e Asset and Hardware data
e SMBIOS Data

All directories are loaded

File Version Data

The following file version data is shown:
e DOS 8.3 Name

¢ Real Name

e Description

e Company Name

¢ File Description

e File Version

¢ Internal Name

e Legal Copyright

¢ Original Filename
¢ Product Name

e Product Version

Exiting Analysis Workbench

You can exit Analysis Workbench at any time. This has the following effects:
¢ C(Closes all open windows and saves their position.

e Asks you if you want to save any modifications made to asset data in the Machines
window.

e Exits the application.

To exit Analysis Workbench:

1 Select the Exit command from the File menu.

A confirmation message is displayed.
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2 Click Yes to exit, or No to remain in Analysis Workbench. The purpose of this confirmation
message is to prevent you from accidentally exiting from Analysis Workbench and losing
work.

3 To disable the confirmation message, so that it is no longer displayed when exiting
Analysis Workbench, select the Don’t ask again check box.

The Analysis Workbench User Interface

The workspace is Analysis Workbench’s main window. It is always displayed and contains all
the other windows.

The Analysis Workbench workspace layout consists of the following visible components:
e Main Menu Bar

¢ Information Windows

e Toolbars

¢ Details Window

e Status Bar

An example of each component is shown here. Detailed information about each component is
provided in this chapter.

The Main Menu Bar is located at the top of the Analysis Workbench window. It contains
Analysis Workbench commands grouped by function:

L Analysis Workbench Z E”Zl

File Edit View Recognition Exports Window Help

The Information Windows are located on the left side of the Analysis Workbench window.
They contain detailed information about the following things: Files, Machines, Applications,
and Directories. The following is an example of a Files window:

[1 of 4347] Files = RES
Filters~ | 3 @) (1 1 [kl | EColumns~ MTag- & Output- @Cnnﬁgure -
Tag | Mame v | Size |F’ub|i5h er |Applicati|:-r1 |‘-.-"ersi|:-r1 o
O atluSchedulerSveRes.dll 13776 Symantec Symantec Endpoint Prots <CheckVer:
O amestream.dll 72704 Microsoft Windows Server 2003 =std =p2 1
O Analysiz Workbench.exe 5707776 Hewlett-Packard  HP DDM Inventary Cliznt <Checkyer:
O ANSInstdll 77824
O tpache.exe 18432 The Apachse Softwe Apache HTTF Server 2.2.80D0DMI
O ApacheSSL.exe 18432 The Apache Softwe Apache HTTF Server 2.2.9 DDMI
O apcupsdll 113152 Microsoft Windows Server 2003 std sp2
O append.exe 12493 Microsoft Windows xp pro sp3
O azpphelp.dil 148992 Microsoft Windows Server 2003 std =p2
O appletviswar.exe B3370 Sun Microzystems Java 2 30K 1.5.0_14 5E
O appmgmts.dil 175104 Microsoft Windows Server 2003 std =p2
= mn sl L n LN [ ~ ARCS a0 - —
£ L] >
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Each information window contains a toolbar. The Toolbars enable you to access various
Analysis Workbench commands without using the menu bar:

Filters~ | O ™= (1 O [ || BColumns~ M Tag~ & Output~ @Cunﬁgure'

You can display additional details about the items listed in the Information windows by using
the Details Window located on the far right side of the Analysis Workbench window. The
following example shows the applications detected on a particular machine:

23 Applications

Publizher Application Y erzion -
ActiveState Software | Active Perl 5.8.8 build 813 DOKI
Adobe Adobe Reader FALL

icrozoft S0AP Toolkit a0

Sun Microsystems Java SE Runtime Ervarg 1.6.0_12
Hewlett-Fackard HF COM Inventory Sers 7.51.000

Hewlett-Fackard HF DOM Irwventory Age 7.51.000

kdicrozoft Intermet Explarer FAl

Sun Microsystems Java 2 Runtime Ervviror 1.5.0_14 5E

S Micrnsnstarns Adawa SF RBunbirme Frowvie 1T R0 MR b

Saving and Loading the Workspace Layout

The current workspace layout (for example, windows displayed, linked windows, columns,
fonts) can be saved, either as a new default workspace or as a named layout that can be
reloaded at any time.

The file can be stored as awdef.awl (Analysis Workbench Layout) or as another . awl file,
which holds layout information about the workspace.

The default location for the . awl files is:

C:\Program Files\Hewlett-Packard\DDMI\7.70\Analysis Workbench

To save or load a workspace layout:

1 Select the Layout command from the Window menu.
2 From this menu select further commands as required:
® Load
Loads a previously saved workspace layout.
®* Save
Saves a new workspace layout.
®* Saveas
Saves the workspace layout as another .awl file
e Autosave

Sets autosave preferences to save the workspace layout automatically when you exit
Analysis Workbench or whenever the layout changes.
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Information Windows

The Analysis Workbench workspace can contain four different types of information windows.
These windows are used to display and examine the scans containing the information about
the computer population.

This information is displayed in columns in the window. You can display multiple windows of
each kind, showing different column selections:

* Files window

Displays information for all files in the population.
®* Machines window

Displays asset and hardware information about the computers in the population.
°* Applications window

Displays information about the software applications contained in the population.
* Directories window

Displays information about the directories contained in the population. This window is
not shown by default when Analysis Workbench is first started but can be displayed by
selecting the Create > Directory command in the Window menu.

Each Information window has three buttons in the upper right corner:
[T| Toggles the toolbar on and off.
Ol Maximizes the window. All other Information windows are minimized.

¥| Closes the window.

Adding a New Window

To add a new information window to the workspace:

From the Window menu, select the Create <window type> command.
Here, <window type> is Files, Directory, Machine, or Application.
You can display multiple views of the same window.

Resizing the Windows

All windows can be resized and positioned in the workspace.

To make a window active:

Click the window title bar or anywhere in the window.

To select options for displaying windows in the workspace:

Use the commands in the Window menu

The Window Title Bar

The title bar show the following information:
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e The name of the window

¢ The number of the entry in the window that is currently highlighted. This is shown in the

left corner of the title bar.

For example, [5 of 1542] means that the fifth entry in the window is currently highlighted
out of a total of 1542 entries displayed in the window.

To customize the user interface:

Select commands from the Configure toolbar menu available in all the information windows.

See Customizing Window Layouts on page 28 for more information.

Moving Within the Windows

You can use the mouse or keyboard to move within an information window.

Table 5 Cursor Control Using Keyboard

Control Function Keyboard Navigation
Next entry Down arrow

Previous entry Up arrow

Up one page Page up

Down one page Page down

Move to start of row Home

Move to end of row End

Start/End of entries Ctrl+Home/Ctrl+End
Beginning/End of row Ctrl+Left/Right
Top/bottom of row currently displayed | Ctrl+Up/Down

Details Window

The Details windows are secondary windows located on the far right of the Analysis
Workbench window that display additional linked data about the selected item in each of the

information windows.

Displaying the Details Window

To display the Details window:

From the Configure toolbar menu in any Information window, select the Detail window link

command.

’ If you clear the Detail window link menu item for all the Information windows displayed, the
Information windows will span the entire width of the Analysis Workbench window.

Analysis Workbench
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A Detail window has two buttons in the upper right corner:
€] Opens the Window Layout dialog box.

¥| Closes the window.

Customizing Window Layouts

Choose one of the following methods to customize the layout of the windows:
e Select options from the Configure toolbar menu (available in every window).

This will display the Window Layout dialog box with the appropriate tab already selected
(Fonts and Colors, Columns or Details Window.

e Select the Configuration command from the Window menu. The Window Layout dialog box
appears.

The Load Defaults button in this dialog box reverts the window layout back to the default
settings.
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Customizing the Font and Color

The Font & Color tab of the Window layout dialog box is used to configure the font, style and
color for the different types of entries displayed in the workspace.

Window layout [E|
_______________ FontiLolor | Cobmns | Detal Window
Iriverzal
Eont name Baze Font Size
T Microzoft Sans Serif w 1 |E|
Sample
Style Marmal Preview Active Preview s
Header row Sample Header Sample Header
File: b ain CiObAbAAR D Ok
File: Azzociated FORMMAT CObd
File: 3rd Party ARTGALRY.DLL
File: Unknown ABCTEST.EXE
File: Checkier ACHYX 5YS
L

< *
Stule zettings

Calar Style

Bl Clack w Marmal v
Background color Belative size
9 [ 24

Load Defaultz 1] ] ’ Cancel ]

As you specify and select parameters in this dialog box, a sample text list gives you a preview
of the applied changes.

Changing the Font Name and Size for All Entries Displayed in the Workspace

To change the font name and size for all entries displayed in the windows in the workspace:

1 Select the font from the Font name drop-down list.

2  Specify the font size by using the arrows in the Base Font Size box.

Changing the Style Settings for Specific Types of Entries

To change the style settings (color, style, background color or relative size) for specific types of entries:

1 In the Sample list, click on the Style entry that you want to work with.
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Select the color for the text from the Color drop-down list.
Select the style for the text from the Style drop-down list.

Select the background color of the windows from the Background color drop-down list.

o A W N

Specify the relative size of the text to the window by using the arrows in the Relative size
box.

6 Click OK to make the changes to the font and color or click Cancel to exit without making
any changes.

Customizing Columns

The Columns tab of the Windows layout dialog box is used to set options for the way columns
are displayed in the workspace. The columns in the windows can be automatically resized
based on the content, header, or both.

Window layout E|
Faont & Colar Colurnng Detail ‘Window
Auto resize columns Gnid lines
Mo i Mone
7 On header test anly (&) Vertical
) On data orly ) Horizontal
%) On bath header and data ) Bath
Options Gnid line style
Expand to window width %) Solid line
[ ] &pply ta all windows ) Dotted line
) Dashed line
Sarting GEnid line colar
- 4 columns W
- 3 columns
T - 2 columng
- 1 column
- Sort dizabled
Load Defaults ok l [ Cancel
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Setting Automatic Resizing Options for Columns

To set automatic resizing options for the columns:

Select one of the following options in the Auto resize group:

No

Resizing is disabled. Columns must be manually resized by dragging the column
boundary.

On header text only

Automatically changes the column width to fit the column header only.
On data only

Automatically changes the column width to fit the data in them.

On both header and data

Automatically changes the column width to fit both the column header and the data in
them.

Setting Column Options

To set options for the columns:

Select from the following check boxes in the Options group:

Expand to window width
The columns are resized so that they fit the width of the window.
Apply to all windows

Any changes made to columns, are applied to all windows in the workspace.

) This option is only available if the Window layout dialog box is invoked from within a window
(that is, from the Configure toolbar menu). If it is called from the Configuration command in
the Window menu, it is implicitly checked.

Setting the Number of Columns to Include in a Column Sort

To set the number of columns to include in a column sort:

In the Sorting group, use the slider to increase or decrease the number of columns that you
want to include in a sort. Move the slider to Sort disabled if you do not want sorting to occur.

Setting Column Grid Line Parameters

To set grid line parameters for the columns:

Select one of the following options in the Grid lines group:

Analysis Workbench

None

The grid lines for the columns are hidden.

Vertical

The vertical grid lines for the columns are displayed.

Horizontal
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The horizontal grid lines for the columns are displayed.

e Both

Both horizontal and vertical grid lines for the columns are displayed.

Setting Grid Line Style

To set the grid line style:
Select one of the following options in the Grid line style group:
* Solid line

The grid lines are displayed as a solid line.

e Dotted line

The grid lines are displayed as a dotted line.

e Dashed line

The grid lines are displayed as a dashed line.

Setting Grid Line Color

To set the grid line color:

1 Select a color from the Grid line color drop-down list.

2 Click OK to make the changes to the columns or click Cancel to exit from the dialog box
without making any changes.
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Customizing the Details Window

The Detail Window tab in the Window layout dialog box is used to set options for the display of
the Files, Machine, Directory and Application Details windows. The window can also be

customized by clicking the icon _T| in the Details window.

Window layout [‘S_<|

| Dretail "W indaw |

Font & Color Columns

Dretail Window Linkz
File: windows
bl achine windows

Directony windows
Application windows

[rata to appear in specific detail windows:
File Details

Azzet numbers File attributes

[ ] Directory names File types

File gizes

File signatures Battom pane
[] File madified date O Unuzed

[ File accessed date (%) Werzion D ata

[] File uzage

Machine Details
Hardware surnmary
(%) Default data
) Machine window data

Applications

Directory Details
File namesz
tachine names

Application Detailz
[nztalled on machines

Fecognition statistics Licensed by
Licenses
Load Defaultz [ Ok l [ Cancel

Setting Links to the Details Windows

To set the windows links to the Details window:

Select any number of the following from the Detail Window Links group box:
¢ File windows

e Machine windows

e Directory windows

e Application windows
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Specitying Data to be Displayed in Details Windows:

To specify the data to be displayed in the various Details windows:

1 Select any combination of the options described in tables Table 6 — Table 9:

Table 6

File Details Options

Option

Description

Asset numbers

Shows the asset number of the machines that the file resides on.

Directory names

Shows the directory that the file resides in.

File sizes

Shows the size of each copy of a file within the population.

File signatures

Shows the signatures found for each file within the population.

It shows a line for each file found in the population. There can be
multiple instances of the file on the same machine.

In this case there will be two lines for this machine in the Details
window.

File modified date

Shows the date the file was last modified files if available.

File accessed date

Shows the last-accessed time stamp for files if available.

File usage

Shows number of days since the file was last executed.

File attributes

Displays system attributes for a file.

The Attribute column along with normal file attributes includes the
X (executable), I (internal file) and D (device driver) information.
Version information (as per Windows Explorer) is available for all
files having the information I attribute.

File types

Shows the type of file (for example, DOS executable file, Windows
executable, OS/2 DLL file).

Bottom pane

Unused

The bottom pane of the File Details window will not be used for
displaying any data.

Version Data

This is the information that is embedded inside most Windows
executables. It describes the publisher, version and is extracted by
the Scanners and stored as part of the file data in the scan file.
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Table 7 Machine Details Options

Option

Description

Hardware summary

Displays basic details of the hardware configuration
scanned from the computer as it is inventoried.

Provides details of the operating system, processor,
type of screen, memory, drives, directories and files
as well as the total disk space and free space.

Applications

Displays details of the applications identified on the
machine, including publisher and version.

Recognition statistics

Displays the total number of files on the highlighted
machine, including a breakdown of the following
both as an absolute number and as a percentage of
the total files:

- Main files
- Associated files
- Files that need the version checked

- Unrecognized files and unprocessed files

Table 8 Directory Details Options

Option

Description

File names

Displays a list of file names found within the
directory, along with the size of the file.

Machine names

Displays a list of machines where the directory is
found within the population, with the drive location
for the directory.

Table 9 Application Details Options

Option

Description

Installed on machines

The machine(s) that the application is installed on.

Licensed by The details of the application suite that licenses the
highlighted application (if applicable).
For example, Word 97 is licensed by Microsoft Office
97 if installed on the same machine.

Licenses The details of any applications that the highlighted

application licenses.

For example, Word 97 licenses Microsoft Photo
Editor if installed on the same machine.

2 Click OK to make the changes to the Details window, or click Cancel to exit the dialog box
without making any changes.

Analysis Workbench
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State Images

A state image is the term describing the current ‘state’ of all data collections (that is, Files,
Applications, Directories and Machines). This includes the scan files that have been loaded
into the Analysis Workbench.

A state image is a file representing a ‘state’. It can be used to maintain an easy to load image
of your computer population.

State images are transitory in nature. If asset data is edited, even when the data has been
loaded from a state image, the original data source will be edited and not the state image
itself.

The version of the state image changes with new releases of the software, and old state
images cannot be read by newer versions of the software.

) The state image files are not backward compatible. You can only use DDM Inventory version
7.70 state images in this version of the software.

State images can be extremely useful in situations where a large amount of analysis work has
been carried out. The image can be easily reloaded at a later time. This is significantly quicker
than loading from the original data source.

Saving a State Image

The current state image of the Analysis Workbench can be saved to a . aws file. This file stores
the current state of all four data collections. State images are always stored to a subdirectory
called State Images.

To save a state image:

1 Click the Save State command in the File menu (or use the keyboard shortcut Ctrl+S). The
Save Analysis Workbench State Image dialog box is displayed.

B Save Analysis Workbench 5State Image |:||E| [Z|

M arne Size  Tupe D ate Maodified

|ﬂ Buzineszh. oS 23 KB Analysiz Workbench State lmage  5/5/2009 11:37 AM
|ﬂ S amples.AhwWS 3.209KB  Analvsiz Workbench State Image 54572003 11:37 Ak

Dezcription |.-5'-.nalysis Waorkbench State Image; Generated Tuesday, kMay 05 | Save

it

Filz narne: |E:-:amp|e..-’-‘-.W5 | Cancel

2 The Description box displays the date that the state image was generated. The text in this
box can be edited as required.

In the File name box specify the name of the file that the state image is to be saved to.

4 Click the Save button.
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Loading a State Image

A previously saved state image can be loaded only when there is no data loaded in the
Analysis Workbench. State images are always restored from a subdirectory called State
Images.

To load a state image:

1 Ifdata is already present in the Analysis Workbench, either restart Analysis Workbench,
or select the Unload Scans > All command from the File menu. All scans loaded into the
Analysis Workbench are now unloaded.

2  Click the Load State command in the File menu (or use the keyboard shortcut Ctrl+L). The
Load Analysis Workbench State Image dialog box is displayed.

B Load Analysis Workbench State Image E|[E| [Z|
File Mame Size kb | Modified Dezcription
BuzinesshaWwsS 235 05 May 2009 11:37 Demo state containing 5 scans in Buziness mode
E wample.Ahw/S 05 kay 2009 15:40 Analyziz Workbench State Image; Generated Tuezday, Mayp 05
Samplez.swS 3209 05 Map 2009 11:37 Demao state containing all zample scans in Bugsiness mode
< b

Analyziz Workbench State Image; Generated Tuesday, May 05
Containg 1 Machines, 107 Applications, 1043 Directories, 4347 Filez and 0 bytes Plug-in data

s l ’ Cancel

3 Select a state image to load (. aws file).

4 Click the OK button.

Main Menu Bar

Most of the Analysis Workbench commands are accessible from the main menu bar.
Commands are grouped by function (for example: File, Edit, or View). Menu commands can be
activated with the mouse or the keyboard.

Opening a Menu

To open a menu do one of the following:

1 Click the menu name with the mouse (for example, File).

2  Use the shortcut keys. Shortcut keys are shown to the right of the command in the menus.
For example, Alt-F4 is a shortcut used to exit the Analysis Workbench.

3 Use the access key, indicated by an underscore on the active letter. For example, the File
menu is accessed by pressing Alt-F.

4  Use the Alt or F10 key to select the menu, the arrow keys to navigate and the Enter key to
select an entry.

Most menus invoke commands, however, some menu commands display a dialog box,
indicated by ... after the menu command. Other menu commands provide a submenu,
containing further commands.
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The Menu ltems

The following sections show tables of the main menu items and the functions that can be
carried out from them. Also shown, are references, indicating where you can find further
information about their functions.

The File Menu

The File menu is used to:

e Load data files that are used by the Analysis Workbench

e Unload scans

¢ Load the Quick Config dialog box

e Set loading options

e Load and save state images

e  Run script files

e Exit the Analysis Workbench
Table 10 File Menu Items

Menu Item Function See
Load Scan Files... |Loads inventory data from XSF files. page 87
Unload Scan Files | Removes the details for a loaded scan file, from the page 88
Analysis Workbench
Current (name of the current scan file selected)
Tagged (any tagged machines)
Untagged (any untagged machines)
All (all entries)
Quick Config... Displays the Analysis Workbench Quick Config dialog box, | page 18
which is also displayed when Analysis Workbench is
started up.
Load Options... Displays the Analysis Workbench Load Configuration — page 62
Advanced dialog box, which allows recognition, load filter,
asset fields, display filter, memory and version options to
be set.
Load State... Loads a previously saved state (.aws file). page 36

State images are always restored from a subdirectory
called State Images.

A state can only be loaded if no data has been loaded into
the Analysis Workbench.
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Table 10 File Menu Items

Menu Item Function See
Save State... Saves the current state of the Analysis Workbench to an page 36
. aws file.
This file stores the current state of all four data collections
(Machines, Directories, Applications and Files).
State images are always saved to a subdirectory called
State Images.
Run Script file... Allows you to run a previously prepared script file ((awcs | page 181
extension).
These scripts facilitate the automation of actions which are
manually carried out within the application (for example,
loading, processing and outputting of information from
Analysis Workbench).
Exit Exits the Analysis Workbench application. page 23

The Edit Menu

The Edit menu is used to:

e Set options for tagging and untagging entries in all information windows (even if they are

not displayed).

e (Clear any filters that have been applied to any of the information windows.

e Save and cancel any changes made to asset data in the Machines window.
Table 11 Edit Menu Items

Menu Item Function See

Tag All Global — applies a global tag to every item in all page 125
information windows.
Local — applies a local tag to every item in all
information windows.
Both — applies both local and global tags to every item
in all information windows.

Untag All Global — removes every global tag in all information page 125
windows.
Local — removes every local tag in all information
windows.
Both — removes every local and global tag in all
information windows.

Clear all Filters Removes all filters that have been applied, from all page 131
windows.

The View Menu

The View menu provides commands for various statistics and charts to be displayed.

Analysis Workbench
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See Viewing Charts and Statistics on page 116 for more information.
Table 12 View Menu Items

Menu Item

Function

See

Charts

Scan File Age displays a bar chart showing a breakdown
of the time elapsed because the data was collected (in
months).

Scan Method displays a pie chart showing a breakdown
of the different Scanners used for collecting data.

Recognition displays a pie chart showing a breakdown of
the different types of file data that was recognized.

Unrecognized/File Frequency displays a graph that can be
used to determine the quality of recognition on a
population. This displays unrecognized files split by the
number of copies.

Recognized/ File Frequency displays a graph that can be
used to determine the quality of recognition on a
population. This displays recognized files split by the
number of copies.

page 116

Audit Statistics

Displays general data statistics, for example, the
number of files scanned, the number loaded, the number
recognized.

page 124

The Recognition Menu

The Recognition menu provides commands for various application teaching related tasks. The
Recognition menu is used to:

e Define Recognition Objectives

e View the Objectives Summary

e Display the SAI Teaching Wizard used to teach applications to a User SAI
e Display SAI Teaching Mode Holding Area

¢ View and Edit entries in your User SAI

¢ Recalculate Recognition Objectives

e Set Objective options

Table 13 Recognition Menu Items

Menu Item Function See

Objectives Set up and review your Recognition Objectives. page 150

Objectives Summary | Displays a summary pie chart of the Recognition page 158
Objectives.

SAI teaching Wizard | Having defined a set of objectives, the SAI Teaching page 164

Wizard can make use of the objective information to
choose which files to teach.
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Table 13 Recognition Menu Items

Menu Item Function See
SAI Teaching Mode | Simplifies the process of teaching new applications to page 144
the SAIL
A non-modal dialog box is displayed (the SAI Teaching
Holding Area), which can be used to hold information
about the next application to be taught.
View/Edit User Displays a dialog box where the current content of the | page 146
SAls... User SAI can be viewed and edited.
Recalculate Recalculate the values for the Recognition Objectives. page 150
Objectives
Objectives Options You can set a number of options defining how page 150

Recognition Objectives are managed.

The Exports Menu

The Exports menu provides export facilities for exporting data in a variety of formats. See
Exporting Inventory Data on page 168 for more information.

Table 14 Exports Menu Items

Menu Item Function See

Machines Exports data from a Machines window in CSV or text page 171
format.

Applications Exports data from a Applications window in CSV or text | page 173
format.

Directories Exports data from a Directories window in CSV or text page 173
format.

Files Exports data from a Files window in CSV or text format. |page 173

Relational Exports data in a format that is supported by Relational | page 174
Database Management Systems (RDBMS).

Stored Files Exports data from the stored files contained in the scan page 177
data as a text file or Hex dump.

The Window Menu

The Window menu provides options for controlling the way windows are displayed in the
Analysis Workbench workspace and options for the configuration of the display.

For more information see:

¢ (Customizing Window Layouts on page 28.

Analysis Workbench
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e Viewing Logs on page 57.
Table 15 Window Menu Items

Menu Item

Function

See

Create

Creates additional Files, Directories, Machines or
Applications windows.

page 26

Equalize

Equally sizes all open information windows.

page 44

Configuration...

Displays the Window layout dialog box, which provides
options for the configuration of the display font and color,
columns and Detail window.

page 28

Layout

Load Loads a previously saved window layout from an .awl
file.

Save Saves the current window layout to the current
layout file.

Save As... Saves the current window layout to a user
specified .awl file.

Autosave Automatically saves the window layout:

None Disables the window autosave facility. Any window
layout changes must be saved manually.

When AW Exits Automatically saves the window layout
when the Analysis Workbench is shut down.

When Layout Changes The window layout is automatically
saved when any changes are made to the layout.

page 25

Log Window

Displays the Analysis Workbench log.

page 57

The Help Menu

The Help menu provides help on all aspects of using the Analysis Workbench.
Table 16 Help Menu Items

Menu Item

Function

Contents

Displays the Help file table of contents.

About

and system memory.

Displays information about the Analysis Workbench version, build
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Shortcut Menus

To access a selection of commands related to your current activities (a shortcut menu),
position the mouse cursor in the appropriate area of the screen and click on the right mouse
button. Analysis Workbench displays a list of commands and you can select the one you want.

There are three types of shortcut menu available for the information windows:

Window title bar shortcut menu
Column header shortcut menus

Information window cell shortcut menus

Column . '
header Window title bar
shortcut Tag N Contains, .. shortcut menu
menu Find... Tag all Maximi n
Untag al Equalize Windows
Toggle all
Lock Mowve up
Duplicates
Chart... Uniques Toggle Toolbar
Sort Ascending Cloze Ctrl+F4
Sort Descending
[2 of 101]
Information Filters~ | O | (O 00| & | | EColumns~ M Ta

window cell
shortcut menu

Analysis Workbench

1% | Publisher

|App|i:atiu:un

[0 Sun Microsystems

Java 2 Runtime Ervire

Tag v m Hewlett-Packard HF DDM Inventory Se

[0 The Apache Software Foundation

Apache HTTF Server

:Dn;;?e : O Intervideo WinDvD
[0 Sybaze FPowerDesigner Datal
Rows above * [0 Sun Mizroaystems Java 2 SDK
Rows below r [0 The Apache Software Foundation Tomeat
Publisker is Hewlett-Packard » <I_I H maael st Baele=ed HE Entarnriea Misens
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The Window Title Bar Shortcut Menu

Right-clicking on an information window title bar displays a menu with the following options:
Table 17 Window Title Bar Shortcut Menu

Shortcut Menu
Item

Function

0| Maximize Window

Maximizes the window. Also activated by:
Clicking the Maximize icon in the top right corner of the window.
Double-clicking the title bar.

Equalize Windows

Makes all windows the same size. Also activated by selecting the
Equalize command in the Window menu.

Move up

Moves the window up a position in the workspace.

Move down

Moves the window down a position in the workspace.

[T] Toggle toolbar

Hides the toolbar if it is currently displayed in the window and vice
versa. Also activated by clicking the Toggle icon in the top right
corner of the window.

%] Close

Closes the window. Also activated by:
Clicking the Close icon in the top right corner of the window.
Using the Ctrl+F4 keyboard shortcut.

Column Header Shortcut Menus

Right-click on a column header in an information window to display shortcut menus with the

following options:
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Table 18 Column Header Shortcut Menus

Option Function

Query This option is only available for the Machines information window.

It displays the Complex Query dialog box which enables multiple
tagging query criteria to be specified from a section of categories,.
These categories are defined by the information collected across
the computer population.

See Machine Queries on page 137 for more information.

Contains This option displays a dialog box which allows you to search for a
specified string in the column.

Tag all Applies a tag to all entries in the column.
Untag all Removes all tags from entries in the column.
Toggle all Toggles the tag status of all entries in the column. If an entry is
tagged then, the tag is removed and vice versa.
Duplicates Tags any duplicate entries in the column.
Uniques Tags all entries that are unique.
Find

Allows you to find a particular entry in the active window.

See Locating Specific Entries in a Window on page 50 for further information.

Sum

This option is available only if all the contents of a column are numerical. It displays a
message showing the sum of the numerical contents of that column.

Lock

When this option is selected, the column clicked and all columns to the left of it are ‘locked’
and will not scroll left or right.

Unlock

This option is used to remove a lock from a column. To set a different lock, select lock on a
different column.

Chart

) This option is not available for the Directories information window.

It displays a graphical representation of the selected column statistics.

Sort Ascending

Sorts text alphabetically, numerically, or by date in ascending order (A to Z, a to z or zero to 9).
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Sort Descending

Sorts text alphabetically, numerically, or by date in descending order (Z to A, z to a or 9 to

Zero).

The Information Window Cell Shortcut Menus

Right-click in a cell in the information windows to display a shortcut menu with the following

options:

Not all the options are available for all information windows. Where this is the case, it has

been indicated.

Table 19 Information Window Cell Shortcut Menus

Menu Option

Function

Tag

All

Tags all the visible entries in the active window.

Current row

Tags the currently highlighted row.

Rows above

Tags rows above the currently highlighted row.

Rows below

Tags rows below the currently highlighted row.

<Variable row>

Tags any entries in the window that match the cell
specification.

This option changes to reflect the cell that the mouse was
right-clicked in.

For example, if the mouse was right-clicked in a cell in
the Main Processor (CPU) column and the cell contains
the following information:

Main Processor (CPU) of Pentium II
Then this option will read Main Processor (CPU) is

Pentium II. All entries in the window that have a
Pentium II CPU will be tagged.

Pressing the Shift key at the same time as right-clicking
on a cell inverts the option.

For example, in the previous case it will read Main
Processor (CPU) is not Pentium II.

Untag

All

Removes tags from any tagged entries in the active
window.

Current row

Removes the tag from the currently highlighted row.

Rows above

Removes tags from the rows above the currently
highlighted row.

Rows below

Removes tags from the rows below the currently
highlighted row.
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Table 19 Information Window Cell Shortcut Menus

Menu

Option

Function

<Variable row>

Remove tags from any entries in the window that match
the cell specification.

This option changes to reflect the cell that the mouse was
right-clicked in.

For example, if the mouse was right-clicked in a cell in
the Computer Manufacturer column and the row
highlighted has a computer manufacturer of DELL, then
any entries in the window that have a DELL computer
make are untagged.

Pressing the Shift key at the same time as right-clicking
in a cell inverts the criteria.

For example, in the previous case it will read Computer
Manufacturer is not DELL.

Toggle

All

Toggles the tag status of all entries in the active window.
If an entry is tagged, the tag is cleared and vice versa.

Current row

Toggles the tag status of the currently highlighted row.
That is, if it is tagged, the tag is removed and vice versa.

Rows above

Toggles the tag status of the rows above the currently
highlighted row. If an Entry is tagged, then the tags are
removed and vice versa.

Rows below

Toggles the tags status of the rows below the currently
highlighted row. If an entry is tagged, the tag is removed
and vice versa.

<Variable row>

Toggles the tag status of any entry in the window that
matches the cell specification.

For example, if the mouse was right-clicked in a cell in
the PEC number column and the row highlighted has
PEC102, then any entries that have a PEC number of
PEC102 are toggled.

Pressing the Shift key at the same time as right-clicking
on a cell inverts the option.

For example, in the previous case it will read PEC
number is not 102.

Rows Above

Tag Tags the rows above the currently highlighted row.

Untag Removes the tags from any tagged entries above the
currently highlighted row.

Toggle Toggles the tag status of any entries above the currently

highlighted row. That is, if an entry is tagged, then the
tag is removed, and vice versa.

Analysis Workbench
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Table 19 Information Window Cell Shortcut Menus

Menu Option Function
Rows Below
Tag Tags the rows below the currently highlighted row.
Untag Removes the tags from any tagged entries below the
currently highlighted row.
Toggle Toggles the tag status of any entries below the currently

highlighted row. That is, if an entry is tagged, then the
tag is removed, and vice versa.

<Variable option>

Tag Tags any entry in the window that matches the cell
specification.

Untag Removes the tag from any tagged entry in the window
that matches the cell specification.

Toggle Toggles the tag status of any entry in the window that

matches the cell specification.

View Scan File

This option is available for the Machines window only.

It opens the scan file in the Viewer application.

Columns

A selection of columns are available for each information window.

Overview of the Columns in an Information Window

To check which columns are available for a particular window, click the Columns toolbar menu
in that window. A list of all columns available in that window is displayed. Currently selected
columns — that is, columns that are visible in the active window — are shown with a check

mark next to them.
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A list of the columns available in the Applications window, for example, is shown here.

v Tag

LTag
v Publizher
Application
App Type
Version

<

Release
OpSys
LangCode

L T T

Language
Description

v Machines
Installz

W Licenses
Files
Licenses Apps
Licensed By
Version Id
Utilization
Used On

Some column names have additional information appended to them as follows:

If the column has the text ‘csv’ in brackets, this means that the column has been extracted
from a CSV file asset field and an option has been set to included this text in brackets. For
more information refer to CSV File Extract Asset Field on page 78.

For example, the column name Asset Number (csv) indicates that the information in the
Asset Number column was extracted from a CSV file asset field.

If a column name is shown with #n after it, where n is a number, this means that more
than one entry is available for this type of the data.

For example, if a computer has been scanned and has three network connections, then
these are shown as three separate columns called Network connection #1, Network
connection #2 and Network connection #3.

’ The sequence of the field entries is taken from the order they are found on a particular
machine and therefore cannot be relied upon to appear in the same column for all scan files.

Sorting Entries in a Column

There are two ways in which you can sort the contents of a column:

1

Analysis Workbench

Click on a column header to sort the contents of that column. The default sort order is
ascending.

Right-click on a column header and select the Sort Ascending or Sort Descending command
from the shortcut menu.

This command sorts text alphabetically, numerically, or by date in ascending or
descending order.
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Locking and Unlocking Columns

To lock a column:

1 Select the column which will be the leftmost column to be locked.

2 Right-click on the column header and select the Lock option. The selected column and
columns to the left of it are locked.

The locked columns are indicated by a grid around the entries.

To unlock all columns:

e Right-click on a column header and select the Unlock option.

All columns are unlocked. The unlocked columns are returned to their normal display
state.

Locating Specific Entries in a Window

In This Section

e Incremental Column Search on page 50

¢ Find Facility on page 50

¢ Contains Option on page 51

¢ Displaying the Entry Names Contained in a Column on page 51

Incremental Column Search
The incremental column facility is used to locate an entry in a column in any window.

To Perform an Incremental Column Search:

e (Click on a column header in the active window and progressively type the word(s) or
number(s) that make up the entry that you want to locate.

The window automatically locates the closest existing value in the column. The progress
of the incremental search string is displayed on the active window titlebar in italic
characters.

Find Facility

To use the find utility:
1 Right-click on the column header and select the Find option.
A Find in “<column name>” column dialog box appears.

2 Enter the string to search for. If required, set the options to match on whole word and
match case.

3 Click Find Next.

The search direction is top to bottom of a column. To reverse the search, click on the column
header to reverse the sorting and use the Find option again.
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Contains Option

This is used to find and tag multiple entries using a search string. It is of particularly use
when you are trying to find files with a specific file extension.

To use the Contains option:

1

4

Right-click on a column header and select the Tag > Contains option.

A dialog box appears, which is used to search for a specified string at the beginning,
middle or end of entries in the column.

“Scan Date” column @

Actian String Pozitian
(%) Tag ") Beginning
() Untag () End
() Tooggle () Arypwhers
Search Sting
] l ’ Cancel ]

In the Search String field enter the text that you want to locate.

You can also specify actions to be carried out, after the string has been located. That is:

e Tag

e Untag
e Toggle
Click OK.

Displaying the Entry Names Contained in a Column

This is very useful for identifying the names of entries that you want to tag or untag.

To display the entry names contained in a column:

1

Analysis Workbench

In the window, right-click on the column header and select the Chart option.
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2
3

Toolbars

A column chart is displayed.

B" Chart: Applications: Publisher

3 MySQL AB

G Sun Microgystems

T Symantec

3 The Apache Software Foundation
3 Other

Licensed o MaZormpa e
Coparight $993- 20009 Hewlst-Fackard Development Company, L P

-

Save bz Copy ’ Frint.... ” O ptions. .. ” Refrezh ]

Click the Options button, and set the Other group, % field to 0.
Click OK.

The chart will show the different entry names contained in the selected column in a list on
the left side.

This list is truncated to fit the window.

You will find the following information in this section:

Overview of Toolbars
Filters Toolbar Menu
The Filter Icons
Columns Toolbar Menu
Tag Toolbar Menu
Output Toolbar Menu
Configure Toolbar Menu
Moving a Toolbar

Resizing a Toolbar
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Overview of Toolbars

Toolbars allow you to access various Analysis Workbench commands without using the menu
bar. They allow you to work faster and more visually.

When the mouse pointer passes over an icon, a tooltip appears indicating the command
corresponding to the icon.

Each of the four information windows in the Analysis Workbench (Files, Applications,
Machines and Directories) has a set of toolbar icons.

With the exception of the filter icons, each of the toolbar icons has a menu associated with it.

’7 Filter icons —‘

Filters~ | O T2 (1 00 || M Columns =~ M Tag~ & Cutput - @Cnnﬁgure*

Filters Toolbar Menu

Provides options for applying filters to the information windows, so that a subset of relevant
information is displayed.

Activating a Filter

To activate a filter:

e Select the particular filter from the Filters toolbar menu.

When a filter is active in a window, visually this is indicated by a check mark (V) in the
Filters toolbar menu and on the associated filter icon. The filter icons are also highlighted
in yellow.

The exception to this is the Local Tags filter [L] icon, which does not have a check mark
displayed on the icon.

Deactivating a Filter

To deactivate a filter:

¢ Click on the filter icon again or deselect the filter from the Filters toolbar drop-down
menu.

The appropriate check marks are cleared.
For more information see Filtering on page 129.
The Filter lcons
Filters can also be applied by clicking the following icons:
e [O Machines filter
o () Applications filter
e [ Directories filter

e [ Files filter
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e [L] Local filter

When these icons are selected they are shown highlighted in yellow and with a check mark on
them (except the Local filter icon).

Columns Toolbar Menu
This is used to select the columns that you want displayed in the active window. When
selected, a check mark is displayed next to the column item in this menu.

In addition, the Machines window has an option which adds or removes columns in this
toolbar menu.

See The Machines Window on page 103 for more information about adding and removing
columns.

Tag Toolbar Menu
This menu provides various options for tagging entries in the active information window. The
following list shows options that are common to all windows.
®* Tagall
Tags all visible entries in the active window.
®* Untag all
Clears all visible tags in the active window.
* Toggle all
Toggles the tag status of all visible entries in the active window.
® Use Global Tags
Uses Global tags only for tagging items in the active window.
® Use Local Tags
Uses Local tags only for tagging items in the active window.
e Use Local Tags Once

Uses Local tags for the next tag operation, after which Global tags are used again for
tagging.
Further information about Global and local Tags can be found in the section entitled Tagging
on page 125.

In Addition:

e The Machines window has a Query option which allows machine queries to be performed.
For more information refer to <Blue>Machine Queries on page 137.

e The Machines window has two extra tagging commands - Load Tags List and Save Tags
List. These will save or load a tag list file (.tag file) and tag matching machines. A .tag file
is a text file containing the asset numbers of the tagged machines.

For more information refer to Tag Lists in the Machines Window on page 128.

e The Files window has an Add to SAI option which is used to ‘teach’ the application to
recognize files which it previously did not recognize or recognized incorrectly (that is, as a
different version/publisher).

Chapter 2



This allows you to optimize the software analysis and consolidation capabilities of
Analysis Workbench to recognize unidentified files and applications.

For more information about adding entries to the SAI, refer to Teaching Applications to
the User SAI on page 139.

) This option is only enabled when a user editable SAI has been loaded (by selecting Load
Options in the File menu and clicking the Recognition tab) and the Files window contains at
least one selected entry.

Output Toolbar Menu

Export from window - Exports the contents of individual windows. This will display the Export
to file dialog box which allows you to export the contents of the window based on the current
column selection and filter settings.

Further Information

For more information about exporting data from windows see Exporting Inventory Data
on page 168.

Configure Toolbar Menu

This menu is used to customize the layout of a window and link the active window to the
Details window. The following list shows options that are common to all windows.

Fonts and colors

Configures the font and color settings for the window layout.

Columns

Sets various column attributes and properties.

Detail window

Configures the window layout and information displayed in the Details window.
Detail window Link

Provides a link to the Details window, so that when an entry is clicked in the active
window, further information is displayed.

See The Machine Details Window on page 105 for more information.

Moving a Toolbar

A Docked toolbar is one that is attached to one edge of the program windows. You can dock a
toolbar below the window title bars or to the left of the window. When you drag a toolbar to
the edge of the window, the toolbar outline snaps into place along the length of the window
edge.

A Floating toolbar is one that is not attached to the edge of the window.

Right-clicking on the toolbar menus and icons presents a menu with the following options:

Analysis Workbench

Floating

Floats the toolbar.

Dock to top

Docks the toolbar to the top of the window, under the titlebar.
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® Dock to left
Docks the toolbar to the left of the window.

To dock the toolbars to the appropriate window and save as default layout:

1 Double-click on the floating toolbars.
2 Select the Layout option from the Windows menu.

3 Select Save to keep this as the default layout whenever Analysis Workbench is started.

To manually move a toolbar:

1 Click the ‘move’ handle on a docked toolbar, or double-click the title bar on a floating
toolbar.

2 Drag the toolbar to a new location. If you drag the toolbar to the edge of the window, it
becomes a docked toolbar.

Resizing a Toolbar

To resize a floating toolbar:

e Move the pointer over any edge until it changes to a double-headed arrow, and then drag
the edge of the toolbar.

) You cannot resize a docked toolbar.

Status Bar

The status bar displays information about each of the data collections. It shows a separate
pane for each of the four data collections (Files, Directories, Machines, Applications). It also
contains information about how many items are available and how many of them are tagged
globally.

The format is:

Number of global tags/Number of items loaded into the window

Wednesday, May 06, 2009 11:04:04 AM  Machines: 0/9  Applications: 0190 Directories; 08537 Files: 019317

This helps to provide a view of the global state of the data, irrespective of what views are open
and gives an up-to-date view of how many items of each kind are available/tagged.

Tooltips

When the mouse cursor stays on top of certain areas, in particular over icons and buttons on
the toolbar, a tooltip appears to indicate which tool it is.

System Information

The About box contains all the system information about Analysis Workbench.
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To display the About dialog box:

e Select the About command from the Help menu.

This box contains basic information about Analysis Workbench:

— Information about the installed software (for example, software name, version

number, version date).

— The total system memory of the client workstation.

— Available system memory of the client workstation after the software has been

installed.

Shortcut Keys

You can quickly accomplish tasks you perform frequently by using shortcut keys.

Table 20 Shortcut Keys

Task Keyboard Shortcut
Load State Ctrl-L
Load Scan Files Ctrl-O
Save State Ctrl-S
Exit Analysis Workbench or close an active window Alt-F4
Tag all entries in an information window (can only be used from | Shift-Ctrl-A
within the window itself)
Untag all entries in an information (can only be used from within | Shift-Ctrl-U
the window itself)
Viewing Logs

Logs can be accessed from the Log Window command in the Windows menu.

The log file records information about the current session of Analysis Workbench. It can
include amongst other items; how many scan files were loaded and how long they took. It can

also log activity when editing SAI entries.

Analysis Workbench
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Command Line Parameters

In This Section

e QOverview of Command Line Parameters on page 58

e C(Creating a Shortcut on the Desktop on page 58

e State Image Command Line Parameter on page 59

e Directory Name Command Line Parameter on page 59

e Scan File Names Command Line Parameter on page 60

e Standard International Date Command Line Parameter on page 60

e Using Combined Command Line Parameters on page 60

Overview of Command Line Parameters

By using command line parameters, you can create shortcuts on your desktop that start
Analysis Workbench with specified state images, directories containing scan files or a specific
scan file.

The command line parameters can be combined, so that you can for example, load a state
image and a directory of scan files or specific scan files.

This can be a very useful tool for cases where you have already loaded a large amount of data
into the Analysis Workbench workspace and have performed some analysis on this data. You
can save the state image of the session, and at the next session you can use command line
parameters to add any new scan files that have been found in your scan file repository
directories.

Because Analysis Workbench does not load duplicate scan files (that is, an identical scan file),
no current data will be overwritten. Scan files are considered identical when the Asset
Number field is the same even if the scan file name is different.

You can also use a command line parameter to specify that all dates in Analysis Workbench
use the standard international date format instead of the one set up in Windows.

Creating a Shortcut on the Deskiop

To create a shortcut on the desktop including parameters:

Create a shortcut without parameters first:
e Drag the Analysis Workbench icon onto the desktop with the right mouse button.

e Select the Create shortcuts here option from the menu that is displayed when releasing the
mouse.

e Right-click on the shortcut and open the properties dialog box.

¢ Add any command line parameters to the end of the target field separated from the
executable name by a space.
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State Image Command Line Parameter

This is the name of a saved state image. State images have as aws file extension. The state
image can be an unqualified file name. The following conditions apply:

If an unqualified file name is used the DDM Inventory State Images directory is searched.
If specified, the state image is loaded.
If the names of multiple images are specified, only the first is loaded.

If the file name contains spaces it must be enclosed in double quotes (").

) The state image files are not backward compatible. You can only use your DDM Inventory
version 7.70 state images in this version of the software.

Syntax

The syntax for state image parameters is as follows:

[State image name]

Examples

Case 1: Path to State Image Contains Spaces

"C:\Program Files\Hewlett-Packard\DDMI\7.70\Analysis Workbench\State
Images\State5.aws"

Case 2: Path to State Image Does Not Contain Spaces

D:\StateImages\Business5.aws

Directory Name Command Line Parameter

This is a directory name. The following conditions apply:

Synfax

If multiple directories are specified, only the first is used.
All scan files in the specified directory are loaded.

If the path to the parameter (directory containing scan file) contains spaces, then it must
be enclosed in double quotes.

If a state image was also specified, it is loaded first and the directory second.

The syntax for directory command line parameter is as follows:

[Fully qualified directory name]

Examples

Case 1: Scan File Directory Does Not Contain Spaces

C:\Scanfiles

Analysis Workbench
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Case 2: Directory Contains Spaces

"C:\Scan files"

Scan File Names Command Line Parameter

This is one or more scan file names. The following conditions apply:
e Scan file names specified are loaded after a state image or a directory specified.

e Ifthe path to any parameter (specific scan files) contains spaces, it must be enclosed in
the double quotes.

Syntax

The syntax for scan file command line parameter is as follows:

[Fully qualified scan file names separated by spaces]

Examples

Case 1: Path to the Scan File Does Not Contain Spaces

C:\scans\IND1260.xsf C:\scans\ILND1240.xsf

Case 2: Name of One Scan File Contains Spaces

"C:\Inventory scans\LND1250.xsf" E:\scans\Test.xsf

Standard International Date Command Line Parameter

When specified, all dates use the standard international date format instead of the one set up
in Windows. This is useful when setting up scripts for exports.

Synfax

The syntax for standard international date command line parameter is as follows:

[/STD DATES]or [-STD DATES]

) The command line switch only turns on the standard international date format. There is no
command line switch to turn it off.

Using Combined Command Line Parameters

You can combine the three command line parameters so that Analysis Workbench can be
started with different data in it.

Specify the names of the scan files, or the state image you want to load. If a directory name is

specified, all the scan files in that directory are loaded. The command line parameter priority
is always:

1 State Image

2 Directories (only 1 is allowed)
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3 Scan files (multiple scan files can be specified)

Synfax

The syntax for combined command line parameters is as follows:

[Fully qualified directory name] [State image name] [Fully qualified scan file
names separated by spaces]

Examples

For example, you may want to load a saved state image and also include new scan files
contained in your repository directory.

Case 1: Path fo the State Image and Scan File Directory Do Not Contain Space.

C:\states\Statel.aws c:\NewScanfiles

Case 2: The State Image and the Scan File Contains Spaces

"C:\states\State 1l.aws” “c:\New Scan Files"
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Setting Load Preferences

In This Section

The Analysis Workbench Load Configuration Dialog Box on page 62
Loading and Saving Options on page 63

Filtering Levels on page 63

Configuring Load Filter Settings on page 64

Configuring Recognition Settings on page 66

Configuring Analysis Asset Fields on page 74

Configuring Display Filter Settings on page 82

Configuring Memory Settings on page 84

Configuring File Version Settings on page 85

The Analysis Workbench Load Configuration Dialog Box

"v

Set Loading preferences before you load data into the Analysis Workbench.

To load the Analysis Workbench Load Configuration Dialog Box:

Select the Load Options command from the File menu.

The Analysis Workbench Load Configuration dialog box appears.

This dialog box has six tabs which are used to set various options:

Load Filter

Specifies which files are to be loaded from selected scan files.

Recognition

Specifies which recognition method to use and which files to pass through it.
Asset Fields

Adds additional columns of asset data.

Display Filter

To minimize the amount of data to be viewed, selections can be made after the files have
been processed. In addition, selected views can be chosen.

Business view — licensable applications

Operational view — all applications with partial or full identification
Memory

These are memory saving options. Includes options for selecting:

e File attribute information to load

e Directories to load

e Machine data to load

Chapter 2



* File Version Data
Configures loading of additional information collected at scan time.

‘- The Recognition, Memory and File Version Data settings are disabled and cannot be changed
while data is present in Analysis Workbench. To enable these settings, either unload the data
(select the Unload scans command from the File menu) or restart Analysis Workbench with
an empty workspace.

It is recommended that you check the load option settings before loading in data to the
Analysis Workbench. This will save you having to unload data if a setting needs to be
changed.

Loading and Saving Options

Load configurations can be saved to or loaded from a LoadOptions.ini file (the default file name
is LoadOptions.ini) by using the Load and Save buttons available in every tab page of the
Analysis Workbench Load Configuration dialog box.

Filtering Levels

There are three levels of filtering in Analysis Workbench - and understanding this is key to
understanding how to use the application. Filtering takes place before the recognition phase
and this determines which information will be displayed in Analysis Workbench and the
status it will be given.

Load Filter

This filter is used to decide which files to extract from the scan file for processing and/or
displaying by the recognition engine.

Recognition Filter

This filter determines which of the files that are passed through the load filter are also sent to
the recognition engine for processing. Sending too many files will make it slightly slower,
however, passing less files through the recognition engine will possibly result in inferior
recognition.

This filter is different to the load filter in that a load filter might load .exe, .comand .d11
files, but a recognition filter might be limited to . exe and . com. This means that .d11s are
loaded but not recognized. This can be useful (depending on the Scanner configuration) since
the .d11 files will still give version information without being recognized.

Display/Storage Filter

This filter is based on the recognition status. Recognition status can be:
* Main

Main files identify the application. An application can have multiple main files, but
normally there is only one. If a Main file is found, the application is considered present.

e Associated

Associated files are part of an application but not the main file.
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®  3rd party

Files such as some DLL files that are technically used by the application, but are also
distributed freely and can be used by other applications.

e  CheckVer file

CheckVer files are files that are found in the Recognition library, but do not match any of
the known versions of an application. This usually indicates that it is a newer version. If
this is the case, it might be a good idea to obtain an updated Recognition Library from HP.

e  Unidentified file
These files cannot be identified.
® Unprocessed file

These files have not been processed by the recognition engine. For example, they are
passed to the load filter, but not to the recognition filter.

e Junk files

These files have been identified as junk files as set up in the Recognition tab page
Advanced options.

e Auto-identified file

These files are known to be a device driver file and were not recognized by the application
library. Files used as Device Drivers represent a large portion of the files that are not
identified by the Application Library. Being able to identify these automatically can
significantly reduce the effort required to achieve good recognition rates.

When performing analysis or recognition, it can be beneficial to allow everything to pass
through the display filter (apart from files you have designated as junk). This effectively
causes the Analysis Workbench to store and display information about all files, irrespective of
their recognition status. In this state, the file data that is needed to teach more applications is
available.

Configuring Load Filter Settings

You can use these settings to determine which types of files will be loaded and optionally be
processed by the recognition engine. In addition, whole directories of files can be excluded
from the recognition process.

1 In the Analysis Workbench, select the Load Options command from the File menu.

2  Click the Load Filter tab in the Analysis Workbench Load Configuration—Advanced dialog
box.

Selecting the Load Filters

To select the load filters:
1 Click the Files tab.
2 In the Files group box, select one from the following options:
* Allfiles - Loads all files.
® Nofiles - No files are loaded. For example, use this for hardware only analysis.

e Some files - Enables the Some files options:
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By extension - This allows you to specify the extensions of any files that you want to be
included. Select the extensions from the drop-down list (this list maintains a history of
previously entered extensions) or type the extension directly in to the box. Multiple
extension must be separated by semicolons.

Executable files - This will allow all executable files to be processed against the recognition
engine. Executable files include * .exe, *.com and *.ddl and other files containing
executable code.

Files within Archives - This will process any files in archive files (for example, Zip files,
CAB, LZH). When this option is checked, any files matching the other criteria (extension
and/or executable) are loaded, even if they are inside an archive. If the option is cleared,
no files within archives are loaded.

If this is the only option enabled, nothing is loaded - it is not possible to load only files
within archives.

For obtaining the best recognition in as short a loading time as possible, enable the Executable
Files option only.

Specifying the Directories to Exclude

Examples of directories that you may want to exclude are shown in the following table:

Table 21 Examples of Excluded Directories

Directory Reason

Temp/Tmp Temporary directory holding transient files.

Recycler/Recycled Recycle directory for C:, D: and so on. Stores files moved to the
Recycle bin.

DOS Operating system directory assuming that all these files are
recognized.

1

Analysis Workbench

Click the Directories tab.

Analysis Workbench Load Configuration

Load Filker | Recognition | Asset Fields | Dizplay Filer | Memary | File Yersion D ata
Specify which filez should be lnaded and oplionally pazzed to the recognition engine.

Files | Directories

Ewclude filez in these directories

VWi TYEN TS ervicePackUninstally)

Save list...

Load... ] [ Save... (] l ’ Cancel
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2
3

In the Directories group box select the Exclude files in these directories check box.

Place the cursor in the list box and type in the path (do not include the drive letter) of the

directories to be excluded. An example of the format is as follows:

\WinNT\$NTServicePackUninstall$

You can save the current list displayed in the list box. To do this, click the Save list button
and specify the file name and path of the text file to save to. The default file name is

dirlist.txt.

You can load a previously saved text list file by clicking the Load list button to display a

dialog box. Enter the file name and path or navigate to the file to be loaded.

Configuring Recognition Settings

In This Section

Recognition Overview on page 66

Displaying the Analysis Workbench Recognition Options Tab on page 67
Disabling Application Recognition on page 67

Selecting the Installed Applications List As the Recognition Method on page 68
Selecting the SAI As the Recognition Method on page 68

Adding, Creating or Removing SAIs on page 69

Setting the Preferred Language on page 69

Adding a New SAI File for Application Recognition on page 70

Removing an Existing SAI File on page 70

Creating a New Empty User SAI on page 70

Recognition Overview

Analysis Workbench is able to perform application recognition on the software scanned, while
the data is being loaded from a scan file.

By default the Analysis Workbench uses Master Software Application Index files (Master
SAI) for performing application recognition. The Master SAI files are read-only files that
contain a database of software applications.

There are multiple Master SAI files that can be used at the same time for recognition
purposes:

Master.zsail
French.zsai
German.zsai
Unix.zsai

BaseUnix0S.zsai

All of these files can be found in the following location:

<DataDir>\SAI
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where <DataDir>is the data directory that you specified when you installed DDM Inventory.
By default, this is C: \Documents and Settings\All Users\Application
Data\Hewlett-Packard\DDMI.

By default, the Analysis Workbench is also configured to use the User SAI file. A User SAI file

is one that you, the customer, have customized with applications you have taught using
Analysis Workbench.

You can use multiple User SAI files for recognition purposes. Each User SAI created has a
unique identifier assigned to it.

Backward Compatibility

Backward compatibility has been maintained in this version of DDM Inventory.

Displaying the Analysis Workbench Recognition Options Tab

To display the Analysis Workbench recognition options tab:

1 Select the Load Options command from the Files menu. The Analysis Workbench Load
Configuration dialog box is displayed.

2 Click the Recognition tab.

Analysis Workbench Load Configuration

Load Filter | Recognition | sszet Fields | Dizplay Filter | Memary | File Wersion Data

“When loading data, application recognition can be performed.  Please select the prefered
recognition method from the options below.

Recognition bethod

) Mo recognition
) Installed Applications

(%) Software Application Indes [SA1]

’ Load... ” Save... ] Ok H Cancel

Disabling Application Recognition

This option is used to disable any application recognition. When recognition is disabled,
loading is slightly faster but no application information is available.

To disable application recognition:

¢ In the Recognition Method group, select the No recognition option.
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Selecting the Installed Applications List As the Recognition Method

This method of recognition is based on the operating system’s internal list of applications. As
such, it is not recommended as the preferred recognition method, except for data from UNIX
Scanners.

To select installed applications for the recognition method:

e In the Recognition Method group, select the Installed Applications option. A further option is
activated.

Use Enriched application data if available

When this option is checked, Analysis Workbench uses the application data from the
enriched scan file instead of running ‘real’ recognition. If no file data is loaded this is
much faster.

Selecting the SAI As the Recognition Method

1 In the Recognition Method group, select the Software Application Index (SAIl) option.

2 Click the Advanced button to set further options if required. The Advanced Configuration -
Software Application Index dialog box is displayed.

Setting General Options for the SAI

B Advanced configuration - Software Application Index EI[E|FZ|

General | Salz | Filering

Mizcellansouz

Level 3 recognition heuristics

Auta-identify unrecognized device driver files

Languages

Preferred Language zelect language j

[ ] Overide 05 Language

k. ] ’ Cancel

Setting Level of Recognition Used

To set the level of recognition used:

1 Select the General tab in the Advanced Configuration - Software Application Index dialog box.
2 In the Miscellaneous group, select options for the level of recognition used.

® Level 3 recognition heuristics
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If this option is enabled, the recognition engine defers its final recognition decision
until all the files in all the directories on the machine have been read. If disabled,
machine-based recognition does not take place and recognition data is returned after
each directory is loaded. A time overhead of about 10% is normal when Level 3
Recognition is enabled.

e Auto-identify unrecognized device driver files

When enabled (by default), files that cannot be identified by standard SAI recognition
and have the Device Driver attribute will be marked as recognized. Files used as
Device Drivers represent a large portion of the files that are not identified by the
Application Library. Being able to identify these automatically can significantly
reduce the effort required to achieve good recognition rates.

Setting the Preferred Language

If you are using a national SAI file, for example, german.zsai or french.zsai together
with the Master. zsai you will want to set this option.

Preferred language is used for cases when the recognition engine encounters more than one
language version of the same file— for example, Microsoft Word in English and in French.
Because these versions are equally recognized, this setting instructs the recognition server on
which of the versions to select.

To set the language options:

1

Select a language from the drop-down list.
This will only work if exactly one of the versions matches the language.

Check the Override OS Language box if you want the recognition engine to overlook the
operating system locale setting and take the setting you specified in the Preferred
Language box.

A Summary of the Process

The process can be summarized as follows:

A rating is obtained for all versions that are possible matches.
The version(s) with the best rating are found.

If there is only one version, then the process goes no further, otherwise, it takes the
language (locale setting) of the operating system, if it is available in the scan.

If the operating system locale setting is not available, it takes the setting you specified
here in the Preferred Language box.

Adding, Creating or Removing SAls

The options on the SAIs tab page allow you to:

Add a new SAI file to be used for application recognition.
Remove an existing SAI file.

Create a new empty User. zsai file.

The list box on this tab page displays the following information:

Analysis Workbench

The path to source files for the SAI — both read-only Master SAls and editable User SAls.
The SAI ID number for User SAI files. Master SAI files do not have an ID.
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A description of the SAI files.

The size of each SAI file (in kilobytes).

The number of application versions in each SAI.

The type of SAI file:

— Master - Read-only SAI (Master SAI)

— Editable - (User SAI)

The creation date for a Master SAI file or for a User SAI, the date the file was last saved.

SAls Used to Store Rule-Created ltems

Any items encountered by Analysis Workbench that were created by rules will be added to the
SALI file specified here. These rules are present within the SAI files themselves and additional
rules can be added using SAI Editor.

Select the SAI file from the drop down list. The drop down list contains a list of the SAls
currently loaded.

If this field is left blank, Analysis Workbench will create a file called Auto. zsai and put this
in the same location as the first SAI in the list.

Adding a New SAl File for Application Recognition

To add a new SAll file for application recognition:

1
2
3

Select the SAls tab in the Advanced Configuration - Software Application Index dialog box.
Click the Add button on this tab page.
Navigate to and select the SAI file (Master or User) you want to use for recognition.

The SAI file is added to the list box which means the file will be included in for application
recognition.

Removing an Existing SAI File

To remove an existing SAl file:

Select the file in the list box and click the Remove button.

Creating a New Empty User SAl

To create a new empty User.zsai:

1

Click the Create button. The Create a User dialog box is displayed. Enter or navigate to the
directory where the SAI file is to be created.

Enter a description for the file.
Click the OK button.

The file is automatically assigned a unique ID. However, you may already have an SAI
with the same filename. If so, a Confirm message will be displayed.

A file named <filename> already exists in this directory. Overwrite this
file?

Chapter 2



Click Yes if you want to overwrite the existing SAI file or click No to return to the dialog
box and assign a new ID to the SAI file.

If you have made modifications to the cfgNextSAIID setting in the SAlL.ini file, you may see
the following message. This happens when the value for the ID in the ini file is missing
or lower than the highest ID in the user SAls currently loaded. This message is for
information only - the DDM Inventory components will correct this situation
automatically by inserting the correct ID value into the ini file.

The next User SAI ID cannot be found in the settings file.

This probably means that you are using User SAIs created with a different
version of the software, or created on a different machine.

Please take care to set the new ID to a value that is unique across your
organization.

Setting Filtering Options for the SAI

1

Analysis Workbench

Select the Filtering tab in the Advanced Configuration - Software Application Index dialog box.

BA Advanced configuration - Software Application Index [Z”E|E|

General | Sals | Filkering

[ ] &pply recognition to selected files only

[] Treat files matching the following regular expressions as junk

ak l [ Cancel

Select the options as required:
°*  Apply recognition to selected files only

This is a recognition filter that determines which of the files are sent to the
recognition engine for processing. Sending too many files can make it slightly slower.

®* By extensions

Allows you to type in the extensions of any files that you want processed against the
recognition engine. Select the extension from the drop-down list (this list maintains a
history of previously entered extensions) or type the extension directly in to the box.
Multiple file types must be separated by a semicolon.

e Executable files

All executable files will be processed against the recognition engine. Executable files
include *.exe, *.com files, DLLs and other files containing executable code.

® Files within Archives
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Processes any files in archive files. The following archive file types are supported:

ARJ, ZIP v1, ZIP v2, LHA, LZH, ARC, CAB, TAR, GZIP, TAR/GZIP and PAK

For the best application recognition, select the Executable Files option.

Junk Files

Some files may be executable but are of no interest for licensing or other purposes. These files
are often identifiable via the file name.

The Treat Files matching the following regular expressions as junk option is a way for the
recognition engine to ignore such files, by allowing one or more file name masks to be specified
as junk.

These files are not passed to the recognition engine and will be marked as junk. This is
available in the Display Filters tab page so junk files can be discarded and not shown.

When matching the junk file name against the junk filter regular expression, the file name is
first converted to lower-case. For this reason, all letters entered as part of the regular
expression must be in lower-case for a match to successfully occur.

To set junk filters:

1 Select the Treat Files matching the following regular expressions as junk option.

2 Type the file name masks you want to treat as junk. See the next section for examples of
regular expressions.

Regular Expressions

This section outlines some of the regular expressions commonly used.

Table 22 Regular Expressions

Character | Meaning

Match any character

+ Match one or more of the previous character.
For example:
A+ matches one or more As

* Match zero or more of the previous character.
For example:
A* matches zero or more As.

? Make the previous character optional. For example:
assets?
matches a string containing either asset or assets.

The ? only applies to single characters when there are no enclosing
parentheses.
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Table 22 Regular Expressions

Character

Meaning

A

The characters after this symbol must appear at the beginning of the string.
For example:

Axsf

means that the string to be matched must start with the characters xsf.

The characters before this symbol must appear at the end of the string. For
example:

xsf$

means that the string to be matched must end with the characters xsf.

This removes the special meaning of a character. For example:
\.

matches the . character, since the \ removes the special meaning of the .
character.

Character class.

Match one of the items contained in the square brackets. For example:

[123] will match either a 1, or 2, or 3.

[123]+, would match a sequence of 1's, 2's and 3's or any combination of them.

Note that within a character class, the » character does not have its usual
status but means any character except those in the class.

For example:
A character class of [*123] will match any character that is not 1, 2 nor 3.

A character class containing a - between two characters means a range of
characters. For example:

The character class [c-h] means all the lower case letters starting from ¢ and
ending in h.
There are a number of additional special predefined character classes to
represent some commonly used groups of characters.
[:alnum:]] Any alphanumeric character

alpha:]] Any alphabetic character

blank:]] Space or horizontal tab

ctrl:]] Control character

lower:]] Lower case letter

punct:]] Punctuation character

[
([:

([:

([:

[[:digit:]] Decimal digit
(:

([: ]

IE ]

upper:]] Upper case letter

0

Groups a set of characters together. For example:
(assets)?
would make the entire word assets an optional part of the match.

Analysis Workbench
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Configuring Analysis Asset Fields

Analysis Workbench can be configured to construct any number of additional named asset
fields. These asset fields are constructed based on data collected at scan time. The analysis

asset fields defined here can be displayed as a column in the Machines window.

To customize the columns that are displayed, select the Edit Column option from the Columns

drop-down toolbar menu in the Machines window.

Adding an Asset Field Extract

The fields are set up in a manner similar to that found in the Scanner Generator. Five
different types of fields can be constructed:

Text file Extract - Takes data from a plain text file (similar to File Extract Field of Scanner).

Ini Field Extract - Takes data from an ini file (no equivalent in Scanner).

CSV File - Takes data from CSV files such as peripheral sheets (allows an external CSV
file, containing a list of data associated with asset numbers to be parsed and loaded along

side the other data).

Environment - Takes data from environment strings (equivalent to same field in Scanner).

Sequence - Takes data from a sequence of asset fields (equivalent to same field in
Scanner).

To configure the asset field extract seftings:

1

Select the Load Options command from the File menu.

Analysis Workbench Load Configuration

Load Filter | Recogrition | &sset Fields | Display Filter | Memary | File Version Data
Mew read-only Aszet Field can be congtructed while loading scan data. Please uze the
caontrals on this page to configure the desired fislds.
Caption Field Field Tyupe Field Data Drefauilt
| add. || Edt. || Remowe
’ Load... ] ’ Save... ] ak. l ’ Cancel

Click the Asset Fields tab. The Asset Fields tab contains a pane with five columns:

e Caption - The caption as specified in the Asset Data page of the Scanner Generator.

¢ Field - The number of the Analysis field (1 to 28)
* Field Type - The type of field to extract the information
® Field Data - The source of the field information

e Default - Any default value that has been set
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Right-click anywhere in the pane to display a menu with the following options:
* Add - Adds a new analysis asset field.

e Edit - Edit the details for an existing asset field.

e Remove - Removes an existing asset field from the list.

Select the Add option. A New Analysis Asset Field dialog box is displayed.

Select the type of field to be extracted.

Use the controls on this page to configure the desired fields.

Text File Extract Asset Field

This field type extracts information from a single line in a named text file.

A useful file extract includes the predefined SMS file which extracts the SMS Unique

Machine ID.
New analysis Asset Field E|
Figld Type File Selection Estract Options
(%) Teut File Extract File Hame Search String
) Ini File Extract
) T3V File File Directary Remave leading blanks
. () Use first occunence Remove trailing blanks

O Environment (3 Uze pricritized directany list:
) Sequence

Field

Analysiz 1 W

Caption :
Analysis 1

I Ok l ’ Cancel

"- The file you wish to extract from must be a file that is included in the Stored Files section. If
the file is not there it will not work. In other words, the Scanner has to be set up to store the
file before you can extract from it in Analysis Workbench.

To set up a new text file extract asset field:

1
2
3

Analysis Workbench

Select Text File Extract as the field type.
Assign a caption for the field if required, by typing it in the Caption field.

In the File Name box, specify the name of the text file that the information is to be
extracted from.

In the Search String box, specify the text string that is going to be located.
Assign the number for the analysis field by selecting it from the Field drop-down list.

Check the Remove leading blanks box, to remove blank spaces (if there are any) before the
search string located in the text file.
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7 Check the Remove trailing blanks box, to remove blank spaces (if there are any) after the
search string located in the text file.

8 In the File Directory group box specify where to look for the file. This is a prioritized search
sequence list. Select one of the following options:

— Use first occurrence Analysis Workbench uses the first match of the file that it

encounters.

Use prioritized directory list A list box is enabled, which allows you to specify the
priority of directories where the file might be located. For example:

%BASEOS% (the base operating system directory)
C:\Winnt

This location will have the highest priority, that is, if the file is located in this
directory, then this file will be used.

%BASEOS% \System (the System directory in the base operating system directory)
C:\'Winnt\ System

If the file is not located in the %#BASEOS% directory and is encountered in the
%BASEOS% \ System location, then this location will have priority as the source for
the text file, and so on.

9 Specify any extract options as required by clicking the Options button. See Specifying
Extract Options for Text Files, ini Files, CSV Files and Environment Variables on page 81
for information about how to do this.

Ini File Extract Asset Field

New analysis Asset Field @

Field Type File Selection Extract Options

) Tewt File Extract File: Harne Iri file zection

(%) Ini File Extract

() CSV File File Drirechany Key Mame

) (%) Uze first occunence
© Enwironment ) Usze pricritized directary list;
() Sequence Remave leading blanks
Fiemnaove trailing blanks

Field

Analyziz 1 w

Caption :
Analysiz 1

I Ok ] ’ Cancel

As with the text file extract asset field, this extracts information from a file collected by the
Scanner as a stored file.

The ini file you wish to extract from must be a file that is included in the Stored Files section.
If the file is not there it will not work. In other words, the Scanner has to be set up to store the
file before you can extract from it in Analysis Workbench.
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The Format of an ini File

Initialization files (.ini files) contains a number of different sections. Each section contains
lines of settings (Key Names) applicable to that section. The format of the ini file is as follows:

[Section Namel] - (The name of the first section)

Key Namel = Value (The first setting)
Key Name2 = Value (The second setting)

[Section Name2] - (The name of the next section)

Key Namel = Value (The first setting)
Key Name2 = Value (The second setting)

The advantage of using this type of asset field instead of using a text file extract asset field, is
that it is possible to pinpoint exactly which Key Name you require and in which section.

To set up an ini file extract asset field:

1
2

Analysis Workbench

Select Ini File Extract as the field type.

In the File Name box, specify the name of the ini file that the information is to be extracted
from.

Assign the number for the analysis field by selecting it from the Field drop-down list.
Assign a caption for the field if required, by typing it in the Caption field.

In the File Directory group box, specify where to look for the file. This is a prioritized search
sequence list. Select one of the following options:

— Use first occurrence - Selecting this option, Viewer will use the first match of the file
that is encountered.

— Use prioritized directory list - Selecting this option enables a list box, which is used to
specify the priority of directories where the file might be located. For example,

%BASEOS% (the base operating system directory) C:\ Winnt

This location will have the highest priority, that is, if the file is located in this
directory, then this file will be used.

%BASEOS%\ System (the System directory in the base operating system directory)
for example, C:\Winnt\System

If the file is not located in the 2BASEOS% directory and is encountered in the
%BASEOS%\ System location, then this location will have priority as the source for
the text file, and so on.

In the Ini file section box, specify the section of the ini file that the asset field extract is
located in. This is the section identifier in the ini file (surrounded by square brackets []).
Do not include the brackets [].

In the Key Name box, specify the Key Name contained in the specified section of the ini file.
This is the start of the string before the equals (=) sign. Do not include the = sign.

Check the Remove leading blanks box to remove blank spaces (if there are any) before the
Key Name located in the ini file.
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9

Check the Remove trailing blanks box to remove blank spaces (if there are any) after the
Key Name located in the ini file.

10 Specify any extract options as required by clicking the Options button. See Specifying

Extract Options for Text Files, ini Files, CSV Files and Environment Variables on page 81
for information about how to do this.

CSV File Extract Asset Field

Hew analysis Asset Field E|
Figld Type C5Y File
) Text File Extract ﬂ
) Ini File E stract Column containing machine dszet Humber ; 1 |E|

Field

Analysiz 1 W

. Mote: The first rove must contain column headers

) Erwvironment
Fields to inclhude;

() Sequence

] l ’ Cancel

Allows an external Comma Separated Variable (CSV) file, containing a list of data associated
with asset numbers to be parsed and loaded alongside the other data.

1
2

Select CSV File as the field type.
In the CSV File box, navigate to the CSV file that is to be loaded.
The first row of this file must contain column headers.

Enter the number of the column that contains the machine asset number (that is, the
primary identifier field). As the number changes so does the fields selection. For example,
if the primary identifier is column 2 in the CSV file, then specify this as the number ‘2’ by
either typing it directly into the field or by using the arrows.

The fields contained in the CSV file are displayed in the Fields list box. Select the fields to
be included by selecting the check boxes next to the field names.

The primary identifier column (asset number field) check box is disabled and cannot be
deselected. This is because it is necessary to load this field.

Select the Append (csv) to column name option if you want the extracted asset fields to be
displayed with the word ‘(csv)’ after the column header name in the Machines window.

Specify any extract options as required by clicking the Options button. See Specifying
Extract Options for Text Files, ini Files, CSV Files and Environment Variables on page 81
for information about how to do this.
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Environment Variable Asset Field

x]

Mew analysis Asset Field

Figld Type E rnevironment vaniable extract
() Text File Extract

O Ini File Estract Enviranmment variable name

) OS5 File

(%) Environment

) Sequence

Field
|.-‘-‘-.na|_l,lsis 1 w |

Caption :
(Analyss 1 |

s l ’ Cancel

This type of field accepts data from a specified environment variable.

To set up an environment variable extract asset field:

1 Select Environment as the field type.

2 Enter the variable name in the Environment variable name field. An example of an
environment variable is:

ComSpec=C: \WinNT\System32\cmd.exe

You can check for environment variable names by looking in the Hardware > System tab in
Viewer.

3 Assign the number for the analysis field by selecting it from the Field drop-down list.
4 Assign a caption for the field if required, by typing it in the Caption field.

5 Specify any extract options as required by clicking the Options button. See Specifying
Extract Options for Text Files, ini Files, CSV Files and Environment Variables on page 81
for information about how to do this.
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Sequence Asset Field

Mew analysis Asset Field

Field Type Field Sequence

) Tewt Fils Extract f |Field Mame N
) Ini File Extract

() C5V File

) Erwvironment

%) Sequence

x]

]| afe] o]~
|

W

|.-'1'-.na|_l,lsis 1 W |

| griore strings

M atching Shorter than

|.ﬁ.nal_l,lsis 1 | | | | 1 |E” O ptions. ..

I ]9 H Cancel ]

This field type extracts information from one of up to ten specified fields. The value returned
as the results of the sequence field, will be the first of these fields which contains a non-blank

value.

To set up a sequence asset field:

1
2
3

Select Sequence as the field type.
In the Field sequence box, click in the Field Name column and select the desired field.

In the Ignore strings group box, specify the criteria for a blank field using one or all of the
following methods:

— In the Matching box, enter a sequence of strings (case-sensitive) separated by

semicolons.

If the content of the field matches (is equal to) any of the strings specified here, the
field is considered to be blank. For example, if the text string Not Found is entered
here, then a field that has the value ‘Not Found’ is considered to be blank.

Multiple entries must be separated by semicolons ( ;), for example:

‘Unknown;Not Tested’

— You can type a strings in the form: *STRING*

Here the asterisks (*) are ignored and any string that contains the text between the
two asterisks will be ignored too.

Specify ignore strings that are less than ‘n’ characters.

In the Shorter than box, use the arrow keys or type in a number to specify the
maximum length of text strings that are to be used to define a blank field (between 1
and 255). If the string is shorter than the specified number, then the field will be
considered blank.

4 Assign the number for the analysis field by selecting it from the Field drop-down list.
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5 Assign a caption for the field if required, by typing it in the Caption field.

6 Specify any extract options as required by clicking the Options button. See Specifying
Extract Options for Text Files, ini Files, CSV Files and Environment Variables on page 81
information about how to do this.

Specitying Extract Options for Text Files, ini Files, CSV Files and Environment Variables
Text file, ini file and environment variable asset fields can be set up so that only part of the
string is extracted instead of the entire string.

They can also be set up, for example, to use the last part rather than the first part of the
string. This can be very useful for obtaining the last part of an automatic field that is too long.

In addition, a default value can be specified for situations where no matching data has been

found.

To specify extract options for text, ini and environment variables:

1 Click the Options button in the New Analysis Asset Field dialog box. The Asset Field Extract
Options dialog box appears.

2 In the Extract characters from group box, specify whether you want to use the last part or
the first part of the string. Select one of the following options:

e Start - Uses the first part of the string. Use the arrows in the Skip characters box to
specify how many characters you want to skip from the beginning of the string.

e End - Uses the last part of the string. Use the arrows in the Skip characters box to
specify how many characters you want to skip from the end of the string.

3 In the Options group box, select the options you want:

e Convert to upper case - Select this option to convert the alphabetic characters to upper
case.

e Treat field as File Name - Select this option to treat the string in the asset field as a file
name. Some characters are however invalid in file names, so any invalid characters
can be replaced with the character specified in the Replace invalid characters with
box.

For example, underscore ‘_’ is a valid file name character and can be used to replace
invalid characters.

Alternatively, invalid characters can be deleted by checking the Delete invalid
characters box.

If the extracted field is empty or is not found (that is, there is no matching data), then
a default value for the string can be specified in the Default Value box.

For example, if the text string ‘Not Found’ is entered in this box, then an empty field
or a field that has not been found will be displayed with this text.

Displaying the Additional Asset Fields

After the asset field extracts have been selected, the columns need to be displayed in the
Machines window. To do this:

e (Click the Columns toolbar button in the Machines window to display the Select columns to
display dialog box.

The additional extract fields are included in the Assets category.
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Refer to The Machines Window on page 103 for more detailed information about how to
include columns to display in the Machines window.

Although these fields are in the Assets category, they are not editable.

Configuring Display Filter Settings

In the Analysis Workbench, select the Load Options command from the File menu. Click the

Display Filter tab.

Analysis Workbench Load Configuration

Filez
Becognized

b ain files
Azzociated files
Jrd Party Files

Applications
() Load Buziness View

(%) Load Operational Yiew

Load Filter | Fiecognition | Asset Fields | Display Fiker | Memaory | File Yersion Data

When filez have been processed by the recognition engine, the options below can be uzed ta
include anly the files that are of interest, bazed on recognition level.

IInicertain

() Treat as unidentified
{(#) Display as Checkyer
{3 Do not display

Fleaze zelect an Application Yiew from the list below. Only licensable applications are included in
the buginess view; the operational view includes all applications whether partially or fully identified.

| Load. || Save.

Unrecoghized
Unidentified files
Urprocessed files
[ 1Junk files
Autc-identified files

] l ’ Cancel

When files have been processed by the recognition engine, the following options can be used to
include only the files that are of interest, based on the recognition level.

These files can be identified in two ways when displayed in the Files information window:

e The color of the entry

e The entry in the Status column

The following table shows the default color and the Status column entry for the five different

file recognition levels.

Table 23 File Recognition Levels

Recognition level

Default color in Files
window

Status column entry
in Files window

Main file Red 1 Main
Associated file Green 2 Assoc
3rd Party files Green 3 3rd Party file
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Table 23 File Recognition Levels

Default color in Files | Status column entry
Recognition level window in Files window
CheckVer file Purple 4 CheckVer
Unknown file Blue 5 Unknown
Unprocessed file Black 6 Unprocessed
Auto-identified Olive 7 Auto-id
Junk file Olive 8 Junk

The colors associated with these file recognition levels can be customized. See Customizing
Window Layouts on page 28.

Selecting the Files to be Displayed

In the Files group box, select the types of files to be displayed from the following three
categories:

Recognized

This category deals with files that have been recognized. Select from the following:

Main files

The main files for an application, for example, Winword.exe are displayed in red (by
default) in the Analysis Workbench Files window.

They are used to determine how many copies of the application are found.
Associated files

Files that are part of an application but not the Main file, for example, Printer.com are
displayed in green (by default) in the Analysis Workbench Files window.

3rd Party Files

Files such as some DLL files that are technically used by the application, but are also

distributed freely and can be used by other applications as well. Another example of a 3rd
Party File is InstallShield, which is packaged with an application from a different vendor.
The files are also displayed in green (by default) in the Analysis Workbench Files window.

Uncertain

This category deals with files that have been partially recognized (that is, they have been
identified but the version cannot be established with certainty). Select one of the following:

Analysis Workbench

Treat as unidentified files
The files will be given an unidentified recognition level and will be treated as such.
Display as CheckVer

No description or versions are given for these files, but the word <Check Ver> is shown in
the version column. This indicates that something is known about the file but it does not
accurately conform to the version information held for it, and the version should be
checked.

Do not display
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The files will not be displayed in the Files window. In other words, they are ignored.

Unrecognized

This category deals with files that have not been recognized or have not been processed
against the recognition engine. Select from the following:

® Unidentified file
These files have been processed, but not recognized.
®* Unprocessed files

These files have not been processed by the recognition engine. These files have been
selected for loading using the load filter, but have not been included in the recognition
filter.

e Junk Files

These files have been set up to be treated as junk by the recognition engine (that is,
recognition does not occur on these files). Check this option if you want these files to be
displayed. The default is to have this option unchecked - that is they are not displayed.

o Auto-identified files

If this option is checked (the default), automatically identified files are loaded. If
unchecked, these files are not loaded into memory.

Selecting the Application View

This is the same as globally tagging Main files in the Files window and applying a Files filter
in the Applications window. In effect, this reflects the contents of the SAIs that have been
recognized in the current load set.

In the Applications group box, select one of the following:
® Load Business View

The business view displays only applications with a Main file (that is, applications that
require a license and have been recognized). Partially installed applications are not
displayed.

® Load Operational View

The operational view displays all applications whether partially or fully identified. The
Application window essentially summarizes what has been recognized — irrespective of
whether the applications are recognized with a Main file (that is, licensable) or not.

Configuring Memory Settings

Saving memory not only saves time at loading but also during sorting and selections,
therefore it is worth while considering selecting memory saving options. Because of the
number of files that will be loaded, removing unnecessary file detail can have significant
impact on the time taken to load and the amount of memory needed. This is particularly
useful when loading a large quantity of scan files.

When more than the physically available memory is needed, the Operating system uses a
page file. Access to this file is of course much slower than to real memory and therefore
degrades performance significantly.
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In the Analysis Workbench:

1
2

Select the Load Options command from the File menu.

Click the Memory tab. This option allows you to specify which attributes are loaded for a
file. Specify the file details to load by selecting the following options as required:

— Size - The file size. This option is permanently disabled and cannot be unchecked. The
Analysis Workbench always loads the file size.

— Signature - The signature (checksum of the first 8 kb).
— Modified time - The time stamp indicating when the file was last modified.
— Accessed time - The time stamp indicating when the file was last accessed.

— Type - The type of file (for example, DOS executable file, Windows executable file, OS/
2 DLL file).

— Attributes - The system attributes for a file (for example, hidden, archive, read-only).

— Software Utilization Data - The number of days that the application was used (as a
percentage) over a period of time.

Loading all directories and cross-referencing them with files, machines and applications
can take up a significant amount of memory. If only parts, or none of the information is
required, then select one the appropriate options:

— Load all directories
— Load only directories containing loaded files
— Do not load directory data

Select the machine data to be loaded. This is a memory saving option, which allows you to
load only some data for each machine. In the Machine data to load group box select from
the following options:

— Asset and Hardware data
— Include Shortcut data

— Include Services data

— Include Environment data
— Include SMBIOS data
Click the OK button.

Configuring File Version Settings

By setting file version options, extra data is made available in the Files window. Specific fields
can be selected to limit the amount of information loaded. This information can then be
displayed by selecting the column name in the Columns toolbar menu.

In the Analysis Workbench:

1
2
3

Analysis Workbench

Select the Load Options command from the File menu.
Click the File Version Data tab.

Select an entry (a single-click in the check box) in the File Version Data page to include it.
Alternatively, right-click in the pane and select an option from the menu:

e Select All - Selects all the entries.
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Information Collected by Version Data

The following information can be collected using Version Data:

e Select None - Clears all of the entries.

DOS 8.3 Name
Real Name
Description
Company Name
File Description
File Version
Internal Name
Legal Copyright
Original File Name
Product Name

Product Version
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Loading Data from Scan Files

In This Section

e  Process for Loading Data into Analysis Workbench on page 87

e Unloading Data from Analysis Workbench on page 88

e Loading Data from a Scan File on page 89

e Setting Scan File Load Options on page 89

e Loading Data from a Scan File on page 89

e Selecting Files on page 91

e (Checking Options on page 91

e Loading Scan Files from a Single Directory on page 92

e Loading Scan Files from Multiple Directories on page 93

e Selecting Scan Files for Specific Computers (Complex Queries) on page 93

e Example Complex Query on page 99

Process for Loading Data into Analysis Workbench

This section explains how you can load data into Analysis Workbench after you set the load
options manually or you have loaded a preconfigured option from the Quick Config dialog box.

Analysis Workbench is an analysis tool and requires data to analyze. This data can be loaded
from Compressed XML Files (XSF) scan files.

You can load files from the processed directory. Enriched scan files are created here. By
default the directory is in the following location:

C:\Documents and Settings\All Users\Application Data\Hewlett-Packard\
DDMI\scans\Processed
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The following diagram shows the process for reading in data:

Set loading options from the File
menu or select a preconfigured
configuration from the Quick Config

dialog box.

Set scan file load
options (if required)

I

Load data from scan
files - XSF' (.xsf)

l l

Load from a Load from multiple
single directory directories
v v
Select scan files Query specific
directly computers

|Load scan ﬁlesl

Unloading Data from Analysis Workbench

There may be times when you need to unload scan files from the Analysis Workbench
workspace. For example:

e The Recognition, Memory and File Version Data load options are disabled and cannot be
changed whilst data is present in Analysis Workbench.

e A previously saved state image can be loaded only when there is no data loaded in the
Analysis Workbench.

To Unload Scans from the Analysis Workbench Workspace:

e Select the Unload Scan Files > Current (name of scan) command from the File menu. The data
for the currently selected scan is unloaded. The name of the selected scan is displayed in
brackets next to the command.

e Select the Unload Scan Files > Tagged command from the File menu. Scans that are tagged
in the Machines window are unloaded. This command is not available if there are no
tagged machines.

e Select the Unload Scan Files > Untagged command from the File menu. All untagged scans
in the Machines window are unloaded.

This option is not available if all machines are tagged.
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e Select the Unload Scan Files > All command from the File menu. All scans loaded into the
Analysis Workbench are now unloaded.

Loading Data from a Scan File

The Analysis Workbench provides various options for reading in scan files to analyze the data
collected for a computer population.

Scan files read into the Analysis Workbench are usually selected from a repository directory
(or directories) used to store all the scan files for a computer population.

To load data from a scan file perform the following steps:

1 Select the Load scan files command from the File menu.
The Open scan file dialog box is displayed.

2  Click the Options button to set the scan file load options. See Setting Scan File Load
Options on page 89.

3 Load the scan files in one of the two following ways:
¢ From a single directory
¢ From multiple directories

4 Load the scan files using one of the two methods:

e Select scan files directly from the directory where they are stored. This allows you to
select individual files, a group of files or all the files in the selected directories.

e Select scan files for specific computers using the hardware and asset data collected for
each computer. A query facility is used for this method, so that the files matching
specified criteria for the hardware and asset details recorded during the inventory, are
selectively read in.

Whichever method is chosen, the Analysis Workbench reads in the software file information
for each scan file, according to specified load options.

Setting Scan File Load Options

After the scan files or data to be loaded into Analysis Workbench have been selected, the
software information collected for each computer inventoried is read in according to the
options selected for processing information. These are referred to as the File Load Options.

Scan file load options are used to deal with situations that can arise when loading older scan
files and specify how to handle scan files with the same name.

e (Click the Options button on the Open scan file dialog box.
The File Load Options dialog box is displayed.
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The following load options can be enabled or disabled:

Table 24 Load Options

Option

Description

File Age Options

Load all possible files
(ignore age limit)

When selected, all scan files (regardless of the age of the scan file
itself) are loaded.

Ask what to do if file
older than limit

Selecting this option make the File age limit (months) box
available. Use the arrows to set the age limit in months.

A prompt is displayed when the file to be loaded is older than the
specified file age limit.

Ignore attempts to load
files older than limit

Select this option to ignore any attempt to load a file that is older
than the age limit specified in the File age limit (months) box.

File Clash Options

Load newest file

Select this option to allow the file with the newest date to be
loaded, if two files with the same name are loaded.

Ask which file to load, if
different

Select this option to allow a prompt to be displayed asking which
of the files to load, when two identical file names are
encountered.

Ignore attempts to load
duplicates

Select this option to exclude any duplicate files from being
loaded. The first file encountered is loaded.

Load new scan file,
unload the current scan
file

Select this option to allow the file with the newest date to be
loaded. The file with the older date will be unload.

Files

Show hidden files

Select this option to show hidden files in the Open scan file
dialog box.

Scan file description
thread

Select this option to display the descriptions of the data files in
the Load scan file dialog box.

Directory List

Show by default Select this option to allow scan files to be loaded from multiple
directories when the File Load scan file command is selected
from the File menu.

Load default directory This option is only enabled when the Show by default option is

list selected. Selecting this option will load the default directory list
when the Open scan file dialog box is opened.

Other Options

Set as default
(Permanently change the
file load preferences to
the options above)

Select this option to enable the load options specified on this
form to be used as the default settings when scan files are
loaded.
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Loading Old Scan Files

If the Analysis Workbench encounters a file that is older than the age limit set in the file load
options (see Setting Scan File Load Options on page 89), an Old file found dialog box is
displayed. The name and path of the scan file is displayed along with some basic information.
From within this dialog box, you have the options to do the following:

e Ignore this file, as it is older than the limit set in the file load options.
e Load this file regardless of its age.

The Set as default option in this dialog box will permanently change the file load preferences
to the previous options.

You can change the default settings later by clicking the Options... button in the Open scan
file dialog box (File > Load scan files...).

Selecting Files

In the Open scan files dialog box, clicking on a file entry in the bottom pane of either directory
view will highlight it in blue. However, this does not mean that the scan file will be
automatically loaded. For this to happen, the check box next to the scan file must be clicked.
You can also use the space bar to check and clear the box.

A scan file in the list can be:

e Selected (highlighted in blue) and/or

¢ Checked (check mark set) or

¢ None or both of the above

Checked scan files will be loaded when the OK button is clicked.

By selecting files you can group them for operations carried out from the shortcut menu
(check/uncheck selected, remove selected, sort by selected).

Multiple files can be selected by clicking on a file and using the Shift/Ctrl keys at the same
time as clicking on other files. This allows the Open scan file dialog box to be more flexible.

For example, right-click on a scan file and select Check all from the menu, select a range of
files and then select Uncheck selected.

If you do not check any files, the Open scan file dialog box will ask to load either of the
following:

e All files, if no files or only a single file is selected.
e  Selected files, if more than one is selected.

) You can use the drag/drop for loading in scan files. Drop any number of directories, scan files,
or a combination of both onto the Analysis Workbench window to load the scan files and all
files in the directories.

Checking Options

Checking options can be set by using the shortcut menu which is available by right-clicking
anywhere in the bottom pane. This menu allows you to:

e Check all — Checks all entries in the list.
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Check none — Unchecks all entries in the list.

Select all — Selects all entries in the list.

Select none — Deselects all entries in the list.

Check selected — Checks the selected entries in the list.

Uncheck selected — Clears the check mark from selected entries in the list.

Remove selected from list — Removes any selected entries temporarily from the list. The file
entries are no longer displayed in the list, but are not deleted from the disk.

Sort by checked — Moves all checked entries to the end of the list.
Sort by selected — Moves all selected entries to the end of the list.

Query Displays a Complex Query dialog box, which allows you to load scan files for specific
computers. See Selecting Scan Files for Specific Computers (Complex Queries) on page 93
for more information.

Selecting Multiple Files

Multiple files can be selected by clicking on a file and using the Shift/Ctrl keys at the same
time as clicking on other files. This allows the Open scan file dialog box to be more flexible.

For example, right-click on a scan file and select Check all from the menu, select a range of
files and then select Uncheck selected.

Loading Scan Files from a Single Directory

Scan files can be loaded from a single or multiple directories. By default the Open scan file
dialog box allows you to load scan files from a single directory.

To open scan files from a single directory:

1

In the top pane in the Open scan file dialog box, navigate to the directory that you want to
load the scan files from. Any scan files found in that directory will be displayed in the
bottom pane.

As the mouse pointer is placed over a scan file in the bottom pane, details are displayed in
the status panel.

Check the box next to the scan file to include it for loading (you can also use the space bar
to check and clear the box). Checking options can also be set by using the shortcut menu
which is available by right-clicking anywhere in this pane. See Checking Options on
page 91.

Set scan file load options if required by clicking the Options button in the Open scan files
dialog box.

Click the OK button to load the checked scan files. A progress indicator is shown.

If an error is encountered during loading, each error is logged in the Log window (Select
the Log Window command from the Window menu to display the Log window) and an
error message is displayed at the end of the load sequence.

’ To load only one scan file, double-click on it.

To load scan files from multiple directories, click the Dir List button. See Loading Scan Files
from Multiple Directories on page 93 for more details.
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Loading Scan Files from Multiple Directories

To load scan files from multiple directories, in the Open scan file dialog box (single directory
view), click the Dir List button.

An extra pane is displayed in the upper right area of the dialog box. This is the list of
directories to load. For each directory, this pane displays the following:

e The total number of files in the directory and their combined size.

e The total number of scan files to load and their combined size.

¢ The total number of scan files selected and their combined size.

The bottom pane displays all the scan files that are available in any of the included

directories.

To load scan files from multiple directories:

1 In the Open scan file dialog box (single directory view), click the Dir List button.

2 Navigate to the directory you want to load the scan files from and use the buttons as
follows.

e Add Dirs Add this single directory to the list.

e Add w/Subdirs Include this directory/drive plus any subdirectories contained in that
directory/drive.

e Clear list Clear the list of directories.
e Load list Load a previously saved default directory list.
e Remove Dir Remove this directory from the list.

Any scan files contained in the selected directory (or directories) will be displayed in the
bottom pane. As the mouse pointer is placed over a scan file in the bottom pane, details
are displayed on the status panel.

3 Check the box next to the scan file to include it for loading (you can also use the space bar
to check and clear the box). Checking options can also be set by using the shortcut menu
which is available by right-clicking anywhere in this pane. See Checking Options on
page 91.

4  Set scan file load options if required by clicking the Options button in the Open scan files
dialog box.

5 Click the OK button to load the checked scan files. A progress indicator is shown.

If an error is encountered during loading, each error is logged in the Log window (select
the Show Log command from the Window menu to display the Log window) and an error
message is displayed at the end of the load sequence.

To load scan files from a single directory, click the No Dir List button. See Loading Scan Files
from a Single Directory on page 92 for more information.

Selecting Scan Files for Specific Computers (Complex Queries)

Querying provides a way of selecting and reading in only those scan files for computers
matching specified search criteria.
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This task is carried out using the Complex Query dialog box which allows multiple search
criteria to be specified from a selection of categories. These categories are defined by the
hardware and asset information collected across the computer population.

When the search criteria are fully specified, the query is invoked and all scan files that match
the query criteria are checked/unchecked. The Complex Query dialog box also allows defined
queries to be saved so that they can be loaded and used again.

The following sections describe the pages of the Complex Query dialog box and their
functions. An example query can be found on page 99.

Displaying the Complex Query Dialog Box

To begin creating a query, you need to display the Complex Query dialog box used to specify
the search criteria:

To display the Complex Query dialog box:

1 Select the Load scan files command from the File menu to display the Open scan files dialog
box.

2 Right-click anywhere in the bottom list. A shortcut menu is displayed.

3 Select the Query option. The Complex Query dialog box is displayed. By default the Queries
tab is selected.

= Complex Query El@| @

[lueries | Optiohs

Available quenes Load machinez matching all of :

= Operating System & | #  Quern Operatar Candition
) Host Dperating CPU Type Pentium 4
Aval!ablef Basze 05 diec Total memary [MEB] > F4
queries list Service Level Physical disk siz...  »= 200
Build Level Host Operating ... containg =P
Dkl Layer
Locale
DS informatic—
Host 05 Cater
DOS Type
05/2 Type
Windowes Marr
Winlk Mode
Windowes NT
Windows Sery
nix Type
Hozt 05 YWersi

wl. | Arala Aata —

1
2
3

load || Save || add | | ok || Ccancel

Query
grid
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This dialog box has two tabs:
e Queries - Displays the hardware and asset fields and allows you to build up the query.

e Options - Sets up the logic, actions and format of the query.

The Queries Tab

The Queries tab in the Complex Query dialog box displays a page that contains the two
components:

e The available queries list

e The query grid

The Available Queries List

There are two categories of information that can be used to query data collected from a
population of computers:

¢ The asset data entered manually using the asset questionnaire.

¢ The hardware configuration details collected automatically for each computer as it is
inventoried.

These categories of information are listed in the Available queries list on the left side of the

dialog box.

Available Query Categories

These categories are used to group the items into the outline used in query and column
selection. The following list shows the hardware fields that are collected during a scan:

For a complete list of hardware and configuration items collected by the Scanners, see Help >
Data Collected by the Scanners.

Table 25 Available Query Categories

Category Description

Asset Data Items collected manually or automatically through the entry
fields in the Scanner, or items calculated using analysis-time
asset fields.

CPU Data Information about the processor(s) and coprocessor of the
machine.
Bus Data Information pertaining the machine's bus. This category

includes the Bus architecture and a list of identified cards that
are not Network cards, disk controllers or video cards.

BIOS Data Data extracted from the machine's BIOS (Which is a read-only
memory area, typically located at the top of the first 1MB of
memory in the machine).

Memory Data Memory information: Physical amount of memory, partitioning
of memory, swap file (virtual memory) and so on.

Operating System Data | Operating System information. This includes information about
the OS running at the time of the scan, name, version, and so on,
as well as OS services, such as user profiles, login name.
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Table 25 Available Query Categories

Category Description

Video Data Provides details of the Video Display Adapter, which include the
adapter type (EGA, XGA, VGA and so on) and model/
manufacturer. In Windows and OS/2, the current desktop
resolution and number of colors are also displayed.

Network Data Information about the machine's network connection. This
includes a list of network cards, as well as logical information
(machine name, logon name, domain name, addresses, shares
and so on).

Keyboard and Mouse Whether a Mouse is connected. Whether a Keyboard is

Data connected.

Disk Data Information related to physical disk drives, CD-ROM drives,

network drives and so on, as well as information about logical
partitioning of these. Also includes a list of disk controllers.

System Data

Items specific to the scan file or scan (but, with the exception of
the asset number, without real relevance to the machine itself)
including asset number, scan time, time since scan, path to scan
file, version of scan file and so on

Port Data

Contains a list of parallel and serial ports.

Storage Data

Shows the name, vendor, revision and device host information
for the storage devices (such as hard drives, CD-ROMs, tape
drives) that have been detected.

Peripheral Data

Information about peripherals, currently modems, sound cards
and printer information.

SMBIOS Information

Information extracted from the machine's SMBIOS, if available.

USB Data

This contains information about the USB (Universal Serial Bus)
devices, controllers, hubs and ports. USB is an external bus
which supports plug and play. It allows peripheral devices to be
connected or disconnected from computers without the need to
shut down or rebooting. These peripheral devices include
CD-ROM drives, joysticks, speakers, cameras.

Machine Window Data

Shows information from the Analysis Workbench Machines
window.

The Query Grid

The query grid is displayed on the right side of the Queries page. Each query item is built up
on a separate row. A maximum of 250 different query items are allowed.

The query grid has four columns:

e #

The number of the query items set up on the options page. The maximum that can be

configured is 250.
*  Query
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This column is reserved for items from the Available queries list. Double-clicking on an
data field in the Available queries list, moves the entry to this column of the query grid.
Alternatively, you can drag the data field from the Available queries list and drop it onto a
row in the query grid.

e Operator

Many hardware fields can be queried against a set range of values. This columns shows
pick lists for the types of queries performed against the Asset fields and some hardware
field values.

¢ Begins with
¢ (Contains
¢ Does not equal
e Ends with
e KEquals
e Greater than
¢ Is not the same as another field
e Isthe same as another field
e Lessthan
e Matches
e Condition

This column is reserved for a parameter value that must be matched by the query.

The Shortcut Menu

Right-clicking on an entry in the query grid, displays a shortcut menu:

e Edit current query - To edit an existing query entry, right-click on the cell and select this
command from the shortcut menu.

e Clear Current Line - To delete an entry from the query grid, right-click on the entry and
select this command from the shortcut menu.

e Clear All - Select this option to delete all entries from the query grid.

The Query Grid Buttons

e Load - To use a saved query, click the Load button and select the saved query file (with a
.awq extension). The query files are loaded from the Queries directory in the DDM
Inventory installation path. Click the OK button.

e Save - To save the query for future use, click the Save button. Enter a name for the query
file (with a . awg extension) and click OK. The query files are saved in the Queries
directory in the DDM Inventory installation path. Saved queries can be automatically
selected and used without having to define the query again.

e Add - Highlight the desired field and click the Add button to add the definition to the
query grid.
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Building a Query

Queries are built within the Query grid by clicking on any + sign in the tree. This expands the
relevant category and lists possible data fields.

1

To select a data field in the Available queries list, do one of the following:
¢ Double-click on a data field in the Available queries list.

e Drag the data field and drop it onto the Query grid.

e Select the data field and click the Add button.

After you have done this, a Define properties for hardware query dialog box is displayed.

2 In this dialog box select the operator for the query.
3 Depending on the type of query you set up, enter a parameter value that must be matched
by the query.
4 Click OK. You are returned to the Complex Query dialog box.
5 Ifrequired, you can save the query by clicking the Save button.
The Options Tab

In the Complex Query dialog box, click the Options tab.
This tab is used to do the following:

Retain the last query or clear the existing query.
Provide a description for the query.

Set up the actions that are to be carried before the query has been made. That is, whether
to clear or set all existing tags, or to leave them untouched.

Set up the logic that will be used to perform the query.

Set up the actions that will be carried after the query has been made. That is, which tags
will be applied and under what conditions.

Table 26 Query Options

Option Description

Caching

Remember the last query | If this option is checked, a query will be retained after it has

been run. If unchecked, the grid is cleared after the query has
been run.

Query Description

Allows you to enter a text description of the queries being made.
This is useful for identifying stored queries.

Before Querying

Do not change tags No actions are performed before the query is made.

Clear existing tags All tags are cleared before the query is made. That is, all scan

files are deselected.
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Table 26 Query Options

Option Description

Tag all items All entries in the Open scan file dialog box are tagged before the
query is made. That is, all scan files are selected.

Query Type

Run as an OR query (at
least one condition must
be met)

When more than one query is specified, the match is made when
either one of them are true.

Run as an AND query
(all conditions must be
met)

When more than one query is specified, the match is made when
all queries are fulfilled.

Note: Only one of these logic rules can be applied to the same query. They cannot be mixed.

Tagging

Set tag when condition is
met

After an entry is found that matches the parameters defined by
the query, a tag is set on that entry. That is, the scan file is
selected.

Clear tag when condition
is met

After an entry is found that matches the parameters defined by
the query, if it is tagged then this tag is cleared. That is, the scan
file is deselected if it was previously selected.

Example Complex Query

In this example, the query will be set up to select scan files for all machines that have a
minimum specification. This may be because you want to locate all those machines that need
to have their hardware and software upgraded in to be able to run a particular piece of

software.

The machine that has the following minimum specification:

¢ Pentium 4 processor AND

e 64 Mbytes or more of memory AND
e  More than 200 Mbyte of space on its local hard disks AND

e Host operating system is Windows® XP

Step 1- Setting Query Parameters for Scan File Data

The first step for specifying the criteria for the query is to select the data items that need to be
matched by the information in the scan files.

1 In the Available queries list click on the + sign next to the CPU Data category. Click on the

CPUs subcategory.

2 Select CPU Type by double-clicking on it with the mouse or by dragging it to the grid. The
Define properties for hardware query dialog box is displayed.

3 Select is from the Operator or Query drop-down list and select Pentium 4 from the other

drop-down list

4 Click the OK button. You are returned to the Complex Query dialog box.
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In the Available queries list, click on the + sign next to the Memory Data category.

Select by Total Memory (Mb) double-clicking on it with the mouse or by dragging it to the
grid. The Define properties for hardware query dialog box is displayed.

Select >= from the Operator or Query drop-down list.

Type 64 directly into the Numeric Value field, or click the calculator icon and use the
keypad.

Click the OK button. You are returned to the Complex Query dialog box.

In the Available queries list, click on the + sign next to the Disk data category. Click on
the Physical Disk Data subcategory and select Physical disk size (MB) by double-clicking
on it with the mouse or by dragging it to the grid. The Define properties for hardware
query dialog box is displayed.

Select > from the Operator or Query drop-down list.

Type 200 directly into the Numeric Value field, or click the calculator icon and use the
keypad.

Click the OK button. You are returned to the Complex Query dialog box.

In the Available queries list, click on the + sign next to the Operating System data
category.

Select Host Operating System Name by double-clicking on it with the mouse or by
dragging it to the grid. The Define properties for hardware query dialog box is displayed.

Select the contains option from the Operator or Query drop-down lists.
Type XP directly into the String Value field.

Click the OK button. You are returned to the Complex Query dialog box. The final Query
grid should look as follows:

L3 Complex Query, E| @| E|

Queries | Dptions
Available queries Load machines matching all of -
=) Operating System || # | Query Operator Condition
Host Operating CPU Type Pentium 4
Baze 05 direc 1 Tatal memory (MbB] > B4
Semvice Level 2 Phpsical disk giz...  »= 200
Build Level 3 Host Operating ... contains =P
Dkl Layer
Locale
D05 informatic
Host 05 Cater
DOS Tupe
05/2 Type
whirrdrums B A
£ > £ >
load || Save || add | | ok || cance |

To save the query for future use, click the Save button (in the Queries tab). Enter a name
for the query file (with a . sqm extension).
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Step 2 - Setting the Query Options
1 Click the Options tab.

2 Select the Remember the last query option. This option allows any previous queries made to
be saved in the grid.

3 Enter a text description of the queries being made in the Query description box. For
example, you could enter something similar to the following:

‘Machines meeting a minimum standard’

4 In the Query type group, select Run as AND query. When more than one query is specified,
the match is made when all queries are fulfilled.

5 After you have specified the query parameters, return to the Queries tab and click the OK
button to tag the scan files matching the query.
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Viewing Data

In This Section

e The Default Display on page 102

e The Machines Window on page 103

e The Machine Details Window on page 105

e The Applications Window on page 106

e Applications Details Window on page 108

e The Directories Window on page 109

e The Directories Details Window on page 110
e The Files Window on page 110

¢ The File Details Window on page 114

The Default Display

The basic analysis of data consists of viewing the hardware, software and asset information in
the scan files collected for a computer population, Analysis Workbench provides various
windows to display and view data.

e Files

e Machines

¢ Directories

e Applications

The default display view on starting Analysis Workbench consists of three windows: Files,
Applications and Machines. A Directory view can be displayed as well, but is not part of the
default screen layout.

Each window can be customized to show different columns and different levels of detail for
each line. The window contents can be sorted on any column displayed, by clicking on the
column headers.

In addition, each window features a Details window, where more details about the currently
selected item can be displayed.

Any number of windows, each displaying a different set of columns and sorted in different
ways can be opened at the same time.

The current workspace layout can be saved, either as the new default workspace or as a
named layout that can be reloaded at any time. The Layout command in the Window menu is
used to save a new or load a previously saved window layout. The default layout is stored in
awdef.ini.

The user interface can be customized by using the options in the Configure drop-down toolbar
menu available in all the windows. See Customizing Window Layouts on page 28 for more
information.

The windows can be resized and positioned in the workspace to reflect your requirements. See
Information Windows on page 26 for more information about the Analysis Workbench
windows.
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Locking and Unlocking Columns

It is possible to ‘lock’ some of the leftmost columns of the main windows.

To do this, right-click on a column header, and select the Lock option. When this is done, the
column clicked and all columns to the left of it will be ‘locked’ and will not scroll left or right.
To remove a lock, select the Unlock option from the shortcut menu, and to set a different lock,
simply select Lock on a different column.

This feature can be used to make sure important columns, remain visible while scrolling
through detailed columns.

The Machines Window

In This Section

e Information Available in the Machines Window on page 103

e TFiltering Data in the Machines Window on page 104

e (Customizing the Columns Displayed in the Machines Window on page 104
e Special Note When Selecting Columns on page 105

Information Available in the Machines Window

The Machines window displays the Machine ID (Asset Number) and various description fields
for computers within the inventoried population.

Included in this information is asset data. Asset data is data that was collected using the
asset questionnaire which collects customized asset information as each computer is scanned.
The asset questionnaire is configured in the Asset Data page of the Scanner Generator.

The information includes details about users, departments, physical assets, equipment, and
any other information that is useful to record.

’ User-defined and Automatic fields now show the actual caption displayed to the user.
However, if more than one scan is loaded into Analysis Workbench and they have different
captions, only the caption from the last scan loaded is shown.

The Machines window allows further details of the hardware, software and asset data
collected for a computer to be viewed, by providing a link to the Machine Details window. See
page 105 for more information about the Machines Details window.
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Filtering Data in the Machines Window

Filters can be set (using the Filters drop-down toolbar menu or the filter icons) to provide
additional information in relation to the other windows in the workspace as follows:

Table 27 Filters in the Machines Window

Filter Shows
1] Machine Any tagged machines in the Machines window.
(%) Application Any machines that contain tagged applications.

It shows any machines that have the application installed.

Note: It does not show machines that have a partial installation (in
other words, machines where a license is not needed).

] Directory Any machines that contain tagged directories.
] File Any machines that contain tagged files.
(L] Local Any machines with Local tags.

Customizing the Columns Displayed in the Machines Window

To customize the columns displayed in the Machines window:

1

Click on the Columns drop-down toolbar menu.
A Select columns to display dialog box is displayed.

¢ The Available columns list shows all the available categories and fields. Clicking on the
+ sign expands the category and shows the fields that are contained in it. A check box
is displayed next to each category and field. A dotted check box next to the category
indicates not all the fields in that category have been selected (that is, only some fields
have been selected). Clicking on a partially checked category will select all fields in
the category. Clicking again will deselect all fields.

¢ The Selected columns list shows the fields that have been selected to be displayed as
columns in the Machines window.

¢ The Show only items in use option will ensure that only hardware items that actually
exist in one of the loaded scan files are shown in this tree.

2 Either drag a category from the left list to the Selected columns list, or select the check

box next to the category and click the >Add button. The functions of the other buttons are
as follows:

e To add all the available columns to the Selected columns list click the >>Add button.
e Toremove an entry from the Selected columns list click the Delete button.
e To delete all entries in the Selected columns list click the Del All button.

¢ You can move the position of entries in the Selected columns list using the Up and
Down buttons.

Click OK after you have selected the columns. You are returned to the main workspace.
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Special Note When Selecting Columns

Each data item collected is shown only once in the tree, even if multiple values for a particular
item are collected. Examples of this are CPU Speed (where one per CPU is collected) and Card
Class (which is collected for every card for every bus supported).

When a column such as this is chosen to be shown in the Machines window, Analysis
Workbench automatically figures out how many columns are required to show all of the
collected data and appends ‘Indexes’ to each column name.

For example, choosing the CPU Speed column will normally create just one column named
‘CPU Speed (0) (Index start at 0).

Now, if the data loaded includes at least one machine with two CPUs, Analysis Workbench
will create two columns instead, ‘CPU Speed (0)’ and ‘CPU Speed (1)'.

The number of columns necessary to show all data for all loaded machines is not recalculated
when new data is loaded or data is unloaded. To have Analysis Workbench refresh this, go into
the Column selection dialog box and click OK.

To enable or disable the display of a single one of these columns. For example to see just ‘CPU
Speed (1), each column is available from the drop-down Column menu.

The Machine Details Window

The Machine Details window provides further information for each computer listed in the
Machines window.

To display the Machine Details window in the Machines window do one of the following:

e Select the Detail window link option from the Configure drop-down toolbar menu.

e Select the Configuration option from the Window menu and check the Machine Windows box
in the Detail Window Link group.

The information to be displayed in the Machine Details window can be selected by doing one
of the following:

¢ Clicking on the Configure icon €| and checking the Machine Windows box in the Detail
Window Link group.

e Selecting the Detail window option from the Configure drop-down toolbar menu and
checking the Machine Windows box in the Detail Window Link group.

Depending on what information was selected in the Window Layout dialog box, the Machines
Details window can show the following information:

e Hardware overview - The information displayed here depends on which option was
selected in the Configuration window.

e The default displays basic details of the hardware configuration scanned from the
computer as it is inventoried. Provides details of the operating system, processor, type of
screen, memory, drives, directories and files as well as the total disk space and free space.

¢ The Machine window data displays all columns as selected in the Machines window but
vertically rather than horizontally making it easier to read.

e Applications - Displays details of the applications identified on the machine, including the
publisher, applications and version.
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¢ Recognition statistics - Displays the total number of files on the highlighted machine,
including a breakdown of Main files, Associated files, files that need the version checked,
unrecognized files and unprocessed files, both as a figure and as a percentage of the total
files.

The Machines Details — Application information links back to the Applications window,
showing details for that selected application entry. That is, if you click on an application in
the Machines Details window, the corresponding application will be located (and highlighted)
in the Application window.

The Applications Window

The Applications window displays a view of the applications within a population that have
been recognized.

The Applications window allows further details of the application license information
collected for a computer to be viewed, by providing a link to the Applications Details window.

The data displayed in the Applications window cannot be changed or altered in any way. The

Applications window provides the following information:
Table 28 Data Displayed in the Application Window

Column Description

Publisher The name of the software publisher (for example, Microsoft, IBM).

Application The name of the software application.

App Type The type of application (for example, Word processor,
Spreadsheet).

Version The version of the software.

Release The release of the software.

OpSys The operating system the application runs on.

LangCode The ISO 639 Language — 3166 Country code of the application.
This is the ISO standard used to define languages. The format is
as follows: <639 3166> for example <EN-US> refers to English —
USA.

Language The name of the language of the application.

Description Any additional relevant information and notes, (for example, that
the application is part of the Microsoft Office97 Suite of
programs).

Machines The number of machines on which the application is found. In the
Operational View, this includes machines on which a partial
install (that is, one or more non main files) is found. In the
Business View, this column is the same as the Installs column.

Installs The number of installations of that particular application that
have been found throughout the population (that is, on how many
machines the application is installed). An application is defined as
installed when at least one Main file has been identified on a
machine.
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Table 28 Data Displayed in the Application Window

Column Description

Licenses The number of licenses required for the application. This is the
same as the Installs column unless a license relation exists, in
which case, the Licenses column may contain a number smaller
than the Installs number.

Files The number of files that are contained in that application (that is,
how many files have been identified as belonging to the
application).

Licenses Apps The number of other applications that the application is

responsible for licensing. For example, if Internet Explorer
licenses NetMeeting on five machines and RealPlayer on three
machines, this column would contain a value of eight.

Licensed By The number of owning applications (licensees) taking
responsibility for licensing this application. In the previous case,
RealPlayer would have a count of three in this column. If
RealPlayer was licensed by some other application on another
machine, the count would be higher.

Version Id This column contains the ID uniquely identifying a given version.

Utilization This shows the number of days that the application was used (as a
percentage) over a period of time. The period is calculated
automatically depending on long the application was used for. As a
rough guideline the time periods are as follows:

- Application used for more than 3 months - utilization is
calculated over the year.

- Application used for less than 3 months - utilization is calculated
over a quarterly period.

- Application used for less than one month - utilization is
calculated monthly

You can drill down to the detail level to see the individual results
in the Details window.

Used on The machine the application was used on.

Filters can be set (using the Filters drop-down toolbar menu) to provide additional
information in relation to the other windows in the workspace as follows:

Table 29 Filters in the Applications Window

Filter Shows
1) Machine Any applications that are contained on tagged machines.
=) Application Any tagged applications in the Application window.
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Table 29 Filters in the Applications Window

Filter Shows

1 Directory Any applications whose main file is contained in tagged directories.
] File Any applications that contain tagged main files.

(L] Local Any applications with Local tags.

You can use the locking feature to make sure important columns, such as Tag, Publisher and
so on remain visible while scrolling through detailed columns. See Locking and Unlocking
Columns on page 50.

Applications Details Window

To display the Applications Details window do one of the following:

e In the Applications window, select the Detail window link option from the Configure
drop-down toolbar menu.

e Select the Configuration option from the Window menu and check the Application Windows
box in the Detail Window Link group.

The information that is displayed in the Applications Details window can be selected by doing
one of the following:

¢ Clicking the configure icon €| in the Details window.

e Selecting the Detail window option from the Configure drop-down toolbar menu. This will
display a Window Layout dialog box.

Depending on what information was selected in the Window Layout dialog box, the
Applications Details window can show the following information:

¢ Installed on machines - The machine(s) that the application is installed on.

¢ Licensed by - The details of the Application Suite that licenses the highlighted application
(if applicable). For example, Word 97 is licensed by Microsoft Office 97.

e Licenses - The details of any applications that the highlighted application licenses, for
example, Word 97 licenses Microsoft Photo Editor.

) The Applications Details — Installed on machines information links back to the Machines
window, showing details for that selected machine entry. That is, if you click on a machine in
the Applications Details window, the corresponding machine will be located (and highlighted)
in the Machines window.

The Applications Details — Licensed by or Licenses information links back to the Applications

window and the Machines window, showing details for that selected application and the
machine it is located on.
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The Directories Window

The Directories window provides a view of the directory names within a population containing
inventoried files. It displays a list of every unique directory of software files within the
population, and enables you to assess the conformance to standards for software installed
across the computer population. It does not take the drive into account, for example, e: \temp
and c:\temp is one line in this window.

The Directory window is particularly helpful for identifying configuration anomalies prior to,
or after installing new applications or upgrades. Any directory which resides in a different
path will be shown as a separate line item.

The Directories window allows further details of the Directories (including files contained in
the directory and machine name) to be viewed, by providing a link to the Directories Details
window.

The Directories window provides the following information:

Table 30 Data Displayed in the Directories Window

Column Description

Tag Global tag column

Ltag Local tag column

Name Name of the directory

Count Number of drives and machines a specific directory occurs on within

the population. The details of the Machines and drives the directory
occurs on can be seen in the Directory Detail window.

Main A check mark is shown in this column if the directory contains a
Main file of an application.

Tagged Files This column shows the number of tagged files contained in the
highlighted directory. The list of tagged files is displayed in the
Directories Details window.

Tagged Applications | This column shows the number of tagged applications whose main
link is contained in the highlighted directory.

Filters can be set (using the Filters drop-down toolbar menu) to provide additional
information in relation to the other windows in the workspace as follows:

Table 31 Filters in the Directories Window

Filter Shows
O] Machine Any directories that occur on tagged machines.
(o) Application Any directories that contain tagged applications.
(1 Directory Any tagged directories in the Directories window.
] File Any directories that contain tagged files.

(L] Local Any directories with Local tags.
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You can use the locking feature to make sure important columns, such as Tag, Name, Main
remain visible while scrolling through detailed columns. See Locking and Unlocking Columns
on page 50.

The Directories Details Window

The Directories Details window displays further information for each directory listed in the
Directories window.

To display the Directories Details window do one of the following:

e In the Directories window, select the Detail window link option from the Configure drop-down
toolbar menu.

e Select the Configuration option from the Window menu and check the Directory Windows box
in the Detail Window Link group.

The information that is displayed in the Directory Details window can be configured by doing
one of the following:

e Clicking the configure icon €| in the Details window.

e Selecting the Detail window option from the Configure drop-down toolbar menu. This will
display a Window Layout dialog box.

Depending on what information was selected in the Window Layout dialog box, the
Applications Details window can show the following information:

® Files - Displays a list of file names found within the directory, along with the size of the
file.

e Machines - Displays a list of machines where the directory is found within the population,
with the drive location for the directory.

’ The Directories Details — Files information links back to the Files window, showing details of
a particular files that resides in the highlighted directory.

The Directories Details — Machines information links back to the Machines window, showing
details of the machine that the directory is on.

The Files Window

The Files window displays information for all the inventoried files in the population. It allows
further details of the file information collected on a PC to be viewed, by providing a link to the
File Details window.

The Files window displays the following:

Table 32 Data Displayed in the Files Window

Column Description
Tag Global tag column
LTag Local tag column

110 Chapter 2



Table 32 Data Displayed in the Files Window

Column

Description

Name

A full list of all the files selected for analysis within the population of
scan files read into the Analysis Workbench (known as the inventory
files).

The files displayed in red are the Main executable files for an
application.

The files displayed in green are the files associated with an
application. They belong to it but are not main files.

The files displayed in blue are unidentified or partially identified files.
The files displayed in purple are partially identified Main or
Associated files.

Note: The colors referred to are the default and can be customized. See
Customizing the Font and Color on page 29 for more details.

Size

Size of the file.

Publisher

Name of the software publisher.

Application

Type of application (for example, Games, Disk creation Utility).

Version

File version number where a file is fully identified.

Release

The release of the software.

OpSys

Operating system under which the application the file belongs to
operates.

LangCode

The ISO 639 Language — 3166 Country code of the application. This is
the ISO standard used to define languages. The format is as follows:
<639 3166> for example <EN-US> refers to English — USA.

Language

Name of the language of the application.

Copies

Shows the number of copies of each file within the population.

# Sizes

Number of sizes of a file with the same name that exist in a population
of machines.

# Signatures

Shows the number of signatures found for each file within the
population.

# Dates

Number of different dates for copies of the file within the population.

# Attributes

Number of different attributes for the file copies.

# Types

Number of different types found for this file name (for example, a file
called Setup.exe can be a DOS executable file or a Windows
executable).
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Table 32 Data Displayed in the Files Window

Column

Description

Status

Whether the file is a:
Main file = 1
Associated file = 2
3rd Party files = 3
CheckVer file = 4
Unknown file = 5
Unprocessed file = 6
Auto-identified = 7
Junk = 8

Description

Version description as entered in the SAI. It is a separate field that
can contain any user description or comment.

Signature

The file Signature column (a number produced for each file by
checking the first 8192 bytes) is usually sufficient to identify a file. If
there is more than one signature, an asterisk ‘*’ is also shown in the
column to indicate this.

Modified

The date the files were last modified.

Accessed

The date the files were last accessed.

Utilization

This shows the number of days that the application was used (as a
percentage) over a period of time. The period is calculated
automatically depending on long the application was used for. As a
rough guideline the time periods are as follows:

Application used for more than 3 months - utilization is calculated
over the year.

Application used for less than 3 months - utilization is calculated over
a quarterly period.

Application used for less than one month - utilization is calculated
monthly

You can drill down to the detail level to see the individual results in
the Details window.
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Table 32

Data Displayed in the Files Window

Column

Description

Attribute

The Attribute column along with normal file attributes includes the
following:

r - Read-only files. Files marked read-only are protected from
modification or deletion.

h - Hidden files. Windows Explorer does not show hidden files by
default unless you tell it to do so.

s - System files.

u - Utilized file. This flag shows that this file was executed and the
application was used.

v - Volume Label. This contains no data and no more than one may
exist on a disk volume (and only in the root directory).

a - If it has the archive attribute of DOS or windows. The Archive
attribute is used to provide an automatic record of what files have
been modified since the last backup.

¢ - Compressed files. These are compressed files and folders. For
example, if it is a file on a compressed NTF'S volume.

x - In a UNIX system this represents a file with the executable
attribute set.

| - Internal file. That is, if it has version data available for it. Version
data (as per Windows Explorer) is displayed for all files having this
attribute.

L - Symbolic link in UNIX. Files (and directories) may be located on
several different file systems. To link files that are in different file
systems a symbolic link is made.

s - This is special case for UNIX for SetUid files. In UNIX scans,
certain files have special attributes that mean that they run with root
privilege. Such files are potentially a security risk and the Scanner
assigns them the system attribute - s

A - This file has been identified as an archive.

C - This file has been identified inside an archive.

X - This file has been identified as an executable file.
D - This file has been identified as a device driver.

If there are more than one set of attributes, an asterisk ‘*’ is also
shown in the column to indicate this.

File Type

Shows the type of file (for example, DOS executable file, Windows
executable, OS/2 DLL file). If there is more than one file type, an
asterisk ‘*’ is also shown in the column to indicate this.
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Filters can be set (using the Filters drop-down toolbar menu) to provide additional
information in relation to the other windows in the workspace as follows:

Table 33 Filters in the Files Window

Filter Shows

&l Machine Any files that are located on tagged machines.
() Application Any files that are part of tagged applications.
[ Directory Any files that reside in tagged directories.

(] File Any tagged files in the Files window.

(L] Local Any files with Local tags.

You can use the locking feature to make sure important columns, such as Tags, Name remain
visible while scrolling through detailed columns. See Locking and Unlocking Columns on
page 50 for more details.

Adding Entries to the SA

The Add to SAl option in the Tags drop-down menu allows you to ‘teach’ DDM Inventory to
recognize files which it previously did not recognize. This enables you to optimize the software
analysis and consolidation capabilities of the Analysis Workbench to recognize unidentified
files and applications. The same data can be used by the Viewer.

See Teaching Applications to the User SAI on page 139 for more information.

The File Details Window

The File Details window provides further information for each file listed in the window.

To display the File Details window do one of the following:

e In the Files window, select the Detail window link option from the Configure drop-down
toolbar menu.

e Select the Configuration option from the Window menu and check the File Windows box in
the Detail Window Link group.

The information that is displayed in the File Details window can be configured by:

¢ Clicking the configure icon €] in the Details window.

e Selecting the Detail window option from the Configure drop-down toolbar menu. This will
display a Window Layout dialog box.

Depending on what information was selected in the Window Layout dialog box, the Files Details
window can show the following information:

e Asset numbers (Machine) - Shows the Asset number of the Machines that the file resides on.
e Directory names (Directory) - Show the directory that the file resides in.
* File sizes (Size) - Shows the size of each copy of a file within the population.

* File signatures (Signature) - Shows the signatures for each file within the population.
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File modified date- Shows the date the file was last modified files if available.

File Utilization - This shows the number of days that the application was used (as a
percentage) over a period of time.

File accessed date- Shows the date that the file was last accessed.

File attributes (Attributes) - Displays system attributes for a file. The Attribute column along
with normal file attributes includes the X (executable), I (internal file) and D (device
driver) information. For all files having the Information I attribute, version information
(as per Windows Explorer) is displayed.

File type (Type) - Shows the type of file (for example, DOS executable file, Windows
executable, OS/2 DLL file).

Version data - Version information (as per Windows Explorer Properties for a file) is
available for all files having the information I attribute.

File Version data - Shows any version data that was collected for the file.

) The File Details — Machine information window links back to the Machines window by
selecting the machine that a selected file exists on. It also links back to the Directory window
by selecting the directory that the selected file resides in.
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Viewing Charts and Statistics

In This Section

¢ Viewing Charts on page 116

¢ Chart Buttons on page 117

¢ Scan File Age Chart on page 119

e Scan Method Chart on page 120

¢ Recognition Chart on page 120

¢ Unrecognized/File Frequency on page 122

¢ Recognition/File Frequency on page 122

¢ Viewing Charts From Individual Windows on page 123

¢ Viewing Inventory Statistics on page 124

Viewing Charts

Charts provide a graphical representation of selected data. There are a number of standard
charts provided by Analysis Workbench to help visualize various data splits. The standard
charts include the variation in scan age, the Scanner used and the split of recognition levels.

In addition, there are two bar charts which plot the number of recognized and unrecognized
files against the frequency of their occurrences. The frequency is expressed as a percentage to
allow for different numbers of machines loaded.

Charts are available from two sources:
e By selecting an option from the View menu.

e By right-clicking on a column header and clicking the Chart option. These displays a
summary count of the column contents with a graphical representation of the results.
This option is only available if there is text in that particular column.
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Chart Buttons

The following buttons are available in all charts:
Table 34 Buttons Available for Charts

Button

Function

Save As

The chart can be saved to three different file formats:
Enhanced metafile: .emf

Windows Metafile: .wmf

Windows Bitmap: .bmp

Copy

This button has a drop-down list menu. The chart can be copied to the
clipboard in following formats:

Enhanced metafile: .emf
Windows Metafile: . wmf
Windows Bitmap: .bmp

Print

Displays a print preview of the chart and allows you to set various
print settings.

Options

Displays the Chart Options dialog box, where various options and
filters can be set for the chart.

Refresh

Refreshes the chart to show any updated information. The chart can
be viewed while data is being loaded.

OK

Click this button to return to the Analysis Workbench workspace.

Chart Options

The following options are available in all charts:
Table 35 Chart Options

Option Function

Options

3D chart Displays the chart in three dimensional graphical form.

Show Marks Displays percentage labels for each segment in the chart.

Show Legend Displays a key to the chart. This allows you to identify what each of
the segments or bars represent.

Show User-defined | Allows you to enter a title of your choice for the chart. Enter the text in

Title the User-defined Chart Title box.

Pie Chart

Circular Displays the statistics as a circular pie chart, otherwise the chart is

displayed as an ellipse.

Use patterns

Uses a patterned fill for the segments of the pie chart.
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Table 35 Chart Options

Option Function

Explode largest The largest segment is offset from the main body of the pie chart for
emphasis.

Other group,% Combines the segments less than the defined percentage into one

group called Other.
Use the arrows to increase or decrease the Other group sections.

Legend Position

Left Positions the legend to the left of the chart

Right Positions the legend to the right of the chart

Top Positions the legend to the top of the chart

Bottom Positions the legend to the bottom of the chart

Data Filter (Filters can be applied to reduce the amount of data reported)
Machines Applies a machines filter to the chart data.
Applications Applies an applications filter to the chart data.

Files Applies a files filter to the chart data.

Directories Applies a directories filter to the chart data.

Local Applies a local tag filter to the chart data.

Background Color

Allows you to select a background color from the drop-down list.

User-defined Chart | Allows you to configure the chart titles as required. This option is only
Title available if the Shown User-defined Title option is checked.
Auto Apply If checked, all changes are applied to the chart as soon as you make

them. Otherwise, they are applied when the OK or Apply button is
click.
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Scan File Age Chart

This chart is displayed by selecting the Charts > Scan file Age option from the View main menu.

The Time since data collected, in months chart is displayed which shows the date of the
loaded scan files.

Time since data collected, in months

I 1 Current
Il 5 1 month
I 1 1Z months

Current 12 montha

The X axis shows the age of the scan files (in months). The Y axis shows the number of scan
files.

The legend (shown in the left corner) allows you to identify the number of scans that belong in
an age category.

This example shows:

¢  One scan (14.29% of the scan files loaded) is 12 months old.

¢ Five scans (71.43% of the scan files loaded) are 1 month old.

®  One scans (14.29%of the scan files loaded) is current (less than 1 month old).

Filters can also be used in the scan file age chart to narrow down and highlight items of
particular interest. These filters are set from the Chart options page (click the Options button
to access the filters).

Example

To view the age of the scan for selected machines:

1 Tag the machines in the Machines page.

2  Apply a Machines filter to the chart data. The chart will display the age of the selected
scans only.

The legend shows the number of scans that belong in an age category and the color of the
bar that represents it.
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Scan Method Chart

This chart is displayed by selecting the Charts > Scan Method option from the View main menu.

This displays a chart of the Scanners used for collecting data chart. For example:

Scanner used for collecting data

I : Viindows (x85) Scanner
I Z HP-UX (HPP&) Scanner
[ 27 A (POYWWER) Scanner
H 1 Linux (x85) Scanner

VWindows (x88) Scar

HP-UX (HPPA) Scanner |

Linux (=85}

| AD{ (POWER) Scanner

This example shows four segments of a pie chart. It indicates that four types of Scanner have
been used to created the scans loaded in Analysis Workbench.

The legend (shown in the left corner) enables you to identify the type of Scanner, the number
of scans created using that Scanner and the color of the segment that represents it. This
example shows:

e Two scans have been created using a Windows (x86) Scanner.

e Two scans have been created using an HP-UX (HPPA) Scanner.
e Two scans have been created using a AIX (POWER) Scanner.

¢ One scan has been created using a Linux (x86) Scanner

Filters can also be used in the Scan method chart to narrow down and highlight items of
particular interest. These filters are set from the Chart options page (click the Options button).

Example

To view the method used for scanning a machine that contains a particular application:
1 Tag the application in the Applications page.

2 Apply an Applications filter to the chart data. The chart will display the Scanner that was
used to scan the machine containing that application.

The legend shows the type of Scanner used, the number of scans created using that
Scanner and the color of the segment that represents it.

Recognition Chart

This chart is displayed by selecting the Charts > Recognition option from the View main menu.
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This displays the Recognition statistics chart which shows Main, Associated, 3rd Party and
Unknown files.

Recognition statistics

Main
Agzsociated
3rd Party
Unknown
 Checkver

[ ¥+
J 3 D0 0 on

— ] == 2
o fn — in rJ

This example shows a pie chart with five segments.

The legend (shown in the left corner) enables you to identify the type of files recognized, the
number of files in that category and the segments that represents them. This example shows:

25 files (0.69%) have been recognized as Main files.
3,059 files (84.06%) are Associated files.

118 files (3.24%) are 3rd Party files.

250 files (6.87%) have been recognized as Unknown files.
187 files (5.14%) are CheckVer files.

See Display/Storage Filter on page 63 for descriptions of these file recognition categories.

Filters can also be used in the Recognition chart to narrow down and highlight items of
particular interest. These filters are set from the Chart options page (click the Options button).

Example

To view the recognition statistics for all Main files recognized:

1

Analysis Workbench

In the Files window, locate an entry that has Status of 1 Main. This is the status setting
for Main files.

Right-click on this entry in the Status column and select the Tag > Status is 1 Main option. A
Global tag is applied to all files in this window that are Main files.

Apply a Files filter to the chart data. The chart will display the Scanner that was used to
scan the machine containing that application.

The legend (shown in the left corner) allows you to identify the type of files recognized, the
number of files in that category and the color of the segments that represents them.
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Unrecognized/File Frequency

This chart is displayed by selecting the Charts > Unrecognized/File frequency option from the
View main menu.

This displays a bar chart that can be used to determine the quality of recognition on a
population.

Unrecognized files are shown split by the number of copies.

Unrecognised / File frequency

2,600
2,400 4
2,200 4
2,000 4
1,800
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200 |
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Unrecognised

10 20 30 40 50 &0 7o a0
File occur on % of machines

The X axis shows number of files that occur on a given percentage of machines loaded.

The Y axis shows the number of unrecognized files. It is an absolute count of different,
unrecognized file entries.

The legend (shown in the left corner) enables you to identify the number of unrecognized files.

Filters can also be used in the Unrecognized/File Frequency chart to narrow down and
highlight items of particular interest. These filters are set from the Chart options page (click
the Options button).

Recognition/File Frequency

This chart is displayed by selecting the Chartsl Recognized/File frequency option from the View
main menu.

This displays the Recognized/File frequency chart which can be used to determine the quality of
recognition on a population.
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Recognized files are shown split by the number of copies.

Recognised / File frequency
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The X axis shows number of files that occur on a given percentage of machines loaded.

The Y axis shows the number of recognized files. It is an absolute count of different,
recognized file entries.

The legend (shown in the left corner) enables you to identify the number of recognized files.

Filters can also be used in the Recognized/File Frequency chart to narrow down and highlight
items of particular interest. These filters are set from the Chart options page (Click the
Options... button).

Viewing Charts From Individual Windows

Other charts are available by right-clicking on a column header and clicking the Chart option.

These charts display a summary count of the column contents with a graphical representation
of the results. This option is only available if there is text in that particular column.

To display a chart for a particular column:

1
2

Right-click on a column header

Select the Chart option

Example

To view the version of the DDM Inventory software that was used to create the scans:

1

In the Machines window. Click on the Columns button to display the Select columns to
display dialog box.

2  Click on the + sign next to the Scan file category.

3 Select Scan file version. The Scan file version column will now be displayed in the Machines
window.

4 Right-click on the Scan file Version column header and select the Chart option.
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A chart is displayed, which shows the versions of the software that was used to create the
scans.

The legend shows the number of scans created by a particular version and the color of the
segment that represents the version.

Viewing Inventory Statistics

The Audit statistics option in the View menu displays the Audit Statistics dialog box.

Audit statistics present summary information about the loading and recognition data as well
as memory consumption. The statistics are:

Files scanned

Files loaded

Files recognized

Different files loaded
Different directories loaded
Machines loaded

Dynamic memory in use

Operating System memory committed

’ If one or more scan files have been unloaded, the audit statistics are no longer available until
Analysis Workbench has been closed down and restarted.
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Tagging

In This Section

e Tagging Overview on page 125

e Tag Types on page 125

e Tagging Data in the Information Windows on page 125

¢ Methods for Applying Tags on page 126

¢ (learing and Setting Tags for All Items in All Windows on page 127
e Tag Lists in the Machines Window on page 128

Tagging Overview

An important part of the analysis process is the ability to intelligently select subsets of the
population and perform further analysis on this subset only.

Tagging is a process which allows the volume of data being viewed to be narrowed down and

allows items of particular interest (files, directories, applications and machines) to be
highlighted.

Analysis Workbench implements several methods for tagging and filtering, all of which are
based on the tagging mechanism.

Every file, machine, application and directory can be ‘tagged’, that is, selected. Visually, this
is indicated by a check box next to each item in the window.

The simplest mechanism is to tag one or more items manually by selecting the tag check box
next to the item (or by hitting the Space bar).

Tag Types

Two different types of tags are available:
e Local tags: Impact only the window they are applied in (the local window).

® Global tags: Can have impact other windows. Only global tags can be used to teach entries
to the SAL

Filters are used in conjunction with these tags to limit the amount of data displayed in a
window.

Tagging Data in the Information Windows

In This Section

e Tagging a File

e Tagging a Directory

e Tagging a Machine

e Tagging an Application
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Tagging a File

Globally tagging a file has the following effect:

It causes a file tag to be set for the file itself.
It causes a file tag to be set for all machines on which it occurs.
It causes a file tag to be set for all applications that contain an instance of this file.

It causes a file tag to be set for all directories in which an instance of this file can be found.

Tagging a Directory

Globally tagging a directory has the following effect:

It causes a directory tag to be set for the directory itself.
It causes a directory tag to be set for all files in any instance of the directory.
It causes a directory tag to be set for all applications in any instance of the directory.

It causes a directory tag to be set for all machines on which the directory occurs.

Tagging a Machine

Globally Tagging a machine has the following effect:

It causes a machine tag to be set for the machine itself.
It causes a machine tag to be set for all the files on the machine.
It causes a machine tag to be set for all the applications on the machine.

It causes a machine tag to be set for all the directories on the machine.

Tagging an Application

Tagging an application has the following effect:

It causes an application tag to be set for the application itself.

It causes an application tag to be set for all directories in which an instance of this
application can be found.

It causes an application tag to be set for all machines on which the application occurs.

It causes an application tag to be set for all the files that are contained in that application.

Methods for Applying Tags

Tagging can be performed from four different places within Analysis Workbench.

Edit Menu
Information Window Toolbar
Column Header

Column Contents
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Edit Menu

Global and Local tag options are available in the Edit main menu.

Setting a tag from this level will impact all the tag settings, both Local and Global. In
addition, any filters that have been set, can be closed. This is a good start point.

Information Window Toolbar

The information window toolbars are used for setting the tag type (Local or Global) as well as
window specific options.

Column Header

Options in the column header shortcut menu can be used to tag unique (only one) or duplicate
(more than one) entries. They also have a Contains function used to select items that match a
substring search.

Column Contents
Options in the column shortcut menu tag entries above, below a particular row or matching a
specific row-column combination.

Using Shift + right-click in the window area has the effect of inverting the tag selection for the
current row.

For example, instead of a right-click in the Version column giving Version is 95, Shift +
right-click gives Version is not 95.

Clearing and Setting Tags for All ltems in All Windows

The Edit menu has options for globally tagging and untagging entries in all information
windows. This can be very useful when you have large volumes of data and you want to
ensure that none of the items in any of the information windows are tagged (even if the
windows are not displayed).

To do this:

1 Select Tag All > Both from the Edit menu. This sets both Global and Local tags in all the
information windows (even if they are not displayed).

The status bar now indicates that all files in all windows are tagged. Information similar
to the following will be shown:

Machines 6/6 Applications 31/31 Directories 121/121 Files 1211/1211

2  Select Untag All > Both from the Edit menu. This clears all the Global and Local tags in all
the windows (even if they are not displayed).

The status bar now indicates that all files in all windows are untagged. Information
similar to the following will be shown:

Machines 0/6 Applications 0/31 Directories 0/121 Files 0/1211

All information windows (Files/Directories/Applications/Machines) contain no tagged
items.
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Tag Lists in the Machines Window

In the Machines window, you can load and store lists of tagged machines.

A .tag file is a text file containing the asset numbers of the tagged machines. It is saved with a
.tag extension.

This can be very useful for saving time in situations where you have carried out complicated
tagging procedures and have reached a subset of machines that are of particular interest.

Rather than having to redo the complicated tagging procedures when you reload the data or
you re-inventory your population, you can load a machines tag list and those particular
machines will automatically be tagged.

Any machines that no longer exist will be ignored in the tag list file.

To save a current machine tagging list

1 In a Machines window tag the required machines.
2 Select the Save Tags List from the Tag drop-down toolbar menu.

The asset numbers of the currently tagged Machines are saved in a .tag file.

To load a tag file:

1 Select the Load Tags List from the Tag drop-down toolbar menu.
2 Navigate to the .tag file, select it and click Open.
3 The file will be loaded and matching machines will be tagged.

Chapter 2



Filtering

In This Section

e Filtering Overview on page 129

e Setting a Filter for a Window on page 129

e Machines Window Filter on page 130

e Applications Window Filter on page 130

e Files Window Filter on page 130

e Directories Window Filter on page 130

¢ (learing Every Filter in All Windows on page 131

Filtering Overview

You can use filters to narrow down and highlight items of particular interest.

Each of the main windows in the Analysis Workbench can have one or more filters applied to
them. Each window can have one or more filters applied to them. Filters are used for the
following purposes:

e To limit the number of items that are displayed in a window.

e To view the impact of a selection in another window. This is done in conjunction with
Global tags. For example, if a file has been tagged with a Global tag in the Files window,
then to see which directory it is located in, you can apply a File filter to the Directory
window.

e To narrow down and highlight items of particular interest in charts and exports.

Setting a Filter for a Window

Select the filter to be applied to the window from the Filters toolbar drop-down menu, or select
one of the icons on the window toolbar:

e [] Applies the Files filter
e [ Applies the Directories filter

o (=) Applies the Application filter
e O Applies the Machines filter

e [L] Applies a Local Tags filter

When a filter is active in a window, visually this is indicated as by a check mark in the Filters

toolbar menu and on the icon. The exception to this is the Local Tags filter (L] icon, which is
highlighted in yellow.

To deactivate a filter either click on the icon again or deselect the filter from the Filters
toolbar drop-down menu. The appropriate check marks are cleared.
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Machines Window Filter

The following filters can be applied from within the Machines window:

Machine Select - Displays any tagged machines in the Machines window.

Application Select - Displays any machines that contain tagged applications. It shows any
machines that have the application installed.

’ It does not show machines that have a partial installation (in other words,
machines where a license is not needed).

Directory Select - Displays any machines that contain tagged directories.
File Select - Displays any machines that contain tagged files.

Local Select - Displays only those entries in the Machines window that have Local tags
enabled.

Applications Window Filter

The following filters can be applied from within the Applications window:

Machine Select - Displays any applications that are contained on tagged machines.
Application Select - Displays any tagged applications in the Applications window.
Directory Select - Displays any applications that occur in tagged directories.

Main File Select - Displays any applications that contain tagged main files.

Local Select - Displays only those entries that have Local tags enabled in the Applications
window.

Files Window Filter

The following filters can be applied from within the Files window:

Machine Select - Displays any files that are contained on tagged machines.
Application Select - Displays any files that are contained in tagged applications.
Directory Select - Displays any files contained in tagged directories.

File Select - Displays any tagged files in the Files window.

Local Select - Displays only those entries that have Local tags enabled in the Files
window.

Directories Window Filter

The following filters can be applied from within the Directories window:

Machine Select - Displays any directories that occur on tagged machines.
Application Select - Displays any directories that contain tagged applications.
Directory Select - Displays any tagged directories in the active window.

File Select - Displays any directories that contain tagged files.
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Local Select - Displays only those entries that have Local tags enabled in the active
window.

Clearing Every Filter in All Windows

The Edit menu has a Clear all filters option for globally clearing the filters for all information
windows. This can be very useful when you do not have all the windows displayed in the
workspace, and you want to ensure that none of the items in any of the information windows
are filtered (even if the windows are not displayed).

Tagging and Filtering Examples

This section is divided into two:

The first example demonstrates the effect of Global tags, Local tags and filters.

The second set of examples demonstrate how to perform common tasks using filtering and
tagging.

The Effects of Global Tags, Local Tags and Filters

Preliminary Settings

1

Equalize all the windows (files, Directories, Machines and Applications, by selecting the
Equalize command from the Window menu.

In each of the windows, select the LTag column from the Columns toolbar menu. This
ensures that the local tag column is displayed in each window.

From the Edit menu select the Untag AllIBoth option. This will clears any existing tags
(both global and Local) in each window.

Select the Clear all filters option from the Edit menu. This ensures that no filters have been
applied to any of the windows.

Tag Selection

Part 1

This part of the example shows the effect of applying a filter to reduce the display
information.

1
2
3

Analysis Workbench

In the Files window, select the Use Local Tags from the Tag toolbar menu.
Apply a Local tag to a file which has a Status of 1 Main.

Note the number of files in the top left corner of the Files window in square brackets [ ].

Apply a local filter in the Files window, either by clicking the [L] icon or by selecting the
Local select option from the Filters toolbar menu.

The result is that the number of files displayed is reduced to a single entry (that is, the
one file that you tagged).
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Part 2

This part of the example shows that Local tags do not affect the other windows.

e Apply a File filter to the other windows, either by clicking the [_] icon or by selecting the
File Select option from the Filters toolbar menu in each window. All windows now become
empty.

) In the Applications window, this option is actually Main File Select.

Part 3

This part of the example shows that removing a filter will restore the window to it’s previous
state.

e Remove the File filter in the Files window only.

The selected file reappears in the Files window.

Part 4

This part of the example demonstrates how a Global tag affects the other windows.
1 In the Files window, set the Use Global Tags option in the Tags toolbar menu.

2 Now set a Global tag on the file. The Directories, Machines and Applications windows all
now display entries:

e Directories window displays the directories containing the file.
e Machines window displays the machines containing the file.
e Applications window displays the applications which contain the Main file.

e Ifthe Local tag is removed from the Files window, while the Local filter is still active,
the file disappears. The Local filter has to be removed for the file to be redisplayed.
The other windows remain unaffected.

Common Tasks Using Filtering and Tagging

e How Do I Get a List of All Files Not Known by the Application Library?
e How Do I Get a List of Machines Containing Unknown Files?

e How Do I Get a List of All Machines That Do Not Conform to the Company Standard
Desktop?

e How Can I See Which Machines Contain the Most Non Standard Applications?

e How Can I See What Files Appear in a Certain Directory?

e How Can I See in How Many Different Directories a File Occurs?

e How Can I Verify That The Data in an Asset Field is Unique Across the Population?
e How Can I See Which Machines Contain Microsoft Applications?

e How Can I See Which Machines Have Less Than 32MB of Memory?

e How Can I See Which of the Machines with Less Than 32MB of Memory Contain
Microsoft Applications?

e Is There Any Way of Just Navigating the Data, Without Setting Any Tags? on page 136
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How Can I Get a List of Files Occurring in the Same Directory as One or More Files I
Have Tagged?

How Do I Get a Complete List of Machines with Full or Partial Installations of a Set of
Applications?

How Do | Get a List of All Files Not Known by the Application Library?

Make sure that a Files window is visible (use Window > Create > Files if not).

2 Using the Columns drop-down menu of the Files window, show the Status column.
3 Sort on the Status column by left clicking on it, or by right-clicking on the column header
and selecting one of the sort options available.
4 Scroll down until an entry showing 5 Unknown is visible. Alternatively, type 5 on the
keyboard to select the first entry of this type.
) If you cannot locate a 5 Unknown file, it could be that your display filter options
have been set up to not display unknown files. See Configuring Display Filter
Settings on page 82 for more information about how to include Unknown files.
5 Right-click on a 5 Unknown entry, and select the menu item Status is 5 Unknown > Tag.
6 Apply a File filter [_] on the Files window.
Alternatively:
1 Using the Columns drop-down menu of the Files window, show the Status column.
2 Right-click on the column header of the Status column, and select the TagiContains menu
item.
3 Enter 5 in the Search string box, select Anywhere in the String Position group box and select
Tag in the Action group box.
4 Click OK.
5  Apply a File filter |_] on the Files window.

How Do | Get a List of Machines Containing Unknown Files?

Assuming that the tags from the previous question are still in place, apply a File filter ] to a
Machine window.

All machines now shown contain one or more tagged files, all of which are unknown.

How Do | Get a List of All Machines That Do Not Conform to the Company Standard
Desktop?

This answer assumes a scan of a standard desktop is available.

1

g A W N

Analysis Workbench

In the Machines window, tag the standard machine.

Apply a Machine filter [ to an Application window.
Tag all the applications shown. Now, all standard applications are tagged.
Remove the Machine filter from the Applications window.

Toggle all tags in the Applications window. Now all non-standard applications are tagged.
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6 Apply an Application filter () in the Machines window. All machines containing any
non-standard applications are shown.

How Can | See Which Machines Contain the Most Non Standard Applications?

Assuming no tags have been changed from the previous question

1 Using the Columns drop-down menu of the Machines window, show the Tagged Apps
column.

2 Sort descending on this column, either by left clicking on the Tagged Apps column header
or by right-clicking and selecting Sort Descending.

The machines at the top of the list now are the ones containing the most non-standard
applications.

How Can | See What Files Appear in a Certain Directory?

1 Make sure that a Directory window is visible (use Window > Create > Directory if not)
2 Tag the directory or directories of interest.
3 Apply a Directory filter [_] to a Files window.

) If you cannot see any directories, it could be that your memory options have been
set up to not display directory data. See Configuring Memory Settings on page 84
for more information about how to include directory data.

How Can | See in How Many Different Directories a File Occurs?

When no filters are applied to the Files window, the Copies column displays the total number
of occurrences of each file entry. This includes multiple copies on the same machine in
different directories.

When a Directory filter [_] or Machine filter [ is applied to a Files window, the Copies value
will always be 1. If two directories are tagged, the count will be 1 for those files that occur in
only one of the directories, and 2 for those files that occur in both.

The same logic applies for tagged machines when a Machine filter [ is applied to a Files
window.

How Can | Verify That The Data in an Asset Field is Unique Across the Population?

This question is important for asset or hardware fields that contain information unique to a
single computer, such as MAC addresses, Asset numbers, and so on.

1 Show the column of interest in a Machines window.

2 Use the Tag menu item of the shortcut menu of the column header, and select Duplicates.

3 Apply a Machine filter [ to the Machines window. Any items shown are not unique across
the population.

How Can | See Which Machines Contain Microsoft Applications?

1 Make sure an Applications and a Machine window are visible.
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In the Applications window, right-click on Microsoft in the Publishers column, and select
the Publisher is Microsoft > Tag menu item.

Alternatively, use the Tags > Contains menu item from the Publishers column header
shortcut menu and use Microsoft as the search string.

In the Machines window, apply an Application filter (=

How Can | See Which Machines Have Less Than 32MB of Memory?

1
2

Make sure a Machine window is visible.

In the Machines window, click the Columns button. In the Select columns to display dialog
box, expand the Memory category in the Available columns list, and check the Total Memory
(Mb) item.

Sort by the Total Memory (Mb) column in ascending order.

Type ‘32’ which moves focus to the first item with 32Mb or memory or more. Press the Up
arrow to select the previous item in the list.

Right-click the highlighted item, and select Tag -> Rows Above.

Apply a Machine filter [ to the window. All machines visible have less than 32 Mb of
memory

Make sure a Machine window is visible.
From the Tag menu, select Query

From the Query form shown, expand the Memory item and double-click the Total memory
(Mb) item.

From the drop-down list of choices, select ‘is less than’. Type ‘32’ in the entry field.

Click OK to execute the query.

How Can | See Which of the Machines with Less Than 32MB of Memory Contain Microsoft
Applications?

Follow the steps in the previous question to tag machines and applications and applying
filters.

1
2

o 0 A W

Analysis Workbench

Show the LTags column in the Machines window by it from the Columns toolbar menu.
From the Tag toolbar menu of the Machines window, select Use Local Tags Once.

This instructs Analysis Workbench to use Local Tags for the next tag operation.
Again using the Tag toolbar menu of the Machines window, select Tag All.

This will give all items currently visible, a Local tag.

Remove all filters from the Machines window. All machines are now shown.

Using the Tag toolbar menu, select Untag All.

This will remove all of the Global machine tags set previously — but the information
needed is stored in the Local tags so this is fine.

Apply a Local filter [L] to the Machines window (or available from the Filters drop-down
menu). The same machine selection as before step 1 is now visible.
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Tag all visible machines (Use the Tag menu, for example).

Apply a Machine filter [ to the Applications window.

The applications now visible occur on machines with less than 32Mb of memory that
contain at least one Microsoft application.

Is There Any Way of Just Navigating the Data, Without Setting Any Tags?

4

In all windows, enable the Link to Details options in the Configure drop-down menu.

In the Details window now shown in the right side of the screen, click the little ‘¢’
(Configure).

Make sure all four check boxes in the Detail window Links group are selected. Optionally,
set the other controls to specify which details are shown for each window.

Click OK.

Now, whenever an item is clicked in one of the main windows, details for that item are
displayed in the Details window. Because the Detail window Links are selected, clicking on
items in the Details window moves the focused line in the main windows when items are
clicked here.

For example, click on a file. A list of machines and directories where the files occur, along with
various details of each occurrence of the file, is shown in the Details window. Click on one of
these occurrences, and focus in all Machines windows is moved to the machine for this
occurrence; the same happens for the directory in which it occurs. This logic extends to
Machines, Directories and Applications as well.

How Can | Get a List of Files Occurring in the Same Directory as One or More Files | Have
Tagged?

This is typically the first step of application recognition — an unknown file is tagged, and all
files in the same directory should be added to the library at the same time.

1

Apply a File filter [_] to a Directories window. Now, all directories with tagged files in them
are shown.

Tag the directory or directories that are of interest.

Apply a Directory filter _] to a File window. This now shows all files occurring in the
tagged directories.

How Do | Get a Complete List of Machines with Full or Partial Installations of a Set of
Applications?

1
2

Clear all file tags in all windows.

In the Applications window, tag the applications in question.

Apply an Application filter (=) to the Files window.
Tag all the visible files.

Apply a File filter [_] to the Machine window.
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Machine Queries

In This Section

e Machine Queries Overview on page 137

e  How to Perform a Machine Query on page 137

Machine Queries Overview

Machine queries target and tag machines based on criteria such as asset data, hardware or
configuration information.

You can perform a query to focus on any combination of hardware, and asset information
collected for a computer population during an inventory.

As a result of any query, a number of machines, applications, files or directories can receive a
number of tags.

Queries to identify particular machines using specified criteria are defined using a special
query grid. This allows multiple query criteria to be specified from a section of categories,
which are defined by the information collected across the computer population.

When the query criteria are fully specified, the query is invoked and all machines within the
population that match the query criteria are tagged. The query grid also allows defined
queries to be saved so that they can be loaded and used again.

How to Perform a Machine Query

Machine queries are available from the Machines information window.

To begin creating a query, you need to display the query grid used to specify the search
criteria.

¢ In the Machines window select the Query option from the Tag drop-down toolbar menu.
The Complex Query dialog box is displayed.

This dialog box has two tabs:

e Queries - Displays the hardware and asset fields and allows you to build up the query.

e Options - Sets up the logic, actions and format of the query.

Differences Between Scan File Queries and Machine Queries

The method of performing a machine query is almost identical to that for selecting scan files
for specific machines (complex query). There is however, one difference to note:

An extra option is made available for Machine queries. This is on the Options tab page and is
the Tagging group box.
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e Affect local tags - Only Local tags are set or cleared.

B Complex Query

Queries | Options |

Caching
Remember the lazt guery

Cluery descrption

|.-'-‘-.na|_l,lsis “Wiorkbench Machines Query

Before querying
() Do not change tags
(#) Clear exizting tags
() Tag all items
(e type
) Bun az an OF query [at least one condition must be met]
(%) Bun az an &MD query [all conditions must be met]
T agaging
(%) Set tag when condition is met

() Clear tag when condition iz met

[] &ffect local tags

[ Load ]’ Save ok ” Cancel

Further Information

Machine queries are covered in detail on page 93.
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Teaching Applications to the User SAI

In This Section

e User Editable SAI Files on page 139

e C(Creating a New User SAI on page 139

e The SAI Editor on page 146

¢ Teaching an Unidentified Application on page 140

¢ Using SAI Teaching Mode on page 144

e Teaching a Directory with Main, Associated and 3rd Party Files on page 145
e Populating the SAI Teaching Mode Automatically on page 146

e The SAI Editor on page 146

Further Information

Application Teaching theory is covered in detail in the Application Recognition and Teaching
Chapter.

User Editable SAI Files

A User.zsai file is an editable Software Application Index (SAl) that can be updated using
Analysis Workbench. You can use the Analysis Workbench to ‘teach’ the library how to
recognize files which it previously did not recognize.

The teaching of applications to your User.zsai is usually done with scan files that have many
installed applications included in them.

) If the information from many machines has been loaded, it can take a significant time to
re-recognize all of the affected files after new entries have been taught to the SAI It is
therefore recommended that no more than 50 scans be loaded when teaching the SAI.

Creating a New User SAl

To create a new empty User SAl:
1 Start Analysis Workbench.
2 Do not load any data.

3 Select Load Options from the File menu. The Analysis Workbench Load Configuration dialog
box is displayed.

4  Click on the Recognition tab.

(6]

Select the Software Application Index (SAl) option and click the Advanced button. The
Advanced configuration - Software Application Index dialog box is displayed.

Select the SAls tab.
Click the Create button. The Create a User SAl dialog box is displayed.

Enter or navigate to the directory where the SAI file is to be created.

O 00 N O

Enter a description for the file.
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10 Click the OK button.

The file is automatically assigned a unique ID. However, you may already have an SAI
with the same filename. If so, a confirmation message is displayed.

N Click Yes if you want to overwrite the existing SAI file or click No to return to the dialog
box and assign a new ID to the SAI file.

12 If you have made modifications to the cfgNextSAIID setting in the Analysis Workbench ini
file, you may see the following message. This happens when the value for the ID in the ini
file is missing or lower than the highest ID in the user SAls currently loaded. This
message is for information only - the DDM Inventory components will correct this
situation automatically by inserting the correct ID value into the ini file.

The next User SAI ID cannot be found in the settings file.

This probably means that you are using User SAIs created with a different
version of the software, or created on a different machine.

Please take care to set the new ID to a value that is unique across your
organization.

The New Publisher/Application/Version Setup Dialog Box

This dialog box allows you to teach entries to the User SAI file.

To display the New Publisher/Application/Version Setup dialog box:

¢ In an Analysis Workbench Files window select the Add to SAl option from the Tag
drop-down toolbar menu.

This option is only enabled if the following conditions have been fulfilled:
e A User editable SAI file is being used

e  SAI recognition is enabled

e TFiles have been tagged (with Global tags).

The New Publisher/Application/Version Setup dialog box is displayed.

The best way to introduce all the various fields and functions in this dialog box is to go
through the steps for teaching files.

Teaching an Unidentified Application

‘- While teaching files to your User SAI it is convenient to use SAI Teaching Mode. This
provides you with the possibility of setting Publisher/Application/Version information and file
status for the files that are about to be added to the User SAI before opening the User SAI
window. See Using SAI Teaching Mode on page 144 for further information about how to use
it.
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Step 1: Tag Files Belonging to the Unidentified Application

To tag files belonging to the unidentified application:

1

Open Analysis Workbench and select the Application Teaching mode from the Quick Config
dialog box.

Load the scan file with the application in question.

If you already know the main directory where the unidentified application resides, tag a
directory and skip the next three steps.

Sort files by the Status column, so that <Unknowns> and <Checkvers> are near the
beginning of the list.

Looking through the list of Unknown files try to find files that belong to the unidentified
application that needs to be taught.

Sometimes you can search for clues in the Version Data columns in the Details windows on
the left side and in the Directory Window. In many cases the directory name can be very
descriptive.

If you have now identified the directory, set a Global tag for the directory.

Set a directory filter in the Files window. You will now see only the files belonging to that
specific directory.

Check whether all the files in the Files Windows belong to the application. Set Global tags
for these files.

Step 2: Specity the Application Details

To specity the application details:

1

Analysis Workbench

In the Tag menu of the File window select Add to SAI. The New Publisher/Application/Version
Setup dialog box is displayed.

Now choose the appropriate Publisher, Application, Release, Version, Operating system
and language details.

Select a publisher from the Publisher drop-down list, or specify a new one by clicking the
New button next to the field. This will display a New Publisher dialog box.

Fill in the Publisher Name (the Description field is optional) and click the OK button.
The new application publisher will now appear in the Publisher drop-down list.

After a publisher has been selected or a new one created, the Application field becomes
enabled. Select an application from the Application drop-down list box or specify a new one
by clicking the New button next to the field. This will display the New Application dialog
box.

Fill in the Application name (the Description field is optional) and click the OK button.
The new application now appears in the Application drop-down list.

If you have created a new publisher or application, the Application Type field becomes
enabled (otherwise the field automatically preselects a type for the application). From the
Application Type drop-down list box, select a predefined type for the application.

Select a Release from the Release Label drop-down list, or specify a new one by clicking the
New button next to the field. This will display a New Release dialog box.

Fill in the Release Name and click the OK button.
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When a publisher releases updates for an existing version of one of their products, they
typically don't change the name of that version. Any particular version of a product could
have several updates to it. In this scenario, the umbrella version is referred to as the
Release Label, or simply as Release. It is not necessary that every version of software has a
release label. In fact, most of them do not. Every version without a release label is
associated to a virtual Stand-alone Releases label.

Select a software version identifier from the Version Identifier drop-down list box, or specify
a new one by clicking the New button next to the field. The New Version dialog box is
displayed.

Fill in the Version Name field.

In the Description field, type in a brief description of the application selected for the
existing Version. This field is optional.

Select the checkbox next to the install strings that apply. Install strings are added to the
list in Control Panel > Add/Remove programs (prior to Windows Vista) or Control Panel >
Programs and Features (Windows Vista) when a program gets installed. The list of install
strings is taken from the scan data loaded into Analysis Workbench. The install string
match will be done during software application recognition if all of the selected install
strings are available in the scan file.

Click the OK button. The new version data now appears in the Version Identifier, Version
Install Strings, and Version Description fields.

A version is defined by its name, application, language and operating system. So, for one
application, it is possible to have many different versions with the same name, provided
that they have different combinations of Operating System and Language.

Select the operating system that the application works under, from the Version OS
drop-down list.

Select the language of the application, from the Version Language drop-down list.

Step 3: Specify Files to be Included

To specity files to be included:

1
2

Click on the Files tab.

Select (check) the files that are to be included. When a file is selected, the bottom pane
displays the Machines and Directories that the file is located on.

If you want to disregard the file size when the file is taught click Ignore file size. The Size
and Signature fields become disabled. Otherwise:

e Specify the size of the selected file if needed. Enter the value in the Size field.
e Specify file Signature by typing directly into the Signature field.

Specify the type of executable file by selecting a predefined type from the Exe Type
drop-down list box.

Go through the list of files and check file characteristics. Make sure that the correct files
are labelled as ‘Main’.

Double check files that are given status ‘Main’ by default; they might be carrying this
status from previously taught applications.

You can change the status of the files (if required) by selecting the file and then selecting
one of the option buttons in the Relation to Application group:
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e Main - This is a key application file, that is, it is a file without which the application
could not be running. It should always be present whenever the application is
installed regardless of whether it is a minimum or complete installation.

e Associated - This is a non-key file that is part of the application and is written by the
publisher that developed the product.

e 3rd party - This is a file written by another Publisher (3rd Party) and is used in the
current application. An example of a 3rd party files is some DLL files that are
technically used by the application, but are also distributed freely and can be used by
other applications.

The VerDLL field shows a concatenation of a set group of version data fields. Do not change
the entry in this field unless absolutely necessary.

) The drop-down lists are produced from a combination of data in both Master.zsai and
User.zsai. Before an entry is committed to the User.zsai a number of options are available.
These can either be set up under options and selected as default, or the default setting can be
left off and you will be prompted each time to select the information. See Step 5: Set Teaching
Options on page 143

Step 4: Select the User SAI File and Commit the Changes

To select the User SAl file and commit the changes:

1
2

Click on the SAIl Selection tab.

This tab page shows a list of User SAI files available for teaching applications to. A file
can be either or both of the following:

e Selected - Any changes made to the SAI are saved to the Selected file only - not the
Default file.

e Default - The Default file is automatically selected when the dialog box is next opened.
You can set a file to be Default and specify another one to be Selected.

To change the automatically selected SAI file, select another one from the list and click
the Select button. The status in the Selected column is shown as Yes.

To change the default SAI to use, select the SAI file and click the Set Default button. The
status is shown as Yes in the Default column.

Confirm your choices by clicking OK. You are prompted to set SAI teaching options. See
Step 5: Set Teaching Options on page 143.

When you have done this, the information in the Software Application Index file is
updated. You can view the newly added application by using the SAI Editor. See the SAI
Editor Chapter for more information on how to do this.

Step 5: Set Teaching Options

To set SAl teaching options:

1

Analysis Workbench

Select the Options button in the New Publisher/Application/Version Setup dialog box. The SAIl
Teaching Options dialog box is displayed.

Set the options as follows:

®* Recognition
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>»

Use level 3 heuristics: SAI teaching uses the same recognition method as is used during
the loading process. This means that if the ‘Level 3 heuristics’ is enabled, teaching a
single file will reprocess all files on all machines on which the file occurs. If ‘Level 3
heuristics’ is disabled, teaching a single file will cause all files in all directory/
machine combinations where the file occurs to be re-recognized.

This setting should be set to the same as when the scans were loaded. If the scans
are loaded with Level 3 heuristics enabled and re-recognition after teaching is
done without it, recognition results can change significantly.

Save changes to SAIl

When AW exits: Any changes to the SAI are saved when you exit from the Analysis
Workbench application.

Immediately: Any changes to the SAI are saved immediately.

Tag changed items

Selecting this option enables the following further options:

Files - Any files that are affected by the SAI teaching are tagged.

Applications - Any applications that are affected by the SAI teaching are tagged.
Directories - Any directories that are affected by the SAI teaching are tagged.
Machines - Any machines that are affected by the SAI teaching are tagged.

Set Local Tags - If this option button is selected, then Local Tags are used for the
operations.

Set Global Tags - If this option button is selected, then Global Tags are used for the
operations.

Set options as default

Select this check box to retain these settings as the default.

Using SAI Teaching Mode

SAI Teaching Mode provides a scratch pad for information to be fed into the User.zsai. Entries
are taken from existing values and stored temporarily. These values can then be inserted
automatically when teaching entries to the SAI. This greatly simplifies the procedure outlined
in the previous section Teaching an Unidentified Application on page 140.

To use SAl teaching mode:

1
2

Tag the files to be taught to the SAI with Global Tags.

Select SAl Teaching mode from the Recognition menu. A non-modal window is displayed —
this is the SAl Teaching Holding Area.

Now, in the main area of the Files window, right-click on a file that has been identified.

The shortcut menu now contains an enabled Publisher menu item, with likely choices
listed as submenu items.

Select the correct publisher. The SAI Teaching Holding Area is updated to display the
selected publisher.

Again, right-click on a file; the Application menu item is now enabled, and can be used to
select the application name.
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Select the correct application. The SAl Teaching Holding Area is updated to display the
selected application.

Right-click on a file; the Release menu item is now enabled and can be used to select an
application release.

The SAI Teaching Holding Area is updated to display the selected release.

Finally, the Version menu item becomes available and can be used to select the version
identifier.

Select the correct version. The SAI Teaching Holding Area is updated to display the selected
version.

’ There is no requirement to select Publisher, Application, Release or Version if the
data presented is incorrect or not applicable.

As each of the Publisher/Application/Release/Version fields of the Holding Area are
populated in this manner, the data becomes editable to facilitate major or minor changes
to the data displayed.

In the Files window, locate the file(s) to be added as identifying, licensable files of the
application.

For each of these files, right-click and select the Main menu item. Each of the file names
selected appear in the Main files column of the holding area.

Locate those files, if any, that are shipped with the application but are 3rd party file (such
as vbrun*.dll).

’ Vbrun200.dll and Vbrun300.dll will have 3rd party status only for non-Microsoft
applications. For all Microsoft applications they will be considered associated files.

Mark these as 3rd party files using the 3rd Party Files shortcut menu item. The holding
area is updated accordingly.

Select the Add to SAI option from the Tag menu of a Files window. The New Publisher/
Application/Version Setup window is displayed.

The Publisher, Application and Version fields are now pre-filled with data from the
holding area. If an item does not already exist in the SAI, it is added automatically by this
process. The File Type for each file is automatically updated based on the file names in
the Main Files and 3rd Party Files lists of the Holding Area.

Teaching a Directory with Main, Associated and 3rd Party Files

To teach a directory with Main, Associated and 3rd Party files:

1
2
3

Analysis Workbench

Select the Main file and any 3rd party files and store in the Holding area.
Tag the multiple Associated files using tagging from a Directory window for example.

Open the New Publisher/Application/Version Setup dialog box from the Tag menu of a Files
window.

The tagged files and the files in the Holding area are displayed with the Publisher,
Application and Version from the Holding Area already entered.
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Populating the SAl Teaching Mode Automatically

To populate the SAl teaching mode automatically:
1 In a Files window, right-click on a file that has been identified.
The shortcut menu now contains an enabled Automatic menu item.
2  Selecting this item is equivalent to:
¢ Right-clicking, selecting Publisher and choosing the first menu item.
¢ Right-clicking, selecting Application and choosing the first menu item.
¢ Right-clicking, selecting Version and choosing the first menu item.

e Right-clicking and selecting the Main file.

The SAI Editor

The SAI Editor presents a view of the SAI files (Master and User) that have been used for
recognition in Analysis Workbench.

The SAI Editor allows you to:

e View and edit a collection of SAI files

¢ C(Create new User SAls

e Move and copy item between SAls

e Delete items in SAls

e C(Create License relationships between applications

e Export the contents of an SAI to xml format, either as an XML Summary or in its entirety.

This tool is available either as a standalone tool or from the Analysis Workbench User
Interface.

To start the SAI Editor from the Analysis Workbench User Interface:

e Select the View/Edit SAls option from the Recognition menu.

To Start the SAI Editor as a standalone tool:

¢ From the Windows Start menu select Programs > Hewlett-Packard > DDM Inventory 7.70 > SAl
Editor

Further Information

Further information can be found in the SAI Editor Chapter.

License Relations and Application Suites

In This Section

e What are License Relations on page 147

e Adding License Relations on page 147
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¢ Displaying Licensed by and Licenses Entries in Analysis Workbench on page 148
¢ Displaying Licensed by and Licenses Entries in Analysis Workbench on page 148

Further Information

e Application recognition is covered in detail in the Application Recognition and Teaching
Chapter.

e Further information about license relationships and the SAI Editor can be found in the
SAI Editor Chapter.

What are License Relations

Each identified file is categorized as either Main, Associated, or 3rd Party. The recognition
library can contain any number of files in a particular version as belonging to either category.

When at least one Main file is identified on a machine, a license is required for the
application, unless another application on the machine assumes license responsibility for the
application.

License relations are part of the Application Library. When two interdependent applications
are identified on a machine, one application can assume license ownership on that particular
machine. The chain of license relations can be any number of levels deep.

License relations solve the problem of Suite licensing simply and effectively, and are
applicable to license relationships outside what would normally be considered a software
suite.

For example, MS Office 2000 licenses MS Access, Word, Excel, PowerPoint, Outlook and is a
well known software suite. In addition Outlook 2000 licenses MS Data Access Components
(ADO) 2.1 sp1 - if Outlook or another licensing application is not present on the machine, a
license is required for the software, but if Outlook is installed on the machine, Outlook
assumes license ownership. Different versions of Outlook license different versions of MS
Data Access Components.

License relations are also useful when an application has a complex component structure. If
application components can be installed on their own, they should be treated as independent
applications, but the connection with the application should be reflected in license relations
for that application.

The SAI Editor allows license relationships to be established and immediately be applied to
the application data loaded. This application is available via the Analysis Workbench User
Interface or as a stand-alone utility from the Start menu.

Adding License Relations

License relations allow a particular version of an application to contain licenses for one or
more versions of other applications.

A single version of an application can assume responsibility for any number of other
application versions, and this can be extended to any number of levels of nesting.

The new relations are stored in a user editable SAI and are used the next time the data is
loaded.

Each version entry has two lists that can be filled separately:

e Owning Release - The application that contains versions of other applications.
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e Licensed Release - The applications that are contained in the Owning Application.

License relations are set up using the SAI Editor. This tool is available either as a standalone
tool or from the Analysis Workbench User Interface.

To start the SAI Editor from the Analysis Workbench User Interface:

e Select the View/Edit SAls option from the Recognition menu.

To Start the SAI Editor as a standalone tool:

¢  From the Windows Start menu select Programs > Hewlett-Packard > DDM Inventory 7.70 > SAI
Editor

Further information

For further information about the SAI Editor and how to use it, refer to Chapter 6, SAI Editor.

Displaying Licensed by and Licenses Entries in Analysis Workbench

In an Applications window, it is possible to have the Detail window selected with Licensed By
and Licenses windows displayed. When an application is selected, the Licenses Apps and

Licensed by columns display the count of files and the details window will report the machines
on which the files occur.

<l

Microsoft - Internet Explorer - 5.00,3790,23959 |

Inztalled on 2 machines

td achine Licenze Itilization &

FaTHaEa

Whware-50_1b_f3_d7 Mo 5.2

Licenzed by [2]

bl achine " ersion Application Publizher

TETMES 2003 ent sp2 "Windows Server Microzoft

Whdware-50_1b_f3_d7, 2003 ent sp2 Windows Server kicrozoft

Licenzesz [4]

bl achine " ersion Application Publizher
Whlware-50 16 9 d7| 201 [5.2.3730.3959] [MetMeeting Microzaft
Whdware-50_1b f3_d¥) 6.00.3730.3359 Outlook Express kicrozoft
TATHEE 301 [5.2.3730.3959])  Methieeting Microzoft
FaTHMER 6.00.3730.3959 Outlook, Express hicrozoft

748 Chapfer 2



To display the Application window Details pane:

1

In an Applications window, select the Detail window link option from the Configure
drop-down toolbar menu, or

Select the Configuration option from the Window menu and check the Application Windows
box in the Detail Window Link group.

The information that is displayed in the Applications Details window can be selected by:

* Clicking the configure icon & in the Details window or

e Selecting the Detail window option from the Configure drop-down toolbar menu. This
will display a Window Layout dialog box.

Select the following options:

e Licensed by The details of the Application Suite that licenses the highlighted
application (if applicable). For example, Word 2007 is licensed by Microsoft Office
2007.

e Licenses The details of any applications that the highlighted application licenses, for
example, Office 2007 licenses Microsoft Photo Editor.

The Applications Details — Licensed by or Licenses information links back to the
Applications window and the Machines window, showing details for that selected
application and the machine it is located on.

Using Recognition Obijectives in Analysis Workbench

In This Section

Why You Need Recognition Objectives on page 149

Setting Recognition Objectives Options on page 150

Starting the Define and Review Objectives Dialog Box on page 154

The Define and Review Objectives Dialog Box Properties Tab Page on page 154
Adding an Applied Objective on page 156

Removing an Applied Objective on page 157

Loading and Saving Recognition Objectives on page 158

Displaying a Summary of the Recognition Objectives on page 158

Reviewing Recognition Objectives on page 159

Using Objectives to Improve Recognition - The SAI Teaching Wizard on page 164

Why You Need Recognition Obijectives

In an ideal world, it would be feasible to make sure that every file on every machine in the
population was recognized. However, the effort involved in ensuring 100% recognition is
normally so large that this is not practical or economical, and less idealistic goals have to be

set.

Recognition Objectives are designed to ensure that the following can be achieved with the
least amount of effort:
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e No machine has a large percentage of unrecognized files on it.
¢ Files that occur often in the population are recognized.
e Files that occur only on a few machines may not be recognized.

Based on this principle, Recognition Objectives help you set achievable goals for the
recognition process, measure how far you are from those goals, and provide assistance in
achieving them.

The objectives engine allows you to define as many objectives as you need. By default, only a
single objective for the entire Enterprise is defined, although this can be extended by setting
up objectives that apply to subsets of the population as well.

Further Information

For further information about recognition objectives, see the Application Recognition and
Teaching Chapter.

Setting Recognition Objectives Options
You can set a number of options defining how Recognition Objectives are managed.

To set Recognition Objectives options:

Click the Objectives Options item in the Recognition menu.

A dialog box is displayed with the Startup tab page showing.

The Startup Tab

You can specify the following:
* File containing default Objectives

To load a default set of objectives when Analysis Workbench starts, type in the name of
the file containing the objectives here.

By default, Analysis Workbench uses the file objectives.xml.
e  Startup Options

To automatically show the Objective Summary dialog box when new scan data has been
loaded, check the option to do so.
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The Calculate Tab

®A Recogpition Objective Options Z E|@

Startup | Calculate |L|:ngging Ignored Files | Excluded Directories

Automatically re-calculate objective compliance in these cazes:
After lnading scan files
After unloading scan files
After loading a state image
After changing objectives
After teaching or editing the User 54
After emecuting a script

] ] ’ Cancel

You can set up when automatic recalculation of objective compliance should take place. When
many scan files are loaded, this may take significant time to do and you may wish to disable
some of the automatic calculation options on this page.

Objectives can be manually recalculated from the Recognition Objectives dialog box.
The Logging Tab

You can specify which log files to use to log teaching activity, if any.

The two log files that can be created are both CSV (Comma-separated variable) files that can
be imported into other tools for further analysis.
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The Ignored Files Tab

B Recognition Objective Options |'._| |’E|[E|
Startup | Calculate Lngging| lgnared Files |E:-:|:Iudeu:| Directories

Files with names in the following list are ignored when calculating any of
the Recognition Objectives. Mote that items in the list are caze inzensitive
and may not contain any wildoard characters.

.g2cih.exe

Mpclean.exe

_mmzetup.exe

_Organization Chart 'Wizard exe

£dd tagged files

0k || cancel |

This page can contain a list of file names that are to be ignored when calculating objective
compliance.

This may be useful if a set of files are known to be of no interest.
e Type the file names into the list pane and they will not count when the Applied objectives

are evaluated.

Adding Tagged Files

You can also add files that have been tagged in a Files window in the Analysis Workbench
workspace.

) You will have to close this dialog box first if you forgot to tag the files.

1 In a Files window, tag the files you want to add to the Ignored Files list.
2 Click the Add tagged files button. The files are added to the list.
3 To clear the contents of the list, click the Clear button.
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The Excluded Directories Tab

Analysis Workbench

®A Recognition Objective Options [Z”E|E|

Startup | Caleulate | Logging || Ignared Files | Excluded Directaries

Directariesz with namesz in the following lizt are ignored when wzing the
Teaching“izard. This lizt should include directories that commonly
cohtain files from a number of different applications.

/bin S
Aib

/zhin

Auzrdbin

Ausrdlib

Auzrdlocaldbin

Auzrdlocaldlib

Auzrdlocaldzhin

Auzrdshin

WTemp 3

Add tagged dirs

OF. H Cancel l

This page can contain a list of directories that are to be ignored when calculating objective
compliance.

Directories with names in this list are ignored when using the SAI Teaching Wizard. The list
will include directories that commonly contain files from multiple applications.

The SAI Teaching Wizard can only help teach applications installed in their own directories.
Example of directories you may want to include in this list are:

C:\tmp

C:\Windows

C:\WINNT\system32

/usr/bin

Type the directory name and path into the list pane and files that occur only in the listed
directories will not be chosen for teaching in the SAI Teaching Wizard. Files in these
directories are not excluded when evaluating objectives.

Adding Tagged Directories

You can also add directories that have been tagged in a Directories window in the Analysis
Workbench workspace.

You will have to close this dialog box first if you forgot to tag the directories.

1 In a Directories window, tag the directories you want to add to the Ignored Excluded
Directories list.

2 Click the Add tagged dirs button. The directories are added to the list.
3 To clear the contents of the list, click the Clear button.
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Starting the Define and Review Objectives Dialog Box

To start the Recognition Obijectives dialog box:

Select Objectives from the Recognition menu.
The Define and review Objectives dialog box is displayed with the Summary tab showing.

This dialog box is non-modal. This means you can have it displayed while working in the
Analysis Workbench workspace. Position the two dialog boxes on your screen so that you can
work with both dialog boxes at the same time.

If the dialog box becomes hidden behind the main Analysis Workbench windows, it can be
accessed through the Windows menu.

The Define and Review Obijectives Dialog Box Properties Tab Page

Click on the Properties tab.

PR Define and review Objectives

Applied Dbjectives Surnmary | Machine Criteria | File Criteria | Properties

% Entire Enterprise

=% By Host 05 Categary
v Al ather values Thiz iz the percentage of files on each machine that should be

% Microsoft Windaws recoghized in order to meet the objective.

v Urix 80

kachine criteria

File critena
It iz important to ensure that filez that occur on a large number of
machines are recognized. Files that occur only on a few machines
are considered less impartant,

& > Specify the dezsired shape of the unrecognized/frequency araph:
Urnused Objectives ey relaxed =
Chazsiz Type
Cost Center -"E
Disaizion ‘=
Department g
Office Lacation O
Building =
#
z
o
=

0 10 20 30 40 50 &0 70 &0 90 100
Filez occur on % of machines

Calculate ” Refrezh

The top left pane shows the Applied Objectives. These are used to measure progress and assist
in the teaching progress. In the previous screen image, four such objectives are defined.

The top Applied Objective, Entire Enterprise, always applies to all machines loaded and is the
only Objective that is defined by default. The next objective groups the loaded machines by
Host OS Category. This allows you to specify different objectives for your Windows machines,
UNIX machines and all other operating systems.
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The Default Objective (Entire Enterprise) specifies a Machine criteria of 80% and the File criteria
uses the Standard graph. These can be changed as required.

The bottom left pane shows the Unused Objective. These fields are available for selection.
Click on an entry in this list and a list of Objective group fields for the Objective is shown on
the right.

B Define and review Objectives Z Ele

Froperties

Applied Objectives

? Entire Enterprise Objective group fields

From the ligt of values below, check thoze fisld values to which
objectives should apply.

All ather values All
Los
IEM 0572

Mac 03
Microzoft WWindows
Other

FDa&

s

Idnuzed Objectives

Hast 05 Category
Chazziz Type
Cozt Center
Divizion
Departrment
Office Location
Building

Apply
Calculate ” Refresh
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Adding an Applied Obijective

To add an Applied Objective:

1 In the Define and review Objectives dialog box select the Unused Objective you want to add

fields from. In our example, we are using the Host OS Category.

BA Define and review Objectives

Applied Objectives

“} Entire Enterprize

Jnuzed Objectives

Chagsziz Type
Cost Center
Drivvizion
Department
Office Laocation
Building

Froperties |

- BX

Objective group fields

Fram the ligt of values belowe, check thoze figld values to which

objectives should applhy.

v| Al other values
Dos
IBM O5/2
Mac 05

| Microsaft \Windows
Other
FDA,

]

Al

MHaone

Apply

Calculate ” Refresh

Cloze

2 In the Objective group fields pane, check the box next to the fields to which the objectives

will apply. In this example, the following fields will be applied:

e All other values
e  Microsoft Windows

e UNIX
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3 Click the Apply button. The entries are moved to the Applied Objectives pane.

PR Define and review Objectives ['._|['E|f'$__(|
fpplied Objectives Surnmary | Machine Criteria | File Criteria | Properties

¥ Entire Enterprize

Objective group figlds
=% By Host 05 Cateqary

v Al ather values Frqm t_he list of walues below, check those field values to which

% Microsoft Windows objectives should apply.

v Unix | Al other values Al
Los

IEM O5/2
Mac 03
¥ Microzoft Windows
Other
PO,
W] Lniw

Irnuzed Objectives

Chaszziz Type
Cost Center
Dhivizion
Department
Office Location
Building

Apply
[ Calculate ” Refrezh

) The Objective group fields for the Asset fields (For example, Cost Center, Division) are based
on data available from the currently loaded scan files. If no scan files are loaded, or if no scan
files define a particular field, the Objective group fields for that field will be empty perhaps
except for the Any other values entry.

Removing an Applied Obijective

To remove an Applied Objective:

1 Select the Objective in the top left pane.
2 Uncheck the relevant Objective group fields in the right pane.
3 Click Apply.

The Applied Objective will be removed.
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Loading and Saving Recognition Obijectives

Recognition Objectives are stored in XML format.

) Recognition Objectives are automatically saved when the Define and review objectives dialog
box is closed. They are saved to the location you specified in the Startup tab of the
Recognition Objective Options dialog box. See page 150 for further information.

The Applied objectives have a pop-up menu associated with it that can be activated by
right-clicking on the item.

® Load Objectives

Use this to replace the currently defined Objectives with a previously saved set of
Objectives.

® Save Objectives
Use this to save the currently defined Objectives.
® Save Objectives As

Use this to save the currently defined Objectives to a file other than the one specified in
the Startup tab of the Recognition Objectives Options dialog box.

Displaying a Summary of the Recognition Obijectives

To display a summary of the Recognition Objectives:

e In Analysis Workbench, select Objectives Summary from the Recognition menu.

A Summary chart is displayed.

Recognition Objective Summary

[ 2 Achieved I 1 Mot Achieved T 1 Undefined

Review... ” [mprove... ]
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This example shows that four Applied Objectives have been defined. Two of those have been
achieved, one has not been achieved and one is undefined.

The undefined section of the chart (usually displayed in grey) implies that the objective
compliance has not been calculated.

To rectify this:

e Return to the Define and Review Objectives dialog box (select Objectives from the
Recognition menu) and click the Calculate button or click the Recalculate Objectives
menu item in the Recognition menu.

Buttons in the Chart Page

There are three buttons in the Chart page:

e (Click the Review button to get a more detailed view of the state of the objectives. See
Reviewing Recognition Objectives on page 159 for further details.

e  (Click the Improve button to start the SAI Teaching Wizard that can help achieve those
objectives that still need some work. See Using Objectives to Improve Recognition - The
SAI Teaching Wizard on page 164 for further details.

e (Click the Options button to launch the Recognition Objectives Options dialog box. See
Setting Recognition Objectives Options on page 150 for further details.

Reviewing Recognition Objectives

To review the Recognition Obijectives in defail:

1 In Analysis Workbench, select Objectives from the Recognition menu, or click the Review
button when the Objective Summary screen is shown.

2 Click the Summary tab.
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The Define and review Objectives window is displayed.

PR Define and review Objectives

Applied Objectives Summary | Machine Criteria | File Criteria | Properties
2 Entire Enterprise b aching criteria compliance
=% ByHost 05 Categary

W Al other values EF Only ¥ of 10 machines meet the machine

> Microzoft Windows chiective.

v Lnix 3 machines are less than 75% compliant and
probably require significant work, to meet the
objective.

File criteria compliance
TI 3 files should be added to the library o
a achieve compliance.
Unused Objectives [& total of 5340 of 17500 files are unrecognized)
Chaszsziz Type
Cozt Center
Division
Departrment
Office Location
Building
Calculate ] ’ Refresh ]

At a glance, you can see from the tree view on the left that one of the Applied objectives has

not been achieved (indicated by the ¥ icon) and two have been achieved (indicated by the .+
icon).

=S

The red X J: on the Machine criteria compliance icon shows that the machine criteria was
not met, and the text explains that 3 of the 4 machines loaded meet the criteria. In order for
the objective to be achieved, all of the machines must meet this criteria.

The green tick on the files icon shows that the file criteria was met (and this is in spite of
the fact that more than 19000 files are unrecognized).

To manually recalculate objective compliance (which may be necessary if some of the
automatic options are disabled and circumstances have changed):

e (Click the Calculate button in the Objective Review dialog box.
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Reviewing Machine Criteria

To get more detail about the Machine criteria:

Click on the Machine Criteria tab, which shows a pie chart of the machines.

T machines (70.0%)
100% Compliant

3 machinez (30.0%)
S0-74% Compliant

In this example:

e Seven of the machines are compliant (Green). In this example, 80% of the files on a
machine must be recognized for that machine to be considered compliant.

e Three machines are not compliant (Magenta).

The percentages show how close the machines are to achieving the criteria. The machines
(Magenta) that are 50-74% compliant have a recognition rate of 50-74% of the target 80%.
That is, the recognition rate is between 60% and 79%.

If you move the mouse over the pie chart, the individual slices of the chart are highlighted.

Right-click to get a pop-up menu that applies to a slice of the pie chart. From the pop-up
menu, you can do the following:

e Tag the machine(s) related to the pie slice to investigate it further in the normal Analysis
Workbench windows.

e Untag those machine(s) related to the pie slice.

e Copy the Chart to the clipboard.

Reviewing File Criteria

To get more detail about the File criteria for an Objective:

e (Click on the File Criteria tab.
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This shows a bar chart containing both the desired (allowed) shape of the unrecognized/
frequency chart as well as the actual shape of it.

Unrecognized files by frequency of file in population
100

G0
&0

% files unrecognized
n
o

0 10 20 30 40 50 &0 TO0O B0 S0 100
File occurs on % of machines

[ Il 2ctual v [l 2lowed |

[] Highlight non-compliant items

¢ Actual values are shown in green.
¢ Allowed values are shown in blue.

For this objective, the File criteria is not met — all of the green Actual values are not lower
than the blue Allowed values.

) When only a few machines are loaded, not all of the categories are used, but the File criteria
graph always shows 20 bars evenly distributed between 0 and 100%, irrespective of the
number of machines loaded.

Moving the mouse over the Actual values shows a pop-up label with details of the data point
in question.
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For example, the bar spanning 30-35% on the Y-axis shows the following text in the pop-up:

Unrecognized fies by frequency of file in population
100

50

% files unrecognized
in
[

30 ' |

20 3435 unrecognized files
[of 7280 files, 47 .2 %)

10 |

0 10 20 30 40 S0 &0 FO B0 S0 100
File occurs on % of machines

(v Il ~ctual [ [l 2lovesd |

This means that 7280 files occur on 30-35% of the loaded machines, and that 3435 of these
(4'7.2%) have not been recognized.

This also demonstrates how it is possible for the file criteria to be met, even though thousands
of files are unrecognized. The majority of unrecognized files probably occur on just a few
machines and are therefore not as important as the common ones.

When teaching, you will want to start with the unrecognized files that occur on the largest
percentage of machines rather those that occur on just a few machines.

An Example of File Criteria Not Met

Here is an example where the File criteria is not met.

Unrecognized files by frequency of file in population
100

80
&0

T
'
'

T
1
'

+
'
1

% filez unrecognized
(4]
[

1
-

'

1

1

1

0 10 20 30 40 S0 &0 V0O B0 90 100
File occurs on % of machines

[V [l 2ctual [ [l 2loved |

In this example:

e The File criteria has been set to Strict in the Properties tab page and is not met by the
scan files loaded.
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¢ The Highlight noncompliant items option is checked, which is why some of the Actual values
are red instead of green. This is to indicate that the Actual value is higher than the
Allowed one.

This chart has a pop-up menu that is shown when right-clicking on one of the Actual bars.
From the pop-up menu, you can:

e Tag or Untag the files in question, and Tag the machines to which the objective applies.

’ For the Entire Enterprise objective, this means that all machines are tagged when
a set of files are tagged from this pop-up menu.

e  Copy the chart to the clipboard.

Using Objectives to Improve Recognition - The SAl Teaching Wizard

Having defined a set of objectives, the SAI Teaching Wizard can make use of the objective
information to choose which files to teach.

’ When the teaching wizard is run, all global tags are cleared.

To start the SAIl Teaching Wizard:

1 Select the SAl teaching Wizard option from the Recognition menu.
The Teaching Assistant is displayed.

2  Click Next to continue.

Choosing an Objective to Improve

The next page of the wizard allows you to choose which of the Applied objectives should be
improved.

The objectives are shown in a tree view and when an objective is selected, a summary of the
objective is shown on the right.

1 Select the objective.

2 Click Next to continue.
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Selecting an Unrecognized File

On this page, the wizard constructs a list of unrecognized files that occur on machines related
to the selected objective. It suggests the file that occurs on most machines.

SAl Teaching Wizard

Select File é :
Which unrecognized file should be uzed? F

The following file has been chozen for recognition. To zelect another file, click Skip.

Attribute Walle
File name naf 292 ene
Size 516,781
Signature BFEOQ-2505
ki odified 2008-08-01 03:29:34
Attributes ® oA 1
Type "Win 32 Exe
Arccessed 2003-03
[tilization A41%
Onmachines B
Skip

¢ Back ][ Mext =

This page shows details of the selected file. The details are similar to those found in the Files
window, as well as the number of machines on which it is found.

e Ifthe selected file is not one that you wish to teach at this time, click the Skip button or
click the Next button to select the file shown for teaching. The wizard will choose the next
candidate for teaching until there are no more unrecognized files to teach.

The following page is displayed if there are no more files from the selected objectives that can
be taught.
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You may need to manually teach the remaining unrecognized files. For more information
about manually teaching a file to the User SAI, see Teaching an Unidentified Application.

SAI Teaching Wizard Ed

Mo more files ﬁ
The wizard cannot find a file to teach p

Mo more files from the selected objective can be taught uzing this wizard.

[f rare unrecognized files exist, they probably exist only in directaries that have been excluded in
the Recoghition Options dialog.

I thiz iz the cage, the remaining teaching waork. must be done without the aid of the Teaching
Wizard.

Click. Back to select another objective, or Cancel to cloze this wizard.

Automatic Selection of a Set of Files

Because most files do not exist alone, but are installed along with a group of other files
making up an application, it rarely makes sense to teach files individually.

For this reason, the teaching wizard automatically performs the following steps at this point:

Tags the file selected for teaching.
Tags all machines (in the objective) on which it occurs.
Applies a machine and file filter to the Directories window.

Tags the first directory in the Directories window (that is, the first directory that has not
been excluded).

Applies a machine and directory filter to the Files window.

Tags all files in the Files window.

In other words, this set of steps tags all files that occur in the same directory as the selected
file, because these are all files that are likely to belong to the same application.

The wizard shows a confirmation dialog box.

At this stage, you can switch back to the Analysis Workbench Files, Machines and Directories
windows view to review the automatic selection.

Review each of the tagged files to ensure the selection is valid. You can untag some files, tag
some more and so on, before proceeding.

When you are satisfied with the selection of files, click the Finish button.
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The New Publisher/Application/Version Setup dialog box is displayed. Here you can enter
details about the application to which the tagged files belong. See The SAI Editor on
page 146 for more information about how to fill in these details.
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Exporting Inventory Data

In This Section

e Introduction to Exporting on page 168

e Selecting the Type of Export on page 168

e Layout of the Export on page 169

e Setting Default Options for Exports on page 171

e Exporting Machine Data on page 171

e Exporting Application, Directory or File Data on page 173

¢ Exporting Relational Data on page 174

¢ Exporting Stored File Data on page 177

e Loading and Saving Exports on page 180

Introduction to Exporting

Various combinations of hardware, software and asset data can be exported. The facilities
used to define the level of detail for exported data provide a means of refining the selection of
data exported.

When a suitable data file containing the exported data has been created, it can be imported to
populate a variety of third party systems including spreadsheets, databases, asset
management and help desk systems, which support the configurable data formats
automatically created by the Analysis Workbench.

Data can be exported directly from the Analysis Workbench either in standard ASCII text
form and CSV format (Comma Separated Variable).

Selecting the Type of Export

In This Section

e Exporting Data Directly From the Analysis Workbench on page 168

e Exporting the Contents of Individual Windows on page 169

Exporting Data Directly From the Analysis Workbench

To export data directly from the Analysis Workbench:

e  From the Exports drop-down menu select one of the following options:

Machines - Generates a machines export.
Applications - Generates an applications export.
Directories - Generates a directories export.

Files - Generates a files export.

Chapter 2



¢ Relational - Relational exports combine hardware, application and file exports in a
manner that allows the data to be imported into an external database application
with little effort. If the relational export option is chosen, then this provides the
opportunity to combine columns from a particular window with link columns from
other windows.

e Stored Files Export - This type of export allows one or more named files to be extracted
from all scan files and stored in a number of different ways.

Exporting the Contents of Individual Windows

To export the contents of individual windows:

e Select the Export from window option from the Output button drop-down menu.

This will display the Export to file dialog box which allows you to export the contents of the
window based on the current column selection and filter settings.

Layout of the Export

An item group is what is represented as a line in one of the main windows. It is known as a
group because one of these line items may represent several occurrences of similar or identical
items.

For Applications, Directories and Files exports the results can be presented in one of two
formats:

®  One line per item group
This presents the results in a format that is same as the active Window.
® One line per item

One line in the export shows details for each item. Each occurrence is shown. That is,
every line in the window is exported and shown as a row in the results.

Export Layout - Example

The Details window can be helpful in demonstrating the concept of item and item groups.

1 Ensure that the Details window link is enabled for a Files window (selected from the
Configure toolbar menu in a Files window).

2  Configure the Details window so that it displays the Asset Number and Directory columns.
To do this use the Detail window command in the Configure toolbar menu.

3 Now click on an entry in a Files window.

Files with the same name are grouped together, if they are recognized as belonging to the
same application/version, are of the same recognition type (for example, Main/Associated)
and so on.

If two files with the same name are both unrecognized, they are only grouped together if they
have the same size. If they are recognized (and otherwise grouped), the size is ignored and can
be different.

If the exact file has been located in multiple places (either on the same machine or on
different machines), each occurrence will be displayed in the Asset Number column as a
separate row and the location will be displayed in the Directories column, hence it is part of a
‘group’.
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If the file has only been located on one machine, then only one row will be displayed in the
Asset Number column (in this case select another file to use for the example).

[19292 of 19887

Fiters= | O & (1 [ & || M Columns~ 2 Tay |winvnc.exe
Mame - Azzet Mumber | Size Signature |2
W IFIVH L EE Windows 95 05 3 2 |COAZ-BEA3|:
'-.-'-.-'ir'r-.-'r'n::.e::-::e Windows 93 5E 335,872 CD42-BEAZ »
vl clazs
wiine. clazs — The file winvnc.exe
'\.Einw rlass 5 . occurs in two places.

In this case on two
different machines.

In the export results, one line in the export will represent the information for this group of
entries. For instance, the number in the Copies column of an export represents the number of
occurrences of the file. This number is equal to the number of rows that are displayed in the
Asset Number column for a particular file.

One Line Per ltem Group

This presents a detailed view which has the same contents as the active Window.

One line in the export shows details for a group of items.

=i Files.csv [Z| [E| [E|

A B c D E FlG @

Py
1 |Hame Publisher Application Wersion Release ﬂ g
2 |winverexe |Microsoft Windows Server 2003 ent 2003 1) 1
3 |WINVER.exe |Microzoft Windowsz SSo=r2 85 0SR2) 1| 1

4 |WINVER.exs |Microsoft Windows NT 40=rvepBa| 405rv| 1| 1—
5 |WINVER.exe |Microzoft Windowsz 58 88 1| 1
6 |winverexe |Microsoft Windows NT Terminal Server 4.0 =2p6 4 1 1
T |winvnc.exe |ATAT Labs Cambridge |WNC Server 3.3.6 I 2 1
8 |winvnc.exe |ATAT Labs Cambridge |WNC Server 3.3.7 I 1 1

9 v

M 4 » »]Files / |< | e

In this example, rows 7 and 8 represent the data for the winvnc.exe file group. In row 7, the
number in the Copies column is 2, which corresponds to the number of occurrences of this file
displayed in the Details window.

One Line Per ltem

One line in the export shows details for each item. Each occurrence is shown. That is, every
line in the Window is exported and shown as a row in the results.
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Setting Default Options for Exports

The default settings allow you to specify the directory the export results will be saved to, the
format of the export file (CSV or TXT) and actions to be taken if an export file of the same
name already exists in that location.

To select default options for exports:

1

Select the export option from the Exports main menu (depending on the type of export that
you want to make), or

Select the Export from window option in the Output button drop-down menu in the window
(Machines, Applications, Directories, Files exports only).

The Export to file dialog box is displayed.
Click the Default Settings tab in the Export to file dialog box.

In the Default export directory field, specify the name and path of the directory (or use
standard Windows navigation methods) to where the export file will be saved by default.

In the Export format group, select one of the following default export format options:
e Comma separated (.CSV)
e TAB delimited (.TXT)

’ This option is not available for Stored Files exports.

Choose an option to specify how the data will be exported if the specified target data file
already exists. The following options are provided:

e Overwrite Overwrites the existing file with the new data.
e Append Appends the new data to the existing data.

e  Prompt A prompt is displayed if the target data field already exists. Prompts to create
a new data file.

Click OK to set the default options or Cancel to exit without making any changes.

Exporting Machine Data

There are two ways in which you can export the contents of the Machines window.

Select the Machines option from the Exports main menu.

Select the Export from window option in the Output button drop-down menu in the
Machines window. This allows you to export the contents of the Machines window based
on the current column selection and filter settings.

The Export to file dialog box is displayed.

Configuring the Machine Export

1
2

Analysis Workbench

Click the Export Machines tab in the Export to file dialog box.
Select the columns to export by checking the boxes as required in the list box.
e To select all items in the Column list, click the All items button.

e To select the default column selection. Click the Default button.
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¢ To add more columns to the list, click the Select button. This displays the Select
columns to display dialog box.

B Select columns to export E@@

Awailable Colurnns Selected Columns
= & Hardware Data A T otal memory (Wb
E Azset Data Esussétﬂ_rpaegrﬁltgg Systern Mame
[« CPU Data CRL
I_. Busz D ata Scan Date
[ BIOS Data bzzet Tag
[ Memaory Data Last Mame
[F Operating System [
[T “ideo data
[T Mebwaork data Del &l
[T Eevboard and Mous
[T Dizk data
[ Spstem data
[T Paort data " -
= Doy
. ;7 [Lpoen |
[ ] 5how anly items in use
’ Load ] [ Save ] ok ] [ Cancel

The left list shows all column categories. Click on the + sign to expand the relevant
category and list all possible columns. If the check box next to the category is displayed as
a dotted line, then this means that the not all fields in that category have been selected.

The Show only items in use option will ensure that only hardware items that actually
exist in one of the loaded scan files are shown in this tree.

Either drag a category from the left list to the Currently selected columns list, or select
the check box next to the category and click the >Add button. The functions of the other
buttons are as follows:

e To add all the available columns to the Currently selected columns list click the >>Add
button.

e Toremove an entry from the Currently selected columns list click the Delete button.
e To delete all entries in the Currently selected columns list click the Del All button.

¢ You can move the position of entries in the Currently selected columns list using the
Up and Down buttons.

e Click OK after you have selected the columns. You are returned to the Export to file
dialog box.

Select the Export option in the Column Headers group if you want the column heading
(title) to be included in the export.

Specify the filters that you want to apply to the data, by selecting the check boxes as
follows in the Data Source Filter group:

e Machines - Applies a Machines filter to the data source.
e Directories - Applies a Directories filter to the data source.

e Local - Applies a Local tag filter to the data source.
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e Application - Applies a Application filter to the data source.
e TFiles - Applies a Files filter to the data source.

5 In the Export to File box, specify the name of the file that the export is going to be saved to.
The path displayed here is the one that you defined in the Default Settings tab.

’ To modify the location used to store the data exported from the scan files, use the
Default Settings tab.

6 Click OK to export or Cancel to exit without making the export.

7 If an earlier export file created with the same name and in the same path is open in
another application (such as Excel) a file sharing violation error message is displayed.
Close the file and attempt the export again.

Exporting Application, Directory or File Data

There are two ways in which you can export the contents of these windows.
e Select the Applications, Directories or Files option from the Exports main menu.

e Select the Export from window option in the Output button drop-down menu in the window
itself. This allows you to export the contents of the window based on the current column
selection and filter settings.

The Export to file dialog box is displayed for the Applications or Directories or Files option.

Configuring the Export

1 Click the Export Applications/Directories/Files tab in the Export to file dialog box.
2 Select the columns to export by checking the boxes as required in the list box.
e To select all items in the Column list, click the All items button.
e To select the default column selection, click the Default button.

3 Select the Export option in the Column Headers group if you want the column heading
(title) to be included in the export.

4  Specify the filters that you want to apply to the data, by selecting the check boxes as
follows in the Data Source Filter group:

e Machines - Applies a Machines filter to the data source.
e Directories - Applies a Directories filter to the data source.
e Local - Applies a Local tag filter to the data source.
e Application - Applies a Application filter to the data source.
® Files - Applies a Files filter to the data source.

5 Select the type of export:
¢  One line per item group

¢  One line per item
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6 In the Export to File box, specify the name of the file that the export is going to be saved to.
The path displayed here is the one that you defined in the Default Settings tab.

’ To modify the location used to store the data exported from the scan files, use the
Default Settings tab.

7 Click OK to export or Cancel to exit without making the export.

If an earlier export file created with the same name and in the same path is open in
another application (such as Excel) a file sharing violation error message is displayed.
Close the file and attempt the export again.

Exporting Relational Data

The Relational Export facility enables data to be exported in a format that is supported by
Relational Database Management Systems (RDMS).

Data exported from the Analysis Workbench using these facilities is divided into three main
areas:

e Software information, including file data and information.

e Machine/scan file information, including asset and hardware data and information about
each scan file.

e Linking information to relate each software file to specific scan files.

The exported data is organized into tables, which include specific items of data that are
repeated for each scan file read into Analysis Workbench. The relational export facility
includes options to export data to three different tables which are related or linked by
common fields known as key fields. The three tables are:

e Hardware and Configuration Table
e Applications Data Table
e Files Data Table

Performing the Relational Export

1 Select the Relational option from the Exports menu to display the relational Export to file
dialog box.

There are four steps to performing a relational export:

e Step 1 Configure the Default Settings

e Step 2 Include the Data Tables to Be Exported

e Step 3 Select the Information to Be Included in the Data Tables
e Step 4 Preview the Relational Export Setup

Step 1 Configure the Default Settings
The procedure for setting the default options is identical to that of the other types of exports.

See Setting Default Options for Exports on page 171 for more information about how to do
this.
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Step 2 Include the Data Tables to Be Exported

To Include the data tables to be exported:

In the Relational Export tab page, select the data tables to be exported.

Hardware and Configuration table

The information for this table is configured on the Export Machines tab page.
Applications table

The information for this table is configured on the Export Applications tab page.
Files table

The information for this table is configured on the Export Files tab page.

Step 3 Select the Information to Be Included in the Data Tables

The Export Applications/Export Files/Export Machines tab pages in the Export to file dialog box
provide options that are used to select the contents of the data tables to be exported.

‘n- For each data table you choose to export, a file name (with a .csv extension and including the
full path) must be entered.

To select the information to be included in the data tables:

1

Click the appropriate tab:

e Export Files

e Export Machine

e Export Application

Select the pages to export using the check boxes.
Enter the page and set the column preferences

Choose to include or exclude column headers with the exported data. If the Column
Headers option is selected, column header fields are included in the exported data file to
identify the data items exported.

Choose OK to export data to the selected data tables.

) Applications and Files under Relational Exports do not have choice of Export type
— only one line per item.

Step 4 Preview the Relational Export Setup

The data tables and the columns exported for each one can be previewed by clicking the
Preview button in the Relational Export tab page.

Analysis Workbench
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The Relational View window is displayed:

B Relational View

Relational Export - Overview

File Data T able Hardware and Configuration Data T able Application Data Table
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Cloze

This window shows the tables of relational data which are related by key fields. Key fields are
shown with an asterisk (*) next to them.

Data tables that have not been selected for the export are disabled.

Each table includes at least one key field. The key fields are used to relate data so that when
data is exported, the information you want to view from the tables can be combined using a
relational database system.

Other items of data are indicated as optional fields, which means that these items of data are
only exported if you choose to export them.

1 The contents of the File, Application and Hardware and Configuration tables are specified
on the other tab pages as follows:

e The contents of the File Data table are specified on the Export Files tab page.

e The contents of the Application Data table are specified on the Export Applications
tab page.

e The contents of the Hardware and Configuration table are specified on the Export
Machines tab page.

2  Click the Close button to return to the Export to file dialog box.

The Export Results

The results of a relational export are saved to a file name (.csv). To specify the file names for
applications, machines and files, select the specific tab in the Export to File dialog box and
specify the file name.
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Exporting Stored File Data

Stored files are embedded in the scan file during scanning. Typically these are system
configuration files, for example, Autoexec.bat, Config.sys.

This type of export allows one or more named files to be extracted from all scan files and
stored in a number of different ways.

The naming conventions for the extracted files allow for multiple instances of the files.

) If only one stored file is required from one scan file, then it is more efficient to save the stored
file from Viewer.

There are six steps to performing a stored file data export:

e Step 1: Configure the Stored File Export

e Step 2: Select Data Filters

e Step 3: Specify the Stored Files to Export

e Step 4: Specify the Name of the Extract Export

e Step 5: Specify the Types of Files to Extract

e Step 6: Specify the Options for the Extract Format Directories on page 179

Step 1: Configure the Stored File Export

1 Select the Stored Files command from the Exports menu.
2  Click the Export Stored Files tab in the Export to file dialog box.

This page is used to set up various options for the stored files export.

Step 2: Select Data Filters

Select the data source filters that you want to apply to the data. In the Data Source Filter
group, select one of the following:

e Machines - Applies a Machines filter to the data source.

e Directories - Applies a Directories filter to the data source.
e Local - Applies a Local tag filter to the data source.

e Application - Applies a Application filter to the data source.
e TFiles - Applies a Files filter to the data source.

See Filtering on page 129 for more information about using filters.

Step 3: Specify the Stored Files to Export

Specify whether you want to export all stored files or specific stored files.

1 To export all stored files select the Export All Stored Files check box (located on the left side
of the dialog box above the list box).

When this check box is selected, the Add and Remove buttons are disabled in the Export
Files group.
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6

To specify stored files for export, use the grid in the Export Files group to configure which
files are to be exported. This grid contains two columns: File Name (the name of the file to
be exported) and Found Where (the location of the file).

Click the Add button to add a stored file to the list. The Specify Stored File dialog box is
displayed.

Specify the file name in the File Name box. Select the file name from the drop-down list
(this list maintains a history of previously entered file names) or type the file name
directly in to the box.

Specify where this file can be located. The options are:

¢ In Any Root Dir - The file is located in a root directory, for example in the E:\DOS
directory.

¢ In Root Dir of Boot Drive - The file is located in a root directory on the boot drive, for
example in the C:\Windows directory.

¢ Anywhere - The file can be located anywhere in the directory structure.

e As specified - This option is only enabled if the path to the file is entered in the File
Name field. The path must start with a backslash (\).

Click OK.

Step 4: Specify the Name of the Extract Export

To specify the format the extract export file name, select an option from the Extract drop-down

list:

All files to <AssetNumbers>.txt - The export is made to a text file that has the name of the
AssetNumber. For example, if the AssetNumber is 23567 then the export file will be called
23567.txt. The files are saved to the location specified in the Default Settings tab.

To directory named as file - The export is made to a directory that has the name of the
stored file and has subdirectories for the drive that the file was located in.

For example

A stored file System.ini was extracted from a scan file called XSF014.xsf.
The location of the file was b:\Win95.

The location for the results has been specified in the Default Setting tab as H:\Stored
Files

The export result will therefore be located in the following directory structure.
H:\Stored Files\ Autoexec.bat\b\Win95\XSF014.txt

To directory <AssetNumber> - The export is made to a directory that has the name of the
scan file and has subdirectories for the drive that the file was located in. This location will
contain the stored files.

For example
A stored file Boot.ini was extracted from a scan file called XSF02.xsf.
The location of the file was c:\1386.

The location for the results has been specified in the Default Setting tab as H:\Stored
Files

The export result will be located in the following directory structure.

H:\stored Files\ XSF02\C\1386\Boot.ini

Chapter 2



There is a separate option to create a CSV file of name mapping. This creates a CSV file
(ExportFilenames.csv) with path information for extracted files.

The ExportFilenames.csv file produces a CSV list with the following fields.

Table 36 ExportFilenames.csv Fields

Field Purpose

Exported to File Path of the export file created
Asset number Asset number of the source scan file
Original File Name Name and path of stored file

Step 5: Specify the Types of Files to Extract

To specify the type of files to export, select the following options as required:

Export text files only - This extracts ASCII text files only. This option is available for all
extract formats.

Hex dump binary files - This extracts any binary files in hexadecimal. This option is
available for the To directory named as file or To directory <AssetNumber> extract
formats.

Step 6: Specify the Options for the Extract Format Directories

You can specify the options for the directories that are to be used in the location of the results.

Select the options in the Directories group.

This group is only enabled if the To directory named as file or To directory <AssetNumber>
have been selected as the extract format:

Analysis Workbench

Ignore directory names - The drive letter and subdirectories will not be included. The
following two additional options are made available.

Ignore duplicate files - If duplicate files are encountered, then the latest file will be
extracted.

Add number to filenames - When directories of the asset names are created, multiple
instances of the file are numbered starting at 000. For example:

FP0214.000.txt
FP0214.001.txt
FP0214.002.txt

Use directory names - The directory name will be used in the extract file name. The
following additional option is made available.

Substitute <\’ with ‘.’ The directory path is indicated in the file name by ‘.’ For example,
the result:

H:\stored Files\ XSF02\E\I386\Boot.ini

Will be represented as a file called

E.I386.Boot.ini

Located in the XSF02 directory. That is, the results can be found in:

H:\stored Files\E.I386.Boot.ini
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Loading and Saving Exports

You can save your export layout to a .awrcl file in the Analysis Workbench/Column Layout
directory by clicking the Save button in the export wizard.

You can load a previously saved export configuration by clicking the Load button in the export
wizard and selecting an export file (with an .awrcl extension) from the load dialog box.
Exports are saved to the Analysis Workbench/Column Layout directory.

) Older .rcl files will not work in this version of DDM Inventory.
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Analysis Workbench Scripting

The Analysis Workbench provides command script options that facilitate the automation of
various settings which are manually set within the application (for example, loading,
processing and outputting of information from Analysis Workbench).

The scripts are standard ASCII text files, similar in layout to Windows ini files, except that
they do not use equals ‘=" in the key lines in each section within the script. The scripts make
use of the various configuration lists (load options, stored queries and so on) which can be
stored as part of Analysis Workbench.

By using scripts which can call these stored configuration lists, different options and
sequences can be predefined and run as required for regular exporting activities. Sample files
have been provided with the Analysis Workbench. The scripts have an AWCS extension to the
file name.

There are four script sections (if they exist) and are processed in the following order:
e Startup section

e Variables section

¢ Process section

e End section

Any number of other sections can be added to the script. Other sections are not processed
unless they are called for specifically by the script.

’ These sections do not have to be in this order in the script file and do not have to exist.

Sample Script

A sample script is supplied with DDM Inventory in the following location:

C:\Program Files\Hewlett-Packard\DDMI\7.70\Analysis Workbench\Scripts

Executing the Script

Scripts are executed by one of three methods:

¢ Including the script name on the command line in Analysis Workbench (for example
Analysis Workbench.exe script.awcs.

¢ Opening Analysis Workbench and then dragging the script file name to the Analysis
Workbench workspace.

¢ Using the Run script file... option File menu.
Having these three options allows:

e The script to run on a scheduled basis if using a Windows utility such as AT.

Analysis Workbench 181



182

e Different scripts to be run when the Analysis Workbench is opened under user control.

Do not do the following

Do not use any commands in the [Variables] section. This section is used for declaring
variables only.

Do not call any of the standard sections with the RUN PROCESS command. (Startup,
Variables, Process, End).

Do not name any variables with the same name as a reserved word (either a command name
or a string used internally by the scripting engine).

Do not call a section that is a list of files or directories.

Writing Scripts

e (Create scripts in a text editor or in a Word processor without formatting.
¢ Do not use any equal ‘=" characters in the command line.
e Save the script file with the extension AWCS.

All commands must have spaces between the command and its parameters. If there are
multiple parameters, then these are separated by just a comma (for example, SAVE STATE
filename, description).

Group Commands into Sections

e Sections have a section header written between square brackets, for example,
[sectionname].

e Section names must not begin or end with space characters and must not be preceded by a
space before the name.

e There are four reserved section names, STARTUP, VARIABLES, PROCESS and END.
e Sections can be stored in any order, but the four reserved sections, if they exist, are
processed in the order STARTUP- VARIABLES - PROCESS — END.

Add Comments to Scripts

Comments can be added to the scripts to improve readability, either by using a section headed
[Comments] to describe the overall function of the script or by using a semicolon (‘;’) at the
start of the line to indicate a comment line, to describe specific activity.

The Script Sections

Five script sections if they exist are processed in the order:
e Comments Section

e Startup Section

e Variables Section

e Process Section

e End Section
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They do not have to be in this order in the script file and do not have to exist.

You do not need to call any of these sections. The script engine calls these sections
automatically. The script engine does not call any other section that has been created unless it
has been specified in a RUN_ PROCESS command.

Any other sections in the script can be created and the lines do not have to be commented out
if the section is not called by the script.

Comments Section

This section is usually placed at the beginning of the script file. The comments section does
not have to exist and is normally used for comments such as the author, date written. It is
recommended that a comments section is used. It may be useful to include the name of the
author, the purpose of the script, and the date it was written. A version number should also be
included so that it can be incremented every time changes are made to the script.

Any other comments made in other sections of the script are made using a semicolon (‘;’) at
the start of the line.

The description in the Run script form is taken from the first valid line in the Comments
section.

Startup Section

This section is used to set up initial load conditions for the script. Variables are not available
in this section or any sections called by this section.

Commands that do not require variables can be used in this section. Typically, this section
would be used to make sure that the Analysis Workbench was in the ‘condition’ expected
before the main [Process] section was called by the script engine.

An Example of Typical [Startup] Code

[Startup]
BREAK ON ERROR ON
LOG_CLEAR
LOG_SCRIPT ON
DISPLAY PROGRESS ON
UNLOAD ALL

SET BUSINESS

Variables Section

This section is available to any section of the script apart from the [Startup] section and any
sections called from the [Startup] section.

Variables are also available in a command script if declared in a subscript called by that
script. They are ‘Global’ variables. Do not try to use a variable before it is declared.

This can occur if variables are declared in a sub script but are used in a different script. (It is
recommended that you declare all variables in a main script file).
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An Example of Typical [Variable] Section Code:

[Variables]
TestIntl : integer
GatewayDirectory : string

StateImage : string

No assignments can be made to the variables in this section. This section is only for
instructing the script engine to make these variables available to the script. The restrictions
on variables are as follows:

Strings are limited to 64 characters in length.

Integer variables are valid from zero to over 2,000,000,000.

Process Section

This section is used for the main script loop or program. Any variables declared, are available
in this section or any processes called from this section. All commands are available in this
section.

Any sections created in the script have the same functionality as this section, except that they
must be called in the script.

The different sections of the script should be named logically, so that the script makes sense
when read as a text file.

A typical [Process] section does not have to be very long, because normally other sections

would be called from the script in this section.

An Example of Typical [Process] Section Code:

[Process]

RUN_PROCESS SetupVariables

IF EXIST $StateImage THEN RUN PROCESS LoadState
RUN_PROCESS LoadScanFiles

; load the machine export setup file - this sets up the files
and columns to export

EXPORT LOAD Gateway
; do the export

EXPORT_RUN

End Section

This section is used to tidy up after the script has finished, unload scan files from the
program, save the script log file and so on. Variables are still available in this section.

When the main command script has finished, all variables are wiped from the memory, so if
any results need to be saved, this should be done before the main script finishes.
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Variable Commands

To set the variables use := (colon + equals sign)

Example

TestIntl := 5

GatewayDirectory := c:\gateway\

StateImage := SGatewayDirectory + GatewayState.AWS

) The dollar sign in front of the string variable indicates that one variable can use another
variable. In this case the StateImage variable will have the value
c:\gateway \ GatewayState. AWS

You can space the assignment operator where you want as long as there is at least one space
between each part of the statement.

(VariableName), (at least one space), ( := ), (at least one space), (variable
value)

A variable can be assigned as a mixture of strings and variables. Integer variables can be used

in the assignment statement and these will be translated to strings.

Example

FOR TestIntl := 1000 to 1999 do

LoadFile := S$GatewayDirectory + TEST + $TestIntl + .XSF

GET_INI_VARIABLE $VariableName,INIFileName, SectionName,KeyName, DefaultValue

This command can be used to set a variable that has been declared, to a value retrieved from
an INT file.

The five parameters needed for GET INI VARIABLE are:
e Variable name with or without a '$' in front of it.

e INI file to get variable from.

e Section name to get variable from.

e Key name to get variable from.

e A default value to use if key is not found - defaults to empty string if not specified.

Example

GET INI VARIABLE $GatewayDir, Gateway.INI, AWScript, GatewayDirectory,
c:\Gateway\

GET_ENV_VARIABLE $VariableName,EnvironmentVariable, DefaultValue

This command can be used to set a variable that has been declared, to a value retrieved from
an environment variable.

The three parameters needed for GET ENV_VARIABLE are:
e Variable name with '$' in front of it.

e Environment variable to read from.
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e A default value to use if variable is not found - defaults to empty string if not specified.

Commands for Calling Other Processes

e RUN_PROCESS Section Name
e RUN_SCRIPT ScriptFileName

RUN_PROCESS Section Name

Calls another section of the command script. It takes a section name as a parameter. Do not
call any of the standard sections Startup, Variables, Process and End.

Example

RUN_PROCESS ClearAW

RUN_SCRIPT ScriptFileName
Run another Analysis Workbench command script. It takes a script file name as a parameter.

Example

RUN_SCRIPT TestScript.AWCS

Commands for Loading Data into Analysis Workbench

e LOAD STATE Filename

e LOAD_SCAN SCANName

e LOAD_SCAN_LIST SectionName

e LOAD_DIRECTORY DirectoryName

e LOAD_DIRECTORY_LIST SectionName

LOAD_STATE Filename

Loads an Analysis workbench state image file into Analysis Workbench.

Example

LOAD STATE TestState.AWS

LOAD_SCAN SCANName
Loads one scan file into Analysis Workbench. It has a single scan file name as a parameter.

Example

LOAD SCAN C:\Program Files\Hewlett-Packard\DDMI\7.70\
Common\Samples\aix52.xsf

LOAD SCAN $XSFDirectory + aix52.xsf
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LOAD_SCAN_LIST SectionName

Has a single section name as a parameter to load a list of scan file names from. This procedure
calls the LOAD SCAN procedure for each file in the list.

Example

LOAD SCAN LIST FileList

LOAD_DIRECTORY DirectoryName

Loads a single directory specified, as a parameter to this command. Optionally, specify the /

SUB parameter to load all scan files in the specified directory and all subdirectories of that
directory.

Example

; Load all files from the Samples directory

LOAD DIRECTORY C:\Program Files\Hewlett-Packard\DDMI\7.70\Common\Samples

; Load all files from the Samples directory including subdirectories

LOAD DIRECTORY C:\Program Files\Hewlett-Packard\DDMI\7.70\Common\Samples /SUB
; Load all files from all the sample directories in Analysis Workbench.

LOAD DIRECTORY c:\ /SUB

LOAD_DIRECTORY_LIST SectionName
Loads a list of directories from a section of the script file. This procedure calls the
LOAD DIRECTORY procedure for each directory in the list. (The /SUB parameter can also be

used in the directory list).

Example

LOAD DIRECTORY LIST TestDirList

Commands for Unloading Data from the Analysis Workbench

e UNLOAD

UNLOAD

Unloads scan file data from Analysis Workbench. Uses a parameter ALL, TAGGED, or UNTAGGED.
Assumes ALL if no parameter is specified.

Example
UNLOAD UNTAGGED

; Unloads from Analysis Workbench all scan files that are not tagged.
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Commands for Setting the Load Options

e SET BUSINESS

e SET OPERATIONAL

e LOAD_DUP_OPTION

e LOAD_OLD_OPTION

e LOAD_CONFIG FileName

e LOAD_EXCLUDE_DIR DirList.txt

SET_BUSINESS

Sets business mode if no scan files have been loaded.

SET_OPERATIONAL

Sets operational mode if no scan files have been loaded.

LOAD_DUP_OPTION

Instructs Analysis Workbench how to treat duplicate scan files. This overrides and changes
the current setting of Analysis Workbench. The settings are available in the File Load Options
dialog box called from the scan file load form Options button.

Valid combinations are:

® LOAD DUP OPTION NEWEST (load the newest of the duplicate files)

e TLOAD DUP OPTION ASK (Ask what to do if duplicate files detected)

e TLOAD DUP OPTION LOAD (load the duplicate file, remove the previously loaded one)

® TLOAD DUP OPTION IGNORE (Leave the file already loaded, ignore the attempt to load
another file with the same name)

LOAD_OLD_OPTION

Instructs Analysis Workbench how to treat old scan files. This overrides and changes the
current setting of Analysis Workbench.

Valid combinations are:
® LOAD OLD OPTION LOAD (Load old files even if they are older than the limit).
® LOAD OLD OPTION Ask (Ask what to do if old scan files are detected).

® LOAD OLD OPTION IGNORE (Ignore files older than the limit).

LOAD_CONFIG FileName

Require a load configuration file as a parameter, to load an INI file saved by the Analysis
Workbench Load Configuration dialog box. This sets up recognition, display filter, asset fields,
duplicate and old scan file options and so on.
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Example

LOAD CONFIG ScriptLoadOptions.ini

LOAD_EXCLUDE_DIR DirlList.txt

Allows a list of directories to ignore to be specified, when loading scan files. The list can be set
and saved using the Load Filter tab of the Analysis Workbench Load Configuration dialog box.

Example

LOAD EXCLUDE DIR c:\Program Files\AI\ExcludeDirectories.txt

Commands for Running Tag Queries

¢ QUERY_CLEAR

e QUERY_LOAD Filename

¢ QUERY_RUN

e QUERY_SET OPTION TAG Switch
¢ QUERY_SET OPTION PREQUERY

QUERY_CLEAR

Clear the current Analysis Workbench query from memory, this is not necessary if you are
loading a query from a file.

QUERY_LOAD Filename
Load a tag query into Analysis Workbench. Takes a query file as a parameter.

Example

QUERY LOAD NT4WS

QUERY_RUN

Run the tag query currently loaded into Analysis Workbench. Ensure that you load the correct
query file before running the query. Typically you would call the QUERY RUN procedure
immediately after a QUERY LOAD.

QUERY_SET_OPTION TAG Switch

Overrides the tagging option set by the loaded query in Analysis Workbench.
Uses the parameters SET, CLEAR, TOGGLE.

Valid combinations are:

e QUERY_SET_OPTION TAG SET

e QUERY_SET_OPTION TAG CLEAR

e QUERY_SET_OPTION TAG TOGGLE

Analysis Workbench 189



QUERY_SET_OPTION PREQUERY

Overrides the pre-query option set by the loaded query in Analysis Workbench.
Uses the parameters NONE, CLEARALL, SETALL.

e Valid combinations are:

¢ QUERY_SET OPTION PREQUERY NONE

e QUERY_SET_OPTION PREQUERY CLEARALL

¢ QUERY_SET_OPTION PREQUERY SETALL

Commands for Tagging

e LOAD_TAGS

e SAVE _TAGS

e TAG_ALL

e TAG_CONTAINS

LOAD_TAGS

Loads a list of tagged machines from a .tag text file. This file contains the asset numbers of
the tagged machines. It takes one argument, the fully qualified name of the tags file to load.

Example

LOAD_TAGS C:\Documents and Settings\All Users\Application Data\
Hewlett-Packard\DDMI\Conf\Machines18Sep2007.tag

SAVE_TAGS

Saves the asset numbers of the machines tagged in a Machines window to a .tag text file. It
takes one argument, the fully qualified name of the tags file to save.

Example

SAVE TAGS C:\Documents and Settings\All Users\Application Data\
Hewlett-Packard\DDMI\Conf\Machines18Sep2007.tag

TAG_ALL

Used to tag or untag all items of a particular type.
The syntax of the command is

TAG ALL (Tag|Untag) (Locall|Global) (File|Dir|App|Mach)

TAG_CONTAINS

Tags files, directories and applications from a script. The syntax is:
TAG _CONTAINS (Tag|Untag) (File|Dir|App) ColumnName Value

Where (x|y) means x or y.
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Example

This will tag all of the unrecognized (Checkver and Unknown) files:

TAG CONTAINS Tag File Status Check TAG CONTAINS Tag File Status Unknown

Example

This will tag all MS apps except Outlook
TAG _CONTAINS Tag App Publisher Microsoft

TAG_CONTAINS Untag App Application Outlook

Commands for Exporting Data from Analysis Workbench

e EXPORT_LOAD ExportLayoutFileName
e EXPORT _RUN
e EXPORT_SETDIR

EXPORT_LOAD ExportLayoutFileName

Loads a saved export layout file. This can be configured using any of the exports available
from the main Analysis Workbench menu. Simply set up the export as required for exporting
the data and save it to the file name used in your script.

Example

EXPORT LOAD TestScript.awrcl

EXPORT_RUN

Runs the currently loaded export layout file. This will export the data to the files specified in
the AWRCL file.

EXPORT_SETDIR
Allows you to change the directory that the files are exported.

Example

EXPORT SETDIR C: \Gateway
) Older .rcl files will not work in this version of DDM Inventory.

Commands for Script Debugging

¢ BREAK_ON_ERROR ON | OFF | TOGGLE
o SINGLE_STEP ON | OFF | TOGGLE
o DISPLAY PROGRESS ON | OFF | TOGGLE

Pressing the Pause | Break key will stop the script at the next command and display a dialog
box — it will not interrupt a running command apart from the WAIT command.
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It only needs to be pressed once, however, it may appear that nothing is happening if a whole
directory of scan files is being loaded.

BREAK_ON_ERRORON | OFF | TOGGLE

Setting BREAK ON ERROR ON will stop the script if any errors occur.

SINGLE_STEP ON | OFF | TOGGLE

Puts up a dialog box for every command when switched on, allowing the script to quit, skip
the current command or turn off the single stepping.

DISPLAY_PROGRESS ON | OFF | TOGGLE

Shows a window with currently processing script line added to a list

Commands for Script Logging

e LOG_CLEAR

e LOG_SCRIPT ON | OFF | TOGGLE
e LOG_WRITE StringToWrite

e LOG_DISPLAY

e LOG_SAVE SaveToFile

LOG_CLEAR

Clears the Analysis Workbench error log. (this is not recommended unless you are saving the
error log to a file each time a script is run).

LOG_SCRIPT ON | OFF | TOGGLE

Writes command lines to the log as they are processed

LOG_WRITE StringToWrite

Writes the specified string to the log file and log window if turned on.

LOG_DISPLAY

Displays the Analysis Workbench main log window to show errors and messages as the
commands in the script are processed.

LOG_SAVE SaveloFile

Saves the log to a file specified as a parameter.

Example

LOG_SAVE $ScriptFile
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LOG_SAVE c:\ScriptFile.txt

Miscellaneous Commands

e [F Expression THEN Command

e EXIST Filename

e [F EXIST FileName THEN Command
e SAVE_STATE FileName, Description
e TERMINATE_PROGRAM

e PAUSE Message

e STD_DATES ON | OFF | TOGGLE

IF Expression THEN Command
This statement performs the command only if the preceding expression is true.

Example

IF $LOOP = 10 THEN TERMINATE PROGRAM

EXIST Filename

Used in conjunction with the IF...THEN command.

IF EXIST FileName THEN Command

Allows a command to be repeated a number of times. The command can be a normal one line
command or a whole process section.

The syntax is FOR (variable) := Start TO end DO (command)
Start and end can be numbers or variables, end must be greater than start.
FOR TestIntl := 1 to 10 DO LOG WRITE HELLO WORLD

FOR $loop := $start TO Send DO RUN PROCESS HelloWorld

SAVE_STATE FileName, Description

Saves the current Analysis Workbench data to a state image file. Takes two parameters —
Filename and Description. The state image description is optional and a default description
will be used if one is not specified.

) The state image files are compressed and decompressed on the fly.

Example

SAVE STATE TestState.AWS, Test state image saved by command script
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TERMINATE_PROGRAM

Shuts down the Analysis Workbench program.

) Will not prompt for shutdown

PAUSE Message

Will display a dialog box prompting for action - optionally you can include a message that will
be displayed in the dialog box.

Example

PAUSE load has finished

WAIT n

Wait n seconds

Example
WAIT 100

Will wait 100 seconds - only checks for times greater than 1 hour — Do not use large numbers
for the wait time. This will lock the program until the time limit is reached or the
Pause | Break key is pressed.

STD_DATES ON | OFF | TOGGLE

Displays and outputs all date fields in a standard format to aid in exporting data to other
applications.

Example

STD DATES ON

Sample Command Script

>»

A sample script is supplied with DDM Inventory in the following location:
C:\Program Files\Hewlett-Packard\DDMI\7.70\Analysis Workbench\Scripts

Section names must not begin or end with space characters. Sections can be in any order.

[Comments]
***% SAMPLE SCRIPT ***

This section is ignored — There is no need to comment out lines.

[Startup]
; This section contains information which will be used to configure
; Analysis Workbench on starting the script and does not have to exist

LOG_CLEAR
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DISPLAY PROGRESS ON

RUN_PROCESS ClearAW

[Process]

LOAD DIRECTORY LIST TestDirList
RUN_PROCESS Businessb5
RUN_PROCESS BusinessAll
RUN_PROCESS Operationalb
RUN_PROCESS OperationalAll

QUERY LOAD C:\Program Files\Hewlett-Packard\DDMI\7.70\Analysis
Workbench\queries\ntdws

QUERY RUN

[ClearAW]

UNLOAD ALL

[Business5]

RUN_PROCESS ClearAW

SET BUSINESS

LOAD SCAN LIST 5XSFListLondon

SAVE STATE C:\Program Files\Hewlett-Packard\DDMI\7.70\Analysis
Workbench\State Images\Business5.AWS,Demo state containing 5 scans from the
London office in Business mode

[BusinessAll]
RUN_PROCESS ClearAW
SET_BUSINESS

LOAD DIRECTORY C:\Program Files\Hewlett-Packard\DDMI\7.70\Analysis
Workbench\Samples/s

SAVE STATE C:\Program Files\Hewlett-Packard\DDMI\7.70\Analysis
Workbench\State Images\BusinessAll.AWS,Demo state containing all scans from
the London and Frankfurt offices in Business mode

[Operational5]

RUN_PROCESS ClearAW

SET OPERATIONAL

LOAD SCAN LIST 5XSFListLondon

SAVE STATE C:\Program Files\Hewlett-Packard\DDMI\7.70\Analysis
Workbench\State Images\Operational5.AWS,Demo state containing 5 scans from
the London office in Operational mode
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[OperationalAll]
RUN_PROCESS ClearAW

SET OPERATIONAL

LOAD DIRECTORY C:\Program Files\Hewlett-Packard\DDMI\7.70\Analysis

Workbench\Samples/s

SAVE STATE C:\Program Files\Hewlett-Packard\DDMI\7.70\Analysis

Workbench\State Images\OperationalAll.AWS,Demo state containing all scans

from the London and Frankfurt offices in Operational mode

[5XSFListLondon]

C:\Program Files\Hewlett-Packard\DDMI\7.
Workbench\samples\London\LND1000.xsf

C:\Program Files\Hewlett-Packard\DDMI\7.
Workbench\samples\London\LND1002.xsf

C:\Program Files\Hewlett-Packard\DDMI\7.
Workbench\samples\London\LND1006.xsf

C:\Program Files\Hewlett-Packard\DDMI\7.
Workbench\samples\London\LND1028.xsf

C:\Program Files\Hewlett-Packard\DDMI\7.
Workbench\samples\London\LND1038.xsf

[TestDirList]

; This section contains a test list of directories to load

; note c:\ /sub will attempt to load ALL Scan Files on drive C

70\Analysis

70\Analysis

70\Analysis

70\Analysis

70\Analysis

; d:\scan files will load only scan files in that directory - subdirectories

would be ignored

c:\/sub
d:\scan files
e:\/sub
f:/sub

[End]

; This section contains commands to be run before script finishes and does not

have to exist
;LOG_SAVE c:\AWScriptLogFile.txt

; TERMINATE PROGRAM
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3 Viewer

Viewer allows you to view the detailed information contained within a scan file (.xsf). This
provides a convenient way of displaying software, hardware and asset information collected
for an individual computer. The Viewer is aimed at technical support and help desk staff who
need detailed configuration analysis and diagnostics.

) The Viewer (part of the DDM Inventory client installation) is similar to the Scan Data
Viewer. They both show similar information, but the Scan Data Viewer is accessible through
the web user interface.

You can also view other information, such as the characteristics of software files stored during
the inventory, applications and the environment variables.

Scan Files - XSF JJ

v

Viewer

View Data

Compare Scans

In summary, the Viewer displays:

e Detailed and summarized hardware configuration information.
e Asset information.

e Details of all software scanned.

e Contents of key files collected during the inventory, such as system configuration files
(Config.sys and Autoexec.bat etc.).

¢ Environment variables.
e Details of all logical drives scanned.
e Details of any applications recognized.

e Alist of installed applications as reported by the operating system.
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Starting Viewer

To start Viewer on your Windows workstation:

1

From the Windows Start menu select Programs > Hewlett-Packard > DDM Inventory 7.70 >

Viewer.

Exiting Viewer

To exit Viewer on your Windows workstation use one of the following methods:

e Use the close icon in the top right of the workspace.

Select the Exit command from the File menu.

Viewer User Interface

In This Section

The Viewer Workspace on page 199

The Menu Bar on page 199

Shortcut Menus on page 200

Toolbars on page 200

Tab Pages on page 201

Status Bar on page 201

Shortcut Keys on page 202

Sorting Lists on page 202

Copying the Contents of a Tab Page on page 202
Searching for Files on page 202
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Viewer

The Viewer Workspace

The following figure shows how the Viewer workspace looks when a scan file is loaded and the
Summary tab page is visible.

% Viewer - [USV3510BQ7__.xsf - C:\DOCUMENTS AND SETTINGS\ALL U.... [= |[B][X]

File Edit View Window Help Menu bar - 0 X
E b BBy M EOR % 2 Tool bar
Sumnmary | Hardware and Configuration | Directones and Files | Stored Files | Software Applications | —
[tem Lsbs List Header
M achine Adrminigtrator - ¥eon, 2800MHz, 1024Mb
Scan date 2003-05-05 075455 Tab
Scanner version 7.60.000 build 3231 ab pages
CPU Heon 2800 MHz [Genuinelntel]
bl oy 1024 MB
HO Capacity 67.8 GB
s Windows 2003 Server Standard Edition
Machine 1D WTEST4R
Scanned volumes oA
Scanned files AR3E
Stored files 4 files
Parially Becognized Applications 23
ITuesl:Iay, May 12, 2009 9:36:03 AM j | 15can(s) 1Sy35108Q7__ . xsf - Administrator - Xeon, 280
Status bar

The Menu Bar

Viewer commands are accessible from the menu bar. Commands are grouped by function
(‘File’, ‘Edit’, ‘View’, ‘Window’, ‘Help’). Each function has its own entry (command) in the
menus. Menu commands may be activated with the mouse or the keyboard.

) File Edit View ‘Window Help - g x

To open a menu:

e Use the mouse. Click the menu name (for example, File) and then click the command you
want (for example, Open Scan File).

e Use the shortcut keys. Shortcut keys are shown to the right of the command in the menus.
For example, Ctrl+0 is a shortcut used to open a scan file.

e Use the access key. Access keys are indicated by an underscore on the active letter. For
example, the Open Scan File command in the File menu is accessed by pressing Alt-F and
then O.

Most menus invoke commands, however, some menu commands display a dialog box. This is
indicated by an ellipses (...) after the menu command.
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Shortcut Menus

You can access a shortcut menu related to your current activity by positioning the mouse
cursor on the appropriate area of the workspace and clicking on the right mouse button.

Toolbars

Toolbars allow you to access various commands without using the menu.

Click the toolbar icon to activate the function associated with it.

Buttons in the toolbar offer the following functionality:

Table 37 Buttons on the Viewer Toolbar

Icon |Name Function

= Open Scan File Loads inventory data from an XSF file.

e Options Displays the Viewer Options dialog box.

Copy Copies the information in the currently selected tab to the
clipboard.

Bg Copy to File Copies the information in the currently selected tab to a file.

Compare Compares two scans.

&% Find File Finds a file within a scan.

= Tile Horizontally Tiles windows horizontally.

| Tile Vertically Tiles windows vertically.

= Cascade Cascades windows.

=n Arrange Icons Aligns all icons of minimized windows.

] Help Displays the help text for Viewer.

When the mouse pointer passes over an icon, a tooltip appears indicating the command
corresponding to the icon.

Moving a Toolbar

The toolbar can be dragged and positioned to be aligned to the top of the window, the left of
the window or into a floating state.

To move a toolbar:

1 Click the “move” handle || on a docked toolbar (one that is attached to one edge of the
program window), and drag it to a new location.
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When you drag a toolbar to the edge of a window, the toolbar outline snaps into place
along the length of the window edge.

2 You can dock a floating toolbar by double-clicking on the title bar.

Resizing a Toolbar

To resize a floating toolbar:

e Move the pointer over any edge until it changes to a double-headed arrow, and then drag
the edge of the toolbar.

You cannot resize a docked toolbar.

Tab Pages

Tab pages in Viewer allow you to examine the data from a loaded scan file. You can select the
following tab pages:

e  Summary

e Hardware and Configuration
¢ Directories and Files

e Stored Files

e Software Applications (only displayed if Application Recognition was set as an option).
See Configuring Recognition Settings on page 203 for further information.

Status Bar

A status bar at the bottom of the Viewer workspace displays information about the current
loaded scan file.

Tuesday, May 12, 2009 10;06:22 AM 1 Scan(s) USY3510BQ7 . xsf - Administrator - ¥eon, 230

The status bar has three panels:

e The first panel displays the current system date and time.

¢ The second panel displays the number of scans currently loaded.

¢ The third panel displays the name of the scan file currently displayed along with a brief
description.
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Shortcut Keys

You can quickly accomplish tasks you perform frequently by using shortcut keys.

Table 38 Viewer Shortcut Keys

Task Keyboard Shortcut
Open Scan File Ctrl-O

Close Ctrl-F4

Options Ctrl-T

Exit Viewer Alt-X

Copy Ctrl+C

Compare Ctrl+M

Find File Ctrl+F

Show Advanced Hardware View Ctrl+V

Sorting Lists

Click on a column list header to sort and reverse sort the order of the information,

alphabetically or numerically in ascending order (A to Z, a to z or zero to 9) or descending

order (Z to A, z to a or 9 to zero).

Double-clicking on the splitter icon between columns will expand the column width to the

maximum cell width.

Copying the Contents of a Tab Page

You can save or copy the contents of all tab pages.

To copy the contents of a tab page to the clipboard:

1 Select the Copy command from the Edit menu, or click the icon in the Viewer.

2 Paste the contents to an editor of your choice.

To save the contents of a tab page to a file:

1 Select the Copy to file... command from the Edit menu (text files only), or click the B icon

in the Viewer.

2 Use standard Windows navigation methods to select or enter a file and the location where

the file is to be saved.

Searching for Files

You can locate a file from any point within Viewer. This can facilitate the location of files for a

machine across multiple drives.
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To locate a file from any point:

1 Select the Find File command in the Edit menu, or click the @ icon. The Find File dialog box
appears.

2 In the Name box, type the name of the file you want to find. You can use DOS wildcard
characters, (using * and ?) as well as normal alphanumeric characters.

3  Click the Find Now button.

If files matching the file name or mask are located, they are displayed in the Search
Results list box.

If the search is lengthy, you can abort the search (with partial results being displayed) by
clicking the Stop button.

4  Highlight a file entry in the Search Results list.
5 Click the Goto button or double-click on a file entry.

The Directories and Files tab of Viewer is displayed in the background showing the located
file.

6 To clear the entries and carry out a new search, click the New Search button.

Configuring Recognition Settings

Viewer

In This Section

¢ Recognition Overview on page 203

e Disabling Application Recognition on page 204

e Selecting the Installed Applications List as the Recognition Method on page 205
e Selecting the SAI as the Recognition Method on page 205

Recognition Overview

The Viewer is able to perform application recognition on the software scanned, while the data
is being loaded from a scan file.

When the application recognition is enabled, a Software Applications tab is available in the
Viewer workspace. This tab shows a summary of identified applications on the selected
machine. When recognition is disabled, loading is slightly faster but no application
information is available.

There are three recognition methods: No recognition, Installed applications, and Software
application index (SAI). By default, the Viewer uses the SAI recognition configured with the
Master SAI files (Master.zsai) to perform application recognition. The Master SAI files are
read-only files that contain a library of software applications.

There are multiple Master SAI files that can be used at the same time for recognition
purposes:

® Master.zsai
® French.zsai

® German.zsai
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® Unix.zsail

® BaseUnixOS.zsai

All of these files can be found by default in the following location:

C:\Documents and Settings\All Users\Application Data\Hewlett-Packard\DDMI\SAT

By default, the Viewer is also configured to use the User.zsai file. A User.zsai file is one that
you, the customer, have customized with applications you have taught using Analysis
Workbench or SAI Editor.

You can use multiple User SAI files for recognition purposes. Each User SAI created has a
unique identifier assigned to it.

Backward compatibility has been maintained in this version of DDM Inventory.
To display the Viewer recognition options tab:

1 Select the Options command from the Files menu, or click the &3 icon. The Viewer Options
dialog box appears.

2 Click the Recognition tab.

Viewer Options fgl
Fecognition | Aszet Fields

YWwhen loading data, application recognition can be performed. Pleaze select the prefered
recognition method from the options below.

Recognition Method

) Mo recognition
i) Inztalled Applications

(%) Software Application Index (540

(] ] ’ Cancel

) Utilization data shows you how much a particular software application is being used. Of the
three available options, only the SAI option will produce utilization data. For more
information on Utilization, see Software Utilization Data on page 241.

Disabling Application Recognition

This option is used to disable any application recognition. When recognition is disabled,
loading is slightly faster but no application information is available.

To disable application recognition:

In the Recognition Method group box, select the No recognition option.
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Selecting the Installed Applications List as the Recognition Method

This method of recognition is based on the operating system’s internal list of applications. As
such, it is not recommended as the preferred recognition method, except for data from UNIX
Scanners.

To select installed applications for the recognition method:

In the Recognition Method group box, select the Installed Applications option.

The Use Enriched application data if available option is then activated. If you select this option,
Viewer uses the application data from the enriched scan file instead of running “real”
recognition.

Selecting the SAIl as the Recognition Method

1 In the Recognition Method group box, select the Software Application Index (SAl) option.

2  Click the Advanced button to set further options if required. The Advanced Configuration -
Software Application Index dialog box is displayed.

Setting General Options for the SAI

B Advanced configuration - Software Application Index |Z||E|rz|

General | Sals | Filering

Miscelaneous
Level 3 recognition heunstics
Auto-identify unrecognized device driver files

Languages

Preferred Lahguage zelect lahguage ﬂ

[ ] Overide 05 Language
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Setting Level of Recognition Used

To set the level of recognition used:

1

Select the General tab in the Advanced Configuration - Software Application Index dialog
box.

In the Miscellaneous group, select options for the level of recognition used.
® Level 3 recognition heuristics

If this option is enabled, the recognition engine defers its final recognition decision
until all the files in all the directories on the machine have been read. If disabled,
machine-based recognition does not take place and recognition data is returned after
each directory is loaded. A time overhead of about 10% is normal when Level 3
Recognition is enabled.

° Auto-identify unrecognized device driver files

When enabled (by default), files that cannot be identified by standard SAI recognition
and have the Device Driver attribute will be marked as recognized. Files used as
Device Drivers represent a large portion of the files that are not identified by the
Application Library. Being able to identify these automatically can significantly
reduce the effort required to achieve good recognition rates.

Setting the Preferred Language

If you are using a national SAI file, for example, German.zsai or French.zsai together
with the Master.zsai, you will want to set this option.

Preferred language is used for cases when the recognition engine encounters two or more
versions within a directory that are identically matched. It will give preference to the one in
the selected language.

This will only work if exactly one of the versions matches the language.

To set the language options:

1
2

Select a language from the drop-down list.

Check the Override OS Language box if you want the recognition engine to overlook the
operating system locale setting and take the setting you specified in the Preferred
Language box.

Summary of the Recognition Process

The process can be summarized as follows:

A rating is obtained for all versions that are possible matches.
The version(s) with the best rating are found.

If there is only one version, then the process goes no further. Otherwise, the version whose
language matches the OS locale is selected. If no version matches this language, then the
version matching the setting in the Preferred Language box is selected.

If the operating system locale setting is not available, it takes the setting you specified
here in the Preferred Language box.
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Adding, Creating or Removing SAls

The options on the SAIs tab page allow you to:
e Add a new SAI file to be used for application recognition.
¢ Remove an existing SAI file.

¢ C(Create a new empty User.zsai file.

%' Advanced configuration - Software Application Index

General | S&ls |Filtering

Sa) file SallD Description Size/kE Werzions  Type Date
chdocuments .. 0 User 5S4l File 7 T User BA242009
o hdocuments nda  Apl Master 541 - 08/04/03 27176 23268 Master 44842003
3 | =

’ Add... l ’ Remove ] ’ Create. ..

SAl uzed ta stare rule-created items:

| 9

Ok l ’ Cancel ]

The list box on this tab page displays the following information:
e The path to source files for the SAI — both read-only Master SAls and editable User SAls.
¢ The SAI ID number for User SAI files. Master SAI files do not have an ID.
e A description of the SAI files.
e The size of each SAI file (in kilobytes).
e The number of application versions in each SAI.
e The type of SAI file:
— Master SAI — Read-only SAI
— User SAI - Editable
e The creation date for a Master SAI file or for a User SAI, the date the file was last saved.

SAls Used to Store Rule-Created ltems

Any items encountered by Viewer that were created by rules will be added to the SAI file
specified here. These rules are present within the SAI files themselves and additional rules
can be added using SAI Editor.

Select the SAI file from the drop down list. The drop down list contains a list of the SAIs
currently loaded.

If this field is left blank, Viewer will create a file called Auto.zsai and put this in the same
location as the first SAI in the list.

Viewer 207



Adding a New SAI File for Application Recognition

To add a new SAl file for application recognition:

1

Select the SAls tab in the Advanced Configuration - Software Application Index dialog
box.

Click the Add button on this tab page.
Navigate to and select the SAI file (Master or User) you want to use for recognition.

The SAI file is added to the list box which means the file will be included in for application
recognition.

Removing an Existing SAI File

To remove an existing SA| file:

Select the file in the list box and click the Remove button.

Creating a New Empty User SAl

To create a new empty User SAl:

1

2
3
4

208

Click the Create... button. The Create a User SAI dialog box is displayed.
Enter or navigate to the directory where the SAI file is to be created.
Enter a description for the file.

Click the OK button.

The file is automatically assigned a unique ID. However, you may already have an SAI
with the same filename. If so, a confirmation message will be displayed.

Click Yes if you want to overwrite the existing SAI file or click No to return to the dialog
box and assign a new ID to the SAI file.

If you have made modifications to the cfgNextSAIID setting in the SAT. ini file, you may
see the following message. This happens when the value for the ID in the ini file is
missing or lower than the highest ID in the user SAIs currently loaded. This message is
for information only — the DDM Inventory components will correct this situation
automatically by inserting the correct ID value into the ini file.

The next User SAI ID cannot be found in the settings file.

This probably means that you are using User SAIs created with a different
version of the software, or created on a different machine.

Please take care to set the new ID to a value that is unique across your
organization.
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Setting Filtering Options for the SAI

1 Select the Filtering tab in the Advanced Configuration - Software Application Index
dialog box.

B Advanced configuration - Software Application Index

General | Sals Fi|tEfif'IEI|

Apply recognition to zelected files anly
[ ] By extension
Executable files
Files within Archives

[ ] Treat filez matching the following regular expressions as junk.

(] l ’ Cancel

2  Select the options as required:

Apply recognition to selected files only

This is a recognition filter that determines which of the files are sent to the recognition
engine for processing. Sending too many files can make it slightly slower.

By extensions

Allows you to type in the extensions of any files that you want processed against the
recognition engine. Select the extension from the drop-down list (this list maintains a
history of previously entered extensions) or type the extension directly in to the box.
Multiple file extensions must be separated by a semicolon.

Executable files

All executable files will be processed against the recognition engine. Executable files
include *.exe, *.com, *.d11 and other files containing executable code.

Files within Archives
Processes any files in archive files. The following archive file types are supported:

ARJ, ZIP v1, ZIP v2, LHA, LZH, ARC, CAB, TAR, GZIP, TAR/GZIP and PAK

For the best application recognition, select the Executable Files option.

Junk Files

Some files may be executable but are of no interest for licensing or other purposes. These files
are often identifiable via the file name for example, TMP[0-9]*\ . \$\$\$.

The Treat Files matching the following regular expressions as junk option is a way for the
recognition engine to ignore such files, by allowing one or more file name masks to be specified
as junk.

209



210

These files are not passed to the recognition engine and will be marked as junk. This is
available in the Display Filters tab page so junk files can be discarded and not shown.

When matching the junk file name against the junk filter regular expression, the file name is
first converted to lower-case. For this reason, all letters entered as part of the regular
expression must be in lower-case for a match to successfully occur. To enter multiple regular
expressions, enter each regular express on its own line.

To set junk filters:
1 Select the Treat Files matching the following regular expressions as junk option.

2 Type the file name masks you want to treat as junk.

For more information about regular expressions refer to the Analysis Workbench chapter in
this guide.

Configuring Asset Field Settings

In This Section

e Asset Field Settings Overview on page 211

¢ Adding an Asset Extract Field on page 212

e Text File Extract Asset Field on page 213

e Ini File Extract Asset Field on page 214

e (CSV File Asset Field on page 216

e Environment Variable Asset Field on page 217
e Sequence Asset Field on page 217

e Specifying Extract Options for Text Files, INI Files, CSV Files and Environment Variables
on page 219
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Asset Field Settings Overview

The Viewer can be configured to construct any number of additional read-only named asset
fields. These asset fields are constructed based on data collected at scan time. The analysis
asset fields defined here are automatically displayed as entries in the Asset Data folder in the
Hardware and Configuration tab page.

Viewer Options ['5_<|

Fecognition | &sset Fields |

MHew read-only Azzet Field can be constructed while loading scan data. Pleaze uze the
controlz an this page to configure the desired fields.

Caption Field Field Type Field Data Drefault

tdd. || Edi. || Remove

k. l ’ Cancel

To configure the asset field extract seftings:

1 From the File menu, select Options, or click the &3 icon. The Viewer Options dialog box is
displayed.

2 Click the Asset Fields tab. This tab contains a pane with five columns:
e Caption - The caption as specified in the Asset Data page of the Scanner Generator.
¢ TField - The number of the Analysis field (1 to 28).
¢ Field Type - The type of field to extract the information.
¢ Field Data - The source of the field information.
e Default - Any default value that has been set.
3 Right-click anywhere in the pane to display a menu with the following options:
e Add - Adds a new analysis asset field.
e Kdit - Enables you to modify an existing asset field.

e Remove - Removes an existing asset field from the list.
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Adding an Asset Extract Field

The fields are set up in a manner similar to that found in the Scanner Generator. Five
different types of fields can be constructed:

Text file Extract

Takes data from a plain text file (similar to File Extract Field of Scanner).
Ini Field Extract

Takes data from an ini file (no equivalent in Scanner).

CSV File

Takes data from CSV files such as peripheral sheets (allows an external CSV file,
containing a list of data associated with asset numbers to be parsed and loaded along side
the other data).

Environment Field
Takes data from environment strings (equivalent to same field in Scanner).
Sequence Field

Takes data from a sequence of asset fields (equivalent to same field in Scanner).

To add a new asset field extract:

1

2
3

Click the Add button. A New Analysis Asset Field dialog box appears.

Mew analysis Asset Field PZ|
Field Tupe File Selection Eutract Ophions
(%) Tewt File Extract File Mame Search String
) Inii File Extract | | |
() C5Y File File Drirectory Remaove leading blanks

_ (%) Use first occunence Remaove trailing blarks
O Environment ) Usze prioritized directary list;
() Sequence
Field
|.-“-‘-.na|ysis 1 W |

Caption :
|.-’-‘-.r'|al_l,lsis 1 | Options...

I OF. ] ’ Cancel

In the Field Type group, select the type of field to be extracted.

Use the controls on this page to configure the desired fields.

Each of the types of extract fields are now discussed individually.
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Text File Extract Asset Field

This field type extracts information from a single line in a named text file.

A useful file extracts include the predefined SMS file which extracts the SMS Unique
Machine ID.

"- The file you wish to extract from must be a file that is included in the Stored Files section. If
the file is not there it will not work. In other words, the Scanner has to be set up to store the
file before you can extract from it in Viewer.

To set up a new text file extract asset field:

1

o 0 A W

Select Text File Extract as the field type.

x]

New analysis Asset Field

Figld Type File Selection Extract Options
() Text File Extract File Name Search String
) Ini File Extract
() T3V File File: Directory Remave leading blanks
. (%) Use first occurence Remave trailing blanks
O Environment (3 Uze pricritized directany list;
() Sequence
Field
Analyzis 1 "

Caption :
Analysis 1

[ Ok l ’ Cancel

In the File Name box, specify the name of the text file that the information is to be
extracted from.

In the Search String box, specify the text string that is going to be located.
Assign the number for the analysis field by selecting it from the Field drop-down list.
Assign a caption for the field if required, by typing it in the Caption field.

Check the Remove leading blanks box, to remove blank spaces (if there are any) before the
search string located in the text file.

Check the Remove trailing blanks box, to remove blank spaces (if there are any) after the
search string located in the text file.

In the File Directory group box specify where to look for the file. This is a prioritized
search sequence list. Select one of the following options:

e Use first occurrence — Viewer uses the first match of the file that it encounters.

e Use prioritized directory list — A list box is enabled, which allows you to specify the
priority of directories where the file might be located.

$BASEOS% (the base operating system directory). For example:
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C:\Winnt

This location will have the highest priority, that is, if the file is located in this
directory, then this file will be used.

$BASEOS%\System (the System directory in the base operating system directory). For

example:

C:\Winnt\System

If the file is not located in the $BASE0S% directory and is encountered in the
$BASEOS%\System location, then this location will have priority as the source for the
text file, and so on.

9 Specify any extract options as required by clicking the Options... button. See Specifying
Extract Options for Text Files, INI Files, CSV Files and Environment Variables on
page 219 for information about how to do this.

Ini File Extract Asset Field

Initialization files (.ini files) contain a number of different sections. Each section contains
lines of settings (Key Names) applicable to that section. The format of the ini file is as follows:

[Section Namel] -

Key Namel = Value
Key Namez = Value

[Section Name2] -

Key Namel = Value

Key Namez = Value

(The

(The
(The

(The
(The

(The

name of the first section)

first setting)
second setting)

name of the next section)
first setting)

second setting)

The advantage of using this type of asset field instead of using a text file extract asset field, is
that it is possible to pinpoint precisely the Key Name you require and in the section in which

it resides.

‘n- The ini file you wish to extract from must be a file that is included in the Stored Files
section. If the file is not there it will not work. In other words, the Scanner has to be set up to
store the file before you can extract from it in Viewer.
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To set up an ini file extract asset field:

1

Select Ini File Extract as the field type.

x]

Mew analysis Asset Field

Figld Type File Selection E stract Options
) Text File Extract File Harne Ini file section
) Ini File Estract
) CSV File File Diirectary Ky Name

) (®) Use first ozcumence
© Environment () Use pricritized directary list

) Sequence Remove leading blanks
Fiemaove traiing blanks

Field

Analyziz 1 w

Caption :
Analysis 1

[ ]9 l ’ Cancel

In the File Name box, specify the name of the ini file that the information is to be extracted
from.

Assign the number for the analysis field by selecting it from the Field drop-down list.
Assign a caption for the field if required, by typing it in the Caption field.

In the File Directory group box, specify where to look for the file. This is a prioritized
search sequence list. Select one of the following options:

e Use first occurrence — Viewer will use the first match of the file that is encountered.

e Use prioritized directory list — Selecting this option enables a list box, which is used to
specify the priority of directories where the file might be located. For example:

$BASEOS% (the base operating system directory). For example:
C:\Winnt

This location will have the highest priority, that is, if the file is located in this
directory, then this file will be used.

$BASEOS%\System (the System directory in the base operating system directory) for
example, C: \Winnt\System

If the file is not located in the $BASE0S% directory and is encountered in the
$BASEOS%\System location, then this location will have priority as the source for the
text file, and so on.

In the Ini file section box, specify the section of the ini file that the asset field extract is
located in. This is the section identifier in the ini file (surrounded by square brackets []).
Do not include the brackets [].

In the Key Name box, specify the Key Name contained in the specified section of the ini file.
This is the start of the string before the equals (=) sign. Do not include the = sign.
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10

Check the Remove leading blanks box to remove blank spaces (if there are any) before the
Key Name located in the ini file.

Check the Remove trailing blanks box to remove blank spaces (if there are any) after the
Key Name located in the ini file.

Specify any extract options as required by clicking the Options... button. See Specifying
Extract Options for Text Files, INI Files, CSV Files and Environment Variables on
page 219 for information about how to do this.

CSV File Asset Field

This type of field allows an external Comma Separated Variable (CSV) file, containing a list of
data associated with asset numbers to be parsed and loaded along side the other data.

To set up a CSV file extract asset field:

1

2

Select CSV File as the field type.

Mew analysis Asset Field rzl
Field Type 5% File
() Text File Extract | @|
) Ii File Estract Columt containing machine Aszet Wumber ; 1 %

i Mate: The first row must contain column headers

) Ervironment
Fields ta include;

) Sequence

Field

|.-‘-‘-.na|_l,lsis 1 w

(] 4 l ’ Cancel

In the CSV File box, navigate to the CSV file.
The first row of this file must contain column headers.

Enter the number of the column that contains the machine asset number (that is, the
primary identifier field). As the number changes so does the fields selection. For example,
if the primary identifier is column 2 in the CSV file, then specify this as the number 2’ by
either typing it directly into the field or by using the arrows.

The fields contained in the CSV file are displayed in the Fields list box. Select the fields to
be included by selecting the check boxes next to the field names.

The primary identifier column (asset number field) check box is disabled and cannot be
selected. This is because it is necessary to load this field.

Specify any extract options as required by clicking the Options... button. See Specifying
Extract Options for Text Files, INI Files, CSV Files and Environment Variables on
page 219 for information about how to do this.
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Environment Variable Asset Field

This type of field accepts data from a specified environment variable. This can be checked by
looking in the Operating System data > Environment folder in the Hardware and Configuration tab

page.
To set up an environment variable extract asset field:

1 Select Environment as the field type.

X

New analysis Asset Field

Field Type Ervvironment wariable extract
() Teut File Extract

O Iri File Extract Erviranmment wariable name

() CSV File

(%) Enwironment

() Sequence

Field

|.-'-‘-.na|_l,lsis 1 W |

Caption .
|.-'1‘-.na|_l,lsis 1 |

] l ’ Cancel

2 Enter the variable name in the Environment variable name field. An example of an
environment variable is:

ComSpec

Where ComSpec could be C: \WinNT\System32\cmd.exe
3 Assign the number for the analysis field by selecting it from the Field drop-down list.
4 Assign a caption for the field if required, by typing it in the Caption field.

5 Specify any extract options as required by clicking the Options... button. See Specifying
Extract Options for Text Files, INI Files, CSV Files and Environment Variables on
page 219 for information about how to do this.

Sequence Asset Field

This field type extracts information from one of up to ten specified fields. The value returned
as the results of the sequence field, will be the first of these fields which contains a non-blank
value.
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To set up a sequence asset field:

1

Select Sequence as the field type.

Mew analysis Asset Field

X]

Field Type Field Sequence
() Test File Extract # |Field Name a
1 —
) Ini File Extract > ™
() C5Y File E3
) Erwironment T
(%) Sequence i
B
Figld i -
|.-'1‘-.na|_lrlsis 1 “ | - . =
|gnore stringz
Captian b atching Sharter than

|.-’-'-.na|_l,lsis 1 | | | | 1 |E” Options...

I OF. H Cancel l

In the Field Sequence box, click in the Field Name column, and from the drop-down list,
select the desired field.

In the Ignore strings group box, specify the criteria for a blank field using one or all of the
following methods:

In the Matching box, enter a sequence of strings (case-sensitive) separated by
semicolons.

If the content of the field matches (is equal to) any of the strings specified here, the
field is considered to be blank. For example, if the text string “Not Found” is entered
here, then a field that has the value “Not Found” is considered to be blank.

Multiple entries must be separated by semicolons ( ;), for example:
‘Unknown;Not Tested’
You can type a string in the form: *STRING*

Here the asterisks (*) are ignored and any string that contains the text between the
two asterisks will be ignored too.

Specify ignore strings that are less than ‘n’ characters.

In the Shorter than box, use the arrow keys or type in a number to specify the
maximum length of text strings that are to be used to define a blank field (between 1
and 255). If the string is shorter than the specified number, then the field will be
considered blank.

Assign the number for the analysis field by selecting it from the Field drop-down list.

Assign a caption for the field if required, by typing it in the Caption field.

Specify any extract options as required by clicking the Options... button. See Specifying
Extract Options for Text Files, INI Files, CSV Files and Environment Variables on
page 219 for information about how to do this.
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Specifying Extract Options for Text Files, INI Files, CSV Files and Environment

Variables

Text file, in1i file and environment variable asset fields can be set up so that only part of the
string is extracted instead of the entire string.

They can also be set up, for example, to use the last part rather than the first part of the
string. This can be very useful for obtaining the last part of an automatic field that is too long.

In addition, a default value can be specified for situations where no matching data has been

found.

To specity extract options for text, ini and environment variables:

1

Click the Options button in the New Analysis Asset Field dialog box. The Asset Field
Extract Options dialog box appears.

Ewtract characters from O ptionz
(%) Start Skip characters [ ] Corvert to upper case
) Erd Q % [] Treat field as a Filz Mame

Default Walue

Asset Field Extract Options

k. ] [ Cancel

In the Extract characters from group box, specify whether you want to use the last part or
the first part of the string. Select one of the following options:

Start

Uses the first part of the string. Use the arrows in the Skip characters box to specify
how many characters you want to skip from the beginning of the string.

End

Uses the last part of the string. Use the arrows in the Skip characters box to specify
how many characters you want to skip from the end of the string.

In the Options group box, select the options you want:

Convert to upper case
Select this option to convert the alphabetic characters to upper case.
Treat field as File Name

Select this option to treat the string in the asset field as a file name. Some characters
are however invalid in file names, so any invalid characters can be replaced with the
character specified in the Replace invalid characters with box.

For example, underscore _’ is a valid file name character and can be used to replace
invalid characters.

Alternatively, invalid characters can be deleted by checking the Delete invalid
characters box.
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If the extracted field is empty or is not found (that is, there is no matching data), then a
default value for the string can be specified in the Default Value box.

For example, if the text string ‘Not Found’ is entered in this box, then an empty field or a
field that has not been found will be displayed with this text.

Loading Data from a Scan File

Each scan file is loaded into a new window. This allows you to view multiple files at the same
time.

You can load files from the processed directory. Enriched scan files are created here. By
default the directory is in the following location on the DDM Inventory Server:

C:\Documents and Settings\All Users\Application Data\Hewlett-Packard\
DDMI\scans\Processed

To load scan files in the Viewer:

1 Select the Open Scan File command from the File menu, or click the & button in the
toolbar.

The Open Scan file dialog box appears.

E-: Open scan files E| E'
.Y

=3 Hewlett-Packard
=03 DOMI
[=) Conf
& sal
=) Scans
3 Db
[5) Failed
[ Firstscan
[ Incoming
[ Logs
[ Original
b Proceszzed
[ Samples
= Temp v

Filz Mame Size kb Modified Descriptian
O Usw3Is10BE7_ xsf 524 05 May 2009 0210 Administrator - eon, 2800MHz, 1024kb

[
|

] l [ Cancel
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This dialog box is split into two viewing areas (panes):

e The top pane is an explorer type directory tree that allows you to navigate to the
directory containing the scan files.

e The bottom pane displays all scan files that are available in the selected directory.

In the top pane, navigate to the directory that you want to load the scan files from. Any
scan files found in that directory are displayed in the bottom pane.

Details are displayed in the status panel when you place the mouse pointer over the scan
file.

Check the box next to the scan file to include it for loading (you can also use the space bar
to check and clear the box). Checking options can also be set by using the shortcut menu
which is available by right-clicking anywhere in this pane.

Click the OK button to load the scan files.

) You can also use drag-and-drop to load scan files. Drop any number of scan files onto the
Viewer window to load them directly.

Viewing Summary Data

The Summary tab displays a small summary of key hardware, software, user and asset
information derived from the other tab pages in Viewer.

' Viewer - [USV3510BQ7__.xsf - C:\DOCUMENTS AND SETTINGS\ALL U... [ |[B][X]

File Edit Wiew Window Help - & x
S| e A B0 2

Summary | Hardware and Configuration | Directories and Files || Stared Files | Saftware Applications
[termn Data
Machine Adriniztrator - ¥eon, 2800MHz, 1024Mb
Scan date 2003-05-05 07:54:55
Scanner versian 760000 build 9231
CPU #eon 2800 MHz [Genuinelntel]
kdemory 1024 kB
HD Capacity E7.8GE
Qs whndaoves 2003 Server Standard E dition
Machine 1D WTEST4A
Scanned volumes C:h
Scanned filez H526
Stared files 4 files
Partizlly B ecognized Applications 23

I'I'uesu:l.ay, May 12, 2009 9:36:03 AM 1 Scan(s) 1ISY3510BQ7__.xsf - Administrator - ¥eon, 280

Navigation in the Summary Tab

To go direcily to the tab page from which the summary information was derived:

¢ Right-click and select the option from the menu or double-click on an item.

Viewer
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The following table shows the items on the Summary page, a short description and the tab
page displayed when you double-click or right-click on the item:

Table 39 Navigation in the Summary Tab

Item Description Page Displayed
Machine Description field Hardware and Configuration
Scan date Date the scan file was produced Hardware and Configuration

Scanner version

Scanner used to create the scan file

Hardware and Configuration

CPU CPU description Hardware and Configuration
Memory Memory size Hardware and Configuration
HD Capacity Disk size Hardware and Configuration
0S Operating system Hardware and Configuration
MachinelID Network name of the scanned Hardware and Configuration

machine

Scanned volumes

Drive letters scanned

Hardware and Configuration

Scanned files

Number of scanned files

Directories and Files

Stored files Number of stored files Stored Files

Fully Recognized Number of fully recognized Software Applications
Applications applications

Partially Number of partially recognized Software Applications
Recognized applications

Applications

Viewing Hardware and Configuration Data

In This Section

e Hardware and Configuration Data Page Overview on page 222

e The Hardware and Configuration Tab Page Layout on page 223

Hardware and Configuration Data Page Overview

The Hardware and Configuration tab displays:

e User and asset information collected using the asset questionnaire during the inventory.

e High level hardware information scanned during the inventory.

Further Information

e For a detailed list of all the hardware items scanned, see Help > Data Collected by the

Scanners.
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¢ For information about the SMBIOS details, refer to the “System Management BIOS
(SMBIOS) Version 2.4 Reference Specification,” which can be found on the DMTF Web site

at http:/www.dmtf.org.

The Hardware and Configuration Tab Page Layout

Category tree

Shows all the
categories of
data
contained in
the scan file

Viewer

The Hardware and Configuration tab page consists of four panes. By default when you first
start Viewer, only the first three are shown (Simple mode):

e Category tree

e Category description
e 1stlevel data

e 2nd level data

The following screen shot shows the Hardware and Configuration tab page in Advanced mode.

% Viewer - [USV3510BQ7__.xsf - C:\DOCUMENTS AND SETTINGS\... [= |[B1)(X]

Fie Edit View Window Help

= & BE ' #d B0 %

Summary | Hardware and Configuration | Directoriez and Files | Stored Files || Software Applications

=1

?

= Hardware Data Index | Buz | Class Yendor [
v Asset Data @22 PO Unknown Intel
¥ CPUData CA220 PO Disk LS! Logic Inc.
=88 Bus Data @221 PO Cerial Bus Contraller — Tesas Instrunme
=ffs Buses Supported || @200 PO Netwark Intel
— @ Bus Name @22 PO Syztem Intel
EE% Cards i FCI Cystemn Ikl
(@ Number of Cards [ o Serial Bus Contraller
M BIOS Data 2 Cerial Bus Controller
. bemory D ata i FCI Serial Bus Contraller — Intel
Operating System D ata i FCI Serial Bus Contraller — Intel
& Video data i FCI Cystemn Irikel w
- Metwork, data < 3
i Fevboard and Mouze dat
124 Disk data [tem 25 -
% System data Bus PCl
F'l,f Part data Elasg lSTriiaI Buz Controller
) StorageData Mame  IntoliR) B2801DB/DBM LISE Liriversal Hos
ET:I SMBHJS |ﬂfoITIEItIEII"I "-.-"Er'll:llzlr |D $DDDDEDEE
5%’ LSE Data Card D F000024C2 w
£ > >
Busz Data‘\Buses Supported\Cards [hwCards]
Drizplays information about the cards that are uzed in the computer.

ITuesu:Iay, May 12, 2009 10:57:05 AM 1 Scan(s)

LSY3510BQ7 . xsf - Administrator - Xe

Category description

Provides a description of the cu

rrently selected category.

1st level
data

Any items
that have
more detai
have a
hyperlink

2nd level
data

This is
displayed
ifa
hyperlink
has been
clicked in
the 1st
level data
pane
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Advanced and Simple Display Mode

By default, when you first start the Viewer, the Hardware and Configuration data page is
displayed in Simple mode.

You can display this information in a Advanced mode (hyperlinks shown and all four panes
are displayed):

To switch between Advanced and Simple mode in the Hardware and Configuration data page:

Select or clear the Advanced Hardware View option in the View menu.

Category Tree

The left side of this tab page shows a tree. This tree contains folders for each of the Asset and
Hardware data items. You can click on a folder to expand it and reveal further items in the
category.

The &% icon indicates that multiple instances of that particular item may exist. In the

following example, the multiple folder icon indicates that multiple Buses are supported (these
being ISA and PCI).

5 Hardware Data # | In..  BuzM.. Cards
-y Asset Data 1154 Cards 1
+ M CPU Data @z PO Cards [2
—|-EE Busz Data

A Bus Name

+ cf:} Cards

@ Mumber of Cards

Category Description

This pane provides a description about the data category you have selected from the tree.

A detailed list of all the hardware items scanned and descriptions for all of these can be found
in the document entitled ‘Hardware and configuration data’.

1st Level Data

When you have selected a category in the tree, information is shown for it in this pane. In the
previous example, the Buses supported were shown.
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2nd Level Data

You will note that some entries in the 1st level pane may have hyperlinks. When clicked,
further information for that instance of the item is show in the 2nd level data pane. In our
example, the Cards (2) hyperlink was clicked and further information about the PCI card is
displayed in 2nd level pane.
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In This Section

Mame

Imtel[R] E7505 Chipzet Host Controller - 25850

Intel[R] 3280108 LPC Interface Caontraller - 24C0

Intel(R] 3280108 Ultra ATA Storage Controller-24CE
Intel[R) 8280108 /DBM SMBus Contraller - 24C3
Multimedia Audio Controller

MDA Quadrod 380 =GL

IntellR] PE4AHZ /0 Adwanced Programmable Interrupt Conl
IntellR] PE4HZ PCI to PCI Bridge - 1460
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e Directories and Files Page Overview on page 225

e The Directory Tree on page 226
e The File List on page 227

e Directory Information on page 229

e File Information on page 229

Directories and Files Page Overview

This page is displayed by clicking the Directories and Files tab after you have loaded the
inventory data into Viewer.
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Further Information

For information about how drive letters are assigned and used by DDM Inventory, what the
volume list means etc. refer to How Drive Letters and Volumes are Assigned in the Reference

Guide.

The Directories and Files tab page is split into four viewing areas (panes):
e Directory tree

e Filelist

¢ Directory information

e TFile information

The Directory Tree

The directory tree is located on the left of the page. It shows the structure of the current
drives displayed as a directory tree.

To obtain information about the drive or directory:

Right-click on the directory and select the Properties option. The Properties dialog box
appears.

If the drive is a shared drive, then a Sharing tab is also made available.

Icons Used in the Viewer to Denote Directory Status

Different icons are used to denote directory status as follows:

Table 40 Directory Status Icons

Icon Directory status

= Indicates a drive

(=] Indicates a shared drive

@ Indicates a normal directory
= Indicates a shared directory.

Indicates filtered or ignored directories (as specified in the Scanner Generator).
Data in the filtered directories is not stored in the scan file.

-
(]

This icon also represents mount points in Windows 2000 or UNIX scans. Mount
points are automatically filtered.

In UNIX scans, files (and directories) may be located on several different file
systems. To link files that are in different file systems a symbolic link is made.

(&

This icon is displayed for directories that are symbolic links. You can follow the
link by right-clicking on the directory and selecting the Follow Link to <link>
option.
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The File List

The file list is located in the top right of the page. It shows a list of files in the selected
directory.

The file list has incremental column search.

To use incremental column search to locate an entry in a column directly:

Click on any row, and type the word(s) or number(s) that you want to find.
The name is displayed on the status bar.

You can obtain information about a file by right-clicking the file and selecting the Properties
option. You can also do this by double-clicking on the file.

AGM.dIl Properties [X]

General Wersion

\ir) AGMdI

Data gource: USW3IRT0BAT__wef - CADOCUMENTS AMND SET
Location: C:%Program Filez'tdobehderobat 7. 0NReader
Size: 1.64 MB [1.715,712 bytes]

MS-005 name: AGK.dI

Created: 14 Dec 2004 04:36
M odified: 14 Dec 2004 04:36
Accezzed: 23 Mar 2003 21:12

Aftributes: [ ] Read-only [ ] Hidden
Archive [ ] 5pstem
[ ]*ersion D ata [ 11z Archive
[ In Archive E xecutable
[ Sharteut/Link, [ ] Compreszed

[ ]Used/Executed [ ]Enciypted

I Ok ] [ Cancel

For files that belong to packages, you can use the Go to installed package menu item on the
right-click shortcut menu to view information about the package. This is displayed on the
Hardware and Configuration tab.

Archive Files

The contents of archive files are displayed, but no signatures are shown. However, if a
checksum is shown, this refers to the archive checksum.
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UNIX Scans

For files in UNIX scans, you can obtain link information about the file by right-clicking on the
file and selecting the Follow link option.

This option is only available for files with the L attribute (indicates a symbolic link file). You
can also do this by double-clicking on the file. The link information is displayed in the file
information pane.

Parameters Displayed for Each File

The parameters displayed for each file are:

e TFile Name — the name of the scanned file.

e Size — the size of the scanned file.

e Modified — the last modified date and time that is stored for the file in the file system.
e Attribute — file attributes (see Table 41).

e Exe/Arc — the type of the executable or archive file.

e Signature — a number that is calculated from the first 8 Kbytes of a file (usually sufficient
to uniquely identify a file).

e (Created — date and time when this file was created.

e Last Accessed — date and time when this file was last accessed on this system.

e Package — name and version of the package to which this file belongs.
Table 41 File Attributes

Attribute | Meaning

r Read-only files
Files that are marked read-only are protected from modification or deletion.

h Hidden files
Windows Explorer does not show hidden files by default unless you tell it to do
so.

S System files

u Used/Executed files
This flag shows that this file was executed and the application was used.

v Volume Label
This contains no data and no more than one may exist on a disk volume (and
only in the root directory).

a If it has the archive attribute of DOS or Windows
The Archive attribute is used to provide an automatic record of what files have
been modified since the last backup.

c Compressed files
These are compressed files and folders. For example, if it is a file on a
compressed NTFS volume.

X In a UNIX system this represents a file with the executable attribute set.
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Table 41 File Attributes

Attribute | Meaning

I Internal data available

That is, if it has version data available for it.

Version data (as per Windows Explorer) is displayed for all files having this
attribute.

L Symbolic link in UNIX

Files (and directories) may be located on several different file systems. To link
files that are in different file systems a symbolic link is made.

Symbolic links to files are not scanned but are stored with this attribute and
are displayed in the directory tree of the Directories and Files page with a
shortcut icon.

S This is special case for UNIX for SetUid files.

In UNIX scans, certain files have special attributes that mean that they run
with root privilege. Such files are potentially a security risk and the Scanner
assigns them the system attribute - s

This file has been identified as an archive.

This file has been identified inside an archive.

This file has been identified as an executable file.

ol N

This file has been identified as a device driver

Directory Information

The directory information pane beneath the directory tree displays information about the
selected directory. It shows the number of files in the directory and the total size of the files.

File Information

Beneath the file list is the file information pane, which displays additional information for the
executable files, where internal version information is included in the file header.

Viewing Stored Files Data

In This Section

e Stored Files Page Overview on page 230

e Toggling the Display Mode on page 230

e Saving or Copying the Contents of a Stored File on page 230
e Locating the Directory of a Stored File on page 231
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Stored Files Page Overview

This page is displayed by clicking the Stored Files tab after you have loaded the inventory
data into the Viewer.

This page displays the contents of key files collected during the inventory, that is, files stored
in the scan file during scan time. Typically these are system configuration files, for example
Autoexec.bat, and Win.ini.

The Stored File tab page is split into two viewing areas:

e Stored file list — The top pane displays a list of stored files. You can sort (in ascending and
descending order) the contents of a column by clicking on a column header.

e Stored file contents — The bottom pane displays the contents of a selected stored file. Text
files are displayed as text, other files are displayed in a combined HEX- and ACSII-views.

Toggling the Display Mode

By default, the Viewer tries to determine the type of the file and select the appropriate mode
of display. However, some text files that have unusually long lines (longer that 255 characters)
are displayed in hex view as binary files.

Using the Toggle Display mode option it is possible to change the view from hex to text (and

vice versa).

To use the Toggle Display mode option in the Viewer:

1 In the stored file list (top pane), click on the file that you want to view.

2 In the bottom pane, select the Toggle Display Mode command from the right-click menu.
The display mode switches between hex and text display.

Saving or Copying the Contents of a Stored File

The contents of a stored file can be saved to a file for future reference or for restoring the
original files if they have been lost.

To save the contents of a stored file in the Viewer:

1 Right-click on the file name, or in the stored file contents (bottom pane) right-click
anywhere in the pane.

2 Select the Save To command (text and hex files) from the shortcut menu. Use the standard
Windows navigation methods to select or enter a file and the location where the file is to
be saved.

To copy the contents of a stored file to the clipboard:

1 Right-click on the file name, or in the stored file contents (bottom pane) right-click
anywhere in the pane.

2 Select the Copy to Clipboard command or click the Bz icon and paste the content of the file
to an editor of your choice.
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Locating the Directory of a Stored File

>»
>»

To locate the directory of a displayed file (this will be displayed on the Software page):

Right-click anywhere in the top pane and select the Go to Directory command from the
shortcut menu, or double-click on the file.

The software page is displayed, with the file highlighted.
This will only work if the directory/file is available.

The stored file will only appear in the directory if the Scanner has been configured to store
the file type.

Viewing Software Application Data

Viewer

The Software Applications tab displays applications that have been recognized by the SAI
recognition or the Installed applications recognition. It is not displayed when the application
list is empty even if a recognition method was specified.

See Configuring Recognition Settings on page 203 for information about how to set up the
recognition method.

Navigation

Double-clicking on an application in the list or right-clicking on an entry and selecting the
Goto command will display the Directories and Files tab with the application highlighted. The
Directories and Files tab shows the file/directory identifying the application.

The following additional commands are also available by right-clicking on an application
entry.

* Copy

Copies the contents of the Applications tab page to a text format and places it on the
clipboard. You can paste the contents to an editor of your choice.

e Copy to File
Copies the contents of the Application tab page to a text file.
® Show applications (Only for SAI recognition)

For the SAI recognition, it shows fully recognized applications, partially recognized
applications, or fully and partially recognized applications by selecting the options: Fully
recognized, Partially recognized, or Both.

Drop-down lists

In addition, there are two drop down lists that allow you to apply filters to the data that is
displayed.

The first drop-down list allows you to see data relating to a particular user. Application
utilization data is attributed to the following special users:

e All Users

For all users.
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System

For other system processes running on the computer. For example, services running that
have no particular user associated with them.

The second drop-down list allows you to see data relating to whether the application is just
running or actually being used. As a result, you can see software utilization time based on one
of the following:

Running Time
Running time is the total amount of time that an application is open and running.
Focus Time

Focus time is the total amount of time that an application is running in the foreground,
that is, the application is in focus.

Information shown in the Application data window

The following information is shown about each software application:

Application data

Application
The name of the software application.
Recognition

For the SAI recognition, this column displays Full for the fully recognized applications or
Partial for the partially recognized applications.

For the Installed applications recognition, this column displays Installed
Applications.

Release

The application release

Version

The application version

os

The operating system the application was running on.
Language

The name of the language of the application.

Publisher

The name of the software publisher (for example, Microsoft, IBM).
Last Used

The last time the file was accessed - (dd/mm/yyyy) (hrs:mins)
File Name

The path to the file designated as the Main file.
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Viewer

Utilization Data

The Viewer shows two types of utilization data:

Per-computer application utilization (select All Users)

Per-user application utilization (select a particular user)

This information is only available if the software utilization agent plug-in was running on the
computer which was scanned.

See the Software Utilization Data chapter in this book for instructions on how to check
whether you have utilization enabled.

To view application utilization data:

1

Select the user you want to see data for from the drop-down list. Alternatively, select All
Users to get the per-computer view).

Select which software utilization time you want to see from the drop-down list, namely
total running time or total focus time for the application.

Click on the application you want to see data for and the details will be shown in the
bottom pane. This pane shows the utilization statistics for how users utilized a particular
application.

Application Utilization Data

Days used (last month)

The number of days the application was used in the last month.
Hours used (last month)

The number of hours the application was used in the last month.
Days used (last quarter)

The number of days the application was used in the last quarter.
Hours used (last quarter)

The number of hours the application was used in the last quarter.
Days used (last year)

The number of days the application was used in the last year.
Hours used (last year)

The number of hours the application was used in the last year.
Hours used (average daily)

The daily average in hours over the period configured.

Hours used (peak daily)

The highest daily number in hours over the period configured.
Utilization

The number of days that the application was used (as a percentage) over a period of time.
The period is calculated automatically depending on how long the application was used
for. As a rough guideline the time periods are as follows:

e Application used for more than 3 months - utilization is calculated over the year.
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If the earliest application usage recorded is more than 3 months old, but less than 1
year (i.e. there was a record that the application was used more than 3 months ago,
but less than a year ago), an annual figure will be used (number of days used in the
last year / 365)

e Application used for less than 3 months but more than 1 month - utilization is
calculated over a quarterly period.

If the earliest usage recorded is less than 3 months, but greater than 1 month, a
quarterly figure is used (number of days used in the last quarter / 90).

e Application used for less than one month - utilization is calculated monthly

A monthly figure is used here (number of days used in the last month / 31)

Comparing Scans

In This Section

e  Why You Might Want to Compare Scans on page 234

e Setting up the Comparison of Two Scan Files on page 234
e Viewing the Comparison Results on page 236

e Key Fields on page 238

e The Go To Option on page 238

e Saving the Comparison Results on page 239

Why You Might Want to Compare Scans

The scan compare feature in Viewer can be an ideal tool for support personnel. It provides you
with a direct comparison between two scans. It can be used to:

e Track which files have been accidentally deleted.

e Compare scan files from recently upgraded computers against their original
configuration.

e  Check for adherence to a standard desktop.

e Check which files have been added, changed or removed after a software installation had
taken place.

¢ (Change management.

Setting up the Comparison of Two Scan Files

The compare function is only available if more than one scan has been loaded into Viewer. You
can perform multiple comparisons at any one time.

To set up the comparison of two scan files:

1 Select the Compare option from the Edit menu, or click the Compare icon [F%.

The first page of the Compare Scan Files wizard appears.
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Viewer

2 Select the two different scans to be compared from the corresponding drop-down lists.

3 Click Finish to compare the two scans with default options, or customize the options by
clicking the Next button. The Set Options page of the wizard is displayed.

B Compare scan files E|@|g|
Set options 6 g
Specify which parts of the F
zcan files bo compare

Check thoze parts of the scans that should be compared.  The more options are checked,

the langer the compare will take to complete.

Hardware and Caonfiguration data
Software Applications
Directaries and Files
lgnore empty directonies
[ ] Usze short Directory and File Hames
Ignore Last Acceszed Time
Show equal K.ev Hardware Fields

Scanner Configuration data

[ Firizh ] [ Cancel

4 Customize the options as required:

Hardware and Configuration data

Compares the information contained in the Hardware and Configuration page for
both scans.

Software Applications
Compares the information contained in the Software Applications page for both scans.
Directories and Files

Compares the information contained in the Directories and Files page for both scans.
Further options are made available:

Ignore empty directories — Any empty directories encountered will not be included
in the comparison.

Use Short Dir/File Names — The file names and directories will be displayed in the
8.3 format used by DOS.

Ignore Last Accessed Time — The last accessed time stamp is ignored when carrying
out the compare.

Show equal Key Hardware Fields — Some of the fields have key fields associated with
them. If any data for the fields in the list has changed, it will be displayed along
with the key field for it. The key fields are displayed in grey to indicate they do not
represent a change.

For an example of how key fields are used see Key Fields on page 238.
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e Scanner Configuration data
Compares the Scanner Configuration (as set up in Scanner Generator) for both scans.

5 Click the Finish button.

The two data sets are compared and a Scan File Comparison window appears showing the
results of the compare operation.

B Scan file comparison

Comparizon of ™. 521 W\COMMOMASAMPLESYHP_U_B_10_20. =sf"
atd " A2 NCOMMONASAMPLES S Hp1 1 s

Data items HF_L_B_10_20.xsf - C:h.. | Hpll.xsf - CAPROGRAM |
Hardware D ata
TF;‘] Software Applications
[ Directories and Files
El Scanner Configuration

Save.. ] ’ Cloze

Viewing the Comparison Results

The Scan File Comparison window has three columns. The first column shows the compared
data items.

The results of the comparison depend on the criteria you defined in the wizard. The following
information can be shown in the first column:

e Hardware Data

e Software Applications
¢ Directories and Files

e Scanner Configuration

To expand a category, click the + sign next to the icon.
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The next two columns show the results for the compared scan files. An example is shown in

the following screen shot:

B scan file comparison

Comparizon of ", 521 05COMMOMNMSAMPLESYHP_U_B_10_20.zsf"
and " 521 NCOMMONSSAMPLESYHRP1 1. waf"!

3 Memory Data

[ Mebwork. data

[ Operating System Data
[ Peripherals

[ Storage Data

[ Swstem data

e e e e

D ata items HP 1= B _10_200=sf - C:h.. | Hpl71.msf - CAPROGRAM .
= Hardware Data
[ AszzetData
[ BIOS Data
[ BuzData
=[] CPU Data
=[] CPUs
ERERI)
CPL HF PA-RISC 20236 MHz ...  HP PA-RISC 2.0 240 MHz ...
| |~ Actual CPU Speed [MHz)
Rated CFU Speed [MHz] 236 240
CPU Type HF Pa-RISC 2.0 HF P&-RISC 2.0
CPU Speed [MHz] 236 240
CPU Model 7a2 200
[ Disk data

F

b

I
T
b=

Save.. | |

Cloze

In this example, the Actual CPU Speed for the first scan file is 236 MHz and 240 MHz for the

second scan file.

237



238

Key Fields

If you enabled the Show equal Key Hardware Fields option on the Set Options page of the
compare wizard, some of the lists of fields will be displayed with key fields associated with
them. These key fields are shown in grey. If the data for the fields in the list has changed, it is
displayed along with the key field. An example is shown in the following screen shot:

Key field
indicates

the

changes
occurred
on this

drive

B Scan file comparison

Comparizon of ™. 521 S\COMMOMNASAMPLESYHP_L-_B_10_20.=sf"

and " A2 1 NCOMMONSSAMPLESSHp1 1 ks

=

[ ata items

[ BIOS Data

[ BuzData

[ CPUData

([ Disk data

=[] Mount Paints
(1 [1H1]

b aunt Paint Yalume Tatal Si...

kaunt Paint Yolume Free Sp...

b ount Point Wolume Mame
b ount Point Wolume Device
[ [3H3
(] [4H4]
(] [5HE]
(1 [EHE]

b aunt Paoint Yalume Tatal Si...

- - -

b ount Point Wolume Free Sp...

b ount Point Wolume Typpe
b aunt Paoint Yalume Mame
b aunt Paoint Yolume Device

HP_L=_B_10_20.xsf - C:AL.

Hpl1 . mzf - C:APF

4G
a2
Adeve g0 el
Adeweg0Aeal

1036

210

hfs
Adewteg0dvols
Adewteg0dvols

a1
57
AdesevegO0ebeal
Adew g0l ol

12604

54594

wifs
Adevwfegl0d ol
Adevwfegl0d ol

The Mount Point Volume Name field is a key field (shown in grey) and this is shown even
though it hasn’t changed itself. This indicates that the information changed relates to this
particular drive; without the key field it would not be possible to see on which drive the

change had taken place, merely that it had changed on some drive.

The Go To Option

A Go To option is available for all categories except for Scanner Configuration data.

1 Right-click on a field and select the Go To option.

The appropriate tab page in the Viewer main workspace will be displayed with the entry
highlighted. This will be done for both of the scan files.

2  Select the Tile option from the Window menu to see both scan files with the appropriate
entries highlighted.
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Saving the Comparison Results

To save the results to a Comma Separated Variable (.csv) file:

1 Click the Save button, or right-click anywhere in the results window and select the Save to
.CSV file option.

2 In the Save Comparison dialog box, specify a file name and path where you want the
results to be saved.

3 Click the Save button.
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4 Software Utilization Data

If you have a Utilization license, DDM Inventory can gather information about what software
is used on the machines in your network. This is referred to as Software Utilization and the
information collected is necessary to optimize software license cost, for example by
eliminating unused or under-utilized software installations.

From a software recognition perspective, any files that are Unknown and are shown to have a
high Utilization should be marked for teaching. See the “Application Recognition and
Teaching” chapter in this guide.

Software utilization data shows the number of days that an application was used (as a
percentage) over a period of time. This period of time is know as the ‘Utilization Period’

As a guideline the Utilization Periods are as follows:
e Month (31 days)

e Quarter (90 days)

e Year (365 days)

Technical Overview

DDM Inventory agents include a plug-in that allows collection of the software utilization data.
If software utilization capability was purchased it can be enabled both globally and on a
per-device group basis using the configuration profiles. Refer to the “Configuring the
Discovery Process” chapter in the Installation and Initial Setup Guide.

Once utilization data is enabled in both places, the agent is instructed to collect usage data. It
launches its software utilization plug-in that constantly monitors the processes that are
running on the computer and collects software utilization information. The plug-in stores its
data in the Perf subdirectory of the agent data directory. There is a separate file for each day
as well as the summarized version named discusg.cxu which contains the aggregated
utilization information.

When the inventory of a computer is performed, the scanner collects a copy of the discusg.cxu
file and stores its content in the scan file in a special stored file called Software Utilization Data.
While processing the scan file, the XML Enricher, the Viewer and the Analysis Workbench
make use of this special stored file to extract and process software utilization data.

Checking to See If You Have a Utilization License

To check whether you have a Utilization license:

e In the Web UI click Status > Current Settings > License Status.
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The Software Utilization option will be set to Yes if you have a license.

Configuring Software Utilization

Enable or Disable Utilization Globally

DDM Inventory can only collect Utilization data if you have a Utilization license. If you want
to stop collecting Utilization data, turn the Process Utilization data option off.

1 In the Web UI click Administration > System Configuration > Scan Processing > Process
Utilization data.

Process utilization data: & Default: Tes

O custom: ® ves O na

2  Set the option to No.

Enable Utilization on an IP Range Basis

This is an Agent Profile setting. It will ensure that Software Utilization is enabled for a device
group (defined by a specific IP range) that is assigned to the Agent Profile. These Profiles
were added when you installed DDM Inventory.

1 In the Web UI click Administration > Discovery Configuration > Configuration Profiles and
select the Agent tab.

Save and Close I Cancel |

L2 O Associated Groups
Allow agent communication

Agent deployment actions:

Allow agent upgrade

Agent automatic upgrade 5c:hedu|e:| <Al the time= L3 |

Collect utilization data

AUM agent migratiun:| None v|

[] user names [] Demain names
Anonymization:
[] Device information [] Usage data
[] Allew agentless scanner execution
Remove scan data

Accept new public client key

Accept changed public client key

[] Limit bandwidth for data transfers: l:l

Communication credentials for Windows:
[Todiy ] ew |
| label | login | Domain |  Share | Path |

No data

2 Ensure that the Collect utilization data option is checked.

3 Click Save and Close.
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4 Activate your changes.

Configure the Utilization Period

The Utilization Period determines how long DDM Inventory will keep Utilization data. For
example, if this is set to 31 days, Utilization statistics for any device will only be available for
the past 31 days.

1 In the Web UI navigate to Administration > System Configuration > Agent Communication
2 Scroll down to the Utilization Period group.
Utilization period: ® Default; | Year (365 days)

O custarn: O Maonth (31 days)
(] Quarter {90 days)
® vear (365 days)

3 Set the Utilization Period as required:
e Month (31 days)
* Quarter (90 days)
®  Year (365 days)
The default Utilization Period is Year 365 days.

Viewing Software Utilization Data in Analysis Workbench

Before you can view and analyze the data in Analysis Workbench you will need to set memory
load options.

Setting Load Options for Software Utilization

Ensure that the Software Utilization Data option is enabled in this dialog box.

1 Select the Load Options command from the File menu.
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2  Click the Memory tab.
Analysis Workbench Load Configuration g|
Load Filter | Recognition | &sset Fields | Display Filker | Memony | Plug-ins

For each file, a number of different attibutes can be loaded. By not selecting all items, the memory
requirement for loading large numbers of files can be reduced.

File: details to load Machine data to load

Azzet and Hardware Data
Signature [ Include Shartcut Data
Modified Time [ Include Services Data
Acceszed Time [ Include Ervironment Data
[¥] File Type [¥] Include SMBIOS Data
Altributes

Software Utilization D ata

Loading all directories, and cross-referencing them with files, machines and applications, takes up
sighificant amounts of memary. If only parts, or none, of the information is required for the task at
hand, select the appropriate option below.

Directories to load

(O Load all directories

(®) Load only directories containing loaded files
() Do not load directory data

’ Load... ” Save.. ] I Ok H Cancel

3 Enable the Software Utilization Data option.
4  Click OK.

Viewing Software Utilization Data in the Windows

Software Utilization Data can be viewed in the Files and Applications Windows. In addition a

link is provided to the Details Window.

Applications Window

Two columns are available:
Table 42 Utilization in the Application Window

Column Description

Utilization This shows the number of days that
the application was used (as a
percentage) over a period of time.

Used on The machine the application was
used on.

You can drill down to the detail level to see the individual results in the Details window.
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Files Window

Two columns are available:
Table 43 Utilization in the Files Window

Column Description

Utilization This shows the number of days that
the application was used (as a
percentage) over a period of time.

This shows the first instance of the
value. If an asterisk is shown next to
the value then it means that more
than one instance of the file was
found and you can see further details
in the Files Details window.

Attribute A u (Utilized file) attributes indicates
that this file was executed and the
application was used.

Software Utilization Data
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Viewing Software Utilization Data in Viewer

This section discusses the Viewer (available as part of the DDM Inventory client). There is
also Utilization data available in the Scan Data Viewer, which provides similar information,
and is available through the DDM Inventory web user interface. For more details on the Scan
Data Viewer, see the Network Data Analysis Guide.

The Stored Files Tab

You can view the contents of the discusg.cxu.Software Utilization Data file in the Stored Files tab.
1 In the stored file list (top pane), click on the Software Utilization Data file.

2 In the bottom pane, select the Toggle Display Mode command from the right-click menu.
The display mode switches between hex and text display.

The Software Application Tab

Utilization information can also be seen in the Viewer Software Application tab page. There are
two drop-down lists that allow you to filter utilization data.

One drop-down list allows you to apply a filter to see data relating to a particular user.
Application utilization data is attributed to the following special users:

e All Users
For all users.
e System

For other system processes running on the computer. For example, services running that
have no particular user associated with them.

The other drop-down list allows you to see data relating to whether the application is just
running or actually being used. As a result, you can see software utilization time based on one
of the following:

¢ Running Time
Running time is the total amount of time that an application is open and running.
¢ Focus Time

Focus time is the total amount of time that an application is running in the foreground,
that is, the application is in focus.

This information is only available if the software utilization agent plug-in was running on the
computer which was scanned.

To view application utilization data:

1 Select the user you want to see data for from the drop-down list.

2 Click on the application you want to see data for and the details will be shown in the
bottom pane. This pane shows the utilization statistics for how users utilized a particular
application.
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Per Computer Application Utilization

Days used (last month)

The number of days the application was used in the last month of the configured period.
Hours used (last month)

The number of hours the application was used in the last month of the configured period.
Days used (last quarter)

The number of days the application was used in the last quarter of the configured period.
Hours used (last quarter)

The number of hours the application was used in the last quarter of the configured period.
Days used (last year)

The number of days the application was used in the last year.

Hours used (last year)

The number of hours the application was used in the last year.

Hours used (average daily)

The daily average in hours over the period configured.

Hours used (peak daily)

The highest daily number in hours over the period configured.

Utilization

The number of days that the application was used (as a percentage) over a period of time.
The period is calculated automatically depending on how long the application was used
for. As a rough guideline the time periods are as follows:

e Application used for more than 3 months - utilization is calculated over the year.

If the earliest application usage recorded is more than 3 months old, but less than 1
year (i.e. there was a record that the application was used more than 3 months ago,
but less than a year ago), an annual figure will be used (number of days used in the
last year / 365)

e Application used for less than 3 months - utilization is calculated over a quarterly
period.

If the earliest usage recorded is less than 3 months, but greater than 1 month, a
quarterly figure is used (number of days used in the last quarter / 90).

e Application used for less than one month - utilization is calculated monthly

A monthly figure is used here (number of days used in the last month / 31)

Viewing Software Utilization Data in the Web Ul

The following reports in the Web UI have a Utilization Data column.

Reports > Application > License Counts by Application

Reports > Application > Top Applications
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The Utilization Data column tells you whether utilization data is available for that machine.

To view the Utilization data further go to the machine by drilling down and getting to the
Device Manager for that machine.

Click on the View Scan Data icon and the scan file for that machine is opened in DDM
Inventory Viewer. Information about what you can see in the Viewer is described on page 246
and in the Viewer chapter.

An example is shown below:

Publisher Application Name Description # # uUtilization
Licenses Installed Data?
Required

AT&T Labs Cambridge VHNC Viewer 248 248 | No

Microsoft windows 243 243 Yes

AT&T Labs Cambridge VHNC Server 223 223 | Tes

Adobe Acrobat Reader 169 170 Yes

Zun Microsystems Java 2 Runtime Environment 155 202 | Yes

Microsoft Internet Explorer 141 328 | Tes

Mullsoft Winamp 128 128 | Yes

Peregrine Systems Desktop Agents 120 120 | Yes

Flmm e S Flmmmuimm FPrmm b Tk anw P IR

The Scanner Generator

Utilization data is collected by the agent plug-in and not the Scanner itself. However, you can
instruct the Scanner to include any directories from where used programs are executed. These
directories will be included in the list of directories to scan. This ensures that the Scanner
collects the file data required for recognition of used applications.

You can do this by selecting the Software Utilization option on the Directories tab page:

-ﬂ Scanner Generator - Server M=l E3

Software Details i
Which files and directories do you want to scan
and store?

Drives Directories r File Scanning r Stored Files |

Directories from shortcuts (Wind only}
Start Menu Desktop
Only use shortcuts to files with these extensions:
[ hat q
| dil [=]
Directories from other sources
Windows Services File As=ociations
|:| Java Home Software LHilization

Hon-Global Zone Root Directories Program Files/Applications
Packaged File Data

Directories from envir
Include directories from these environment variables:
[PaTHLIBPATH =]

Shorteuts to d drives
Scan excluded drives

= Back I Hext = | | Cancel
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5 Application Recognition

Application recognition is the process of determining what software is installed on a machine.
The process takes place after scanning, when a scan file is loaded into the Viewer or Analysis
Workbench and SAI Editor components, or when it is processed by the XML Enricher.

The recognition process is driven by a Recognition Engine built into the components
previously listed, and is based on the Software Application Library (SAI files) supplied with
the product. The Software Application Library stores the information required by the
Recognition Engine to determine which applications are installed on a machine. The Software
Application Library is updated by HP Librarians on a regular basis, and the updated version
is made available to customers every month.

If you would like DDM Inventory to recognize an application that is not contained in the
Software Application Library, there are several methods you can use to “teach” this
application. These methods are discussed in Chapter 7, Application Teaching.

What to Expect from Application Recognition

There are several ways in which applications installed on a machine can be recognized. Each
method has its benefits, and until the purpose of performing application recognition has been
established it is difficult to see why one method might be preferred over another.

The best forms of Application Recognition have the following characteristics:
1 Identifies all applications on a machine

This is of course the primary goal of any recognition mechanism. An accurate list of
applications allows you to enforce the corporate standards, determine software license
compliance, assist internal support, and so on.

2 Identifies software licenses required

Identifying the list of applications is not enough for accurate software licensing. For
example, if a machine has both Microsoft Word and Microsoft Office on it, a
straightforward count of installed applications would require two licenses for the
machine, where clearly only a license for Office would be required.

3 Presents the data in normalized form

For reporting and analysis purposes, it is important that the data is normalized. For
example, it is useful to have a ‘publisher’ field that allows you to quickly choose all
applications from a particular publisher without having to isolate this data yourself.

When the data is not normalized, it is much more difficult to analyze and report. Just
imagine Microsoft Word 2000 represented as a single entry such as ‘Word 2000 -
Microsoft’, and WinZip 8.0 represented as ‘WinZip v8’.

4 Identifies the relationships between files and applications
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When this relationship is identified, support and troubleshooting becomes much easier. If
an identified application should be upgraded or removed, it is immediately obvious which
files will be affected by the change when this kind of information is available.

Similarly, if a user has a problem with an application, a comparison between two scans of
his machine can often identify changed or deleted files that are necessary for the
application to run.

Identifies a list of unidentified files

With this information, it is possible to estimate the accuracy of the information, and to
determine where library teaching may be required: for a population of machines,
unidentified files that occur on a large number of machines should be added to the library
as they are likely to be part of a commonly installed application.

Allows custom applications to be added to the library

No library-based mechanism can cover 100% of all applications. Some companies use lots
of bespoke software, or customized versions of generally available software. The algorithm
must allow the user to customize the library used to easily cover such applications within
the User.zsai.

Allows improved accuracy without revisiting the machine

The most intrusive and time consuming step in any inventory process is that of scanning
the machine. It is desirable to keep the number of scans to a minimum, both to minimize
the impact on the user and to avoid consuming network bandwidth unnecessarily.

Consequently, the application recognition should be applied to the scan file and it must be
possible to improve application identification without revisiting the machine.

An Overview of Different Recognition Mechanisms

The recognition methodology applied by DDM Inventory has all of the benefits previously
mentioned. The following table shows a summary of the most common methods and their
benefits and drawbacks.

Table 44 Overview of Different Recognition Methods

HP Installed Version Other

Benefit Library |Applications |Data Library
1 - Applications Yes Some Some Some

2 - Licenses Yes No No No

3 - Normalized Yes No No Some

4 - Files/Apps Yes No Yes Some

5 - Unidentified files | Yes No No Some

6 - Teaching Yes No No Yes

7 - Server teaching Yes No No Some

HP’s SAl Based Recognition

Software Application Index (SAI) recognition is HP’s preferred method and offers the full
range of benefits associated with application recognition.
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The full details of SAI-based recognition are discussed throughout this chapter.

Installed Applications Recognition

Installed Applications recognition relies on the operating system to supply a list of
applications installed on a particular machine. This mechanism is not particularly reliable
(for example, it is often possible to edit the list and install applications without adding them
to the list), and the data retrieved is often not very accurate. However, it is very fast and
requires no library maintenance.

If you do not want the added overhead of a library-based recognition mechanism, the HP tools
support this mechanism.

Version Data Recognition

Version Data recognition also requires no library and works by extracting all “version data”
from executable files during the scan, and presenting this information as a list of applications.

Unfortunately, the version data is added by the software publishers and is notoriously
unreliable. For example, some companies forget to update it with a new release, do not include
the information at all, or use a different version numbering scheme in these files than they do
in the product.

The addition of the VerDLL field to the SAI allows you use version information in addition to
the normal SAI data to provide more accurate version recognition. Particularly in cases where
executables are of an unpredictable size.

’ Version data is available only in Windows executable files. Therefore, this type of recognition
works only for Windows applications. It does not work for UNIX or Mac OS X applications.

Other Library Based Mechanisms

A number of other library-based application recognition technologies exist. However, due to
the overhead of meticulously adding all files for an application to the library (something HP
does for you), most of these libraries include information only about the ‘Main’ file of a
version. This results in poorer recognition (for example, differentiating between two similar
versions of an application) and loses some of the benefits discussed previously.

Most of the libraries are also included with the Scanners, which means that all machines have
to be re-scanned when the library has been updated.

The Results of SAI Based Application Recognition

During application recognition, each file on a machine is flagged as belonging to a particular
application (or as unidentified). From this identification, a list of applications (and licenses
required) for each machine is calculated. For each application recognized, the software
identifies:

¢ The publisher name
e The application name
e The type of the application

e The release
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e The version

¢ The operating system

¢ The language

¢ The license relationship to other installed software

License relations are also known as release relations.

For Microsoft Word 2000 Service Pack 2 for Windows (English version), the resulting data
would be:

Table 45 Example of SAI Recognition Results

Publisher Microsoft

Application Word

Application Type Office App

Release 2000

Version 2000 SP2

Operating System Windows 9x/NT

Language English

License relationships Licensed by Microsoft Office 2000 SP2

As you can see, the data is available in an easy-to-use normalized form, which makes it easy
to group applications by publisher, language, OS, etc.

The rest of this chapter goes into much detail about how this data is found, represented,
manipulated, and augmented.

The Release and Version Fields

The Release and Version fields need a word of explanation.
¢ An application release will be represented as X (such as 4)
® An application version will be represented as X.Y (such as 4.3)

The Release identification is of value in cases where several versions of the same application
are licensed as a single application, in which case all those versions are grouped as belonging
to a single Release. For example, all versions of Word 2000 are grouped under the “2000”
Release, with the Version identifying the exact version installed.

When your primary concern is support, the Version value is most useful as it indicates exactly
which version of the software is installed.

When the primary concern is license management, the Version is of less interest — irrespective
of the service packs installed, the Release allows you to identify how many licenses of Word
2000 are required.
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An Overview of How Application Recognition Works

The Software Application Library is delivered with the product in the form of a set of SAI
files. All of the components capable of performing Application Recognition start by reading the
information stored in the SAI files and apply this information to scan files during the
recognition process. See The Software Application Library on page 257.

Based on the configuration and file data collected by the Scanner, the Recognition Engine
determines which applications are installed on a particular machine, and which licenses are
required.

To do this, each file is associated with an application and the file's relationship to the
application is established.

The relationship can be either Main, Associated or 3rd party. When a Main file is identified,
the corresponding application is said to be installed. Associated files may belong to an
application but do not necessarily require a license. 3rd party files ship with the application in
question but are produced by a third party.

Based on the list of recognized Main files, a list of applications on the machine is produced.

As a final step, the license relations between the installed applications are identified, to give a
complete list of software licenses that are required for the machine. This step allows license
requirements for complex software such as software suites to be reported accurately.

In the following, the application recognition process is described in more detail.

Application Recognition at the File Level

Recognition takes place when data is being loaded from a scan file, for example when loading
into the Viewer. Each file entry in the scan file is passed to the Recognition Engine for
processing. The Recognition Engine then tries to find matches for the file, comparing file
details (collected during the scan) with the entries for this file name in the Software
Application Library. File name, file type, file size and file signature are taken into account.

) The process of looking up a file by its name is very efficient. The time required for performing
application recognition increases very slowly as the size of the scan file grows.

If no match for a file name is found, the file is flagged as Unrecognized.

If one or more matches are found, the file's data is stored in memory along with all of the
possible ways in which it can be recognized. The Recognition Engine stores list of all possible
matches together with internally calculated ratings for each match. The ratings determine
how “reliable” each match is for a file. This process continues until all files in the same
directory have been processed in the same way.

When a complete directory has been read, it is possible to build a list of all possible versions
and again assign ratings to each possible version based on the “match strength.” If it is now
possible to establish a good match for every file in the directory, recognition data is returned
to the calling process.

If the process results in a situation where two or more application versions have the same
rating, the Recognition Engine looks at the Install String entries for the candidates for
recognition. If one of the applications has an Install String that is present on the machine,
this application is chosen over the other applications.
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The Install Strings are extracted from the Add/Remove Programs list when the machine is
scanned. Most applications add an entry to this list, and this is the entry that can be used as a
“tie-breaker” in the Recognition Engine.

Level 3 Recognition Heuristics

If Level 3 Recognition Heuristics is enabled, the Recognition Engine will defer final
recognition for directories where it is not possible to establish that all files belong to the same
application. When such directories are found, the Recognition Engine waits until all files have
been processed and then applies the version selection logic outlined in the previous section to
the files that were difficult to recognize.

If Level 3 Recognition is disabled, machine-based recognition will not take place and
recognition data will be returned after each directory. A time overhead of about 10% is normal
when Level 3 Recognition is enabled.

Although disabling Level 3 Recognition Heuristics will speed up the process of loading scan
files slightly, it is worth noticing that the recognition results will be less accurate. In complex

cases, some applications may be identified incorrectly or not at all when this setting is
disabled.

Examples of such applications could be Windows with a service pack applied, where many
files do not change between the versions, or Microsoft Office Professional and Standard
Editions where the majority of files are shared between the two applications and the files are
spread over a large number of directories.

Recognition of UNIX Operating System Versions

Application recognition by installed files alone is insufficient to completely distinguish
operating systems. This is especially true of the various UNIX operating system versions. The
reasons for this recognition problem include the fact that some critical files are not
executable, the kernel directories may not be scanned, different operating system versions use
identical kernel files, kernel file size can change upon recompilation, and so on.

However, DDM Inventory scanners can identify the operating system and report it reliably in
two hardware fields in their scan files, which can be used to point to a placeholder application
in the SAI by using a custom Install String.

To achieve better recognition of UNIX operating system versions, DDM Inventory uses a
placeholder version for the operating system (which has no file data) in an SAI file. The
Install String for this version exactly matches the hwHostOS and hwOSServiceLevel
hardware field combination as displayed in the DDM Inventory Viewer.

During the recognition process, the Recognition Engine inspects the SAI files collecting the
Install String entries from all such versions that have no file data. If the Recognition Engine
detects that the hardware fields match the custom Install String, the operating system
version is reported as being installed.
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Application Recognition in Analysis Workbench

Analysis Workbench allows more control over the recognition process than the Viewer and
XML Enricher, and allows you to add more applications to the SAI files used for recognition.

Because Analysis Workbench can be used as a teaching tool, an additional level of recognition
is available: “checkver.” Checkver is short for “check the version” and is the recognition
engine’s best guess at recognition for a file it would normally flag as unidentified. Checkver
files normally indicate that a machine has a new version of an application that is already in
the library, but that the new version has not yet been added to the library.

The 5 different recognition levels for files are indicated by different default color in the
Analysis Workbench, as shown in the following table. The colors can be customized, see the
section about Customizing the Font and Color on page 29.

Table 46 Customizing Recognition Level Colors in Analysis Workbench

Recognition Level | Type Default Color in Files Window
Recognized Main Red

Recognized Associated Green

Recognized 3rd Party Teal

Partially Recognized | Checkver Purple

Unrecognized Unknown Blue

Unrecognized Unprocessed Black

Unrecognized Auto-identified | Olive

Junk Junk Olive

Information about licenses and license relations can be found in an Applications window and
the associated Details window. For more information about Analysis Workbench, and how it is
used in application teaching refer to License Relations and Application Suites on page 146.

Application Recognition in XML Enricher

Application recognition is core to the enrichment process that takes place inside the XML
Enricher service. When the XML Enricher processes a scan file, it uses information in the
Software Application Library to provide more detailed information about the files and
applications detected on the scanned device.

The Software Application Library consists of one or more SAI files. See The Software
Application Library on page 257.

The XML Enricher reads scan files and outputs “enriched” XML scan files containing all of
the original data as well as data identified in the application recognition step.

Each file is stored as a <file> element. When a file is identified as belonging to an
application, two attributes are added to the element: versionid and type.

For example,
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<file name="winword.exe” size="12345" versionid="1111" type="M"/>

would represent a file named winword.exe identified as belonging to the application with a
version ID of 1111. The type of the file is “M”, which means Main file. The possible values for
the type field are:

Table 47 Type Tags in Enriched XML Files

Type “type” Tag in Enriched XML File
Main M

Associated Y

3rd Party 3

Unknown N

The versionid attribute refers to the unique ID associated with every version in the library.
In an enriched XML scan file, the <applicationdata> section contains a list of applications
identified on the machine along with the version IDs.

For example:

<applicationdata>
<recogconfig>
<sail name="C:\Documents and Settings\All Users\Application
Data\Hewlett-Packard\DDMI\SAI\master.zsai" desc="April Master SAI -
08/04/09" date="4/8/2009" type="Master"/>
<sail name="C:\Documents and Settings\All Users\Application

Data\Hewlett-Packard\DDMI\SAI\user.zsali" desc="User SAI File"
date="4/29/2009" type="User"/>

</recogconfig>

<application version="6.00.3790.3959"
release="6"
name="0utlook Express"
publisher="Microsoft"
language="English"
os="Windows Srv 2003"
type="Desktop communications software"
maindir="C:\Program Files\Outlook Express"
lastUsed="2009-05-05 01:54:28"
versionid="22002"
releaseid="372"
licencedby="22006"
licencedbyrelease="104"/>

<application version="6.00.3790.3959"
release="6"
name="Internet Explorer"
desc="Microsoft Internet Explorer"
publisher="Microsoft"
language="English"
os="Windows Srv 2003"
type="Internet browser software"
maindir="C:\WINDOWS\ie7"
lastUsed="2009-04-01 12:48:52"
versionid="22004"
releaseid="131"
licencedby="22006"
licencedbyrelease="104"/>

</applicationdata>
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The example above could be found for a machine with just two applications on it: Microsoft
Internet Explorer and Microsoft Outlook Express. The 1icensedby attribute indicates that
Microsoft Outlook Express is licensed by Microsoft Internet Explorer. In other words, while
both are licensable applications, this machine requires 1 license for Microsoft Internet
Explorer — with this license, no separate Outlook Express license is required.

The XML Enricher then proceeds to write the scan file in compressed XML File format (.xsf)
to its “processed” directory, adding information about recognized applications to the file data
and adding a separate application data section to the XML file.

After the enriched file is complete, scan file data is imported into the DDM Inventory
database. The data in the database is used by reports and the Scan Data Viewer. The enriched
scan files can be analyzed using the Windows Analysis Tools (Viewer, Analysis Workbench
and SAI Editor).

Further Information

You can find further information about the XML enricher in the “XML Enricher” chapter of
the Configuration and Customization Guide.

The Software Application Library

In this Section

e Types of Software Application Index Files on page 257
e Master SAls on page 257

e User SAIs on page 259

e Keeping SAI Files Updated on page 259

Types of Software Application Index Files

The storage mechanism that provides recognition information is implemented by using a file
format called the Software Application Index (SAI). The SAI enables the identification of files
and applications installed across a computer population.

Two types of SAI file are available:
e Master SAlIs
e User SAIs

Master SAls

These are produced by HP and form the backbone of your Software Application Library. A
Master SAI knows everything HP knows about applications and about the history of the
library, allowing you to apply a new Master SAI to your own database even if you have
changed/added/deleted from a User SAIL. A Master SAI is self-contained. It contains all
versions, applications, publishers, operating systems and application types referenced by the
library. You cannot produce or copy a Master SAI file for editing or making modifications.

Thousands of unique application versions are currently supported by the Master SAls.
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Master Library File Breakdown

The Master Library is distributed to you as a set of Master SAI files:

e Master.zsai contains English versions of software, language-independent application
versions, and language-neutral versions of Windows software.

e French.zsai contains French versions of Windows software.
® German.zsai contains German versions of Windows software.
¢ Unix.zsai contains English and language-neutral versions of UNIX software.

® BaseUnix0S.zsai contains language-neutral installed package rules for base UNIX/
Linux operating system packages.

Frequency of Recognition Library Releases

Recognition libraries for all languages are released once every month through the HP
Customer Support web site. Library updates are available without additional charge for all
customers under maintenance.

What to Do If Software is Unrecognized

Occasionally, DDM Inventory might not precisely identify the software application installed.
In this case it may be reported as “Unrecognized” if it is completely unknown or “Check
Version” if at least some information about the application files is available in the library
(Analysis Workbench only).

In these cases, the application should be taught to the User.zsai or added to the Master
Database.

If you encounter an unknown version and report it before the next monthly release, it can
typically be included in the next scheduled release of the library. If it needs to be included
right away, you can call HP Customer Support for assistance in using the Analysis Workbench
to teach the software immediately to a User.zsai file.

What to Do When You Get a New Master SAI File

Updates to the Master SAIs are provided as part of a Discovery Knowledge Update Package.

The contents of the SAI files are also available as HTML files from the HP Customer Support
web site.

The Discovery Knowledge Package contains the following SAI files:

® Master.zsai

® French.zsai

® German.zsai

® Unix.zsail

® BaseUnixOS.zsai

By default, DDM Inventory is configured to use the Master and UNIX SAI files.

To ensure that any other SAI files are included in the enrichment process, you will need to
configure the XML Enricher and restart the XML Enricher Service.

See the section entitled “Configuring the XML Enricher” in the Configuration and
Customization Guide for information on how to do this.
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Viewing Contents of a Master SAI File
The Master SAI is stored in an optimized proprietary binary form and can be displayed

directly in the SAI Editor.

This application is available via the Analysis Workbench User Interface or as a stand-alone
utility from the Start menu. For further information refer to Chapter 6, SAI Editor.

How HP Decides What Applications to Put in the Master SAI

HP’s goal is to include all currently supported mainstream software available on the market
in the Master SAI file. HP does not include applications developed by customers nor does HP
include beta versions of any application.

Priority is given to industry leading software publishers, but HP does address other
mainstream publishers as well. In some cases HP receives the software directly from
publishers. In other cases, HP borrows the software (only for the duration of the teaching
process) from customers who are interested in having it added to the library.

User SAls

User SAIs are custom libraries created using the Analysis Workbench or SAI Editor. The User
SAl is a Software Application Index created by you through the process of “teaching”
applications to the library. The User SAI may contain new or changed information from what
is contained in the Master SAI. For example, a locally produced application or the version
name of an application that is already known by the Master SAI.

Keeping SAI Files Updated

The Master SAI set, as supplied by Hewlett-Packard, provides a comprehensive database of
applications. However, if there are new, in-house, or home-grown applications that are not
being recognized, there is the ability to add new file entries to a separate User SAI file.

Using Analysis Workbench

Analysis Workbench provides a range of features enabling the Software Applications Index
(SAI) to be updated and maintained. This includes facilities to:

e Add new applications to the Software Applications Index to “teach” the software how to
recognize applications that are not identified with the default libraries.

e Enter grouping information to enable different versions of a main application to be
identified.

e Update the list to keep pace with new software releases from the numerous software
publishers.

Using SAI Editor

The SAI Editor is available as a standalone tool from the Start menu or from Analysis
Workbench, where it can be used to review and edit work on SAIs during a teaching session.

The SAI Editor enables you to:
e View and edit a collection of SAI files
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e Create new User SAls

e Move and copy item between SAIs

e Delete items in SAls

e Export the contents of an SAI to XML format, either as a summary or the entire contents.
e Display license relationships.

¢ Add and edit existing license relationships.

Using Express Teaching

You can teach applications in the DDM Inventory web Ul from a list of files that were not
recognized in an inventory scan. See Chapter 7, Application Teaching for more information.

Caveats When Creating and Moditying User SAI Files

A

It is extremely important to follow sound and consistent practices when you are creating or
modifying User SAI files in your environment. For this reason, the following information is
repeated in Chapter 7, Application Teaching.

As indicated, you can create and modify User SAI files with the analysis tools and modify
them by the Express Teaching method. When you create or modify User SAI files, irrespective
of the teaching method that you use, you must consider issues that may arise regarding
potential ID and content clashes.

Problems are likely to occur in the following situations:
e There is more than one librarian teaching applications.
e The SAI files are maintained in more than one location.

e The SAI files need to be deployed to more than one DDM Inventory server (for example, in
an aggregated environment).

The following guidelines should help you avoid these problems:

e Provide unique SAI IDs and file names across the entire organization. You cannot deploy
different SAIs that have the same ID.

e Configure the same set of SAI files for all DDM Inventory servers within an aggregated
environment to provide consistent recognition.

e Modify SAI files in one place regardless of the teaching method. You can modify the SAI
file on an administrator’s computer where the client tools are installed or on a DDM
Inventory server using either the client analysis tools or the Express Teaching method.

e After an SAI file is modified in one place, do not modify it on another machine. Instead,
replicate the file regularly so that new changes are available on all machines.

The use cases presented in the following sections reinforce the problems that can occur and
the best practices to use to avoid these problems.

See Chapter 7, Application Teaching for specific considerations related to application teaching
on multiple client machines or in an aggregated environment.
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Additional Information

As a customer of DDM Inventory, you are well aware of the value a complete inventory of your
computer population has to your business. One common use of the collected data is to manage
your computer assets, including licenses for software used in the organization.

DDM Inventory utilizes a unique heuristic algorithm to identify all software installed on each
machine in the population. Rather than using notoriously unreliable sources of information —
such as the Windows registry or the version information sometimes embedded inside
executables — the recognition algorithm uses a custom built library of applications and
employs an adaptive algorithm to determine whether a given application is present based on
data such as file names, executable types, sizes, signatures, etc.

For this reason, it is imperative that the library is as complete and as up-to-date as possible.
HP’s Application Librarians are working constantly to update and expand the library.

What Does This Mean for You?

After you perform a complete software inventory scan of your devices, some applications may
not be reported. DDM Inventory uses many approaches to collect software inventory data,
from collecting information reported by the operating system to fully automated software
recognition. Software recognition is a cornerstone of DDM Inventory’s capabilities. HP
maintains an extensive Software Application Index (SAI) and updates it on a regular basis.

Due to its nature, recognition requires an application to be “known.” This means that the SAI
must contain at least one of the following three items: (1) an entry for the specific version of
the application, (2) an entry for a specific platform in the file-based section, or (3) a rule for
the application in the rule-based section (provided that the application is available from the
vendor in a native package format such as RPM, BFF, or MSI).

To enable the inventory of a specific application that is not currently recognized, you have
three choices:

e Ifthe application is a popular business application, and you believe that it should be
recognized out-of-the-box or that other DDM Inventory users would also benefit from
having the application recognized, you can submit an enhancement request to HP. HP
provides monthly updates to the library, so such requests are reviewed promptly.

When the Application Librarians add a requested title to the library, they may require the
original installation media. This is used to install and scan the software so that it can be
added to the Master SAI. If you are not able to share this media, and HP does not have an
appropriate agreement with the application manufacturer, it may be possible to add the
application using a scan file.

After the application is added, the updated Master SAI will automatically be made
available for download from the HP Software Support web site.

’ Note that not all applications will be accepted, and not all applications lend themselves to
file-based or rule-based recognition.

e Ifthe application is specialized in nature, and it is not a good candidate for addition to the
Master SAI, you can use the tools provided with DDM Inventory to add the application to
a “User SAI” file. DDM Inventory has a variety of tools to assist in this process, and most
customers should expect to perform at least some application teaching.

®  You can contact HP Professional Services or an HP Partner to obtain assistance in adding
applications to a User SAI.
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HP is constantly adding new applications and vendors to the Master SAI to ensure maximum
out-of-the-box value for all of its customers. As a result, HP’s focus is on common applications
that are in general use (such as Microsoft Office), high value applications that require
accurate tracking to optimize costs, and certain industry-specific applications.

HP is always looking for feedback and guidance from our customers — even if you have added
an application to a User SAI, you can still file an enhancement request to have the
application added to the Master SAI

Chapter 5



6 SAl Editor

The SAI Editor enables you to:

e View a collection of Software Application Index (SAI) files
e Edit User SAls

¢ C(Create new User SAls

e Move and copy items between SAls

¢ Delete items in SAls

e Import data from an MSI file, an MSI scanner result file, a recognition result, or a scan
file comparison

e Export the contents of a User SAI to XML format, either as an XML Summary or in its
entirety

This chapter describes the features of the SAI Editor and explains how to explore and modify
the contents of a User SAI. For more detailed information about using the SAI Editor to
“teach” new applications, see Chapter 7, Application Teaching.

) The SAI editor is a standalone tool. If the SAIs change on the DDM Inventory server, the
Administrator must update the SAIs on all systems where the client tools installed.

Starting the SAI Editor

The SAI Editor can be started in two ways:
¢ From the Recognition > View/Edit SAls menu item in the Analysis Workbench

¢ As a standalone utility from the Windows Start menu

The SAI Editor User Interface

In This Section

e QOverview Tab on page 264
e Kditor Tab on page 265
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Overview Tab

The Overview tab shows the SAIs loaded and details of the data items contained in them.

PR Uzer-E ditable Software Application Index E

| Editer |

The lizt below shows the loaded 54l files along with information about how much data iz in each.

S8 File | Sl D | File namesz | Werzions | .ﬁ.pplicatinnsl P'ul:ulishersl A elations |
|lzerzzai 1] 1] 1 3 3 1]
b azter. zzai n'a 1298531 15112 46493 1143 2352
auto.zzai 1 1] 1] 1 1 1]

1| | »]

Save | Reload... Cloze |

) The Overview tab is only visible when you start the SAI Editor from within the Analysis
Workbench application.

The following details are shown for each of the SAI files loaded:
e SAl File—Name of the SAI file.

¢ SAlIID—Unique ID for the SAI file. This is relevant to User SAI files only. Master SAIs do
not have an ID.

* File Names—Number of file names contained in the SAI.
e Versions—Number of software versions in the SAI.

e Applications—Number of applications in the SAI.

e Publishers—Number of publishers in the SAI

e Relations—Number of license relations in the SAI.

Right-Click Menus

If you right-click an entry on the Overview tab, the Export summary to XML option is available.
By default, the XML summary is saved to the following file:
<DataDir>\SAI\user.xml

Here <DataDir> is the DDM Inventory data folder (see Conventions Used in this Document
on page 4).

See the Example of a Summary XML Export on page 304 for further information.

Buttons on the Overview Tab

There are three buttons on this tab:
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e Save—Saves any modifications made to the User SAls.

e Reload—Discards any unsaved changes to the User SAls, reloads the existing ones from
disk, and re-organizes all affected file entries.

e Close—Closes the application and causes re-recognition to occur.

Editor Tab

The Editor tab is where you can see the contents of the SAI files in detail. In addition, you can
perform many tasks here.

- {;Ej AccentSoft

- & Access Developments -
1| | v
| | | | |

) The screenshot shown here is of the standalone SAI Editor. The main menu bar is not
available in the built-in SAI Editor of the Analysis Workbench.

‘ Software Application Index [SAl] Editor Hi=] E3
File Edit Tools Help
Toolbar —— 2 [0 &% o | [E& | Sub Tabs |
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= el
= File [term | Size | Sighatu
Mazterzzai | = 4@ Apil Master 541 - 03,/04409 C:A\Documents and Settirﬂ
s .E il b aste - &3 3Com
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== Software - &3 TthLevel
= Applicati... - £ b Initio Software
- &3 ABBYY Software House
Left G- £ Abilty Plus Saftware
Navigation — - & Abranus
Pane - &3 ABT
-- {EI Academpsoft
G- & Accelwiare
.
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The Left Navigation Pane

The left navigation pane for this tab shows an icon list of the SAI files that can be viewed. The

following icons are used to represent User and Master SAI files.
Table 48 Icons in the SAI Files List

Icon

Description

B

This icon represents a User SAI file

o

This icon represents a Master SAI file

Click the icon to view the contents of that particular SAI file.

Right Click Options for the Left Navigation Pane

The following menu items are available when you right-click an SAI file icon in the left

navigation pane:

Table 49 Right-Click Menu Items for the SAI Files List

Further
Menu Item Description Information
New User SAI Enables you to create a new page 273
empty User SAI file.
Export SAI to XML | Opens the SAI XML Export page 303
dialog box, which enables you
to export the contents of the
selected User SAI file to XML
format.
Unload SAI Unloads the selected SAI from | N/A
the SAI Editor.
Edit Description This option is only available for | N/A

User SAl files. It enables you to
change the label associated
with this file.
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The Editor Tab Toolbar

The following toolbar icons enable you to access various SAI Editor commands. When the
mouse pointer passes over an icon, a tool tip indicates the command that corresponds to that

icon.
Table 50 Editor Tab
Further
Icon Description Information
= Create a new empty User SAI page 273
(=] Save changes made to User SAI files N/A
o f}xport the contents of a User SAI in XML page 303
ormat
) Search for entries in an SAI file page 302
E Set SAI Editor options page 271
Sub-Tabs on the Editor Tab
The Editor tab consists of the following eight sub-tabs:
Table 51 Sub Tabs on the Editor Tab
Sub Tab Further Information
All Contents page 274
Files page 285
Application Types page 288
Operating Systems page 289
Languages page 291
License Relations page 292
Package Rules page 298
Version Data Rules page 300
The Application Types, Operating Systems and Languages sub-tabs are static pages and are

pre-populated by Hewlett Packard. You can, however, add new items to the Application Types

and Operating Systems sub tabs for your User SAI.
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Icons Used on the Editor Tab

The SAI Editor displays a hierarchical structure of software publishers, application names,
releases, application versions, and files contained in the SAI files. The following icons are

used to represent these items.

Table 52 Icons Used on the Editor Tab

Icon Description

All Contents Tab

8 Software Publisher
This is the name of the company or corporation that released the software
application. For example, Hewlett-Packard is a software publisher.

| Application Name

This is the name of the software program. For example, DDM Inventory is an
application name.

Release

When a publisher releases updates for an existing version of one of their
products, they typically don't change the name of that version. Any particular
version of a product could have several updates to it. In this scenario, the SAI
Editor refers to the umbrella version as the Release, and to each of the
updates as an application Version.

o]

Application Version
See description above

[

File
Each file is categorized as Main, Associated, or 3rd Party.

Files Tab

[

File

Each file is categorized as Main, Associated, or 3rd Party.

[m}

Main File

This is a key application file—that is, a file without which the application
could not be running. It should always be present whenever the application is
installed regardless of whether it is a minimum or complete installation.

Associated File

This is a non-key file that is part of the application and is written by the
publisher that developed the product.

3rd Party File

This is a file written by another Publisher (3rd Party) and is used in the
current application. An example of 3rd party files is some DLL files that are
technically used by the application but are also distributed freely and can be
used by other applications.

Application Types Tab

Chapter 6



>»

SA/ Edlifor

Table 52 Icons Used on the Editor Tab

Icon Description

This icon represents the different applications software categories (for
example, word processor and spreadsheet).

Operating Systems Tab

.jé& This icon represents Operating Systems.

Languages Tab

®

This icon represents languages.

License Re

lations Tab

&

Indicates that this application also licenses another application.

&

Indicates that this application is licensed by another application.

&

Indicates that this application both licenses and is licensed by another
application.

Package Rules Tab

B

This icon represents installed package rules.

Version Da

ta Rules Tab

B

This icon represents version data rules.

The following buttons are available only when you start the SAI Editor from the Analysis

Workbench.

Buttons on the Editor Tab
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Table 53

Buttons on the Editor Tab

Button Function

Save Saves any modifications made to the User SAI

Reload Discards any unsaved changes to the User SAI, reloads the existing one from
disk, and re-organizes all affected file entries.

Close Closes the SAI Editor. If you have made any changes, the SAI Teaching

Options dialog box is displayed. Set the teaching options as follows:
e Recognition
Use level 3 heuristics—SAI teaching uses the same recognition method
that is used during the loading process.
— If Level 3 heuristics are enabled, teaching a single file will reprocess
all files on all machines on which that file occurs.

— If Level 3 heuristics are disabled, teaching a single file will cause all
files in all directory/machine combinations where the file occurs to be
re-recognized.

e Save changes to SAI

— When AW exits—Any changes to the SAI are saved when you exit the
Analysis Workbench application.

— Immediately—Any changes to the SAI are saved immediately.
e Tag changed items

Selecting this option makes the following further options available:

— Files—Any files that are affected by the SAI teaching are tagged.

— Applications—Any applications that are affected by the SAI teaching
are tagged.

— Directories—Any directories that are affected by the SAI teaching are
tagged.

— Machines—Any machines that are affected by the SAI teaching are
tagged.

— Set Local Tags—If this option is selected, Local Tags are used for the
operations.

— Set Global Tags—If this option is selected, Global Tags are used for the
operations.

e Set options as default

Select this box to retain these settings as the default for future Close
operations.
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Incremental Search

You can use the incremental search feature to locate an entry in the tree. To perform an
incremental search, click the tab that you want to search, and type the word(s) or number(s)
that make up the entry that you want to locate. The window automatically locates the closest
existing value in the currently visible nodes in the tree.

For example, highlight the Master SAI file in the left navigation pane. Click the All Contents
tab, and type Microsoft. The Microsoft publisher node is located and highlighted.

The entry that you want to locate must be visible in the tree—it cannot be in a branch that is
currently collapsed. For example, if only Publisher nodes are visible in the tree on the All
Contents tab, you can only search for publishers. If you expand a Publisher node, you can also
search for applications associated with that publisher.

It is necessary to type quickly to perform an incremental search. If you type too slowly, the
search may not produce the result you expect. For example, if you type M and then wait a
second or two, the first publisher beginning with “M” will be highlighted. If you then type I,
the first publisher starting with “I” will be highlighted.

Sorting Entries in a Column

Click the column heading to sort the contents of that column. The default sort order is
ascending. This command sorts text alphabetically, numerically, or by date in ascending or
descending order. Click the column heading to toggle the sort order.

Moving Columns to a New Position

Columns on the Editor tab can be moved to any position on the page. To do this, drag the
column heading to the location you want.

Setting Properties for the SAI Editor

In This Section

e Opening the SAI Editor Options Dialog Box on page 271

e The General Tab on page 272

e The SAI List Tab on page 272

e Adding a New SAI File for Application Recognition on page 273
e Removing an Existing SAI File on page 273

e Creating a New Empty User SAI on page 273

Opening the SAI Editor Options Dialog Box

To open the SAI Editor Options dialog box, click the SAl Editor Options [ icon on the toolbar
on the Editor tab. There are two tabs in this dialog box:

e The General Tab on page 272
e The SAI List Tab on page 272
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The General Tab

The General tab enables you to set the following options:
e Show ID Column

Checking this option will display an ID column in all the tabs. IDs are assigned to each
entry in the User SAI. When you copy or create an entry, a new ID is assigned to that
entry.

® Hide items without files (in read-only SAls)

This option provides you with a cleaner view. It hides any entries that are empty—that is,
entries that do not have files in them. This option is for the Master SAI only.

e Automatically save modified SAls on exit

All modifications made to the User SAls will be automatically saved when you exit the
SAI Editor application.

®* Re-enable all error messages

Checking this option will re-enable all error messages that you have previously disabled.

The SAI List Tab

The options on the SAI List tab enable you to:
¢ Add a new SAI file to be viewed or edited.
¢ Remove an existing SAI file.

e Create a new empty User SAI file.

The list box on this tab displays the following information for all currently loaded SAlIs:
Table 54 SAI List Tab Columns

Column Name | Contents

SAI file The path to source files for the SAI—both read-only Master SAls and
User SAI files.

SAI ID The SAI ID number for User SAI files. Master SAI files do not have an
ID.

Description A description of the SAI files.

Size/kB The size of each SAI file (in kilobytes).

Versions The number of application versions in each SAI.

Type The type of SAI file:

e Master SAI - Read-only SAI
e User SAI - Editable SAI

Date The creation date for a Master SAI file or for a User SAI, the date the file
was last saved.
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Storing Rule-Created ltems

Any items encountered by the SAI Editor that were created by rules will be added to the SAI
file specified in the SAls used to store rule-created items box. These rules are present within the
SALI files themselves. You can add more rules by using the SAI Editor.

To specify the SAl file used to store rules that you create:

Select the SAI file from the drop-down list. The drop-down list contains a list of the SAls
currently loaded.

If this field is left blank, the SAI Editor will create a file called Auto.zsai and put this in the
same location as the first Master SAI.

For information about application teaching using rules, see Rule-Based Application Teaching
on page 373.

Adding a New SAI File for Application Recognition

In addition to any SAI files already listed on the SAI List tab in the SAI Options dialog box,
you can specify one or more other SAI files to use for application recognition.

To add a new SAl file for application recognition:

1 In the SAI Editor Options dialog box, select the SAl List tab.
2 Click the Add button on this tab.
3 Navigate to and select the SAI file (Master or User) that you want to load.

The SAI file is added to the list box which means the file will be included in the SAI Editor
ready for you to view or edit.

Removing an Existing SAI File

You can remove any of the SAI files listed on the SAI List tab in the SAI Options dialog box.
When you remove an SAI file, it is no longer available in the SAI Editor.

To remove an existing SAl file:

1 In the SAI Editor Options dialog box, select the SAl List tab.
2 In the list box, select the SAI file that you want to remove.
3 Click the Remove button.

Creating a New Empty User SAl

By using the SAI Options dialog box, you can create a new and empty User SAI file. This file
will then be available for editing in the SAI Editor.

To create a new empty User.zsai file:

1 In the SAI Editor Options dialog box, select the SAl List tab.

2  Click the Create button. The Create a User SAl dialog box opens.

3 Enter or navigate to the directory where the SAI file is to be created.
4

Enter a description for the file.
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Click the OK button.

The file is automatically assigned a unique ID. However, you may already have an SAI
with the same filename. If so, a confirmation message will be displayed. If this happens,
choose one of the following options:

— Click Yes if you want to overwrite the existing SAI file.
— Click No to return to the dialog box and assign a new ID to the SAI file.

If you have made modifications to the cfgNextSAIID setting in the Analysis
Workbench.ini file, you may see the following message:

The next User SAI ID cannot be found in the settings file.

This probably means that you are using User SAIs created with a different version of the
software, or created on a different machine.

Please take care to set the new ID to a value that is unique across your organization.

This happens when the value for the ID in the Analysis Workbench. ini file is missing
or lower than the highest ID in the user SAls currently loaded. This message is for
information only—the DDM Inventory components will correct this situation
automatically by inserting the correct ID value into the Analysis Workbench.ini file.

The All Contents Tab

The All Contents tab displays a a hierarchical structure of software publishers, application
names, releases, application versions, and files contained in the SAI file.

Viewing Information in the All Contents Tab

4

Click the + (plus) sign next to a Publisher & to expand the tree.
All the Applications by that software publisher are shown.

Expand an Application [ to display the Releases for it.

Expand a Release |__hl to display the Versions of that particular software application
release that are in the database.

Expand a Version 8 of the software to display the Files D for that version.

The following information is shown in the columns:

Size - The size of the file
Signature - The signature is a checksum of the first 8 Kilobytes of a file.
Exe Type - This indicates the type of the executable (for example, Win32 exe).

Relation - Whether the file is a Main, Associated, or 3rd Party file. See Viewing
Information on the Files Tab on page 285 for definitions of these terms.
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¢ ID - The unique identifier for that particular entry. This column is only shown if you
selected the Show ID Column option in the SAI Editor Options dialog box. See page
Setting Properties for the SAI Editor on page 271 for further information.

If none of the files identified for a particular version has the relation of Main file for that
version, the version will be displayed in red in the SAI Editor to highlight this fact. The
reason to flag this condition is that if a version does not have one or more Main files, the

application will not be recognized. So you must identify one or more files with the relation of
Main if you want application recognition to occur. There are only a few cases when it makes
sense to teach an application without a Main file. These would include, for example, a set of
drivers or internal utilities for which it is convenient to have corresponding files recognized,

but it is not important to report them as individual applications.

Right-Click Menus

Different right-click menus are available for different nodes of the Publisher tree.

Table 55 Right-Click Menus

Node

Menus Available

# Root - the User SAI

New Item

& Publisher

Delete
New Item
Properties

1 Application

Edit Application Rules
Delete

New Item

Properties

DI Release

Explore License Relations
Delete

New Item

Properties

l.j_:ﬂ_hl Version

Delete
New Item

Properties

[ File

Delete
Properties

Relationship to Application

Master SAls are read-only, so menu items relating to editing the SAI content are disabled for

Master SAIs.

Adding a New Publisher

SA/ Edlifor

This procedure is used to add a new software publisher to a User SAI
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To add a new software publisher to a User SAI:

1 Right-click the root User SAI File entry in the tree. It is the first entry (the root) of the tree.

All Contents | Files I Application T_I,Ipesl

Itern

= =2 Uzer SAl File Right-click here
] &3 3Com

- aBT

- &3 Activision

- &3 Adobe

- &3 Campbell Services

-ﬂ‘:j Europrezs Software

2 Select the New Item option.
The Publisher Properties box is displayed.

3 Enter the Name and Description for the new software publisher.

0 Ensure that the Publisher Name is spelled correctly. Before adding a publisher name to
the file, check whether the entry for the publisher already exists in the Master SAI file.

4 If the publisher already exists in the Master SAI, copy it from the Master SAI to your
User SAI

Deleting an Existing Publisher

This procedure is used to delete an existing software publisher from a User SAI.

To delete an existing publisher:

1 In the tree, right-click the software publisher to be deleted.

2  Select the Delete option or hit the Delete key on your keyboard.
A confirmation message is displayed.

3 Click Yes to delete the software publisher and all its associated sub-items.

Editing the Properties for an Existing Publisher

This procedure is used to edit the properties for a software publisher.
1 In the tree, right-click the software publisher to be edited.
2  Select the Properties option.
The Publisher Properties box appears.
3 Edit the details as required.
4 Click the OK button to complete the edit.
Once the publisher details have been edited, the amended details are displayed in the tree.

Chapter 6



Merging the Contents of Publishers

You can merge the contents of a software publisher with another publisher within the same
SAI so that they contained under the same entry. You would do this, for example, if a software
publisher has been acquired by another company.

To merge the contents of publishers:

1 Drag and drop the publisher onto another publisher entry in the tree.
A confirmation dialog box is displayed.

2  Click the OK button to accept the merge.

Copying Publisher Contents to Another User SAI

You can merge the contents of a software publisher to a different User SAI.

To copy a publisher to another SAI:

Drag and drop the publisher into the appropriate User SAI entry in the left hand pane of the
Editor.

The publisher entry is copied to the other SAIL. This will only copy the publisher information.
If you want to copy the file-level data to the other User SAI, you should select the files that
you want to copy and then drag and drop the data into the appropriate User SAI.

) Alternatively, you can hold down the CTRL key and drag the publisher to another SAI. This
will result in a “deep” copy that will copy the publisher and all of its child items (applications,
releases, versions, and files).

Moving the Contents of a Publisher to Another Publisher Within the Same SAI

You can move the contents of a publisher to another publisher within the same SAI.

To move the contents of a publisher to another publisher within the same SAI:

1 Select the applications under the publisher and drag them to the publisher to which you
want to move them.

A confirmation dialog box is displayed.

2  Click the OK button to accept the move.

Adding a New Application

This procedure is used to add a new software application to a User SAIL

To add a new software application to a User SAI:
1 Right-click the appropriate software publisher entry in the tree.
2  Select the New Item option.

The Application Properties box is displayed.

3 Enter the Name and Description for the new software publisher.
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4 From the Application Type drop-down list, select the software category that the application
falls under (for example, word processor software or spreadsheet software).

Ensure that the Application Name is spelled correctly. Before adding an application name to
the file, check whether the entry for the application already exists in the SAI file.

Deleting an Existing Application

This procedure is used to delete an existing software application from a User SAI.

To delete an existing application:

1 In the tree, right-click the software application to be deleted.

2  Select the Delete option or press the DELETE key on your keyboard.
A confirmation message is displayed.

3 Click Yes to delete the software application and all its associated sub-items.

Editing the Properties for an Existing Application

This procedure is used to edit the properties for a software application.

To edit the properties for an existing application:
1 In the tree, right-click the software application to be edited.
2 Select the Properties option.
The Application Properties box appears.
3 Edit the details as required.
4 Click the OK button to complete the edit.
After the application details have been edited, the amended details are displayed in the tree.

Editing the Application Rules

Application rules are used for software recognition. You can teach DDM Inventory how to
recognize a new application — or a new version of an existing application — by creating
recognition rules.

To edit an application’s rules:

1 In the tree, right-click the software application that you want to work with.
2 Select Edit Application Rules. The Application Rules Editor opens.
3 Choose one of the following actions:

a To modify an existing rule, select the rule, and click Edit.

b To create a new rule, click Add.

c¢ To delete an existing rule, select the rule, and click Remove.

See the Rule-Based Application Teaching on page 373 for information about creating and
modifying recognition rules.
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Merging Applications Within the Same SAl

You can merge the contents of an application with another application within the same SAI so
that they are contained under the same entry.

To merge the contents of applications:

1 Drag and drop the application onto another application entry in the tree.
A confirmation dialog box is displayed.

2  Click the OK button to accept the merge.

Copying an Application to Another User SAI

You can copy a software application to a different User SAI

To copy a software application to another SAI:

Drag and drop the application into the appropriate User SAI entry in the left hand pane of the
Editor.

The application and the publisher entries are copied to the other SAIL If the publisher for this
application does not already exist in new User SAI, it will be copied into it automatically.

) Alternatively, you can hold down the CTRL key and drag the application to another SAI. This
will result in a “deep” copy that will copy the application and all of its child items (releases,
versions, and files).

Moving an Application to Another Publisher Within the Same SAI

You can move an application to another application publisher within the same SAI

To move an application to another publisher within the same SAI:

1 Select the application and drag it to the publisher you want it moved to.
A confirmation dialog box is displayed.

2  Click the OK button to accept the move.

Adding a New Release

This procedure is used to add a new software release to a User SAI

To add a new software release to a User SAI:
1 Right-click the appropriate software application entry in the tree.
2 Select the New Item option.

The Release Properties box is displayed.

3 Enter the Name for the new software release.

0 Ensure that the Release is spelled correctly. Before adding a release to the file, check whether
the entry for the release already exists in the SAI file.
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Deleting an Existing Release

This procedure is used to delete an existing software release from a User SAI.

To delete an existing release:

1 In the tree, right-click the software release to be deleted.
2 Select the Delete option or hit the Delete key on your keyboard.
A confirmation message is displayed.

3 Click Yes to delete the software release and all its associated sub-items.

Editing the Properties for an Existing Release

This procedure is used to edit the properties for a software application.

To edit the properties for an existing release:

1 In the tree, right-click the software release to be edited.
2 Select the Properties option.
The Release Properties box appears.
3 Edit the details as required.
4 Click the OK button to complete the edit.

After the release details have been edited, the amended details are displayed in the tree.

Merging Releases

You can merge the contents of a release with another release within the same SAI so that they
are contained under the same entry.

To merge the contents of releases:

1 Drag and drop the release onto another release entry in the tree.
A confirmation dialog box is displayed.

2  Click the OK button to accept the merge.

Copying a Release to Another User SAI

You can copy a software release to a different User SAI.

To copy a software release to another SAI:

Drag and drop the release into the appropriate User SAI entry in the left hand pane of the
Editor.
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The release, application name and publisher are copied to the other SAI. If the publisher and
application for this release do not already exist in new User SAI, they will be copied into it

automatically.

’ Alternatively, you can hold down the CTRL key and drag the release to another SAI. This will
result in a “deep” copy that will copy the release and all of its child items (versions and files).

Moving a Release to Another Application Within the Same SAI

You can move a software release to another application within the same SAI.

To move a software release fo another application within the same SAI:

1 Select the release, and drag it to the application to which you want it moved.

A confirmation dialog box is displayed.

2  Click the OK button to accept the move.

Adding a New Version

This procedure is used to add a new software version to a User SAI.

To add a new software version fo a User SAI:

1 Right-click the appropriate software release entry in the tree.

2 Select the New Item option.

The Version Properties box is displayed.

3 Enter the following details for the new software version.
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Name

Name of the new version (must be entered)
Description

This is a user defined field that can contain any text.
Install Strings

This is the text that the installer of the program uses to describe the software in the
Control Panel > Add/Remove programs (Windows prior to Windows Vista), Control Panel
> Programs and Features (Windows Vista), or the operating system package manager
(UNIX/Mac OS X).

Normally there is only one install string, which is entered on the first line of the entry
field. Occasionally, it may be necessary to make a match based on multiple install
strings. For example, if you add a service pack for a product, there may be an install
string for the service pack, in addition to the install string for the product itself. In
this case, the install string match should be based on both install strings. You can
enter additional install strings on the subsequent lines of this entry field.

The install strings can also be found from the Hardware and Configuration tab and
the Operating System Data and Operating System Installed Application Description
columns for the Windows applications.

Operating System
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The Base Operating System of the application version (for example, Windows Vista).
Select the Base OS from the drop-down list.

°* Language

Select the language of the application version from the drop-down list.

4  Click OK to add the new software version to the SAI file.

0 Before adding a software version, check whether the entry already exists in the SAI file.

Deleting an Existing Version

This procedure is used to delete an existing software version from a User SAIL

To delete an existing version:

1
2

In the tree, right-click the software version to be deleted.
Select the Delete option or hit the Delete key on your keyboard.
A confirmation message is displayed.

Click Yes to delete the software version and all its associated sub-items.

Editing the Properties for an Existing Version

This procedure is used to edit the properties for a software version.

To edit the properties for an existing version:

1
2

3
4

In the tree, right-click the software version to be edited.
Select the Properties option.

The Version Properties box appears.

Edit the details as required.

Click the OK button to complete the edit.

After the version details have been edited, the amended details are displayed in the tree.

Merging Versions

You can merge the contents of a version with another version within the same SAI so that
they are contained under the same entry.

To merge the contents of versions:

1

Drag and drop the version onto another version entry in the tree.

A confirmation dialog box is displayed.

2  Click the OK button to accept the merge.
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Copying a Version to Another User SAI

>»

You can copy a software version to a different User SAI.

To copy a software version to another SAI:

Drag and drop the version into the appropriate User SAI entry in the left hand pane of the

Editor.

The version, release, application name and publisher are copied to the other SAIL. If the
publisher, application and release for this version do not already exist in new User SAI, they
will be copied into it automatically.

Alternatively, you can hold down the CTRL key and drag the version to another SAI. This will
result in a “deep” copy that will copy the version and all of its child items (files).

Moving a Version to Another Release Within the Same SAI

You can move a software version to another release within the same SAI.

To move a software version to another release within the same SAl:

1

2

Select the version entry and drag it to the release you want it moved to.

A confirmation dialog box is displayed.

Click the OK button to accept the move.

Adding a File
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There are two methods of adding a new file to a User SAI.

Method 1—Add a new file to a User SAI using the Editor:

1
2

Right-click the appropriate software version entry in the tree.

Select the New Item option.

The Filename box is displayed.

Enter the name of the file and click the OK button. The File Properties dialog box is
displayed.

Enter the following details for the file:

Size
The size of the file
Care about Size

When this option is enabled, the size of the file is used as a recognition criterion.
When disabled, file size will not be used in recognition, and N/A will be displayed in
the size column.

Be careful when disabling this setting, especially for main files. If the setting is
disabled, only the match on the file name is needed to produce a good file match — and
if the file is main, simply the presence of the file in the scan file will cause the
application to be recognized.
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® Relation to App

Whether the file is a Main, Associated or 3rd Party file. See Viewing Information on
the Files Tab on page 285 for definitions of these terms.

® Signature
The signature is a checksum of the first 8 Kilobytes of a file.
If the signature is unknown, use FFFF-FFFF.
® Exe File Type
The type of executable file (for example, Win 32 exe or Archive).
5 Click OK to add the new file to the SAL

0 Ensure that the file name is spelled correctly. Before adding the file, check whether it already
exists for this version.
Method 2—Add a new file to a User SAI using Windows Explorer:

Using Windows Explorer you can automatically add the file to the software version.
1 In Windows Explorer, navigate to the file you want to add.

2 Drag the file onto the version in the SAI Editor. The file will be added to the version
automatically with the properties details filled in. These properties can be amended as
necessary - see Editing the Properties for Files in the Files Tab on page 287 for
information on how to do this.

Deleting an Existing File

This procedure is used to delete an existing file from a User SAIL

To delete an existing file:

1 In the tree, right-click the file to be deleted.
2 Select the Delete option or hit the Delete key on your keyboard.
A confirmation message is displayed.

3 Click Yes to delete the file.

Editing the Properties for an Existing File

This procedure is used to edit the properties for a file. For more information, see Editing the
Properties for Files in the Files Tab on page 287.

Copying a File to Another User SAI

You can copy a file to a different User SAIL

To copy a file to another SAl:

Drag and drop the file into the appropriate User SAI entry in the left hand pane of the Editor.
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The file is copied to the other SAI. If the publisher, application, release and version for this file
do not already exist in new User SAI, they will be copied into it automatically.

) You can select multiple files by pressing the SHIFT key and clicking on the files.

Moving a File to Another Version Within the Same SAI

You can move a file to another version within the same SAI.

To move a file to another version within the same SAI:

1 Select the file entry and drag it to the version you want it moved to.
A confirmation dialog box is displayed.

2  Click the OK button to accept the move.

Setting Relationship to Application

This procedure enables you to change the relationship of multiple files to the application. To
change the relationship of one file to the application, see the Editing the Properties for Files
in the Files Tab.

To set relationship to application:

1 In the tree, right-click the file(s) to be edited. To select multiple files, hold down the Shift
key while clicking on the files.

2 Select the Relationship to Application option.
3 Select one relationship from the Main, Associated, and 3rd Party options.
See Viewing Information on the Files Tab on page 285 for definitions of these terms.

After you edit the file details, the amended details are displayed in the tree.

The Files Tab

In This Section

e Viewing Information on the Files Tab on page 285
e Editing the Properties for Files in the Files Tab on page 287
) You can only edit User SAI files.

Viewing Information on the Files Tab

Click the + (plus) sign next to a File [ to expand the tree.
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All the instances of that file in the SAI are shown:

l Software Application Index [SAl] Editor Mi=]
File Edt Taoolz Help
= N
,_D g;ﬂ;_ﬁsai: User | All Contents  Files | Application Types I Operating Systems I Languages I Lici 4 I k I
= e
= File name ¢ I Size | Sighature | Exe type | Fublizh
- s i e = — 5 -
= Master.zsai 1 le_weify. dll —I
_- April Maszter - ]
=1 54l - 03/044 | [LIMEENE
. | rumba.exe
= gi}‘f;;fa' | rumba. exe 14686 FFFF-FFFF Unknown
= Application | | rumba. exe 13280  FFFF-FFFF  Unknown hdic
Associated | rurmba.exe 14734 FFFF-FFFF  Unknown Mic
File | rurmba.exe 9728 FFFF-FFFF Unkrown Mic
| rurmba.exe 10512 FFFF-FFFF  Unknown % [T
Main File | rumba.exe 3135 FFFF-FFFF Unknown Mic
| rumba.exe g208  FFFF-FFFF  Unknown hic
Eil | rumba.exe 169504 O074F-2E8C  ‘“Win 16 Exe i
iles | rumba.exe 168864  FFFF-FFFF  Unkrown Mic
| rumba.exe 169504 FFFF-FFFF  Unknown hic
| rumba.exe 178832 FFFF-FFFF Unknown hic
A m] rumba,ese 168272 FFFF-FFFF Unknown hic
M- rumbaZrumba. exe ==
B- rumbad.dl
Third Party & rumbal.dl 29696 C411-CEEF  ‘Win 32 Exe [Eb
File - 5 rumbal.dl 29696 C411-CEEF  ‘Win 32 Exe [Eb
-- ruriba3d. dll
-- rurnbad 00, fan
-- ruribaad. adw -
1| | r
| il Master 541 - 08/04/09 | Micro Focus [NetManage] | Rumba Office | 2 |1 [English - Windows Sx/NT
The following information is shown in the columns:
¢ The relation of the file to the application. This is indicated by the following icons:
[i] Main File
This is a key application file, that is, it is a file without which the application could not
be running. It should always be present whenever the application is installed
regardless of whether it is a minimum or complete installation.
El Associated File
This is a non-key file that is part of the application and is written by the publisher
that developed the product.
& Third Party File
This is a file written by another Publisher (3rd Party) and is used in the current
application. An example of a 3rd party files is some DLL files that are technically used
by the application, but are also distributed freely and can be used by other
applications.
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Filename—the name of the file.
Size—the size of the file.
Signature—the signature is a checksum of the first 8 Kilobytes of a file.

Exe Type—the type of executable file (for example, Win32 exe, Linux x86 ELF, or SPARC
ELF).

ID—the unique identifier for the file entry. This column is only shown if the Show ID
Column option was enabled in the SAI Editor Options dialog. See Setting Properties for
the SAI Editor on page 271 for more information.

Publisher—the publisher of this file.

Application—the application that this file belongs to.

App Type—the type of the application (for example, Word Processor or Spreadsheet).
Release—the software release that this file belongs to.

Version—the software version that this file belongs to

Language—the language of the application version that this file belongs to.

OS —the operating system on which the application version that this file belongs to runs.

Version Data—The combination of key version data fields of the file. It is automatically
populated.

Editing the Properties for Files in the Files Tab
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Only one option is available for the Files tab. This is the Properties option.

To edit the properties for a file:

1
2

Expand the tree to select the instance of the file.
Right click the file to be edited, and select the Properties option.
The File Properties box appears.
Edit the details as required.
* Size
The size of the file
® Care about Size

When this option is enabled, the size of the file is used as a recognition criteria. When
disabled, file size will not be used in recognition and N/A will be displayed in the size
column.

Be careful when disabling this setting, especially for main files. If the setting is
disabled, only the match on the file name is needed to produce a good file match — and
if the file is main, simply the presence of the file in the scan file will cause the
application to be recognized.

® Relation to App

The Relation to App shows whether the file is a Main, Associated or 3rd Party file. See
Viewing Information on the Files Tab on page 285 for definitions of these terms.

® Signature
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The signature is a checksum of the first 8 Kilobytes of a file.
° Exe File Type

The type of executable file (for example, Win32 exe, Linux x86 ELF, or SPARC ELF).
® Version Data

The combination of key version data fields of the file. It is automatically populated
and you are not recommended to modify it manually.

4 Click the OK button to complete the edit.

Once the details have been edited, the amended details are displayed in the tree.

The Application Types Tab

In This Section

Viewing Data in the Application Type Tab on page 288

Adding a New Application Type on page 289

Deleting an Existing Application Type on page 289

Editing the Properties for an Existing Application Type on page 289

) You can only edit User SAlI files.

Viewing Data in the Application Type Tab

The Application Type tab shows a view of the different types of software application
categories you allocate to entries in the SAI files. Examples of these categories are:

Database
Developer Tools
Word Processing

Web Servers

These entries are pre-populated by HP. However, you can add new items to this tab for your
User SAIL

The following information is shown for each entry in this tab

Application Type—the category of software

ID—the unique identifier for this application type entry. The application type IDs
supplied in the master SAI correspond to UNSPSC standard codes for these application
types.

This column is only visible if the Show ID Column option was enabled in the SAI Editor
Options dialog. See Setting Properties for the SAI Editor on page 271 for more
information.
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Adding a New Application Type

This procedure is used to add a new application type to a User SAI.

To add a new application type to a User SAI:

1 Right-click the root User SAI entry in the tree. It is the first entry (the root) of the tree.
2  Select the New Item option.

The Application Type Properties box is displayed.
3 Enter the name of the new application type (must be entered).

4 Click OK to add the new application type to the SAI file.

0 Before adding an application type to the file, check to see whether the entry already exists.

Deleting an Existing Application Type

This procedure is used to delete an existing application type from a User SAI.

To delete an existing application type:

1 In the tree, right-click the application type to be deleted.
2 Select the Delete option or hit the Delete key on your keyboard.
A confirmation message is displayed.

3 Click Yes to delete the application type.

Editing the Properties for an Existing Application Type

This procedure is used to edit the properties for an application type.

To edit the properties for an existing application type:

1 In the tree, right-click the application type to be edited.
2  Select the Properties option.
The Application Type Properties box appears.
3 Edit the details as required.
4 Click the OK button to complete the edit.
After the details have been edited they are displayed in the tree.

The Operating Systems Tab

In This Section

e Viewing Data in the Operating System Tab on page 290
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¢ Adding a New Operating System on page 290

¢ Deleting an Existing Operating System on page 291

e Kditing the Properties for an Existing Operating System on page 291
) You can only edit User SAlI files.

Viewing Data in the Operating System Tab

The Operating Systems tab shows a view of the different operating systems you can allocate
to entries in the SAI files. Examples of these categories are:

e  Windows Vista
e Solaris 10
e Linux 2.6

These entries are pre-populated by HP. However, you can add new items to this tab for your
User SAIL

The following information is shown for each entry in this tab
e Operating System—the name of the Operating System.

e Short Name—the abbreviated name for the Operating System. For example, Windows
Vista is represented as Vista.

e ID—the unique identifier for this operating system type entry. This column is only shown
if the Show ID Column option was enabled in the SAI Editor Options dialog. See Setting
Properties for the SAI Editor on page 271 for more information.

Adding a New Operating System

This procedure is used to add a new operating system to a User SAI.

To add a new operating system to a User SAI:
1 Right-click the root User SAI entry in the tree. It is the first entry (the root) of the tree.
2 Select the New Item option.

The Operating System Properties box is displayed.
3 Enter the following details for the new operating system.

e Name

Name of the new operating system (must be entered)
e Shorthame

The abbreviated name for the Operating System. For example, Windows Vista is
represented as Vista.

4 Click OK to add the new operating system to the SAI file.

0 Before adding an operating system to the file, check to see whether the entry already exists.
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Deleting an Existing Operating System
This procedure is used to delete an existing operating system from a User SAI.

To delete an existing operating system:

1 In the tree, right-click the operating system to be deleted.

2 Select the Delete option or hit the Delete key on your keyboard.
A confirmation message is displayed.

3 Click Yes to delete the operating system.

Editing the Properties for an Existing Operating System

This procedure is used to edit the properties for an operating system.

To edit the properties for an existing operating system:
1 In the tree, right-click the operating system to be edited.
2 Select the Properties option.
The Operating System Properties box appears.
3 Edit the details as required.
°* Name
Name of the new operating system (must be entered)
® Short Name

The abbreviated name for the Operating System. For example, Windows Vista is
represented as Vista.

4 Click the OK button to complete the edit.

After the operating system details have been edited, the amended details are displayed in the
tree.

The Languages Tab

In This Section

e Viewing Data in the Languages Tab on page 291
e Viewing Properties for a Language on page 292

) You can only edit User SAI files.

Viewing Data in the Languages Tab

The Languages tab shows a view of the different languages you can allocate to entries in the
SAI files. Examples of these categories are:
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¢ Dutch

e English

e French

These entries are pre-populated by HP. You cannot add new items to this tab.
The following information is shown for each entry in this tab

¢ Language - The name of the language.

¢ Code - The ISO standard code for the language.

¢ ID - The unique identifier for this language type entry. This column is only shown if the
Show ID Column option was enabled in the SAI Editor Options dialog. See Setting
Properties for the SAI Editor on page 271 for more information.

Viewing Properties for a Language

This procedure is used to view the properties for a language.

To view the properties for a language:

1 In the tree, right-click the language.
2  Select the Properties option.
The Language Properties box is displayed.

The License Relations Tab

In This Section

e Viewing Data in the License Relations Tab on page 292

e Viewing Details for a License Relation on page 293

e Kditing the Properties for an Existing License Relation on page 294
) You can only edit User SAI files.

Viewing Data in the License Relations Tab

This tab provides a view of the license relationships that exist in the SAL
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Click the + (plus) sign next to a License Relation to expand the tree. All applications
contained in the suite are shown along with their license relationship to the suite.
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Icons represent the relationship of the various applications to the application suite as follows:
o {'ﬁ Indicates that this application also licenses another application.
o fh| Indicates that this application is licensed by another application.

o g‘j Indicates that this application both licenses and is licensed by another application.
The following information is shown about each application in the license relationship.
e Item—the name of the publisher, application, and release.

e ID—the unique identifier for this entry. This column is only shown if the Show ID Column
option was enabled in the SAI Editor Options dialog. See Setting Properties for the SAI
Editor on page 271 for more information.

Viewing Details for a License Relation

To view more details for a license relationship:

1 Right click an application in the License Relation tab, and select the Go To option.

The application release will be automatically selected and displayed on the All Contents
tab.

2  On the All Contents tab, right-click the entry, and select Explore license relations.

This will display the license relationship editor. Here you can view the relationship in
greater detail or you can make changes to the relationship as required.

See The License Relations Tab on page 292 for further information about setting up and
editing a license relationship.
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Editing the Properties for an Existing License Relation

This procedure is used to edit the properties for a release.

To edit the properties for an existing release:

1 In the tree, right-click the release to be edited.
2 Select the Properties option.
The Release Properties box appears.
3 Edit the Name of the release (must be entered)
4 Click the OK button to complete the edit.
Once the details have been edited they are displayed in the tree.

License Relationships

License relations solve the problem of suite licensing simply and effectively. They are
applicable to license relationships outside of what would normally be considered a software
suite.

For example, Microsoft Office 2003 licenses Access, Word, Excel, PowerPoint and Outlook and
is a well-known software suite. In addition, Outlook licenses MS Data Access Components
(ADO) 2.1 SP1. If Outlook or another licensing application is not present on the machine, a
license is required for the software; if Outlook is installed on the machine, however, Outlook
assumes license ownership.

License relationships for a application release are represented by icons in the SAI Editor All
Contents tab.

Table 56 Relationship Icons in the SAI Editor All Contents Tab

B Indicates that the application also licenses another application.

fhl Indicates that the application is licensed by another application.

ghl Indicates that the application both licenses and is licensed by another
B application.

Chapter 6



Viewing License Relationships
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The License Relationship Editor is a non modal dialog box. This means you can have it
displayed while working in the SAI Editor. Position the two dialog boxes on your screen so
that you can work with both at the same time.

To explore license relationships:

1 In the All Contents tab, right-click a Release and select Explore License Relations. The
License Relationship Editor is displayed.

There are three panes in this dialog box.

e Licensing Releases

The applications listed in this pane are those that license the selected application.

® <Selected Application>

This is the application that was selected in the SAI Editor All Contents tab.

e Licensed Releases
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The applications listed in this pane are those that are licensed by the selected

application.
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In this example, Microsoft SQL Server 2005 was selected in the SAI Editor All Contents
tab. The center pane contains details for this particular application release.

¢ The left hand pane shows any applications that license Microsoft SQL Server 2005.

¢ The right hand pane shows any applications that Microsoft SQL Server 2005 licenses.

Double click an entry in the left hand pane. This application becomes the focus in the
center pane. For this example, Microsoft Office SharePoint Portal Server 2007 has been

used.

e The left hand pane does not contain any data because Microsoft Office SharePoint
Portal Server 2007 is not licensed by any other application.

¢ The right hand pane now shows the applications that Microsoft Office SharePoint
Portal Server 2007 licenses (including the original Microsoft SQL Server 2005).

l Licenze Helationzhip Editor

f‘j Licensing Releases

Microsoft Office SharePoinkt
Portal Server 2007

- Licenses: 2

E----Licensed By: O

- Release Details
Publisher: Microsaft
Application: Office Share
- Release: 2007

< | i

{';_'] Licensed Releases

Microsoft Sgl Server 2005
Micrasaft Sql Server 2005 expi

1 | >

To return focus to the original application (Microsoft SQL Server 2005), double click the
Microsoft SQL Server 2005 entry in the right hand pane. The center pane focus is now

returned to this application.

By double clicking through various entries in the License Relationship Editor you can
explore how these applications relate to each other regarding licensing.

) You can also right click an entry and select the Explore Relations option instead of
double-clicking.
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Right clicking on an entry and selecting the Go To option will show the License Relations page
in the SAI Editor with the application selected.

Setting up a New License Relationship

This procedure shows you how to set up a new license relationship.

To set up a new license relationship between two or more applications:

1 Position the License Relationship Editor and the SAI Editor on your screen so that you
can work with both at the same time.

2 Right click the release of the application you want to set up the relationship for, and select
the Explore License Relations option.

The License Relationship Editor is displayed with the center pane showing details for the
selected application.

‘ Licenze Helationship Editor [_ (O] x|
f‘j Licensing Releases Microsoft SQL Server 2005 {':] Licensed Releases
EMicrosoft OFfice Accounking Microsoft Data Access Compor

Microsoft Office SharePaint - Licenses: & Microsaft Microsoft . MET Frame

Microsoft Office Accounting

Microsaft S0L Server Mative C
Hewlett-Packard HP Openti

- Licensed By: 9 Microsoft S0L Server Analysis

Micrasaft Office Accounting =- R:alease Details Micrasaft S0L Server Reportin
Sage aroup Act! 2007 i Publisher: Microsoft Microsaft SOL Server Mokificati
Sage Group Act! Premiurm F Application: SCL Server Microsoft S0L Server Inkegrati

Maonticello The Paper Tiger «

. Release: 2005 Microsaft SOL Server Workstal
Acresso Software (Macrowvic '

rr .0 KN H

3 Return the focus to the main SAI Editor All Contents tab and navigate to the release for
the application that you want to add.

4  Drag and drop the release entry from the SAI Editor explorer tree view to the left or right
pane either of these panes as follows:

e Left hand pane—This will be a licensing release. The application that you drag and
drop will license the application in the center pane.

¢ Right hand pane—This will be a licensed release. The application that you drag and
drop will be licensed by the application in the center pane.

5 If you make a mistake, you can remove the entry by right- clicking on it and selecting the
Delete option.

6 Continue these steps as required.

Creating a License Relationship Using the Master SAI

You can use entries in a Master SAI file to create a new license relationship. Once created it
will automatically be copied to a specified User SAI file.

) The Master SAI will not be edited in any way.
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The procedure for doing this is similar to that shown in Setting up a New License
Relationship on page 297.

1

Position the License Relationship Editor and the SAI Editor on your screen so that you
can work with both at the same time.

In the Master SAI file, right click the release of the application you want to set up the
relationship for and select the Explore License Relations option.

The License Relationship Editor is displayed with the center pane showing details for the
selected application.

Return the focus to the main SAI Editor All Contents tab and navigate to the release in
the Master SAI for the application that you want to add.

Drag and drop the release entry from the SAI Editor explorer tree view to the left or right
pane either of these panes as follows:

e Left hand pane—This will be a licensing release. The application will license the
application in the center pane.

¢ Right hand pane—This will be a licensed release. The application will be licensed by
the application in the center pane.

A Select User SAI dialog is displayed if you have multiple User SAls:
Select the User SAI you want to create the license relationship in and click the OK button.

Continue these steps as required.

The Package Rules Tab

In This Section

Viewing Package Rules on page 299
Editing the Properties of a Package Rule on page 300
Navigating to the Application on page 300
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Viewing Package Rules
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The Package rules tab shows a view of the package rules for an SAI.
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For Master SAIs, the rules are pre-populated by HP and are not editable.

For User SAls, you create the rules manually. For more information, see Example of a
Recognition Rule Using Installed Package Information on page 384.

The following information is shown for each entry in this tab.

Package Name - The name of the package.

Package Type - The types of the installed packages (such as MSI, RPM, etc.) to which the
rule applies.

OS - The operating system on which the application runs.

Language - The language for the application.

Publisher - The publisher of the application to which the package rule belongs
Application - The application to which the package rule belongs

Description - The brief description of the package rule.

Release Match - The regular expression for the release name. For more information, see
step 8 on page 387.

Release Format - The format of the release name. For more information, see step 8 on
page 387.

Version Match - The regular expression for the version name. For more information, see
step 10 on page 388.
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¢ Version Format - The format of the version name. For more information, see step 10 on
page 388.

e Extra - The extra regular expressions used in the rule. For more information, see step 11
on page 389.

"- You can view the total number of the package rules in the current SAI in the status bar.

Editing the Properties of a Package Rule

This procedure is used to edit the properties for a package rule.

) You can only edit the package rule properties for User SAI files.

To edit the properties of an existing package rule:

1 Right-click the package rule to be edited and select the Properties option.
The Application Rule Wizard box appears.

"- Alternatively, you can also access the Application Rule Wizard by double-clicking
the package rule to be edited.

2 Edit the details as required.
See Editing the Application Rules on page 278 for more information.
3 Click the Finish button to complete the edit.
After you edit the package rule details, the amended details are displayed in the tree.

Navigating fo the Application

This procedure is used to navigate to the application to which the package rule belongs.

To navigate to the application:

1 Right-click a package rule.
2 Select the Go to Application option.
You are led to the application to which the package rule belongs in the Application tab.

The Version Data Rules Tab

In This Section

e Viewing Version Data Rules on page 301
e Kditing the Properties of a Version Data Rule on page 301
e Navigating to the Application on page 302
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Viewing Version Data Rules

‘-v

The Version Data rules tab shows a view of the version data rules for an SAI.

For Master SAIs, the rules are pre-populated by HP and are not editable.

For User SAls, you create the rules manually. For more information, see Example of a
Recognition Rule Using Version Data on page 376.

The following information is shown for each entry in this tab.

File Name - The name of the version data rule.
OS - The operating system on which the application runs.

Language - The language for the application.

Publisher - The publisher of the application to which the version data rule belongs.

Application - The application to which the version data rule belongs.

Description - A brief description of the version data rule.

Release Match - The regular expression for the release name. For more information, see

step 13 on page 379.

Release Format - The format of the release name. For more information, see step 13 on

page 379.

Version Match - The regular expression for the version name. For more information, see

step 14 on page 383.

Version Format - The format of the version name. For more information, see step 14 on

page 383.

Extra - The extra regular expressions used in the rule. For more information, see step 15

on page 384.

You can view the total number of the version data rules in the current SAI in the status bar.

Editing the Properties of a Version Data Rule

>»
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This procedure is used to edit the properties for a version data rule.

You can only edit the properties of version dates rules for User SAI files

To edit the properties of an existing version data rule:

1

3

After you edit the version data rule details, the amended details are displayed in the tree.

In the tree, right-click the version data rule to be edited and select the Properties option.

The Application Rule Wizard box appears.

‘- Alternatively, you can access the Application Rule Wizard by double-clicking the

version data rule to be edited.

Edit the details as required.
See Editing the Application Rules on page 278 for more information.

Click the Finish button to complete the edit.
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Navigating to the Application

This procedure is used to navigate to the application to which the version data rule belongs.

To navigate to the application:

1
2

Right-click a version data rule.
Select the Go to Application option.

You are led to the application to which the version data rule belongs in the Application
tab.

Searching for ltems in the SAI

How to Search for ltems in the SAI

You can search for any item contained in the SAI using the Search in SAI dialog.

To search for a file in an SAI:

1
2

6
7

Click the @ icon in the toolbar. The Search in SAI window opens.

In the Search for items with a name containing field, type all or part of the item you want to
find. A history of search items is maintained and can be accessed from the drop down list.

Check the Use Regular Expression option if you have specified a regular expression in the
name field above.

Check the Limit to items also available in other SAls option if you want to limit the search to
only those items that are also available in other SAls. If an item exists in only one SAI, it
will be ignored. This is useful for finding all items that appear in more than one SAI. This
option is especially of interest with regard to application versions.

In the Search in pane, check the box next to those areas you want to include in your search.
You can narrow your search by specifying the areas in which the search will be carried
out. The default settings is that all criteria are selected - the entire SAI is searched.

Click Search. The results are shown in the bottom pane and are presented in a tree view.

Double click an entry to go directly to that item in the All Contents window.

In addition, you can use the local menu command, Copy to Clipboard, in the search dialogue. It
allows you to copy the content of the search results into the Windows clipboard. The content is
copied in a tab separated format, so that it can be pasted into another external application,
such as Microsoft Excel, Windows Notepad, and others.

How to Use the “Limit fo items also available in other SAls” Option

There are some very good reasons why you would want to use this option when searching the
SAls that you create.

Consider the case of the user SAIs that you create for the applications that are not currently
included in the master SAI. When a new monthly SAI update for master SAI files is available,
you will want to search the user SAIs to show all versions in the user SAI that are also
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available in the new master set. This would highlight any possible clashes with the new
master data. It is useful to know about these clashes because in such cases an application that
previously was recognized from a user SAI might change its recognition to be recognized as a
master SAI version instead.

Another case to consider is the rule-based recognition applications that are created when you
define rules in the user SAI. When these rules are triggered, they create applications in the
auto.zsai (or whatever SAI file that you have designated to receive automatically generated
versions). When you receive a new master SAI, you will want to search the content of the
auto.zsai to find out if any of the new master SAI data include versions that were created
by the rule-based recognition. Again, you want to track the cases when the recognition might
change from a version in the auto.zsai file to a version in a master SAI. It is important to
track these recognition changes only if the recognition data is linked to some external
systems, such HP Asset Manager using the version IDs.

In both cases, the search procedure to identify these items is the following:
1 From the SAI list on the left, select the user SAI that you want to search.
2 In the Search for items with a name containing field, enter .*

3 Check the Use Regular Expression option indicating that all items will be found since the .*
regular expression matches all items.

4 Check the Limit to items also available in other SAls option.
5 In the Search in pane, check only the Version Names check box.

The result of this search shows all versions in the user SAI that are also available in the new
master set.

Exporting the Contents of a User SAl to XML Format

In this Section, the following topics are discussed:

e Exporting the Contents of a User SAI File on page 303
e Example of a Summary XML Export on page 304

e Example of a Complete XML Export on page 305

Only User SAI files can be exported.

The XML file format is an easy way to share the SAI information with an external system.
Since XML is a standard, open text-based markup language, there are many tools available
that can parse it. For example, one can create a simple XSLT transform and convert this XML
to an HTML web page, an XML document of a different format, or even a simple text file.

Exporting the Contents of a User SAI File
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1 In the left hand pane of the SAI Editor, select the User SAI file you want to export.

2 Click the Export SAI ¥ icon on the toolbar.
The SAI XML Export dialog opens.

3 You can select either Export SAl Summary only or Export Complete SAl. Samples of both
types of export are shown in the following sections.
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If you select Export SAI Summary only, you have the following options:

— Include IDs: If checked, the summary SAI includes item IDs in the exported XML. If
unchecked, the IDs are not included.

— Include release relationships: If checked, the summary SAI includes the release
relationships in the exported XML. If unchecked, the release relationship information
is omitted.

4 You can select the Include items with no file data option.

If checked, the export will also include items in the User SAI that are empty - that is, they
do not have any files in them.

5 In the Export to file field, you can browse to or type in the location where you want the file
saved. By default, the XML export is saved to the following file:

<DataDir>\SAI\user.xml

Here <DataDir> is the DDM Inventory data folder (see Conventions Used in this
Document on page 4).

6 Select the Open file in default XML viewer option if you have an XML viewer already
installed on your machine and it has been associated to XML file types. This option
automatically opens the file with that application once the export has been completed.

7  Click Export to complete the procedure.

Example of a Summary XML Export

The Summary export shows details of the application only:

<?xml version="1.0" encoding="UTF-8" ?>

<sail description="User SAI File" type="User" id="0"
version="281" revision="0" timeStamp="2004-05-20 10:28:55"
exportType="Data for items without files is included">

<publisher name="3Com">

<application name="3+open/lan Manager"
applicationType="Utilities">

<release name="Standalone Releases'">

<version name="x.x" operatingSystem='"<generic>"
language="English" />

</release>
</application>
</publisher>

</sai>
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Example of a Complete XML Export

This type of export is a complete dump of the User SAI contents. All items are displayed
showing their IDs. The Application Types, Operating Systems and Languages contained in
the SAI are also shown with IDs.

<sal description="User SAI File" type="User" id="0"
version="281" revision="0" timeStamp="2004-05-20

<application id="2334" name="3+open/lan Manager" apptypeId="8">
<release 1d="4330" name="Standalone Releases">

<version id="6799" name="x.x" 0sId="0" languageId="2304">
<file name="3comemm.com" type="Associated" size="4289" />
</version>

</release>

</application>

</publisher>

</sai>

Importing Data from a Recognition Result

The SAI Editor has a feature that allows you to load in a scan file and check what the

recognition results will be. You can also use this feature to add files from the scan file directly
to User SAI

To check scan file recognition:

1 Select the Import Data from Recognition Result option from the Tools menu. The Recognition
Verification window is displayed.

2 Navigate to the scan file to perform recognition on. You can also apply filters on files to be
passed to the recognition engine.

e By extension
e Executable files
¢ Files within archives
3 Click the OK button.
The Recognition Result Import dialog is displayed with the Files tab showing.
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This tab shows how files were recognized in the scan file. Icons are used to indicate the

following:

Icon

Meaning

Has been recognized with a high degree of confidence.

Has been recognized, but the recognition cannot be guaranteed 100%.

Does not exist in the Master SAI and has not been recognized.

The right hand pane shows the SAIs to which you can add files.

’ You cannot add files to the Master SAI.

In the right hand pane, select the SAI file to which you want to add the file(s), and
navigate to the applicable Application version.

In the left hand pane, select the file(s) to be added to that Application version. Multiple
files can be selected by holding down the SHIFT/CTRL key while clicking on the files.

Before you select the files to be added, you can sort the files displayed by clicking on a
column heading. For example, you can click on the Package column on the Files tab to sort
files by package. All files belonging to a particular package will then be grouped together,
even though they may be located in different directories scattered throughout the file
system. The ability to sort files based on their package allows you to easily teach all files
belonging to a particular package. Simply select all of the grouped files belonging to that

package.
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6 Drag and drop the file(s) directly onto the application version in the right hand pane.
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Drag and drop the file(s) to the version

‘n- Alternatively, select both the files in the left hand pane and the Application
version in the right hand pane. Then click the Add button.

An Importing Files dialog box is displayed.

7 Right-click the file(s) to be set the relationship to the application. Multiple files can be
selected by holding down the SHIFT/CTRL key while clicking on the files.

8 Select the relationships from the Main, Associated, and 3rd Party options.
9  Click the OK button.

The files are now added to the selected application version in the SAI.

Importing Data from a Scan File Comparison

Before you start this procedure, ensure that you have done the following:
e Started with a scan of the machine before the application is installed.

e Installed the application.

e Taken a scan of the machine after the application has been installed.
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To import data from a scan file comparison:

1

Create a new version for the application in your SAI file, unless you want to add files to an
existing version.

Click the version in the tree view, and select the Import data from Scanfile comparison option
from the Tools menu. The Scanfile Comparison Teaching Configuration dialog appears.

The wizard requires two scan files. The first scan file (pre-installation scan file) is the
result of a scan performed on a machine prior to the installation of the program and the
second (Post-installation scan file) is the result of the scan of the same machine after the
new version was installed.

e Enter the path to the pre-installation scan file.

e Enter the post-installation scan files. Click the Add button and navigate to the file.
You can specify more than one file for cases where patches need to be installed too.

Click the Load Filter tab.

Set options in this dialog to specify which files should be loaded and optionally passed to
the recognition engine.

In the Files tab, select the Load filter, and choose one of the following options:
e All files—Loads all files.

® No files—No files are loaded. For example, for hardware only analysis.

e Some files—Enables the Some files options:

By extension... This allows you to specify the extensions of any files that you want to be
included. Select the extensions from the drop-down list (this list maintains a history of
previously entered extensions) or type the extension directly in to the box. Multiple
extension must be separated by semi colons.

Executable files—This will allow all executable files to be processed against the
recognition engine. Executable files include *.exe, *.d11, and other files containing
executable code.

Files within Archives—This will process any files in archive files (for example, Zip files,
CAB, LZH). When this option is checked, any files matching the other criteria
(extension and/or executable) are loaded, even if they are inside an archive. If the
option is cleared, no files within archives are loaded.

If this is the only option enabled, nothing is loaded - it is not possible to load only files
within archives.

In the Directories tab, specify the directories to exclude.
Select the Exclude files in these directories check box.

Place the cursor in the list box and type in the path (do not include the drive letter) of the
directories to be excluded. An example of the format is as follows:

\WinNT\$NTServicePackUninstall$

You can save the current list displayed in the list box. To do this, click the Save list button
and specify the filename and path of the text file to save to. The default filename is
dirlist.txt.

You can load a previously saved text list file by clicking the Load list button to display a
dialog box. Enter the filename and path or navigate to the file to be loaded.

Click the OK button.

After a few second the Scanfile Comparison Import dialog is displayed.
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The right hand pane shows an explorer-like tree view of the SAI files loaded. Expand the
tree down to the version you want to add the files to.

Three tabs are available in the left hand pane:
e New Files
This page shows new files added by the installation.
e Changed Files
This page shows files that have been picked up that differ between the two scan files.
e Unchanged Files

This list shows those files that were unchanged by the upgrade of the named version
but are nonetheless part of the new version. You can change the version named by
clicking the ‘Click here to change’. An SAI Browser dialog is displayed. Navigate to the
new version and click OK.

10 Drag and drop any files to be taught onto the correct version in the right hand pane.
1 Click the Close button when you have finished.
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Importing Data from an MSI File

This section describes how to use the MSI Importer to import applications from an MSI file
into a User SAI without having to install them or perform and scans of machines.

Overview of the MSI Importer

The MSI Importer can be used to teach any application that was packaged using the MSI
Installer. This module allows software teaching based on an MSI file, which removes the need
to install and scan software in order to add it to a User SAI

MSI is short for Microsoft Installer and was introduced with Windows 2000, although
Microsoft provides MSI as a separately deployable piece of software that can be added to older
Windows operating systems.

To distribute an installer for a piece of software, a publisher no longer has to rely on
proprietary installer packages for managing creation of directories, registry entries, copying
of files, or uninstallation. If instead the installer is distributed as one or more MSI files, the
MSTI process in Windows takes care of the details.

The MSI Importer is an SAI Editor module that uses this standard to add applications
packaged in MSI-based installers directly to User SAI files without having to install them
first.

To teach the contents of an MSI files in the SAI Editor

1 Use the MSI Importer to view the structure and contents of the file. See Components of a
Software Installation on page 311.

2 Once you have become familiar with the structure of the MSI file, teach the contents of
the MSI file to a User SAIL. See An Example of Teaching an MSI Based Installer to the
User SAI on page 324.

The MSI Importer supports standalone msi files, Microsoft's self-extracting installers, and
installers that were generated using some versions of the Wise for Windows Installer. For
handling InstallShield generated MSI installers, see How to Open an InstallShield MSI
Installer in the MSI Browser on page 314.

Further Information

You can find comprehensive information about the MSI standard at:

http:/msdn.microsoft.com

The Advantages of Using the MSI Importer

e Speed
The overhead of having to install the software and scan the machine is removed.
¢ Convenience

The teaching is accomplished using only one computer, as the need for a separate ‘clean’
computer to install the software is removed.

e Completeness
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An installer often contains files that are only installed under certain conditions. For
example, an application might require certain extra libraries under older operating
systems to make up for missing functionality available under newer versions of Windows.
Using the traditional method of installing software before teaching it, these extra files
would only be found if the correct combination of software and operating system was used
during installation. The MSI Importer, on the other hand, retrieves all of the files
available in the installer.

The Challenges of Using the MSI Importer

¢  Understanding MSI structure

You will need to understand how MSI files are structured. With MSI, every installation is
different. It is necessary to browse the MSI Installer (and its associated directories) to
understand how the installer has been structured before teaching the application.

It is also necessary to understand what components the application has. For example, the
same installer might contain application Server and Client components. While browsing,
special attention should be paid to shared components included in the MSI installer. Some
of them may already exist in the Microsoft library applications, such as MSDE (Microsoft
SQL Server Desktop Engine) or DAO components.

e Lack of MSI installations

More and more software companies are adopting MSI as their installer platform.
However, it will be some time before all software companies ship their products in MSI
Installers. For these products, the traditional method of scan-install-scan-teach will still
have to be used.

e  Hybrid MSI Installers

Some MSI installers invoke legacy proprietary installers to install some components of
the product. The files in the invoked legacy installers will not be available for teaching
from the MSI Importer.

Components of a Software Installation

SA/ Edlifor

A software publisher must provide three components when publishing an application:
e The MSI System installer

e The .msi file

¢ The Setup.exe file

MSI was introduced with Windows 2000. Consequently, some computers will not be able to
install MSI-based installers if they are provided only as .ms1i files.

It is for this reason that most MSI based installers are still invoked by running an executable

file usually named Setup.exe.

The Setup.exe file:

1 Checks to see if the MSI system is installed

2 Installs it, if necessary

3 Once it has done the previous two steps, invokes the installation of the .msi file.

’ The MSI system is available as a downloadable module from Microsoft. This
module can be installed for the purpose of MSI installation.
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Locating the MSI and Setup Files for Different Application Installations

There are two ways in which a software application can be made available:

1
2

Applications Shipped on a CD
Applications Downloaded from the Internet on page 312

Applications Shipped on a CD

When loading such an installer into the MSI Importer, load the .ms1 file.

If the application is shipped on a CD, all three of the components will normally be placed
separately on the CD. An installer packaged in this way may be identified by the following:

A .msi file will be found in the same directory as the Setup.exe file.
The Setup.exe file will normally be no larger than 1 MB

An installer for the MSI system will be located either in the same directory or in a
subdirectory.

Applications Downloaded from the Internet

When importing a self-extracting installer to the MSI Importer, load the Setup.exe. The
MSI Importer will display an error message if you attempt to load an unsupported installer
package.

If the application is downloaded from the Internet, a publisher will typically provide a
single-file download. The Setup.exe file will be a sophisticated self-extracting archive
containing the other two components.

You can identify this type of installer by the following:

There is no associated MSI file

The Setup.exe file will be several MB in size.

Other MSI Files on the Install Media

Often a search of the install media (the CD) will reveal a number of additional .msi files in
subdirectories. These .msi files are usually installers for additional components the publisher
provides with the application. Examples of these are required system updates and third-party
database engines.

You will need to examine these .msi files to determine whether their contents should be
added to the application in the User SAI file.

If the MSI appears in the nested installers tab, it should be taught - but only once.

If the .msi file was provided by another publisher then its contents should either be
added to the application as third party files or, in case when a component exists as a
separate application, the MSI file data should be taught to the respective application. The
connection between the two applications should be established through License Relations
(see License Relationships on page 294).

If the software publisher has provided one of the additional .msi files themselves, then its
contents should either be added to the application as associated files or, in the case when
the supplied component exists as a separate application, the data should be taught to the
respective application. The connection between the two applications should be established
through License Relations (see License Relationships on page 294).
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MSI Installers and External Files

Some of the files referenced by an MSI file might be outside the MSI Installer package itself.
This may take the form of a relative path directory structure or an Cab file outside of the MSI.

If an MSI file is moved, for example, it might cause a problem if external files are referenced.
Always check the MSI Reading Log page to see if a CAB Missing Error has been displayed. If
this is the case, ensure that all the files are in the correct locations. If you have copied a file
from a CD, ensure that all the external files have been copied too.

|dentifying Main Files

The Main file will probably be pointed to by a Windows shortcut installed in the Start menu.
Use the list of shortcuts to identify and add the Main files. Bear in mind that an application
may have more than one shortcut, and that not all of those shortcuts will point to Main files.
You will need to examine the file and its internal version information to determine whether it
is a Main file.

You can view more information about the list of shortcuts on the Summary page of the MSI
Importer. See Summary Tab on page 316 for further information.

Identifying Third Party Files

Third Party files can be identified by checking the name of the publisher in the version
information contained in most executable files. If the publisher name specified differs from
the publisher of the product, the file is a third party file.

You can view the version information in the MSI Database page of the MSI Importer. See MSI
Database Tab on page 317 for further information.

The Structure of an Application Packaged in an MSI Installer

An application packaged in an MSI-based installer is divided up by the software publisher
into:

e Features
e Components
A Feature can contain any number of Components. Essentially, when you decide to install a

feature, you are deciding to install all of the Components that comprise that Feature.

Features

A Feature is a part of an application’s overall functionality that is user recognizable and can
be installed independently.

For example, a Feature could be a spell-checker, a thesaurus, or a group of clip art.
Hierarchical relationships of parent and child Features commonly exist such that if a child
Feature is installed, the parent Feature is automatically included as well.

Every, MSI-based installer contains a tree-like structure of Features. Each Feature could
potentially contain children. If you decide to install a Feature then you could further decide
whether or not to install its children.
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Components

A Component is a piece of the application or product to be installed. Example of Components
included single files, a group of related files, COM objects, registration, registry keys,
shortcuts, resources, libraries grouped into a directory, or shared pieces of code such as MFC
or DAO.

Components can appear in more than one Feature.

How to Open an InstallShield MSI Installer in the MSI Browser

InstallShield is a popular installer authoring tool, used by many people worldwide. While the
SAI Editor is unable to extract MSI files directly from InstallShield installers, it is possible to
use the installer itself to extract the required files.

How Can You Tell if an Installer is Built Using Installshield?

When installing the application, the words “preparing the InstallShield wizard” appear
somewhere in the text of the opening page.

How Can You Tell if an Installer is MSI Based?

Very shortly after starting the installer, the Windows Installer screen will be shown. The
graphic on the left hand side is characteristic of MSI based installers.

Windows Installer :

Importing the InstallShield MSI Based Installer

The process to import an InstallShield based MSI installer takes advantage of the fact that
InstallShield extracts the MSI in its entirety to the TEMP directory when it runs.

Start the installer and leave it open while you import the MSI and cancel it afterwards. When
the installer closes it will delete the MSI and associated files that it extracted to the TEMP

directory.
1 Start the installer.

2  Wait until the installer stops and waits for user interaction. This could be the Welcome
page of the installer, or even an error message indicating that the installer cannot
continue, like the following:

Another version of this product is already installed. Installation of this
version cannot continue. To configure or remove the existing version of
this product, use Add/Remove Programs on the Control Panel.

3 Leave the installer open and waiting for interaction until you have finished this process. If
you close the installer it will delete the MSI file that you are attempting to import.

4  Determine where your temp directory is on the system. You can do this by opening a
command prompt, and typing the following:

Chapter 6



echo %temp%
For example:

¢+ [Command Prompt

Microzsoft Windows [Uersion 5.2.37981
CC» Copyright 1785-28803 Microsoft Corp.

C:sDocuments and SettingssAdministrator>echo xtempx
C =5 DOCUME™1~ADHINI “1~LOCALS 1~ Temp

C:“Documents and Settings“Administratorl_

5 Select Import Data from MSI from the Tools menu
6 Enter (copy and paste or type in) the TEMP location revealed above.

7 Look for a directory named is* where * is any combination of alphanumerical
characters.

8 You will find the extracted MSI file in this directory. Select it.

9 When you have finished importing the appropriate files, the installer can be closed. You
can also cancel the installation (you do not need to install the application).

The MSI Importer Workspace

In This Section

e Launching the MSI Importer on page 315

e Summary Tab on page 316

e MSI Database Tab on page 317

¢ The Features and Components Tree on page 318
e The Files Pane on page 318

e The Version Information Pane on page 319

e Toolbar on page 319

e Actions Tab on page 323

e MSI Reading Log Tab on page 324

) To emphasize the MSI file detail, the screen images shown in this section do not include the
Destination SAI pane on the far right of the MSI Import window.

Launching the MSI Importer

To launch the MSI Importer:

1 In the SAI Editor, select the Import Data from MSI from the Tools menu.
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A File Open dialog is displayed.

Navigate to and select the installer file (this is either the setup.exe or the .msi file
depending on how the publisher published the application).

For further information on which file to choose, see Locating the MSI and Setup Files for
Different Application Installations on page 312.

The Import MSI Installer workspace is displayed.

The Import MSI Installer window is non-modal. This means you can have it displayed while
working in the SAI Editor. Position the two windows on your screen so that you can work with
both at the same time.

The MSI Importer window consists of four tabs.

Summary
MSI Database
Actions

MSI Reading Log

) The Actions and MSI Reading Log tabs are optional and will be visible only if there is
something to show in them. Whether they appear or not depends on a particular MSI used.

Summary Tab

The Summary page shows information extracted from the MSI file.

Product Details

316

Product Code
The product code is an ID that is the main identifier for an application or product.
Upgrade Code

This is an identifier used by the MSI system to determine which installed products are
affected by a given upgrade.

Manufacturer

The software application publisher

Name

The name of the application. This is the application’s install string.
Version

The version of the application

Package Code

The package code is an ID identifying a particular Windows Installer package. It
associates an .ms1i file with an application or product.
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Shortcut information

Lists the shortcuts this installer created and shows the targets under each shortcut.

Shortcuts
Nan_‘E . . | Diirechary | Companent |
[#] INSTAL™ZlInstall Security Template DOk [rventor 7570 SecurityT emplates il
= B AMALYS~1)Analysis Work bench Help Analysis\aorkbench
Analysiz_Wworkbench : Analyziz Workbench
= [F SAIEDI11SAI E ditar Help Sal_Edior.exe
. [E] Sal_Editor : A1 Editor
- B Wiewer Help Wiswer, exe
Wiewer : Wiewer
- [ ANALYS~1nalysis Waorkbench DDM lrventory 770 Analyzizworkbench
Analpziz_Workbench : Analpsis ‘Workbench
=8 [# SaUPD~1ISAl Update Wizard DOk [rventar 770 Sal_Update -
s | of

The following information about the shortcut is given:
¢ Name of the shortcut

¢ The Directory the shortcut points to

e The file pointed to

e The Component to which the file belongs

¢ A description of the shortcut command

¢ Any arguments applied if relevant

e The Working directory

The Go to button is only enabled when you select a Feature or if a shortcut’s target exists in
only one feature and you select the shortcut. If you select a shortcut in this pane and click the
Go to button you will be automatically redirected to the MSI Database tab and the file will be
highlighted.

Warnings

Warnings are provided whenever actions are found that require further examination. You will
need to examine the entries associated with the action warnings and decide whether they are
files that need to be taught to the application and what relationship they have with the
application. Examine the warnings by clicking on the links in the bottom pane. You will be
automatically directed to the appropriate place in the Actions tab.

MSI Database Tab

The MSI Database tab has several components:
e The Features and Components tree

e The Files pane

e The Version Information pane

e Toolbar
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The Features and Components Tree

The Features and Components tree displays a tree view of the features and (optionally) their
child components.

SEIEIRREY

- Dizcovemdgents : Dizcovery Agents ;I
: Decibel : Topology Convverter

s Caszandra : Cazzandra

- E] Authd : NewFeature1

: Allaz : Allaz

: Ariadne : Ariadne

: Apache : Apache Web Server

: Abby : Event Manager

Component Node

Feature Node bbmCant
“o [#] S8l_Corverter

: Scanner_Generatar | Scanner Generator

. Sal_Update Mwizard . SAl Update “wizard
FSF_Canverter : FSF Corveerter

: Analziz_\warkbench : Analvzis Workbench

: SHMP : NewFeature

. HML_Enricher_Service ; ®ML Enricher Service

: Yiewer | Yiewer

s Tomcat ; Tarmcat Serviet Container

: Sal: SAls

: Perlit : Perlib

: Hydra : Dizcovery Engine

: Cormrman ; Common Features [Required by all cormporne
bl ACS : Agent Communication S erver

Icon Node . @l lcons ~

4| |_’|_

This displays a tree structure of the features and (optionally) components contained in the
installer. The following icons are used to differentiate between the three types of node:

e Feature Node E]
e Component Node

o Icon Node ‘Hl
Icons are stored in different locations. They are extracted and placed into the Icon node.

A pop-up menu item (Import Files) is displayed when you right-click the selected Feature
Node. This option allows you to import the files contained in the Feature Node into the version
selected in the SAI Editor.

The Files Pane

The Files pane lists the files contained in the Feature or Component currently selected in the
Features and Components tree.
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The Files pane displays a list of the files belonging to the currently selected node.

If the node is a Feature and the Show Component Node toolbar option is not selected, the
Feature will contain the files that belong to all of its (now invisible) Component nodes. You
can find further information about the toolbar options on page 319.

Due to the legacy of MS DOS, the file name is stored in the MSI in two versions.

e The old-style MSDOS 8.3 format (with eight characters, a full stop, and then a three
character extension)

¢ The more recent mixed-case long version
Both of these names are displayed in the Files pane separated by a ‘|’. For example:
IMAGES~1.EXE| ImageSlicer.exe

If the MSI Importer was unable to extract a file from the installer in order to scan it then that
file’s icon will have a red ‘No Entry’ Symbol superimposed on it to indicate this.

You can find more information about why the file could not be extracted in the Messages tab.

Pop-Up Menu

Two pop-up menu items (Find Files and Import Files) are displayed when you right-click a
file.

e Find File

The SAI Editor will search its database for other occurrences of the selected file. The SAI
Editor’s Search in SAI dialog is displayed.

e Import Files

This option allows you to import selected files into the version selected in the SAI Editor.

The Version Information Pane

The Version Information pane displays the version information from the currently selected
file.

The Version Information pane displays data that the MSI Importer has extracted from the file
currently selected in the Files pane. If no information was extracted from the file, this pane
will be blank.

The information in this pane is exactly the same as the version information that the Scanners
extract from a file during a normal scan of a computer. It is commonly used to determine the
original publisher of the file so that the file relationship to the application (main, associated or
third party) can be determined.

Toolbar

There are two types of buttons available from the toolbar:
¢ Functional Buttons

e  Option Buttons

Functional Buttons

There are two functional buttons in the MSI Importer toolbar:
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Find File ‘@

Clicking the Find File button 2 while a file is highlighted will cause the SAI Editor to search
for other occurrences of the selected file. The Search for Files window is displayed.

Add Selected Files to a Version &

Clicking this button ] imports the selected files into the version selected in the SAI Editor.

It has the same effect as dragging the currently selected item from the Features and
Components tree or the Files pane (whichever was last clicked) to the currently selected
version node. If no version node is selected, this button will appear greyed out.

) When the mouse pointer passes over an icon, a tooltip appears indicating the command
corresponding to the icon.

Option Buttons

Three option buttons are also available from the toolbar. All three of the option buttons are
sticky buttons.

e Ifthe option is selected the button appears depressed

e To de-select the option, click the button again and the button returns to its normal state

Hide Features With No Files =

Enabling this option causes the SAI Editor to only show those Features that contain files.
Features without files in an installer are typically containers for registry entries, shortcuts
and services, and as such are not used to teach to the application library. They therefore
appear empty in the tree and can safely be ignored. This option makes them invisible.

When enabled, the MSI importer queries the information on all Features and Components
before it displays the tree. This could take some time on larger installers.

vy

The option to remove empty Features is carried out before the option to Show only executable
files. This means that if a node has only non-executable files, it will still appear in the tree
even though the Show Only Executable Files option has caused it to be empty.

Show Only Executable Files 3

When this option is enabled only those files that were identified as executable are visible.
Further, only the files displayed will be added during imports. This is the default setting, as
non-executable files should not be added.
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Show Component Nodes

When this option is enabled, the Features and Components tree will contain a node for every
Component. This is a true reflection of how the MSI-based Installer is structured internally.

That is, a Feature does not contain files directly when this option is applied. All of the

Features contain Components, and those Components in turn contain the files. This is useful
for determining the origin of a particular file.

M3l Data

Summary M5I Databaze |.-’-'-.n::tin:|ns| k51 Reading Ln:ngl

Blup B g

Agentless bin

Agentz_CertRegk.ey
- Agentz_Rawkedia

- Decibel : Topology Converter
: Cagzandra : Cassandra

- Authd : MewFeature

-E] Atlas: AHas

: Ariadne : Ariadne

- Apache ; Apache "Web Server
- Ahbby : Event M anager |

e BB

Y

E Digoovepdgents | Dizcoverny .ﬁ.gentsﬂ

_CB4BE3F1DEE34EBDE 310028

o

Filename

AGENTG~1.EXE Ihgent Generate
AGEMTI™1 ExElagentlporade.
L compress.exe

libeay32.di

openzs. exe

seleay32.dl

KN i

1=
L
o
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When the Show Component Nodes option is disabled, the Component nodes are not shown. All
of the files contained in the Component nodes are placed directly under the Feature node.
While this is a less accurate view of the installer, it is more user-readable. You do not have to

click the hundreds of Component nodes to view the files a Feature would install.

MaI Data

Summary M5! Database |.-’-'-.n:ti|:|ns| k51 Reading Lu:ugl

Decibe
Caszandra ; Cazzandra

Authd : MewFeaturel

Az Atz

Anadne : Anadne

Apache : Apache “Web Server
Abby : Event Manager

[
SaAl_Update Wizard : SAl Update W
FSF_Corvverter : FSF Corvverter
Analyziz_\workbench : Analysis Work
SNMP : MewFeature
#ML_Enncher_Service : =ML Ennch

Viewer : Yiewer =
= | \

@ = U= S

| : Topology Converter

Secanner_Generator | Scanner Gener

Filenarne

COMPIEss. ene
libeay32.di
openzzl exe
ssleay32 dil

KN —

AGEMTG™1.EXElhgent Generat:
AGEMTU1.EXElbgentU pgrade.

LIBEAY1.DLLIIbeay32-disc-+09
OVEDSC™1 EXE lovedscansve.e
SSLEAY™ . DLLIszleap32-dizc-0

i

In the example above, note how the files that were shown for each individual component now
appear with the parent feature of those components.
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Actions Tab

This page lists the actions that the MSI Installer invokes during the installation process. It is
necessary to examine these actions in order to determine whether any of them will install files

not contained in the MSI.

M5I Data

Summaryl M5l Database Actions I k5| Reading Ll:ugl

Thiz page liztz the actions that the k51 inztaller invokes during the installation process. 1tz mo
if order to determine if any of them inztall files not contained in the M5,

Mested Installers  Called Executables | DLL Eallsl [rvoked Scriptsl

M ame | | nternal | Command Line | Path -
AddFirewalltpache Yes "[BIMNF]apache exe’ "Per..  MNewBinamg
InztallPPh 2 Yes "'MNoad_ppmz.crd]" "[P...  HideExec
AddFirewallbpacheSSL ez "[BINTpacheSSh.exe’ .. MewBinanb
AddFirewallkdySEL Yes "[BIME]rmpeqld-rmax-ntexe...  MNewBinams
CreateHelpCaolurmn Yes "rweglexe]" "-defaultz..  HideExec
DelFirewalldpache Yes "[BIM7]apache.exse” "Per..  MNewBinawg
DelFirewallbpacheS5L0L ez "[BINTpacheSSh.exe’ .. MewBinanb
DelFirewallMpSOL Yes "[BIME]rmpeqld-rmax-ntexe...  MNewBinams
FlipDECaonfigFileSlazhes Yes "[Hdizcoverydbini] MewBinan23
FlipLog5ServConfFileSlashes  Yes "[#logzery. conf]" M ewBinany23
FipLogServLogFileSlashes  Yes "[#logger_log.ir]" MewBinan23
InztallPPM R ollback. Yes "'MNoad_ppraz.crd]" "[P...  HideExec
InztallSHMP Mo gygocmgr AfwindowszFal.. SwztermFolder
InztallfiztaSH b P Mo oczetup SHMP SyztemFolder™
StopSystembd onitor ez "net.exe stop ovedSysmo..  HideExec
« | _*I_I
Add

SA/ Edlifor

Nested Installers

A nested installation action installs another Windows Installer package during a

currently running installation. A nested installation action can only reinstall or remove
an application that has been installed by the current application's installation package.

Called Executables

This page shows any actions that may install some other executable files.

DLL Calls

This page shows any dll calls that may have been made.

Invoked Scripts

This page shows any scripts that may have been invoked
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MSI Reading Log Tab

The MSI Reading Log tab is used to view the log. It displays messages generated by the MSI
Importer when reading the MSI-based Installer.

M5I Data

Summar}ll b Databasel &ctions  M5S| Reading Log |

LogTime

| Log Mezzage

=]

@ 2009/08/11 12:52:59
@ 2009/08/11 12:52:59
@ 2009/058/11 12:54:00
@ 2003405411 12:54:00
@ 2003/05/11 12:54:00
@ 200340511 12:54:M
@ 200340511 12:54:M
@ 2009/05/11 12:54:0
@ 2009/05/11 12:54:0
@ 2009/058/11 12:54:M
@ 2003405411 12:54:m
@ 2003/05/11 12:54:M
@ 200340511 12:54:02
@ 200340511 12:54:02
@ 2009/05/11 12:54:02

@ 2009/08/11 12:54:02
1]

File zoan of response. it done.
File zcan of szleap32.dil done.
File zcan of HP DOM [nventom dgent [PPC] 7.70.000.9236.dmg done.
File zzan of HP DOM [rventom dgent [x86] 7.70.000,9236. dmg done.

File zoan of HP DD [nventony Agent [x86] 7.70.000.3236. mz done.

File zoan of hp-ddrm-inventong-agent-ais-ppe-7. 70,000, 9236 . tar.2 done.
File zoan of hp-ddr-inventon-agent-hpus-hppa-7.70.000.9236.tar.2 done.
File zcan of hp-ddr-inventon-agent-hpus-iab4-7. 700009236 tar £ done.
File zzan of hp-ddm-inventang-agent-inus-x86-7. 70.000.9236 tar.Z done.
File zzan of hp-ddm-inventarg-agent-macosx-ppe- 7. 70.000.9236. tar. 2 done
File zzan of hp-ddm-inventon-agent-macosx:-x86-7. 700009236 tar.2 done
File zman of hp-ddr-inventony-agent-zalariz-zparc-7. 70,000, 9236 tar.Z done
File zoan of hp-ddr-inventon-agent-zolariz-«86-7. 70.000.9236.tar £ done.
File zoan of ibeay32-dizc-v033k.dll done.
File zzan of ovedscansye.exe done.

File zoan of 2zleay32-dize-v098k. dll done.

oF

fdd

An Example of Teaching an MSI Based Installer to the User SAI

Step 1 Importing the MSI Installer Package

1
2

Select Tools > Import data from MSI.

From the Open dialog, navigate to and select the MSI file to use. The file will have an

extension of .msi or

.exe.
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3 Click the MSI Database tab to examine the contents of the MSI file.

MaI Data

Summary M35l Database I.ﬂ.ctinnsl k5| Feading Lu:ugl

S EIEREN

B E] ~az . &g ;I
-- Ariadne : Aniadre e — T
-- Apache : Apache Web Server
-- Abby - Event Manager

L:.l Scanner_Generator : Scanner
EI Sample_Scanners : Sampl
P SG_Samples
FSFDelta

M5 P=

B [E] SAI_Update_wizard : SAI Upe | [ | D
FSF_Corwerter : FSF Correerte - —
. : . FileDiescription:  [rsentony Scanner ;I
E38 Analysiz_Workbench : Analysi File\ arsion: 7 7009236
-- SMMP : MewFeaturel OrnginalFilename: ‘\Win32Scanner.exe
-- HML_E nricher_Service : #hL
F B Wiewer  Viewer bl
4 I 3 -

4 In this example, there are several features. Features are displayed in the following way
and are indicated by the E] icon.

Unique Name Key: Display name

If we look at the Scanner Generator Feature entry we can see that the Unique Name Key
is Scanner_Generator, while the display name has no underscore.
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Looking through the MSI structure, look for the components of the application that can be
installed separately and therefore should be taught as individual applications. For
example Client/Server parts (see the example below) or some shared applications that are
also packaged in the installer, for example MSDE or DAO components.

SETEIEEE
E- ﬁ_%' MSI Inztaller Filename I Size | Signature | ExeTupe I -
Clignt : Clignt mzwcpB.dll 401462  BADF-CAES ‘win 32 Exe
- B Server: Server | K mevert.d 266293 23DCETDF  Win 32 Exe
.ﬁ lcons rnzxrl3.dil 1110528 ABAF-MET  win 32 Exe
gl 3 dil 43520 BF73-EDBE  ‘Win 32Ewe |
mzxml3a. di 24064 CAFE-DAST  'win 32 Exe
MLEWIZ ™1 EXEIMLBWizard exe 13384 C448-1B44  ‘win 32 Exe
MLEBUMNI™T.EXEIMLEUninzt.exe 13760 2939-BEER  win 32 Exe
OEMSetup.exe B30 FPA0-FCA? Wwin 32 Exe
whemDC. dlilwbernDC.dl 29184 DOE4-BE1T  'win 32 Exe
*wornidcad. difwridead.dl 241152 20C8-BD38  ‘win 32Exe
varniitils. dllivernivatilz. il 160112 AACAFADE  ‘win 32 Exe
SETCLE™1.E=E|SetCLBIdentity... 24064 [a56-40FE  ‘win 32 Exe
AL, ene 211968 FADD-F8RS  win 32 Exe
Achdmin, exe 409600 BFB1-CCAE  win 32 Exe
Actdminp.dll a192 230B-93EE  ‘win 32 Exe
ACCLUS ™1 EXE|acchuster. exe 343040 84846236 Win 32 Exe
Account. exe 22016 MBC-C235  win 32 Exe
AcCPIERm.DLL BEO1E D7VA0-AE92  ‘win 32 Exe
AcDSMEnm.DLL 79360 JIBE-EIBC win 32 Exe
acermsg. di bl =t BR43-10B1  “Win 32 Exe
l_'h A ACIE e Tl o1 4Ano Q7270 a27n e DI
1 |+

This example displays the contents of the Microsoft Applications Center 2000 SP2
installer. The same installer contains both Server and Client components of the
application.

5 Click the Show Only Executable Files button 4 on the toolbar and make sure that all
other toolbar buttons have been deselected. Now you will see only executable files.

6 Check the Company Name and see if it is the same as the Manufacturer entry in the
Summary tab.

7  You can do this by clicking on the executable file name in the Files pane and looking at the
Version Information displayed in the pane below. In this case the Company Name is the
same as the Manufacturer entry in the Summary tab.
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example is shown below:

M3l Daka

Summary  M51 Database |.-’-'-.|:ti|:|ns| k5| Reading Lu:ugl

SR cIEE

ECiDel . [ opology Converer
Cassandra : Caszandra

- [B] Authd : NewFeature

-~ E] AHaz: Atlas

&rniadne : Ariadine

Apache : Apache Web Serve
fbby : Event Manager

El- Scanner_Generator : Scanne

5a1_Update ‘wizard : 54l Up
FSF_Corverter : FSF Corveert
Analpziz_\warkbench : Analys
SHMP : NewFeaturel
#ML_Erricher_Service : XML
Yiewer : Yiewer

Taomcat : Tomcat Serviet Con
SAl: SaAls

Perlib : Perlib

Hydra : Digcoverny Engine
Caomman : Commaon Features
ALCS : Agent Communication

Filenarne |

Size

2 icudt20.di
HMLAL ™1 ERE MUY alidate. exe
#“ERCES™ .DLLIserces-c_1_6_0.dl

MSISCA™1. ExElmsizcanner. exe

1 |

3481¢
g224,
1146
1597:
439

Yerzion Information

tﬁ lcons i
KN o

Lanquane Code: 0
Comments:

hitp: //ozs. zoftware. b comdcu
Froductdame:  International
Compaonents for Unicode
CompanyMame: 1BM Corporation and
others
LeqalCopyright:  Copyright [C] 2001,
International Buzines: Machines
Corporation and others. All Rights
Reserned.
Froductverzion: 2,.0.0.0

1=

FileD'escrption:  |1BM [ICU Common DLL _I

Privated uild:

&dd

Here we can see that the Company Name is IBM Corporation.

8 However, had it not been the same, you would then add the file as a third party file. An
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Step 2 Teaching Files to a Version of the Software

To teach files to a version of the software:

1

In the SAI Editor main window, select a User SAI, and navigate to the pertinent release.

For this example, we will create a new Version under the following release:

=+ 2% Uszer SAl File
= &3 Hewlett-Packard
=- E HP DDM Inventon Server

If these items (publisher, application, and release) are not present, you will need to create
them. See pages 275 — 283 for detailed instructions.

In the MSI Importer, examine the Version entry on the Summary tab.

For example:

Product Details

Property | W alue |
ProductCode  {EE4BADSF-3133-40EC-447F-847EFFIEFIF 3}

UpgradeCode  {0ED4FAEF-14D4-4CCA-BCT1-323149ERATAD 2}

Manufacturer  Hewlett-Packard Development Compar, L.P.

M ame HF Dizcovery and Dependency Mapping ventary 770,000

Y erzion ¥.¢0.000, 3000

PackageCode {44BB4ABT-B91A-4A0D-ABEL-3FFB1ADMFCAE)

In the SAI Editor main window, create a new Version (if necessary) to match the MSI
version:

a Select the release to which the new Version belongs.

b  Click the 2] icon. The Version Properties dialog is displayed.
c¢ Fill in the details, and leave the Install string blank (it gets imported later).
d Click OK.

For this example, we will create version 7.70.000 under release 7:

- ZE Uszer 54l File C:ADocuments and
El {;EI Hewlett-Packard
=- E HF OO Irventary Server
B [a7

----- % 7.70.000 [English - windows Sry 2003/2008)

Go back to the Summary tab of the MSI Importer.

a In the Destination SAI box, select the version that you just created. You will need to
expand the tree to do this.

b In the Product Details box, select the Version listed.
The version that you selected in the Destination SAI box will now be highlighted in gray.
Switch to the MSI Database tab of the MSI Importer.
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6 Select a Feature or Component node in the tree.

7 Choose one of the following methods to import its files into the User SAI:

Method 1: Click the Add button.

Method 2: Drag the whole Feature (or individual files) onto the Version node in the
Destination SAI box. You can select multiple files by using the SHIFT/CTRL key while
clicking the files.

If you drag a Component node on to a Version, the files in that node will be imported.
If you drag a Feature node onto a version, the files in that Feature and all of that
feature’s descendants will be imported.

Method 3: Right-click the feature or component, and choose Import Files from the
shortcut menu.

Method 4: Right-click files in the Files pane, and choose Import Files from the shortcut
menu.

The Importing Files dialog opens:

B Importing files for HP DDM Inventory Server (Hewlett- D, = | I:Ilil
Select each file's relationship o the application:

Filename | Felationzhip To Application | Exe Type | | -

A agent communicatorexe  Associated Win 32 Exe b

A charzet.dl Agzociated Win 32 Exe

A icory.dl Azzociated Win 32 Exe

A intl.dil Agzociated Wi 32 Exe

A |beay32-0.9.8k. 4l Azzaciated Win 32 Exe

A libeay32 di Agzociated Win 32 Exe j
(] Cancel |

Right-click the file(s) and select the relationship of the file(s) to the application from
the Main, Associated, and 3rd Party options:

B Importing files for HP DDM Inventory Server (Hewlett- D, = | I:Ilil

Select each file'z relationship o the application:

Filename

F.Y agent communicator exe ated
A charzetdi A zzociated

A iconvdl Agzociated A Associated =

A intl. dil Azzociated 3 3rdParty 3

A |beay32-0.9.8k. 4l Azzaciated Win 32 Exe

A libeay32 di Agzociated Win 32 Exe j
(] Cancel |

You can select multiple files holding down the SHIFT/CTRL key while clicking on the
files.

Main files are generally pointed to by a shortcut. Any files pointed to by shortcuts will
be marked as Main. Double-check that these files should really be given the Main
rating.
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After you have specified the correct relationship for each file, click OK.

The new file is now included in the User SAI and will be recognized as scan files are processed
in the future.

Step 3 Examining Warnings and Messages

1 Examine the warnings and messages by clicking on the links in the bottom pane of the
Summary tab.

hMezzages

Thiz inztaller containg 1 nested installers - click here for detailz.
Thiz installer callz 16 programs - click here for detailz.
Thiz inztaller containg an install stnng. Chek here toimport it into the currently zelected version.

2 You will be automatically directed to the appropriate place in the Actions tab. You will
need to examine the entries associated with the action warnings and decide whether they
are files that need to be taught to the application and what relationship they have with
the application.

Nested Installer Tab

A nested installation is where another MSI resides inside the MSI. You will need to choose
one of the following ways to handle this situation:

e Is the nested installation a standalone application that can also be released—either as
part of another application or standalone? If so, it needs to be taught as a separate
application and linked with the current application using a release relationship.

e Ifnot, the files need to be added to the same application as associated files.

Called Executables tab

You will have to examine whether the called executable is going to install some other
executable files. For example, look at the command-line column—if it says install.exe or
setup.exe this would indicate that an executable file is being installed. You could get clues
from the Name of the Action. A Called Executable Actions could be for example,

Install <name of the executable>
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In the following example, the Called Executables are not installing other files, they are merely
sending commands to run SQL scripts.

Mested Installers i Called Executables I DLL Eallsl Irweoked Scripts I

M ame | Internal I Command Line | Fath
AddFirewalltpache Yes "[BINY]apache. exe" "Per...  MewBinamg
[nztallPPhd = Ve "'MNoad_pprnz.cmd]’ "[F...  HideExec
AddFirewalltpache550L Yes "[BINYpacheS5Sl exe’ .. MewBinamg
AddFirewalltdpSEL ez "[BINE]myzgld-masx-ntexe...  MNewBinamb
CreateHelpCalurin Yes "ropzal.exe]’ '--defaultz...  HideExec
DelFirewalldpache Ve "[BINlapache exe" "Per...  MewBinamb
DelFirewallbpacheS5L0 Yes "[BINYpacheS5Sl exe’ .. MewBinamg
DelFirewalld ySCL ez "[BINE]myzgld-masx-ntexe...  MNewBinamb
FlipDBCanfigFileSlazhes Yes "[#dizcovendb.ini]” MHewBinary3
FlipLogSerConfFileSlazhes  Yes "[#logzery. conf]" MewBinan:3
FlipLogServLogFileSlazhes  Yes "[#logger_log.ini]" MewBinan:3
InztallPPMeFollback. ez "Moad_ppmz.cmd]' "[P...  HideExec
InstallSMMP Mo spzocmgr A [wWindowsFal..  SpstemFolder
InztalliztaSHkP Mo ocgetup SHKP SypgtemFolder
StopSystemtd anitor Yes "net exwe stop ovedSyamo..  HideExec
GenerateCertificatesk.eys ez "Mgencertkeyz.cmd]" "[l...  HideExec

ol | ]

DLL Calls tab
This tab lists all DIl calls made.

Invoked scripts tab

This tab shows any scripts that would be invoked. Once you have examined the files, return to
the MSI Database tab.

The MSI Scanner Command Line Utility

SA/ Edlifor

Overview of the MSI Scanner

For situations where the installation media is not accessible, the MSI Scanner can be used.
This is a command line utility that takes as input an MSI file. This is then analyzed. The
result of the analysis is an XML file containing a summary of the MSI.

In a large enterprise it may not be feasible to have remote offices send their software install
media to central locations to be added to the corporation’s central application library. In this
case, the MSI Scanner may be of some use.

The MSI Scanner is a command line utility used to scan an MSI based installer, extract all
required file information and write an XML file describing the installer and its contents. This
XML file can then be sent to the central office where the person maintaining the application
library can load it into the SAI Editor exactly as if it was the original MSI based Installer.

3317



332

‘-v

Starting the MSI Scanner

The MSI Scanner (msiscanner.exe) is not generated by the Scanner Generator. It is
supplied with the software in the following location by default:

C:\Program Files\Hewlett-Packard\DDMI\7.70\Common\bin
To start the MSI Scanner:

From the command prompt, type the following:

msiscanner <setup package> <output file>

Where:

* <setup package>is the path and filename of the MSI-based installer.

* <output_file>is the path and filename of the output XML file. Note that if the
specified filename does not end in . xm1, the MSI Scanner will append a . xml extension to
it.

Opening the MSI Scanner Output File in the MSI Importer

The output from the MSI Scanner is usable in the MSI Importer so that you can browse the
MSI and teach from the XML file in the same way as directly from the MSI file.

To open the MSI Scanner output file:

1 Select the Import data from MSI option from the Tools menu.
The File Open dialog box is displayed.
2 In the Files of Type dropdown box, select the MSI Scanner output file.
3 Navigate to the file to be opened.
4 Click OK.

The file is opened in the same way as any MSI-based installer. You can import files from it in
the same way as described on page 324.

MSI Scanner Error Level Codes

The MSI Scanner produces error level codes which can be used to handle situations if the
Scanner terminates without producing an XML output file.

These error codes can, for example, be used in a batch file so that specified actions can be
carried out in the event that particular error codes are returned.

These can be used to control re-scan activities when a scan has not completed successfully.
Table 57 MSI Error Level Codes

Error Level Description

6 Unexpected error

5 Unable to open the output file

4 Insufficient space available in the Temp
directory.
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Table 57 MSI Error Level Codes

Error Level

Description

Unable to open input MSI

Unrecognized package

Incorrect parameters

S| | N[ W

Success
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7 Application Teaching

Application Teaching is a process that you can use to increase the number of applications (or
versions of existing applications) that DDM Inventory recognizes on your scanned devices.

There are four methods that you can use to “teach” new applications to DDM Inventory:
e Express Teaching on page 337

e Teaching Using Scan Files on page 349

¢ Rule-Based Application Teaching on page 373

e Teaching Using Recognition Objectives on page 392

Each of these methods is described in detail in this chapter. The first method is currently
supported for Windows platforms only. The last three methods are supported for both
Windows and UNIX platforms.

For information about how application recognition works, see Chapter 5, Application
Recognition.

Caveats When Creating and Modifying User SAI Files

A It is extremely important to follow sound and consistent practices when you are creating or
modifying User SAI files in your environment. For this reason, the following information is
repeated in Chapter 5, Application Recognition.

You can create and modify User SAI files with the analysis tools and modify them by using the
Express Teaching method. When you create or modify User SAI files, irrespective of the
teaching method that you use, you must consider issues that may arise regarding potential ID
and content clashes.

Problems are likely to occur in the following situations:
e There is more than one librarian teaching applications.
e The SAI files are maintained in more than one location.

e The SAI files need to be deployed to more than one DDM Inventory server (for example, in
an aggregated environment).

The following guidelines should help you avoid these problems:

¢ Provide unique SAI IDs and file names across the entire organization. You cannot deploy
different SAIs that have the same ID.

e Configure the same set of SAI files for all DDM Inventory servers within an aggregated
environment to provide consistent recognition.

e  Modify SAI files in one place regardless of the teaching method. You can modify the SAI
file on an administrator’s computer or on a DDM Inventory Server using either the client
analysis tools or the Express Teaching method.
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After an SAI file is modified in one place, do not modify it on another machine. Instead,
replicate the file regularly so that new changes are available on all machines.

The use cases presented in the following sections reinforce the problems that can occur and
the best practices to use to avoid these problems.

See Chapter 5, Application Recognition for an overview of application recognition and
instructions for using Analysis Workbench and Viewer for this purpose.

Teaching on Different Client Machines

You can create more than one User SAI file for a DDM Inventory server. Each User SAI file
must have a unique name and ID across the entire organization. When you create a new User
SAI file, a new and unique ID is automatically generated. This mechanism can be
compromised, however, if you are teaching applications on more than one machine—a practice
you should avoid.

Analysis Workbench and the SAI Editor are client analysis tools that are usually installed on
a machine that is distinct from the DDM Inventory server because of performance issues. If
you create User SAI files on multiple client machines, while the ID will be unique for the
machine on which it is created, it will not be unique with regard to the ID of a User SAI file
created on another machine where the client tools are also installed. This can lead to a
potential clash of User SAI IDs for the User SAI files that you want to deploy to a single DDM
Inventory server.

0 To prevent this situation from occurring, you should only create User SAIs on a single
computer to make sure that all user SAI files have unique IDs.

Teaching in an Aggregated Environment

An Aggregator is a DDM Inventory server that collects and combines data from several
remote DDM Inventory servers in your network. There are some issues to consider when
teaching applications for servers that are part of an aggregated environment. It is important
for the User SAI files on the Aggregator and remote servers to have identical content with
unique names and IDs across the entire organization.

A recommended procedure to use to ensure that the User SAI files stay in sync is the
following:

1

Select a single computer (with the analysis tools installed) or remote server (for Express
Teaching) that contains the files that you want to teach. As unrecognized file data is not
aggregated, Express Teaching must be performed on an individual DDM Inventory server.

Using any of the teaching methods described in this guide, teach the application on this
single computer at a single point in time. The resulting User SAI file represents the
reference instance that must be replicated across the entire organization as described in
the next step.

Copy the modified User SAI file to all of the remote servers in the aggregated
environment, including the Aggregator server. Once the file is replicated, any one of the
copies of the new User SAI file can be used as the reference instance for the next round of
teaching. In Express Teaching, you do not have to always use the same remote server to
teach applications. You can teach on different remote servers (but not at the same time for
the same User SAI), as long as you make sure that the modified SAI is replicated on all the
servers in the aggregated environment.

Ensure that each remote server is configured to use this User SAI
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Express Teaching

Express Teaching is a process that you can use to increase the number of applications that
DDM Inventory recognizes on Windows devices.

The Express Teaching process works by detecting information on your scanned devices about
applications that are not yet recognized and organizing this information into a series of
reports. From these reports, you can launch the Express Teacher, a tool that enables you to
“teach” these applications from the DDM Inventory web user interface (UI). This is a lighter
and more automated alternative to using the SAI Editor or Analysis Workbench.

When DDM Inventory scans a device, it may find some executable files on that device that it
does not recognize. Many Windows executable files (EXE, COM, or DLL files) contain
embedded information about the application, publisher, and version to which they belong. The
Express Teaching process presents this information in reports to help you determine which
applications are missing from the Software Application Index (SAI). You can then define new
applications in the SAI that includes the pertinent executable files. From that point forward,
those executable files will be recognized as belonging to these applications.

The Analysis Workbench and SAI Editor are alternative methods of teaching unrecognized
files. Both of these tools, however, are separate from the DDM Inventory web user interface
(UI). To use them, you must load each pertinent scan file separately.

When Would | Use Express Teaching?

Express Teaching is useful for teaching “simpler” applications and can act as an introduction
to application teaching using other methods. The SAI Editor or Analysis Workbench, for
example, are very powerful tools but are somewhat more complicated to learn.

Express Teaching also offers a very convenient method of finding information about
unrecognized files and applications. If you do not know which specific applications or files
need to be taught, this is an expedient way to identify them.

If you will be performing application teaching relatively infrequently — or teaching a small
number of files — Express Teaching may be the most convenient method to use.

When Would | Use Other Methods of Teaching?

The Express Teacher tool does not have all the functionality of the SAI Editor or the Analysis
Workbench, such as license relationships. Express Teaching is intended to be a simple and
convenient tool, but it is not optimal in all circumstances. To get the most from your DDM

Inventory recognition capabilities, you will also need to use the SAI Editor and Analysis
Workbench.

For example, if you already have a clearly defined list of files and applications that you want
to teach, and you are familiar with the SAI Editor and Analysis Workbench, you should use
these tools instead of Express Teaching.

Express Teaching can only teach files that contain embedded version information. For this
reason, UNIX software cannot be taught using Express Teaching. Windows executable files
that have little or no version data are also poor candidates for Express Teaching.

Express Teaching is not helpful for teaching 3rd-party files. These files are particularly
difficult to teach, because they normally have quite different version data than the core files of
the application. In the Express Teaching reports, files are grouped based on the publisher/
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application/version found in the version data. This means that 3rd-party files will not be
included in these reports. If you want to teach 3rd-party files, you should use a different
teaching method, such as the SAI Editor or Analysis Workbench.

Limitations of Express Teaching

If you frequently teach new applications, Express Teaching may not be appropriate. When you
teach a file using Express Teaching, that file is not removed from the Express Teaching
report. This file will remain in the Express Teaching report until the complete set of scan files
on which the report was based are reprocessed. The time required for this to happen depends
on the scanning schedule specified for your network devices, among other factors.

For example, say that you have an unrecognized file in the Express Teaching report called
ABCD.exe, and that this file was found on five different devices (in five different scan files).
You decide to teach this file using Express Teaching. The next time you open the Express
Teaching report, however, the ABCD. exe file will still be included in the report.

Only after the DDM Inventory server has a chance to re-scan the five devices where
ABCD. exe was found — and reprocess the five scan files — will this file disappear from the
Express Teaching report. As long as one of these scan files has not been reprocessed, the
ABCD. exe file will remain listed in the report.

This delay applies to all teaching methods; it is not a specific limitation of Express Teaching.
However, because Express Teaching depends on the Express Teaching reports to identify the
files to be taught, this method is particularly sensitive to this delay.

The SAI Editor and Analysis Workbench do not rely on reports to show you that recently
taught applications are being recognized. You can see the effects of the recognition right away
without this delay. This is another advantage of using these tools.

How Express Teaching Works

The Express Teaching process includes four primary steps:

1 Alist of unrecognized applications and files is updated on the DDM Inventory server each
time a new scan file is processed by the XML Enricher.

2 Using this list, you select a file (or multiple files) to teach. This launches the Express
Teacher.

3 Using the Express Teacher, you can define new applications by specifying the following
information about the files:

— Relationship of this file (or files) to the main file
— Publisher

— Application name and type

— Release

— Version, including operating system and language

4 After you click Submit in the Express Teacher, your new application is added to the User
SAI that you specify (see Configuring Express Teaching).

Chapter 7



Configuring Express Teaching

You must set two configuration options if you want to use the Express Teaching method. The
first option instructs DDM Inventory to collect information about unrecognized files on your
client devices.

The second option tells DDM Inventory which User SAI file to use for Express Teaching. This
enables you to use different Express Teaching User SAI files on different servers. This can
help you avoid update collisions within those SAI files if updates are performed concurrently
on multiple servers. It is not necessary, however, to use different User SAI files for this
purpose. You can have one such file if you enforce the proper update discipline and only
update the file on one server at a time. In an aggregated environment, once modified, these
files will have to be replicated to all of the other servers in order to share their content.

To configure the Express Teaching options:

1 Go to Server > Administration > System Configuration > Scan processing in the DDM
Inventory web UL

2 For the Import file data option, select Custom, and then select Yes.

By default, this option is disabled. If you do not enable it, DDM Inventory will not collect
unrecognized file information from the scanned devices, and your Express Teaching report
will be empty.

3 For the SAlfile to be used for Express Teaching option, select Custom.
If you select the Default, Express Teaching is disabled.

4 Select the name of the User SAI file that you want to use for Express Teaching from the
drop down list.

The drop down list contains a list of the User SAIs currently loaded. The file you select
should be created originally by using the SAI Editor to ensure that it has a unique SAI ID.

5 Click Change to activate your changes.

Viewing Express Teaching Reports

The Express Teaching reports provide hierarchically organized information about
unrecognized files detected on your scanned client devices.

In these reports, the names of the publishers have been “normalized” to make it easier to find
the information you need. It is not uncommon for the publisher name embedded in a file to be
written in a non-standard way. For hypothetical software publisher ABC Software, for
example, we might find ABC, ABC Software, ABC Inc., or several other variations in the
embedded information. DDM Inventory attempts to resolve all of these variations and

organize the pertinent applications and files under a single name.

’ Normalization tables are provided as part of your monthly Discovery Knowledge updates. If
you need to incorporate additional normalization information, you can request this from your
HP Software customer support representative (see Publisher Name is Incorrect or Missing on
page 348).

When application and version description information is available, it is displayed in
parentheses below the application or version name, respectively.
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To view the Express Teaching reports:

1 In the left navigation menu, click Express Teaching. The first report that opens is the
Summary of Publishers with Unrecognized Files.

2 Toview a list of the applications associated with unrecognized files for a particular
publisher, click the name of that publisher in the report.

3 To view a list of the files associated with a particular application, click the name of that
application in the report. From here, you can do three things:

a To view more information about a particular file, click the file name.
b To teach a single file, click [this file].
c¢ To teach all files associated with this application, click [all files].

The reports available on the Reports > Unrecognized Files page (in the Software Inventory
Reports category) contain related information. You cannot launch the Express Teacher from
these reports, however.

Launching the Express Teaching Process

>»

There are three steps required to initiate the Express Teaching process:

Step 1 Choose a publisher.

Step 2 Choose an application to teach from the list of unidentified applications for that
publisher.

Step 3 Choose a file (or files) to teach from the list of unrecognized files associated with
this application, and launch the Express Teacher.

Each of these steps is explained in detail here.

Before you begin, be sure that you have properly configured DDM Inventory as described in
Configuring Express Teaching on page 339.

Step 1: Choose a Publisher

1 In the left navigation menu, click Express Teaching.

A report opens that lists the publishers associated with unrecognized files detected on
your scanned devices.

2 In the Publisher column of the table, click the name of the publisher of the application that
you want to teach.

Step 2: Choose an Application

After you choose a publisher, a report opens that lists all of the applications from this
publisher that are associated with unrecognized files detected on your scanned devices.

This report shows you the following information for each application listed:
¢ Name of the application
e Specific version detected

e  Number of devices affected
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e Number of unrecognized files found that are associated with this version
In the Application column of the table, click the name of the application that you want to teach.

Multiple versions of the same application may have unrecognized files. For example:

Wiware Toolz Service [Expor] 1.0.1 build-255955 Viware Toole Service 2 2
Vilware Toelz Service [Export] 2.5.2 build-18250 WMControlPansl DLL 33 1
Viware Toolz Service [Expor] 3.0.1 build-32035 VM ContrelPanel DLL 1 1

In this case, be sure to click the application name that corresponds to the specific application
version that you want to teach.

Step 3: Choose a File and Launch the Express Teacher
After you choose an application, a report listing all of the unrecognized files associated with
that application is displayed.

If you want to view detailed information about this file, including the devices where it is
installed and its location in the file system, click the name of the file. Click your browser’s
Back button when you are ready to proceed with the teaching process.

To launch the Express Teacher, do one of the following things:
— Click [all files] to teach all of the files listed in the table.
— Click [this file] to teach a specific file.

At this point, the Express Teacher opens in a separate window. See Using the Express
Teacher on page 341

Using the Express Teacher

After you choose a publisher, application, and file (or files) from the Express Teaching reports,
the Express Teacher opens automatically. The Express Teacher enables you to specify the
following information:

e The relationship of each file that you are teaching to the application: main file, associated,
or third-party.

e The publisher of that application.
e The application to which the file belongs.

¢ The release and version of the application.
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The Files page contains a list of the files that you have selected for teaching:

ﬂExpruﬁs Teacher - Server EEE
Filea The list of fles below will be used to recogrize the .
application. if they are not correct visit the Express TE&CHIF-Q web
page o choose them, To continue préss Mexd.
File set Remove Properties Files .
Mame Sire Exe T WErsion I |
s e [+ vMControlPanel.cpl -

WiControlPanel cpl | 159,744 | WWin 32 Exe  |1.01 build-23838 |+
E YhiwareService gxe | 139,744 (Win 32 Exe  |1.0.1 build-23335

File properties

Hanme: WiAControlPane cpl
Size: 159,744

Care about size: ves

Relation to app:  Main

Signature: 1DED-F414

Exe file type: Win 32 Exe

File version data

Publisher Wivbevare, Inc.,
Application Vistarare Tools Service
Version 1.0.1 buahd- 23936
Description WiiControlPanel DLL
-
Help < Back Mext = Subrnit Cancel

The File set table (on the left) lists the files that you have selected to teach. Information in the
Version column comes from the embedded version data in the file.

The Files tab (on the right) shows information about the properties for the file selected in the
File set table.

The Properties tab is empty at this point. Later in the process, this tab will reflect the teaching
parameters that you specify as you proceed through the wizard.

If you want to remove a file from the list, select that file in the table, and click Remove.

When you are ready to teach the files listed, click Next.

Main File

On this page of the Express Teacher, you will specify the relationship between each file that
you are teaching and the application to which the file belongs.

To specify the file relationships:

1 For each file listed, select one of the following values in the Relation to App column:
— Main
— Associated

— 3rd Party
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See An Overview of How Application Recognition Works on page 253 for more information
about these relationship types.

2 For each file listed, specify one of the following options in the Care About Size column:

— Select yes if you want to consider the size of this file during the application recognition
process. In this case, DDM Inventory will only recognize the application if both the file
name and the file size match exactly.

— Select no if you do not want to consider the size of the file.

A Be careful when disabling this setting, especially for main files. If the setting is
disabled, only the match on the file name is needed to produce a good file match — and
if the file is main, simply the presence of the file in the scan file will cause the
application to be recognized.

3 Click Next.

Publisher

On this page of the Express Teacher, you will specify the publisher of the application to which
the file (or files) that you are teaching belong. The name of the publisher embedded in the
unrecognized file that you are teaching will appear in the search box:

*. |"-.-"|'I.I1WEFE | s L

If this publisher is in the list of Known Publishers, it will be highlighted:

Known publishers
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To specify the publisher:

1 If the correct publisher is highlighted in the list, click Next. Skip to Application on
page 344.

2 If the correct publisher is not highlighted, use the scroll bar to look for the correct
publisher, or follow these steps to search for it:

a Type part of the publisher’s name in the search box.

b Do one of the following things:
—  Click the down arrow to search for the next instance of this string in the list.
—  Click the up arrow to search for the previous instance.

For example, if you enter “abc” and then click the down arrow, the next occurrence of
“abc” in the list is highlighted.

3 If the correct publisher is now highlighted, click Next. Skip to Application on page 344.
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4 If the correct publisher is not in the list, click the New button to add it.

If you create a new publisher entry, you will also need to create a new application, release,
and version, because nothing is yet known about this new publisher. See New Publisher.

Each time that you click Next, the information that you specified is added to the Properties
tab.

New Publisher

When you are using the Express Teacher, if the publisher that you want to specify is not in the
list of known publishers, you can add it to the list.

To add a new publisher for Express Teaching:

1 On the Publisher page, click New.

2 In the Name box, type the name of the publisher.

3 Optional: In the Description box, type a description of this publisher.
4 Click Next.

You will also need to create a new application, release, and version, because nothing is yet
known about this new publisher. See New Application.

Application

>»

>»

On this page of the Express Teacher, you will specify the application to which the files that
you are teaching belong. You can use the scroll bar or search function to locate the application
in the list (see Publisher on page 343 for details).

Select an application from the list, and click Next.

If the application that you want to specify is not listed, click the New button to add it. If you
create a new application entry, you will also need to create a new release and version.

New Application

When you are using the Express Teacher, if the application that you want to specify is not in
the list of known applications belonging to this publisher, you can add it to the list.

If you just added a new publisher, skip to step 2.

To add a new application for Express Teaching:

1 On the Application page, click New.

In the Name box, type the name of the application.

Optional: In the Description box, type a description of this application.
Click Next.
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From the list of Application types, select the type that best describes this application. See
Application Type for more information.

6  Click Next.
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You will also need to create a new release, and version, because nothing is yet known about
this new application. See New Release.

Application Type

When you add a new application using the Express Teacher, you must also specify the
application type.

To specify the application type for a new application:

1 On the Application Type page, select the type of application that you are adding.

The application types are listed in alphabetical order. You can use the search function to
locate a particular type (see Publisher for information about searching).

2  Click Next.

Release

On this page of the Express Teacher, you will specify the release to which the files that you are
teaching belong. You can use the scroll bar or search function to locate the release in the list
(see Publisher on page 343 for details).

Select a release from the list, and click Next.

) If the release that you want to specify is not listed, click the New button to add it. If you create
a new release entry, you will also need to create a new version.

New Release

When you are using the Express Teacher, if the release that you want to specify is not in the
list of known releases for this application, you can add it to the list.

) If you just added a new application, skip to step 2.

To add a new release for Express Teaching:

1 On the Release page, click New.

2 In the Name box, type the name of the release. This may be a number.
3 Click Next.

You will also need to create a new version, because nothing is yet known about this new
release. See New Version.

Version

On this page of the Express Teacher, you will specify the version of the application to which
the files that you are teaching belong. You can use the scroll bar or search function to locate
the version in the list (see Publisher on page 343 for details).

Select a version from the list, and click Next.

’ If the version that you want to specify is not listed, click the New button to add it.
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New Version

When you are using the Express Teacher, if the version that you want to specify is not in the
list of known versions of this application, you can add it to the list.

) If you just added a new release, skip to step 2.

To add a new version for Express Teaching:

1
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On the Version page, click New.

In the Name box, type the name of the version.

Optional: In the Description box, type a description of this application.
Click Next.

Select the appropriate Operating system from the list.

Click Next.

Select the appropriate Language from the list.

Click Next.

Operating System

When you add a new version using the Express Teacher, you must also specify the operating
system.

To specify the operating system for a new version:

1

On the Operating System page, select the pertinent operating system for the version that
you are adding.

The operating systems are listed in alphabetical order. You can use the search function to
locate a particular system (see Publisher for information about searching).

Click Next.

Language

When you add a new version using the Express Teacher, you must also specify the language
for that version.

To specify the language for a new version:

1

346

On the Language page, select the language for the version that you are adding.

The languages are listed in alphabetical order. You can use the search function to locate a
particular language (see Publisher for information about searching).

Click Next.

Chapter 7



Submit the Files

On this page of the Express Teaching wizard, you can verify that the information you have
specified is correct and then submit the files to be added to the Express Teaching SAI.

1 On the Properties tab, verify that the information specified for the file (or files) that you
are teaching is correct. If they are not, use the Back button to modify them.

2 To update the DDM Inventory database and complete the Express Teaching process for
this file (or files), click Submit.

The new application is then added to the SAI, and the DDM Inventory server is reconfigured
to begin recognizing the application. This may take several minutes. Thereafter, when a scan
file that contains the matching files is processed, the application will be consistently
recognized.

Best Practices for Effective Express Application Teaching

Be sure to use a separate User SAI for Express Teaching (see Configuring Express Teaching
on page 339). Before you can perform Express Teaching, you must create this User SAI by
using the SAI Editor. It must have an SAI ID that is unique across your organization.

Never modify the Express Teaching User SAI in another tool, such as the SAI Editor, while
the DDM Inventory Web Ul is being used to perform Express Teaching. Only one tool should
be used to modify the SAI — otherwise, data loss can occur.

After performing Express Teaching, it is useful to move the information stored in the Express
Teaching User SAI to another User SAI that contains other applications taught by using the
standard DDM Inventory teaching tools, such as the Analysis Workbench or SAI Editor. By
combining the results from all teaching methods in a single User SAI, it is easier to share this
information across an aggregated environment.

A Be sure to stop the XML Enricher before editing an SAI using the SAI Editor.

The XML Enricher keeps the Express Teaching SAI in memory. If you do not stop the XML
Enricher, it will overwrite any changes that you make in the SAI Editor.

There are two ways to do this:

e Disable the XML Enricher by setting the Server > Administration > System Configuration >
Discovery Services > XML Enricher active option to No.

It may take some time for the XML Enricher to stop as it must finish processing the
current scan file. Make sure that the HP DDMI XML Enricher services are stopped before
you proceed with editing using the SAI Editor.

e Stop the HP DDMI System Monitor service.

A Before moving an application from the Express Teaching User SAI to the another User SAI,
examine the data first to ensure that it is correct and complete.

Express Application Teaching in an Aggregated Environment

In an aggregated environment, it is not always possible to perform Express Teaching on a
single DDM Inventory server. This is because different software applications are likely to be
installed on managed machines handled by different DDM Inventory servers. In such cases,
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the content of Express Teaching User SAIs collected from each DDM Inventory server can be
moved to the same user SAI (as described in Best Practices for Effective Express Application
Teaching on page 347), and this User SAI can be shared across all DDM Inventory servers.

Troubleshooting Express Application Teaching

This group of topics contains information you can use if the Express Teaching process is not
producing the results that you expect. The title of each topic describes the symptom of a
possible problem.

Publisher Name is Incorrect or Missing

If the name of a software publisher that you expect to see listed in the Express Teaching
report does not appear in the report — or the name appears in a slightly different way than its
normalized form (for example, Microsoft Corp instead of Microsoft) — it is possible that a
problem occurred when DDM Inventory attempted to normalize the publisher name. To
determine if this is the problem, you can export a list of publisher names that have been
detected on your client devices but have not yet been normalized. The list is exported in
comma-separated value (CSV) format. This information can be used by your DDM Inventory
support engineer to diagnose the problem.

To export a list of publisher names prior to normalization:

1
2
3

4

In the left navigation menu, go to Status > Device Status > CSV publisher list for support.
In the File Download dialog box, click Save to export the file.

In the Save As dialog box, specify the name and location where the CSV file should be
saved.

Click Save.

The Express Teaching Report Is Empty

If you click the Express Teaching link in the left navigation menu, and the report displayed
contains no data, investigate the following causes:

On the Administration > System Configuration > Scan processing page:
— Is the Import file data option enabled?

— Is the SAl file to be used for Express Teaching specified?

Are network devices being scanned?

Are scan files being retrieved?

The Express Teacher Will Not Work

If there is data in your Express Teaching report, but you get an error message when you
attempt to launch the Express Teacher, follow these steps:

1

Specify the SAl file used for Express Teaching (see Configuring Express Teaching on
page 339).

Close your browser.

Open the DDM Inventory Web Ul in a new browser window.
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The User SAI File that | Want to Use is Not in the List
If you do not see the User SAI file that you want to specify for Express Teaching in the list on
the Administration > System Configuration > Scan processing page, follow these steps:

1 Make sure that the SAI is located in the <DataDir>\SAI directory (otherwise, it will not
appear in the web UI). By default, this directory is:

C:\Documents and Settings\All Users\Application Data\Hewlett-Packard\
DDMI\SAT

2 Ifthe SAI is not located in the <DataDir>\SAI directory, move it there.

3 Ifthe SAI is not yet available, create a new User SAI with a unique ID (using best
practices — on the same machine that is used for User SAI creation), and copy it to the
<DataDir>\SAT directory on the computer running the DDMI server.

Applications Taught are Still Not Recognized

It can take a long time for previously unrecognized applications to become recognized, because
the inventory data that contains those files needs to be reprocessed by the XML Enricher. In a
typical large network environment, files will not disappear from the unrecognized file reports
for several days (the inventory interval) after they are taught. This makes it difficult to

quickly verify the recognition to determine whether an application was taught properly or not.

| Made a Mistake During Express Teaching

It is not possible to correct a mistake made during the Express Teaching process within the
DDM Inventory Web UL You must use a separate tool, such as the SAI Editor to fix mistakes
in the Express Teaching User SAL

A You must stop the XML Enricher before you edit the Express Teaching User SAI using the
SAI Editor. See Best Practices for Effective Express Application Teaching on page 347.

Teaching Using Scan Files

You can use scan files to teach applications for both Windows and UNIX platforms. See the
following topics for detailed information about each platform:

e Teaching Windows Applications Using Scan Files on page 349
e Teaching UNIX Applications Using Scan Files on page 362

For more information about scan files and the application recognition process, see Chapter 5,
Application Recognition.

Teaching Windows Applications Using Scan Files

This section discusses the following topics:
e QOverview of an Application Recognition and Teaching Project on page 350
e Determining an Acceptable Level of Recognition on page 350

e Kstimating How Long the Recognition Project Will Take on page 352
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e Example Recognition Information from a Small Project on page 352
e Specifying the Scope of Teaching from Scan Files on page 353

e Selecting Scan Files for the Project on page 353

¢  Grouping Files on page 355

e Activities During Recognition Project on page 356

¢  Finishing the Teaching Project on page 357

e Dealing with Specific Groups of Software on page 358

e Components of Applications on page 360

e Tracking Your Progress on page 361

Overview of an Application Recognition and Teaching Project

Application teaching is the process of showing DDM Inventory how to recognize new
applications — or new versions of applications that are already included in an active SAIL. An

application consists of one or more files. Information about these file can exist either in the
Master SAI provided by HP or it can be added to the User SAI.

In a Windows environment, files belonging to an application typically contain embedded
Publisher, Application, and Version information. In both Windows and UNIX environments,
certain installed package properties contain this type of information.

For more information about how DDM Inventory recognizes applications, see Chapter 5,
Application Recognition.

Questions to Ask Yourself

There are two key questions you must ask yourself when starting software recognition
projects:

e What is an acceptable level of recognition?

e How long will it take to achieve the required recognition level?

Determining an Acceptable Level of Recognition

The Unrecognized/File frequency chart available from the Analysis Workbench can be used to
help you determine an acceptable level of recognition.

Displaying the Unrecognized/File Frequency Chart

In Analysis Workbench, after you have loaded your data, select the Charts > Unrecognized/File
frequency option from the View main menu.
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The Unrecognized/File frequency chart is a simplistic representation of the distribution of the
number of files with a particular name compared with the number of times this file occurs
across a sample of computers.
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Interpreting the Chart

What is shown in the example chart is that the bulk of the files requiring recognition will
exist on several machines within a sample, whereas the largest number of files to be
recognized may only occur once or twice across the whole sample of computers.

If the computers on which these files were found can be identified, you can check them to see
if they fit into the business critical category of machines needing attention.

This graph holds true for most situations where the number of copies and number of files vary
with a particular sample of machines and the amount of recognition work carried on these
same machines.

Using the graph, you can realistically assess the file recognition level required to achieve the
goals for a particular project.

‘- With these restrictions, 100% recognition is usually unrealistic.

Defining the Cut-Off

By looking at the typical profile of unknown files versus the number of times they occur, it can
be seen that typically there are a large number of files that only occur once or twice across the
sample of scan files.

This file count drops rapidly as files that occur multiple times are encountered. Therefore it is
sensible to define a cut-off level in the file count to keep the number of files manageable. The
cut-off may start at the 10% off level and progressively be reduced to 5% off or lower,
depending on the number of known files that need to be handled and the target recognition
level.
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The exception to this is when there are business critical or special applications that only occur
once or twice across the scan file sample. In this case, these applications are targeted and
added to the SAI

In many instances a cut-off of 95% of installed files is seen as a realistic target.

Estimating How Long the Recognition Project Will Take

Estimating the time required for software recognition is based largely on experience. Factors
that can play a big part are:

e Familiarity with Analysis Workbench.

¢ The number of scan files available.

¢ The quality of the scan file data — does it include valid header information in the files?
¢ The cut-off point required.

e The availability of local contacts — accessibility and responsiveness.

e Availability of personnel to visit machines or to investigate particular software.

e The file types to be included in the recognition. It is usual to restrict the types to COM,
EXE and DLL files when teaching from scan files.

As a rule-of-thumb, over the project period an average of 100 files per day can be taught to
your User.zsai file. This equates to 10-12 files per hour or roughly one every 5 minutes.

In the early stages of the project, you will need time to become familiar with the data set and
to select a subset of scan files for teaching.

The most productive stage is when you have lots of files that can be quickly analyzed and
taught. In particular, if it is possible to cluster a number of files together, it may be possible to
achieve a better result than 100 files a day.

However as the project progresses, the amount of useful data available from Analysis
Workbench can diminish. It becomes necessary to spend time contacting people who have
specialist knowledge of the products or physically visit the machines and check the
applications manually.

This can have a significant impact on recognition productivity.

Example Recognition Information from a Small Project

The following are recognition statistics from a software recognition project.

The project used 900 scan files that contained 19,680 file names with 448,991 occurrences.
The percentage of unrecognized files and occurrences is shown in the following table:

Table 58 Example Recognition Information from a Small Project
Start Finish
Recognized file names 45% 54%
Unrecognized file names 55% 46%
Recognized occurrences 82% 95%
Unrecognized occurrences 18% 5%
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Around 1,820 files were taught over the duration of the project. The result was a 9% increase
in recognition and 13% changes in occurrences.

Specifying the Scope of Teaching from Scan Files

It is important that you make all parties involved in the project aware of the scope of the
teaching process before the project commences so that expectations are correctly set and met.

This is due to the difference in methods between using scan files for information and using
installations of applications.

With application installations, it is possible to perform typical installations and see where all
files are being deployed.

In the case of using the information available from scan files, the information relating to an
application may be incomplete or different from other databases. This may be because:

e Available scan files may have incomplete installations.

e License relationships may be incomplete again due to incomplete installations.

Getting the Best Results
As discussed, scan files of users’ machines are not an ideal source of data for teaching,
although it often is the only source of data.

For applications where it is imperative that they be recognized as accurately as possible, it is
recommended that you follow these steps where possible:

1 Use an “empty” machine with just the operating system installed. The best way is to
install the machine once and generate an image of it that can be restored to this state for
every application.

Scan the machine and store the result as the “reference” scan.
Install the application to be recognized.
Scan the machine again, storing the result as the “application” scan.

Use both scan files in an import in the SAI Editor.
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When used in this fashion, the SAI Editor can “subtract” the reference scan from the
application scan. This allows a very accurate degree of teaching as all files affected by the
installation can be automatically added to the library.

However, this method is more time consuming than when using scan files of users’ machines
and requires a dedicated machine for the teaching work as well as access to the installation
media for the applications.

The HP Application Librarians use this methodology for almost all applications that are
added to the Master Library. MSI files are added to the Library using the MSI Importer in the
SAI Editor.

Selecting Scan Files for the Project

Although a large number of scan files may be available, the only time that they all need to be
loaded is when you need to produce progress statistics.

For teaching purposes, the smaller the subset of scan files loaded the better. This is because
the recognition algorithm has fewer files and directories to scan, hence producing recognition
results faster.
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When choosing scan files for the project, consider the following:

Particular location or department

Certain departments such as Finance or Personnel may be the only users of a certain type
of application (for example, invoicing software).

Machines types — server or laptop

These may contain special software (for example, communications software). Servers may
contain server components of an application.

Specific scan files by name

These may contain specific applications — such as a bank payment transfer — that only
occur on a particular machine. Alternatively, the scan file may be an example of a much
larger set of scan files that contain particular files.

Using Analysis Workbench to Pick Scan Files to Load

Choosing a few scan files from a list of several thousand can be time consuming. The following
steps show two different methods of different complexity that can be used to single out the
scans that would be best for a teaching session.

Simple method: Use an Analysis Workbench Load Query

1

Use the query option when loading scan files and generate a query that includes the
desired assets.

The selected Query will check all entries, which in a large list of scan files can be time
consuming. If you need to load the same list of assets repeatedly, the more complicated
method may be more appropriate.

Complex method: Load all scan files to locate the best ones to use

1
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Load your scan files into Analysis Workbench

In the Files window, tag all CheckVer and Unknown files.

Select the Files option from the Export menu. The Export to Files dialog box is displayed.
In the Export to Files dialog box, click the Export Files tab.

Select the One line per item option.

Make sure you have selected the Asset Number and Name options in the list.

Click the OK button.

Import the exported data into a database program such as Microsoft Access 2000.

Run a query that groups on the first instance of a file name. This provides a list of scan
files that contain files of interest. The following is a sample SQL query:

SELECT DISTINCTROW Files.Name, First (Files.[Asset Number]) AS
[FirstOfAsset Number], Count (Files. [Asset Number]) AS
[CountOfAssetNumber], Files.Directory, Files.Publisher, Files.Application,
Files.Version, Files.Size

FROM Files

Group BY Files.Name, Files.Directory, Files.Publisher, Files.Application,
Files.Version, Files.Size

HAVING (((Files.Name) In (SELECT [Name] FROM [Files] As Tmp GROUP BY [Name]
HAVING Count (*)>1)))
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ORDER BY Files.Name, Count (Files. [Asset Number]):;

10 Take the output from this query and edit it into a script file under a section heading.
Ensure that the full path is loaded. This can be defined with a variable for the path. Then
use the Analysis Workbench LOAD SCANFILE LIST script to select the section.

11 Run the script and this will load the defined scan files without having to wait for the user

interface.

Further Information

See the following sections in Analysis Workbench on page 17:

e Analysis Workbench Scripting on page 181 for more information about the “scan file list”
script.

¢ Loading Data from Scan Files on page 87 for more information about querying when
loading scan files.

e State Images on page 36 for more information about state images.

Grouping Files
Having selected the scan files to work with for a particular session, the next thing you need to
consider is the grouping of files based on specific criteria of interest.

This method is preferable to just examining files individually as it may lead to multiple files
being selected for teaching at one time. The following sections discuss the benefits of
particular selections.

Group Files by Date Without Selecting by Type

This method allows files (recognized and unrecognized) to be grouped together. This can help
pick up stray files that may have been stored in directories away from the main application
directory.

Date and Time Stamp in Windows

The file date and time stamp in Windows 200x/XP/Vista usually depends on daylight savings
time. This means that if a file was originally installed under GMT with a time stamp of 4:50,
if the time is changed to BST (GMT+1), then the files’s time stamp becomes 5:50.

Vice versa, if an application was installed under BST and then the clocks were put back, the
time stamp would change to 3:50.

This also means that using the date to cluster files when the machine is running Windows
200x/XP/Vista could give different results if machines have been scanned with installations
either side of a time change.

) This effect does not occur with UNIX.

Group Files by Name

Products such as HP printer drivers often start with the same letters (that is, HP). Also files
starting DC or DD may in fact be deleted files in the RECYCLE directories.

Group Files by Header Information

There are a number of files which are in archives or Cabinet files. It may be necessary to
create a special Scanner which stores archives as directories.
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Examine Directory Names

This can include Publisher, Application and even Version in some cases. Look for more than
one directory with subdirectories off it. Look particularly under Program Files as often this
is the default base directory for an application.

Look at Entries in Installed Applications

In Analysis Workbench you can select a machine and right-click it to display the scan file in
Viewer. By looking in the Hardware and Configuration Data > Operating System > Installed
Applications folder, the applications that have been registered in the System Registry will be
displayed.

This information is also available in Analysis Workbench in the Machine Window under

Windows Installed Apps. The column entries are not necessarily in alphabetical order.

Use Applications Window in Operational View

The Operational View displays all applications with partial or full identification.

In this view, Checkvers are displayed for an item. This reflects the fact that the file(s) is
Checkver. Use this to recheck files and directory information. Often the grouping yields some
information about a version.

To set Operational view:

1 In Analysis Workbench select the Load Options command from the File menu.
The Analysis Workbench Load Configuration—Advanced dialog box appears.

2  Click the Display Filter tab

3 Select the Load Operational View option.

Activities During Recognition Project

Teaching Recognition

After files have been selected, the teaching can be performed. This is the process of converting
Checkver and Unknown files into recognized files in the Main or Associated categories.

See Teaching Applications to the User SAI on page 139 for information about how to do this.

Logging Your Progress

There are several ways that you can log your process:
¢ Checking the number of files that have been added to the User. zsai file.

This must be done manually from the beginning each time, because files added later to an
existing application are absorbed into the existing application.

¢ Checking the number of applications in the User. zsai file.
This is useful but does not reflect the number of files contained in each application.
e Loading a set of scan files against the User. zsai file.

This is the most reliable way of tracking progress.
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This is one of the few times that all the scan files need to be loaded. To keep the memory
requirement down, only load *.exe and *.com files, and ignore Directories and
Hardware data. This cuts down the amount of data to store in memory. This is a valid file
selection, as it is unusual to teach *.d11 files, for example, when just using scan files.

If the number of scan files gets too large for the available memory, then it will be
necessary to split the load sets into more manageable chunks. Produce an export of all
files using Name, Copy Count, and Status. These exports can be appended to produce one
file. Then import the file into a database, and perform the necessary query on the data
having first produced a query to eliminate duplicate file names.

Although the bulk of Main files are * . exe files, some applications are only identified by
specific *.d11 files or some other executable. In this case, all executable files will need to
be loaded with the consequent impact on memory.

Finishing the Teaching Project

The project objective is to produce a clean User SAI that has recognized files to the defined
cut-off level. The quality of the data will only be assessed as the information is being used.
Issues that may compromise the data quality can occur for a number of reasons. Remember
that when teaching from scan file based information only, the data available may be
incomplete. The following section shows some examples of possible errors that may occur.

Recognition Errors

Here are some common recognition error scenarios:

Header information is at a variance with the actual product. This can happen with OEM
or 3rd party support products. The product version is often different from the file version
(in this case, use the product version).

Versions have not been applied correctly. Scan files may not include version information if
the Scanner has not been set up to collect internal file identification data. Another reason
might be that the application version reported in internal file data does not match the
marketing version of the product. For example, Windows NT5 is packaged as Windows
2000. Microsoft Publisher 2000 has an internal version number of 6.0.

Orphan files may be assigned incorrectly. These may be files that are not part of the main
directory list for an application. They often reside in the \Windows or \Winnt directories.

User recognition of application is incorrect. An application may be given a working name
that is different from its official title.

A version is installed that is different from the current license. Newer versions may have
to be purchased for license purposes, but copies of the older version are deployed for
compatibility reasons.

Input Errors

Here are some common input error scenarios:

Application Teaching

Vendor or application name is not consistent. This needs to be edited to ensure
consistency for reports and exports.

Product name does not match invoices or packaging. This would not be identified purely
from the scan file content.

The wrong version has been applied to a particular file. This could be caused by multiple
versions being installed in the same directory.
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e A space has been left in front of the text entry. This can happen if the entry is taken from
teaching mode straight from the header.

Situations Where the Recognition Information Does Not Match the Client's Software Invoice Details

If a client already has a database of software purchases, there can be a number of situations
where the information taught to the SAI does not match software invoice details.

e The information in the SAI is incorrect. This may be due to incorrect descriptions obtained
from file headers or the effect of misallocation of files in a mixed directory.

e The information in the SAI is out of date. Often for marketing reasons a product is
rebranded. Edit the SAI to reflect the change. For example, Dr Solomon’s Antivirus
becomes Total Virus Defence.

e The application is a device driver that needs hardware to be present. Therefore, the
hardware effectively is the license and so there may not be a Main file.

e [If after a Service Pack, Service release, or Hotfix is applied, only some associated files of
the original application — but not the main file — are changed, the application itself will be
reported as it was before the update. In this case, there might not be a Main file
associated with a particular Service Pack, Service release, or Hotfix.

Dealing with Specific Groups of Software

The following items should not be regarded as a definitive list of recognition methods, but
rather they show the types of decisions that need to be taken when interpreting the available
data. It is up to the individual to define a scheme that meets the needs of a particular
situation.

Install/Uninstall Programs

Unless they can be tied to specific applications, use a generic setting of:
e Publisher = Various
e Application = Installation Program

e Version = Generic

Compressed Files

Often these come as part of the application, but they can sometimes be located in directories
away from the application.

For a zip or Microsoft Cabinet file, use the archive option in the Scanner to capture the

directory list of compressed files, and then compare with the other files on the machine.

Run-Time Files from Applications

Products such as Macromedia Director, Flash, etc., can produce run-time executables. It is not
always possible to identify the content of the file, as the header will usually relate only to the
generating application.

e  Publisher = Name of the Publisher of the generating application
e Application = Name of the generating application

e Version = Version of the generating application (if known) otherwise use date of run-time
file.
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Files in Recycle Bins

Files in Recycle Bins will have file names such as DC1, DC9, DD1, etc. To remove them from
the Unknown count, either:

e In Analysis Workbench, set load options to exclude recycle directories so that the contents
do not appear in file counts.

e Teach the files in the directories with a generic description. For example
— Publisher = Various
— Application = Recycle Bin
— Version = Generic

It is important to check that the file name is not being used by a valid application. This means
that any file not in a recycle directory still needs to be taught separately. This also means that
it is dangerous to set a wide range of file sizes, as this range might encompass valid files.

The best approach would be to first load with the Recycle Bin directories included to produce a
list of files in these directories. Then, reload the data with the load options set to exclude the
recycle directories from normal teaching.

Zero Length Files

Files of zero length do occur as a result of uninstalling applications. Because these will never
be executable files, then there is no recognition to be done. Therefore, just produce a report of
zero length files for record purposes. Typically in a batch of 3000 files, there may be 10 to 20
such files.

Windows Hoffix

These are the intermediary fixes that are available between service releases. Identify:
e  Publisher = name of publisher issuing the fix
e Application = name of application + HOTFIX

e Version = Date of file unless version details supplied

Applications That Are Available on Different Platforms

Some applications have the same name irrespective of which platform they appear on. Two
approaches can be used, either:

¢ Consolidate all the files from all the different platforms into one application. This could
lead to a range of file sizes for a particular file name.

e Teach each platform separately, and add the platform detail in the OS field of the

application version.

Creating a List of Files Not Requiring Detailed Recognition

This may be a list of files not requiring detailed analysis for some reason. It may be that you
wish to highlight internal use of applications (such as games) or that an application is
internal and does not need detail version information.

e  Publisher = Dummy or some other generic name

e Application = Dummy or some other generic name
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e Version = Dummy or some other generic name to save having to use separate dates.

0 This activity should only be used as a last resort, otherwise everything will be added to this
list without proper analysis. You may be tempted to do this thinking that if you move files
from unrecognized to some form of recognition, then the recognition job is done. The problem
will become apparent when you start to produce reports.

Why Applications May Be Taught Without a Main File

One situation where an application can be taught without a Main file is when the application
is a device driver that requires hardware to be present. Therefore the hardware effectively is
the license.

Using States

Rather than loading large numbers of scan files each time for a session, using States can
considerably reduce the time to access data, provided that States and SAIs are kept
synchronized. If the User SAI is updated, then a new state needs to be stored before exiting
Analysis Workbench.

For further information refer to the section about State Images on page 36.

Components of Applications

Some examples of groups of applications are given in this section:

e Microsoft Office 95 has Word 6

e Office 2000 is packaged as Office 2000 but has an internal version numbers of 9.x.
e  Microsoft Publisher 2000 has internal version of 6.0

Components of the Different Editions

Table 59 Examples of Components of Different Editions - 1
Office 2003 Professional Enterprise 2003: | Office 2003 Standard:
Office Word 2003 Office Word 2003
Office PowerPoint 2003 Office PowerPoint 2003
Office Excel 2003 Office Excel 2003
Office Publisher 2003 Office Outlook 2003
Office Outlook 2003
Office Outlook 2003 with Business
Contact Manager (US)

Office Access 2003
Office InfoPath 2003
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Lotus SmartSuite Release 9 (or ver.9.8)

Table 60 Examples of Components of Different Editions - 2

Name

Application type

WordPro Wordprocessing software
1-2-3 Spreadsheet software
Approach Database management system software

Freelance Graphics

Graphics or photo imaging software

Organizer Calendar and scheduling software
FastSite Web page creation and editing software
ScreenCam Video creation and editing software

How to Handle Special Groups of Files
e  WinZip Self Extractor

Use the Scanner with ZIP extension

Abbreviations

e ZAK - Zero administration Kit from Microsoft

e ZEN - Novell

e TVD - Total Virus Defence - Network Associates

e SMS - Systems Management Server - Microsoft

Tracking Your Progress

When using a large number of scan files for recognition, the bulk of the time is spent with a
subset of the total scan files available. Usually, the total number of scan files only need to be

loaded to produce figures relating to the split of Recognized and Unrecognized files.

The easiest way to track your progress is to:

1 Load the scan files into Analysis Workbench.

2 Locate the Status column in a Files window.

3 Right-click the column header, and select the Chart option.

This produces a chart showing the necessary split of the status of files—that is, Main,
Associated, 3rd Party, checkVer, Unknown, Unprocessed and Auto-identified.

You can also:

1 Select the Copies column.

2 Left click the column header.
This ranks the files in copy order.

3 Use a Global tag to tag all.

4  Untag selections to deselect unwanted types and/or chop count cut-off.
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If a tag selection is made of Unknown and Checkver above a certain number of copies,
then a file filter can be applied to the machines window to select the scan files where these
occur.

To prioritize the work, just select the scan files with the most tagged files. This is done by
ensuring that the Tagged Field column (from the scan file section) is displayed.

Sort on the number of tagged files and select a small group of scan files from this
selection.

These can be added to an OR query when loading scan files. Or, for a faster response
without the user interface, use scripts to load a list of scan files.

Further Information

For further information about exporting refer to Exporting Inventory Data on page 168.

For further information about tagging and filtering data refer to Tagging on page 125 and
Filtering on page 129.

For further information about scripts refer to Analysis Workbench Scripting on page 181.

Teaching UNIX Applications Using Scan Files

This section discusses the following topics:

Special Considerations for UNIX Teaching on page 362
Recommendations on page 363

UNIX Teaching Process Overview on page 364

Selection Techniques on page 365

File Clustering Notes on page 367

File Identification on page 367

Information Stored in Installed Applications Lists on UNIX on page 367
Standard UNIX Directories in System V Release 4 (SVR4) on page 368
Configuring DDM Inventory for UNIX Application Recognition and Teaching on page 369
Confidence Levels for SAI Teaching on page 370

Flavors of UNIX on page 371

UNIX File Types on page 373

Additional background information related to teaching with scan files is available under
Teaching Windows Applications Using Scan Files on page 349.

Special Considerations for UNIX Teaching

This section is for users who are not familiar with the UNIX OS environment and some of the
issues associated with dealing with UNIX files.

These are guidelines for best practice rather than hard and fast rules. As you gain familiarity
with the various data analysis tools supplied with DDM Inventory, you can develop new ways
of clustering files to meet specific needs.

Chapter 7



The mechanics of teaching UNIX applications to a User SAI are exactly the same as for
Windows applications. For example, Publisher, Application, Application Type, Release,
Version, etc. need to be identified and applied to one or more files.

However, the information gathering exercise required for UNIX teaching can be challenging,
since the files themselves do not provide the same richness of information as in Windows.

Teaching software under the UNIX operating system relying only on scan files requires a
slightly different approach than that used with Windows. Here are some of the points to
consider:

e No version data is available from the files. This means there is no direct confirmation as
to the source of the file.

e There is a limited amount of information available from the OS installed application list.
This is assuming built-in UNIX software install tools (such as, SWTOOLS) have been
used for installation. Many applications like Oracle can use their own installer and,
hence, do not appear in the OS installed applications list.

e More communication with local knowledge specialists (site administrators or staff who
are familiar with the on-site applications) may be needed than with Windows. Ideally,
these people should have solid UNIX systems-level knowledge.

e Analysis Workbench is used in a different way from Windows data analysis. The main
difference is that rather than concentrate on files and their properties, the emphasis is on
clustering files from the directories into an application.

e There is no single version of UNIX. See Flavors of UNIX on page 371 for the different
UNIX platforms that are supported by DDM Inventory.

Recommendations
Here are some recommendations you can consider incorporating into your teaching project:

Use Separate User SAI Files for UNIX Entries

It is preferable to use a separate User SAI for UNIX entries. The reasons for this are:
¢ (learly identifies UNIX specific applications.
e It is quite likely that UNIX machines will be processed separately from Windows based

machines so this allows a separate set of load options to be set.

Use Separate User SAI Files for Different UNIX Flavors

If there are numerous UNIX flavors on site, then it may be preferable to have separate SAIs
for each of them (for example, Solaris, HP-UX, AIX).

Scan a Base Machine that has Only UNIX On It

Since UNIX installations can be highly configurable, the ideal situation would be to scan a
base machine that only has the operating system installed on it. This provides a base line
from which to work. This should be considered even when the Operating System is included in
the UNIX Master, since site specific patches may have been applied.

However, it may not always be possible to scan a machine that has only been installed with
the Operating System and no other applications. If one is available then this should be used to
teach as many Operating System related files (for example, patches) as possible. This should
be dealt with first.
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Tag the target machine and the selected files, and teach these files as the base operating
system build. This then removes the files from the unknown list.

If a clean build is not available, then files normally found within the Operating System
directories should be selected for teaching first.

From a file recognition perspective, the binary executable types for each UNIX platform are
distinct and easily recognizable (e.g., HP/PA Coff for HP-UX, SPARC ELF for Solaris, AIX Coff
for AIX, x86 ELF for Linux). Directory structures and file names are typically the same across
different UNIX platforms for a given application.

UNIX Teaching Process Overview

An overview of the process of UNIX Teaching using Analysis Workbench follows:

1

5
6
7
8

From discussions with local specialists, identify a range of applications that are known to
be on the scanned machines.

Since the number of applications is likely to be much smaller than for Windows, it is
useful to track the clustering of files by machine selected and base directories included in
the cluster.

This can be used in further discussions with local specialists to determine and confirm the
application details.

Determine the number of unknown files to discover from the scanned files. To do this:
e Load a full set of scan files into Analysis Workbench with the Master UNIX SAI.
e Select the Status column, right click the header, and choose the Chart option.

This will give an indication of the level of unknown files.

Select machines with the largest number of unknowns. To do this:

e In a Machines Window, create a column from System Data > Application Recognition >
Unrecognized Files

¢ Sort on this column, and then Tag machines with the largest unrecognized files
counts. Save these machines as a Tag list for further use.

Unload the scans.
Take a selection of sample machines from each flavor of UNIX in turn.
Create a user SAI for each flavor of UNIX

Select and load a target scan file — use entries in the previously saved Tag list

OS Files

1

2
3

Identify the OS version on the target machine:
Hardware > Operating System Data > UNIX type and Host OS
Tag the OS directories

Teach the unknown files found in these directories using the OS details

Installed Applications

1

364

View the OS installed applications list in the Hardware tab of the Viewer.
If there are any that can be identified then teach these.
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Recognized Applications
When a UNIX Master SAI is available, use this to identify as many of the files as possible.

If there are some recognized applications do the following:

1 In Analysis Workbench, select an application, tag it, and then check the Files Window and
Directories Window to see if the are any sub directories that contain Unknown or
Checkver files.

2 Ifthey do contain such files, then a reasonable assumption is that the Unknown and
Checkver files are from the same application—possibly patches, for example.

3 Cluster the files and add them to the SAI using same details as the existing files.

Directories

Having worked on these applications, turn your attention to the directories.

1 Check environment paths for execution paths (for example, PATH). These are likely to be
the directories where the main applications are located.

2  Select directories for file clustering.

3 Cluster files and add them to the SAI.

Selection Techniques

Identify OS Version on the Target Machine

Use one of the following methods to identify the OS version on the target machine:

e In Viewer, use the selection Hardware > Operating System Data > Host OS Name and
Host OS Version

¢ In an Analysis Workbench Machine window, select the appropriate column to display. This
is used to establish the version for the files in the main operating system directories.

Tag OS Directories — See OS Directories List

Select main OS directories and cluster files to an application.

Select known applications and select their directories and check for unknown or Checkver
files mixed in the same directory as known files.

View the OS Installed Applications List

Some UNIX flavors contain directory paths of the OS Installed applications — see the HP-UX
example on page 367.

In the Viewer Hardware tab, go to Operating System Data/OS Installed Applications to see
which applications are logged under the Operating System.

Check Environment Paths for Execution Paths

On the Hardware and Configuration tab in the Viewer, use the Operating System Data >
Environment information to check specific paths.

These will point to directories containing executable applications.

Choosing Directories to Target for File Clustering

In Analysis Workbench, select directories for file clustering using the following criteria:
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¢ Directories with recognizable descriptions in the path name

¢ Directories with the largest number of unknown files

How to Find Directories with a Specific Name

1 In an Analysis Workbench Directories Window, right-click the Name column heading, and
select Tag > Contains.

2  Enter the name or partial name in the Search String box.

3 Select Anywhere for the String Position.

How to Determine Which Directories Have the Most Unknown Files

1 In Analysis Workbench, ensure that the Directories Window has the Tagged Files column
displayed.

2 Go to a Files Window, and tag files with Status = Unknown or Checkver.
3 Go to a Directories Window, and sort on the Tagged Files Column.

The result may appear confusing, because the file counts do not always display in file count
order. This is because the directory displays the total count of files but is placed in the order of
the tagged files. To obtain a total count of the files, right click the Tagged Files column
heading, and choose Sum.

The screen does not refresh the tagged files count correctly if the file tags are removed.

File Details

If there are multiple versions of an application that have shared files in the same directory,
choose the oldest version first and then progressively teach the newer versions in order. This
is on the basis that the older files have carried forward into the newer versions.

Check that the main file selection is consistent in order to count licenses. This may require
more than one Main file to be selected.

Look for consistency under the same date for the same version of the application

Group the files under the known application. There may be more than one version of the
application sitting in the same directory. In this case it will be necessary to try and allocate
the files to each version based on date.

Recommendations

e Never use a script file type as a Main file because these can appear in different operating
environments or not used on a particular machine. This could lead to incorrect license
counts.

e Load one UNIX operating system flavor at a time. This is to ensure that if an application
exists for different environments, that they are taught for the specific operating system.
This is because the same file name can have widely differing file sizes depending on the
operating system. The binary executable file types will also vary from one UNIX platform
to another. For example, HP/PA Coff files should only exist in HP-UX applications, not in
Solaris versions.

e Version numbers may need to be approximated e.g. 4.3.3.79, 4.3.3.12 and 4.3.3.26 etc. may
need to be consolidated as 4.3.3.x
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File Clustering Notes

1 Identify a machine with the sample applications on it.

2 Select the base directory.
’ To tag all sub directories off a base directory.

e Select base directory in Directory Window.

e  Go to Details pane display path.

e (Click on path and use Ctrl C to copy all or part of the path string.

e Go to Directories Window and right click on “Name” column header.
e Select Tag > Contains > search string and Ctrl V to copy path string.
e C(Click OK. This will tag all the directories with the base path string.
Tag the directory and sub-directories.

3

4  Apply directory filter to Files window.

5 Tag All files displayed in filtered display.
6

Add to SAIL

File Identification

Use web search facilities to identify applications and publishers. It may be sufficient to enter
the name of a file and it can be found in an on-line document that relates to an application.

It may be necessary to become familiar with the various acronyms associated with a product
in order to identify it.

Information Stored in Installed Applications Lists on UNIX

You can find the installed applications for different operating systems in the Hardware tab of
the Viewer.

The installed applications are listed under:
Operating System Data>0S Installed Applications

The amount of detail provided varies between UNIX flavors. These mainly refer to OS drivers
etc. but can be useful in determining version numbers when teaching OS support files and
libraries.
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Standard UNIX Directories in System V Release 4 (SVR4)

The following table lists all standard UNIX directories in System V Release 4 (SVR4).

Table 61 Standard UNIX Directories

Directory Description

/ The Root directory, which is always present and is the parent
of all the files in the file system.

/dev Contains device files including terminals, printers and hard
disks

/etc Contains system administration and configuration files, the
most important of which is /etc/passwd

/home Directory containing the home directories for all the users

/opt Root directory for file systems used by add-on applications

/sbin Programs used when booting the system

/spool Contains the directories for spooling files

/spool/lp Spooling files for the printer

/spool/uucp Files queued for UUCP

/spool/uucppublic Files placed by UUCP

/stand Standard programs and configuration files used when
booting

/tmp Contains temporary files created by UNIX

/usr User accessible programs

/usr/bin Executable programs and utilities

/usr/ucb Contains the BSD compatibility package

/usr/games UNIX games

/usr/lib Libraries for programs and programming languages

/var Contains files whose content vary as the system runs

/var/admin

/var/mail

/var/news

/var/opt

/var/tmp

/var/uucp

Other UNIX systems may contain other key directories
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For instance:

Table 62 Key Directories in Other UNIX Systems
Directory Description
/kernel Contains OS kernel and related files

for Solaris.

/X11 Contains files for the X Window
windowing system.

Directories such as /opt or /var may be used for customer installations in the same way that
Program Files directory is used in Windows. However, some applications choose their own
directory structure and local configurations of applications may override the default directory
paths. Again, local knowledge is useful here.

Configuring DDM Inventory for UNIX Application Recognition and Teaching

Scanner Configuration for UNIX Scanning

For scanning, include signature to assist with uniquely identifying the first 8K of a file.

The file details are to save UNIX executables (binary and script). File extensions can be
included but this may lead to spurious recognition.

Selected directories can be ignored provided they are known to be data directories only. This
can be included in the scanner generator, otherwise create an .override.ini file that
contains the directory exclusions.

Setting up XML Enricher to Include the UNIX User SAI for Recognition
Follow these steps:

1 Go to Server > Administration > System Configuration > Scan processing > SAls

2 Make sure that unix.zsai as well as the User SAI used for UNIX teaching are in the
SAI list and that they are enabled.

Load Options in Analysis Workbench

The key load options are set as follows:

Table 63 Load Options in Analysis Workbench
Option Description
Load Either Load ALL files. This includes non executables.

Or Load Executable and Archived only. This will reduce the number of files to
load and needing recognition may not include script files.
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Table 63 Load Options in Analysis Workbench

Option Description

Recognition | Recognition method - SAI

Recognition Settings — Use level 3 heuristics.

Either Apply recognition to ALL files.

Or Executable and Archived only. This will reduce the load time.
In either case the SAI libraries to use are as follows:
master.zsai contains key information for Operating System etc.

unix.zsai this contains a mixture of Solaris, AIX, HP-UX, and Linux
applications.

Display Applications
Either Operational View.
Or Business View.

Business view only displays applications in the Applications window that
have a Main file in the Files window, while the Operational view displays
ALL application entries found in the SAI. These may be just be Associated
files or Check ver.

Recommendation

Use Operational View for teaching to see all the entries.

Use Business view when reporting to concentrate on Applications that are
licensable.

Confidence Levels for SAl Teaching

Without original media that can be installed on a clean build, SAI teaching cannot be perfect.
Therefore some assumptions need to be made about the quality of the data produced. The
following list rationalizes the confidence levels of recognition based on the information
available and its suitability for inclusion in the various libraries.
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Files used for Main file selection should be in the first two options since they have
implications for license management.

Table 64 Confidence Levels for SAI Teaching
Option | Information Available Confidence Comment
1 Publisher, Application, Release, | 100% Best possible result
Version, Key file, Before and
After Installation scans
Relationships known
2 Publisher, Application, Version, | 80% Application is identified
Key file, Identifiable Base but associated files may
Directory plus sub-directories not all be included if
located in orphan
directories. This may
make application
relationships incomplete.
3 Directory providing information | 60% Application identified but
about application and version key file may be incorrectly
that can be checked on Internet assigned leading to
or other sources miscount in the
Applications and incorrect
relations.
4 Directory providing information |40% Version information may
about Application name only be mixed or inconclusive.
Need to use date
5 File sitting in a directory that is | 40% Could be an associated file
part of the operating system but is unlikely to be a key
file for an application.
Need more information
6 File name identified from 20% Could be an associated file
Internet or other sources but in a shared library.
other files in directory from other Need more information.
applications
7 File name not found in Internet | 0% Unless more information
or other sources, Directory name can be found or a copy of
not recognizable as an the file executed then it
application or publisher, date not will remain unknown.
matching any other in set
Flavors of UNIX
AlX

Acronym for Advanced Interactive Executive. A version of UNIX from IBM that runs on its
Power Systems, including System p and System i.

Although AIX is derived from System V Release 4, it is POSIX-compliant and meets the
Trusted Computer Base (TCB) Level C2 security.
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One of the major enhancements AIX offers is Visual System Management (VSM), a graphical
interface into the older System Management Interface Tool (SMIT). VSM contains four main
elements: Print Manager, Device Manager, Storage Manager and Users and Groups Manager.

HP-UX

A version of UNIX for HP computers. HP-UX includes BSD extensions, including the
networking commands, the Korn shell, and a version of emacs. VUE (Visual User
Environment) is HP’s GUI with individual workspaces for different tasks, drag-and-drop
functions, a text editor, color icon editor, as well as other productivity tools.

HP-UX also includes SAM (System Administration Manager) for common administration
tasks, such as adding new users, installing and configuring peripherals, managing processes
and scheduling jobs. Diskless computers, either clients or servers, can boot from the server
and can support locally mounted file systems, so that each client has access to its own data
files as well as being able to share files with others.

Solaris

A version of UNIX from Sun Microsystems that runs on Intel/AMD based computers and Sun
SPARC workstations and servers.

Solaris is based on UNIX System V Release 4, and includes networking support. The latest
version features Java Desktop System based on GNOME that comes with a large set of
applications, including StarOffice.

Linux

A UNIX-compatible operating system originally developed for Intel-based PCs. It now exists
for many other platforms as well, including PowerPC, and Sun SPARC.

Strictly speaking, Linux is the name of the operating system kernel. Other parts of the
operating system are part of the GNU Project. Linux is a complete UNIX clone and supports
the X Window system.

Mac OS X

Mac OS X is a UNIX based operating system from Apple. The core of the system is a POSIX
compliant operating system named Darwin that provides the standard UNIX command line
interface. On top of it, higher levels of the Mac OS X system are built, including the Aqua user
interface. Mac OS X is the most popular general-purpose UNIX-like operating system
currently in use.
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UNIX File Types

Table 65 UNIX File Types
Operating System File Type Description
All Script List of commands in a text file to be

executed by an interpreter. The term
script and shell program are often
used interchangeably.

Solaris (SPARC/x86)

ELF

Executable and Linking format is the
binary output produced by gcc
compilers. It replaced an earlier
format to take advantage of shared
libraries.

Coff

Common Object File Format. A
revision to the format of executable
and object files to provide support for
dynamically linked libraries. The
COFTF definition was replaced by the
Executable and Link Format(ELF) in
SVR4

HP-UX (HPPA, ia64)

ELF

See ELF above

HP-UX (HPPA)

Coff

Similar to AIX Coff

Linux

x86 ELF,
x86-64 ELF

See ELF above.

Mac OS X

Mach-O

Mach-O is short for Mach Object file
format, the executable file format
used on Mac OS X for executables
and shared libraries. It is a
derivation of the a.out format that
offers more extensibility and faster
access to information.

Rule-Based Application Teaching

In addition to traditional scan file based recognition — where file details of executable files
that make up a particular application version are added to the software application library —
DDM Inventory offers an easier and more flexible way of teaching some applications to the
SAI by means of rule-based recognition.

By creating a flexible recognition rule, many versions of the same application can be
recognized without the need to keep file details for all executable files that make up the
application. There are two kinds of rules currently supported.
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¢ Version data based rules: These rules can be used to recognize simpler Windows
applications that have consistent publisher and version information reported in the
version data inside its executable files.

¢ Installed packages based rules: These rules can be used to recognize applications that
are packaged in the standard operating system package format.

Creating a rule is usually much simpler and faster than teaching scan file data for different
versions of the corresponding application to the SAI

You can create recognition rules by using the SAI Editor. In order to use this feature
successfully, you must have a good understanding of regular expressions. This chapter
provides several examples of regular expressions, but it is not a comprehensive reference. You
also need a good understanding of DDM Inventory’s recognition and teaching processes. See
Chapter 5, Application Recognition for more information.

The Version Data Rules Tab and The Package Rules Tab of the SAI Editor show the available
installed package rules and version data rules in the selected SAI.

Teaching a New Application to the User SAI

Each of the steps in the following procedure are documented in Chapter 6, SAI Editor. The
following overview table shows each of the steps and where you can find information about

carrying out that step.

Table 66 Steps for Teaching a New Application to the User SAI

Step Further Information
Add a new Publisher if it doesn’t already exist in the SAI page 275

Add a new Application page 277

Add the new Release page 279

Add a new Version page 281

Add files to the version — either from scratch or by dragging them | page 283
from Windows Explorer

Set the main file for the application page 313

Set up any license relationships for the application page 297

About Version Data Based Recognition Rules

A version data based recognition rule provides a rule-based extension to the software
recognition in the User SAI by using the embedded version data information in Windows
executable files. Recognition rules, if triggered, create entries in a separate rule-based SAI (by
default, auto.zsai) that sits alongside the standard User SAls.

This rule-based recognition feature helps DDM Inventory anticipate new versions of the
applications already installed on your scanned devices and already saved in your User SAIL
By looking at the current data for an application, you can create a rule (based on a series of
regular expressions) that will provide automatic recognition of any new versions of that
application.
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This means that you will not have to teach each new version of an application. The rule
should automatically recognize an application upgrade.

Prerequisites:

e Rule-based recognition using version data works on a unique file found in only one
directory on each machine. If this directory contains files that can also belong to other
applications (libraries, for example), then the rule may not trigger the recognition. This is
because the recognition level from the other applications may swamp the recognition level
of this one target file.

¢ For Windows devices, the Scanners must be configured to collect file signatures, identify
Windows executable files, and collect internal file identification from them. See:

Scanner Generator > Software Details > File Scanning > File Identification

Examples Where a Rule-Based Entry Could Augment the Standard Recognition Algorithm

Example 1: For the prediction of the format of a future version of a product

If an entry in the Product Version field of the version data had the format 1.2.345, for example,
a rule could be created based on a release and version having the format 1 and 1.2
respectively. The release rule would take the portion of the string before the decimal point and
classify it as the release, the version would take the string up to the second decimal point and
ignore the remaining digits.

Example 2: For translation of the Version information associated with a file

This could be mapped to a marketing version name. For example, the file version is 9.0 but the
marketing name is 2009.

What Happens When You Have Created a Rule Entry

After the rule entry has been created, it must go through the recognition process to produce
an entry in the rule-based SAI.

DDM Inventory locates the rule-based SAI as follows:

e Ifafile name appears in the SAl used to store rule-created items box at the bottom of the
SAI List tab in the SAI Editor Options dialog, this file is used.

To open this dialog, click Edit > Options in the SAI Editor, and go to the SAI List tab.

e Ifno file name appears in the SAl used to store rule-created items box, the auto.zsai file
located in the same directory as the first Master SAI file is used.

The XML Enricher should also be configured in the web UI to use a rule-based SAI. See:

Server > Administration > System Configuration > Scan Processing > SAl file used to store
rule-created items

Creating a Recognition Rule

The rule needs to have enough information to create the release and version for the selected
application.

When you create a rule by using the embedded version information in a Windows executable
file, the names for the release and the version are extracted from one of the version fields
collected by the scanner from that file.
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The version fields include:
e CompanyName

e TFileDescription

¢ FileVersion

¢ InternalName

e LegalCopyright

¢ OriginalFilename

¢ ProductName

¢ ProductVersion

When you create a rule by using installed package information, the names for the release and
version are extracted from various package properties, including hardware fields.

In either case, a regular expression is defined that can match against the version data of a
target file. The rules relating to these entries are stored in the current SAI selected by the SAI
Editor. If there is a match between the regular expression and the information in the target
file, an entry is triggered and written to the rule-based SAI file.

This file is defined on the SAI List tab in the SAI Editor Options dialog or created as
auto.zsai in the same directory as the first Master SAI.

If mapping is invoked, the result of the trigger may be mapped to a different output value. For
example, if a mapping has been defined as 9 = 2003, then when there is a successful match, it
produces a result of 9. However, instead of reporting the value as 9, it is reported as 2003.
This is used in situations where a publisher uses version descriptions for marketing purposes
that are different from those used by the software development team.

It is possible to perform the match using the full field value or to match on just part of the
field, known as Regular Expressions (Regex) Group. To create a Regex Group, it is necessary
to insert parentheses ( ) around the chosen expression. These groups allow part of the string
to be extracted and used for naming the release and version. A list of commonly used Regular
Expressions can be found on page 380.

Example of a Recognition Rule Using Version Data

The following procedure shows you how to set up a recognition rule that matches a regular
expression against embedded version data in a Windows executable file.

Also see Example of a Recognition Rule Using Installed Package Information on page 384

To set up a Recognition Rule using version data:

1 Open the Viewer and the SAI Editor.

To create a rule for a specific application, you want to see the current data in the Viewer.
This enables you to build an appropriate rule so that DDM Inventory can immediately
recognize future versions of that application.

2 Inthe Viewer, open the scan file that contains the application for which you want to create
a recognition rule. You can add rules only to a User SAI
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3

Also in the Viewer, locate the file that you want to teach using the Directories and Files tab.
In this example, we will use the WinRAR. exe file.

_{ol x|
File Edit vView Window Help -18] x|
||| mE @ B M ?
Summary I Hardware and Configuration  Directaries and Files | Stored Filez I Software Applications I
G [5ymentsc =) | Filename | Siee| Modified | attribute | E
. Rar.exe 323072 09 Awg 2008 2156 X a ,
D?mt;”‘j%ﬂ”w' RiarE st ol 132608 09 4ug 2008 2156 ¥ a )
B @ TextPa RarExthd. dl E2464 20Jun 20080041 ¥ a F
""" CTightvNCunstal | Rafutl gader.. 44032 20Jun 20081313 X a y
- [ Tookit for Devel Uninstall. exe 93240 094ug2008 21:56 = a ,
H- [ ¥Mware UnRAR. exe 205312 09Aug 2008 21:56 X a Y
- [ Windows Media 35874 005 5 )
B ] Windows NT
B 3 WinRAR « L
~ [ Formats Compary Marme Alexander Roshal
e [ Windip File Dezcrption WinBAR archiver
- 7 tem « | | File Wersion 3.80
a Dtemp i _’|_I Internal Mame WinRaR
Leqal Copyright Copyright & Alexander Rozhal 1333-2008
Clp e p i Original Filename WinRAR. exe
?.f'l - Product Marne WinRAR
ilez
1.836.032 bytes

|I'~"I|:un|:|a1,-', May 11, 2009 4:59:25 PM

|1 Scan(s)

4 Open the SAI Editor.

5 In the User SAI file, locate the application for which you want to create a rule.

If the application is not yet present in the file, you will need to add it.

6 In the SAI Editor, create a placeholder Release (for example, “X”) and placeholder Version
(for example, “XX”) for the application. If the application has not previously been taught,
it is also necessary to add the main file to the application. You can do this by dragging the

main file from Windows Explorer to the SAI Editor.

All Contents I Filez I Application T_I,Ipesl Opera

ting Systemsl Languagesl License Fi 4 I *I

[tem |

Size | Signature | Exe hype

= 2 Uzer 54 File

C:hDocurments and Settingshall U sershdpplic

= {;,‘:_"j Alexander Rozhal
= B wWinRAR archiver
=B8] 5% [eneut

{winrar.

...................

[«neutral> - <genernics]

965704

CE18-7CEF  'Win 32 Exe

7 Find the application to teach (in this example, WinRAR Archiver), and right click it.

8 Select Edit Application Rules. The Application Rules Editor opens.

9

Application Teaching

If the rule that you want to work with already exists, select it and click Edit. Otherwise,

click Add.
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The Application Rule Wizard window opens:

l Application Rule Wizard

i _|ol x|
Welcome to the Application Rule Wizard. b
Pleaze choose the type of rule ta create. F

{* File version data rule (Windows)

{~ Installed package rule

¢ Back I Mexst = I Eimizh Cancel

10 Select File version data rule (Windows), and click Next.

Now you will specify the file name, operating system, and language:

h Application Rule Wizard

=10f %]
File rule: specify an executable file name. é
The application verzion will be bazed on werzion data found i thiz file, O ptionally F

inchade 05 and language properties for the werzion,

File name to match

File name: I'-.-'-;'inRF-.R.exe

Properties for the version to be created

Operating system:  [windows 20035rv/%p 7]

Language | «<neutral= j

< Back Eimizh Cancel

11 Follow these steps to specify the file name, operating system, and language:

a Specify a Filename for a new rule or change the Filename as desired for an existing rule.

In this example, we use WinRAR. exe.
b Specify the Operating System on which the application runs.
c  Specify the Language for the application.
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12 Click Next to proceed to the next page.

‘ Application Rule Wizard T = | Dlﬂ
File rule: specify how the ame will be obtained. ﬁ
It iz extracted from one of the fil2%=sers fields uzing a regular expression. F

Data field match for release name

Field:

IF“E".-'EFSiI:II'I

Format/map matched group

Regular expression: I(( OS]+ [0-3]+)

Format: IE rfieldvalus}
Regex group index: |2 j
Mapping:

< Back I Mewt > I Firmzh Cancel

13 To specify how the release name will be obtained, follow these steps:

a
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In the Field box, specify the Version Data Field from which the release name will be
extracted.

In the Regular expression box, specify the regular expression to use. If the same field
will be used to extract both the Release and the Version, the regular expression needs
to be generic enough to provide groups that can match both names.

In our example, the Release is 3, and the Version is 3.80, as shown here:

Company Mame

File Descrption &R archiver
File Werzion
[nternal Mame e ]

Legal Copyright
Original Filename
Froduct Mame

opyright € Alexander Roghal 1993-2008
WinRAR. exe
WinRaR

The regular expression we will use for this example is as follows:

(([0-91+)\.[0-9]1+)

This expression represents two groups of digits separated by a period (dot). For
additional information about and examples of regular expressions, see Table 67 on
page 380 and Table 68 on page 381.
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The following table lists special characters you can use to build regular expressions.

Table 67 Regular Expressions

Character | Meaning

Match any character

+ Match one or more of the previous character.
For example:
A+ matches one or more As

Match zero or more of the previous character.
For example:

A* matches zero or more As.

? Make the previous character optional. For example:
assets?
matches a string containing either asset or assets.

The ? only applies to single characters when there are no enclosing
parentheses.

The characters after this symbol must appear at the beginning of the string.
For example:

Arxsf

means that the string to be matched must start with the characters xsf.

$ The characters before this symbol must appear at the end of the string. For
example:

xsf$

means that the string to be matched must end with the characters xsf.

\ This removes the special meaning of a character. For example:
\.

matches the . character, since the \ removes the special meaning of the .
character.
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Table 67

Regular Expressions

Character

Meaning

I

Character class.

Match one of the items contained in the square brackets. For example:

[123] will match either a 1, or 2, or 3.

[123]+, would match a sequence of 1's, 2's and 3's or any combination of them.

Note that within a character class, the » character does not have its usual
status but means any character except those in the class.

For example:
A character class of [*123] will match any character that is not 1, 2 nor 3.

A character class containing a - between two characters means a range of
characters. For example:

The character class [c-h] means all the lower case letters starting from ¢ and
ending in h.

There are a number of additional special predefined character classes to
represent some commonly used groups of characters.

[:alnum:]] Any alphanumeric character

[:alpha:]] Any alphabetic character

[:blank:]] Space or horizontal tab

[:ctrl:]] Control character

[:digit:]] Decimal digit

[:lower:]] Lower case letter

[:punct:]] Punctuation character

—_— — — — — — — —

[:upper:]] Upper case letter

0

Groups a set of characters together. For example:
(assets)?
would make the entire word assets an optional part of the match.

Table 68

Examples of Regular Expressions

RegEx

Description

([0-91+)\.([0-9]+) This will recognize a variety of version numbers with

two digits divided by a dot. For example, 2.4, 5.6,
etc.

([0-9]+)\.([0-9])\.([0-9])\.([0-9]+) | Similar to the one above, this will recognize a version

number with four digits, suchas 1.2.2.3, 3.4.4.4,
ete.

N[A-Za-z]*)( )([A-Za-z]*) This will recognize any text that may appear, in upper

or lower-case letters.
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¢ In the Format field, specify how the extracted field will be formatted. You can enter a
combination of text and any of the following macros.

Table 69 Examples of Macros
Macro Description
${fieldvalue} Covers whatever text appears in the field. Cannot be used for

Application Name, Publisher Name, or Release.

${appname} Application Name (returns the complete value of the Application
Name, including all formatting).

${pubname} Publisher Name (returns the complete value of the Publisher Name,
including all formatting).

${rlsname} Release (returns the complete value of the Release, including all
formatting).
${group<n>} Returns the regex group referred to by its index <n>, where <n> is an

integer number. For example, ${groupl} refers to the regex group 1.

d For the Regex Group Index, select the group from which the release will be taken—or
the entire field if the entire version field value is required.

When the Regex Group Index is N, it points to the group (sub-expression) delimited by
the Nth left parenthesis in the regular expression.

In this regular expression, for example, there are five choices: 1, 2, 3, 4 or Entire field:

(([0-9]1+)\. ([0-9]+)\. ([0-9]+)\ . [0-9]+)
I I

2 3 4

1

Here, both 1 and Entire field specify the whole regular expression. An index of 2
matches the leading digits to the left of the first period. An index of 3 matches the
digits between the first and second periods.

In our WinRAR.exe example, the Regex Group Index for the release will be 2 (the
leading digits before the period).

The Regex Group Index for the Version will be 1 (leading digits, then period, then
digits).

e For Mapping, you can enter some extra rules that will help identify applications. For
example, you can enter the following to recognize different marketing names for the
applications:

5.1=Windows XP
5.2=Windows Server 2003
6.0=Windows Vista
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In our example, we do not use this capability, as the Release is a numeric value that
does not require a mapping.

f  Click Next to go to the next page.

h Application Rule Wizard

=100 x|
File rule: specify how the version name will be obtained. &
It iz extracted from one of the file's data fields using a regular expression. F

Data field match for version name

Field: [FileVersion i

Regular expression: I: ([0-9]+)% [0-9] +)

Format/map matched group

Format: IS rfieldvalue}
Regex group index;: I 1 j
Mapping:

¢ Back I Mest = I Eimizh Cancel

Follow the same procedure to specify how the version will be obtained.

The Regular expression box is only enabled if the version data field specified in the Field
box is different from the one used to determine the release. If it is the same and you need
to amend the regular expression, click Back and edit it on the previous screen.

When you are finished, click Next to proceed to the next page.
& Application Rule Wizard -0 x|
File rule: specify additional data fields to match. 6
For example, Companyiame can be matched uzing a regular expression to make F

zure the applications comes fram the corect publisher.

{* Mo further matches
{~ Add an extra data field match

Field: IC:Jr lame j

Regular expression: I

< Back Hext = | Finizh I Cancel
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15 On this page the Finish button becomes enabled. When no further matches are required,
leave the radio button in the No further matches state, and click Finish to complete the
wizard. Normally, however, it is necessary to specify extra conditions to ensure that the

file comes from the expected publisher.

In our example, we want to make sure that the CompanyName field refers to Alexander
Roshal, which is the company we expect. If WinRAR.exe happens to be used in another
unconnected application for which the CompanyName is different, the rule will not be

triggered. Another useful option is to match is the ProductName field.

‘ Application Rule Wizard |

=] 4
File rule: specify additional data fieldz to match. ﬁ
Far example, CompanyMame can be matched uzing a reqular expression to make P

zure the applications: comes from the corect publizher.

{~ Mo further matches
{+ Add an extra datz field match

Field: ICl:umpam'r-lamE

Regular expression: Iﬁ.lexander Roshal

< Back Firnzh Cancel

Note that the Field drop-down list only includes fields that have not previously been used

either for Release, Version, or extra matches.

16 Click Finish to complete the rule configuration or Next to add another extra match.

Your new rule is now ready to be used for recognition. See View Your New Rule on page 390 to
determine whether it successfully detected the application. The Version Data Rules tab shows
all of the available version data rules in the current SAI. For more information, see The

Version Data Rules Tab on page 300.

Example of a Recognition Rule Using Installed Package Information

When the Scanner is configured to collect Installed Applications file data (see “Hardware
Data Page” in the “Scanner Generator” chapter of the Configuration and Customization
Guide), the Scanner can collect information as to which files belong to which installed
packages. Using installed package recognition rules, files belonging to a particular package
can be automatically recognized as belonging to a particular version of an application.

The following procedure shows you how to set up a recognition rule that matches a regular

expression against installed package information.

Also see Example of a Recognition Rule Using Version Data on page 376

To set up a Recognition Rule using installed package information:

1 Open the SAI Editor.
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2 In the User SAI file, locate the application for which you want to create a rule— in this
example, we will create a rule for tcl from ActiveState Software.

If the application is not yet present in the file, you will need to add it.
3 Right-click the application that you want to teach, and select Edit Application Rules.

All Cantents l Filez ] Application Types ] Operating Spstems ] Languages ] Licenze Relations ]

[tem | Size | Signature | Exe tupe | Yerzio...
= £ rhel5.zzai chvdocuments and settingzhall uzershapplicizcove ~
= <,‘-,,‘:_"fl ActiveState Software

'!I

<,‘-,,‘:_"fl BradeTech

B Tamenie Melan | niversit

¥ Edit Application Rules

¥ i Delete Del

+ Mew Item... Ctrl+M

¥

- Properties B
¥

¥

The Application Rules Editor opens.

4 Ifthe rule that you want to work with already exists, select it and click Edit. Otherwise,
click Add.

The Application Rule Wizard window opens:

h Application Rule Wizard

Welcome to the Application Rule Wizard.
Fleaze choosze the type of rule to create.

[

{" File version data rule {Windows)

i+ Installed package rule

< Back I MHext = I Eimzt Cancel
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5 Select Installed Package, and click Next. The following page opens:

h Application Rule Wizard -0l x|
Package rule: specify a package name and type. é
The application verzion will be bazed on werzion data found in thiz package. F

Optionally include 05 and language properties for the version,

Installed package to match

Fackags name: Itu:l

Packages Type
[T BFF (AIX) [T Pkg {MacOs %)
[T Depot (HP-UX) [~ Pkg (Solaris)
[T MsI (Windows) [+ RPM {Linux, ALX)
Properties for the version to be created
Operating system: IRHEL %30 j
Language I <neutral > j

Firizh Cancel

6 Follow these steps to specify the package name, type, and properties:

a Specify a Package name for a new rule or change the Installed Package Name as desired
for an existing rule. The string you enter must match the package name exactly and is
case sensitive. In this example, we use tcl.

b  Select the Installed Package Type for this application. This is determined by the
operating system on which the application runs.

¢ Specify the Operating System and Language for the application.
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7  Click Next. The following page opens:

% Application Rule Wizard O] x|
Package rule: specify how the release name will be obtained. b
It iz extracted from one of the package data fields uzing a regular exprezsion. F

Data field match for release name

Format/map matched group

Field: Ih';-.'OSInstaIIEdF-.pp'-a'ErsiDn j

Regular expression: I(( 0-2]+).+)

Format: IE rfieldvalue}
Regex group index: 1 b
Mapping:

¢ Back I M et = I iz Cancel

8 Follow these steps to specify the regular expression for the release name:

a

Application Teaching

In the Field box, select the hardware field from which the release name will be
obtained.

In the Regular expression box, specify the regular expression to use. If the same field
will be used to extract both the release and the version, the regular expression needs
to be generic enough to provide groups that can match both names.

The regular expression we will use for this example is as follows:
([0-91+)\..*

This expression represents a group of digits, followed by a period (dot), followed by
any string. For additional information about and examples of regular expressions, see
the tables on page 380 and page 381.

In the Format field, specify how the release name will be formatted. You can enter a
combination of text and any of the macros listed on page 382.

For the Regex Group Index, select the group from which the release name will be
taken—or the entire field if the entire version field value is required. See Example of a
Recognition Rule Using Version Data, step d on page 382 for information about how to
choose this value.

For Mapping, you can enter some extra rules that will help identify applications. For
example, you can enter the following to recognize different marketing names for the
applications:

5.1=Windows XP
5.2=Windows Server 2003
6.0=Windows Vista
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In our example, we do not use this capability, as the release is a numeric value that

does not require a mapping.

9  Click Next to proceed. The following page opens:

h Application Rule Wizard

Package rule: specify how the version name will be obtained.
It iz extracted from one of the package data fields uzing a regular exprezsion.

[

Data field match for version name

Field: IthSInstaIIEd.ﬁ.pp'-s'ersinn

=~

S R LI

Regular expression: I::'_'-".-_ +4.

Format/map matched group

Format: IE{ﬁE|II|Vﬂ|LIE}

Regex group index: IEnﬁrE field

Mapping:

¢ Back Eirmizh

Cancel

10 Follow the same procedure to specify the regular expression for the version name.

The Regular expression box is only enabled if the version data field specified in the Field
box is different from the one used to determine the release name. If it is the same and you
need to amend the regular expression, click Back and edit it on the previous screen.

Chapfer 7



When you are finished, click Next to proceed to the next page.

B Application Rule Wizard - | I:Ilil
Package rule: specify additional data fields to match. 6
For example, hwid5]nztalleddppPublizher can be matched using a regular expression P

to make sure the applications comes from the correct publizher.

{~ Mo further matches
{% Add an extra data field match

Field: Ih';-.'OSInstalledﬁ.ppF‘uhlisher j

Regular expression: IRE::I Hat, Inc.|

< Back I Mext » I Firizh Cancel

1 On this page the Finish button becomes enabled. When no further matches are required,
leave the radio button in the No further matches state, and click Finish to complete the
wizard. Normally, however, it is necessary to specify extra conditions to ensure that the
file comes from the expected publisher.

In our example, we want to make sure that the publisher field refers to Red Hat Inc.,
which is the company we expect. If the tc1 package happens to be used in another
unconnected application for which the publisher is different, the rule will not be triggered.

Note that the Field drop-down list only includes fields that have not previously been used
for the release name, version name, or other extra matches.

12 Click Finish to complete the rule configuration or Next to add another extra match.

Your new rule is now ready to be used for recognition. See View Your New Rule on page 390 to
determine whether it successfully detected the installed package. The Package Rules tab
shows all of the available installed package rules in the currently selected SAI. For more
information, see The Package Rules Tab on page 298.
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View Your New Rule

After you create a new rule for application recognition, you can use the SAI Editor to view the
results of adding that rule.

In the SAI Editor, click Tools > Import Data from Recognition Result.

Recognition Verification ) x|

Scanfile

IE:HD ocuments and Settingsiall Usershdpplication D ataHewlett-Packard DD MINS cansProcess il

Filez to perform recognition an
I~ By extension EXE:COM.DLL =]

[+ Ezecutable files
[ Files within Archives

ok Canicel |

Select your scan file, and click OK.

The Recognition Result Import window appears, and it will process the scan data for a few
seconds.

Right-click the file or package that you were teaching, and select View File Properties. You
can see the latest version data or installed package information as seen in the scan file.

In the SAI Editor, click Edit > Options.
Click the SAl List tab.

From the SAIl used to store rule-created items list, select the file that you specified for
rule-based recognition (by default, auto.zsai) and click OK.

In this file, expand the entry for the application to which your rule applies, and you will
see the latest data available for this application, based on the rules that you created.
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Rules Section in the XML Export

The rules section is added to end of the SAI.

/>
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</publisher>

<rules>

<rule appid="1500000000" filename="default.exe">

<fieldmatch field="ProductName" regex="" />

<fieldmatch field="ProductVersion" regex="[1-9].[0-9]" />

<fieldmatch field="CompanyName" regex="" />

<releasefield field="CompanyName" format="${fieldvalue}" groupindex="0" />
<versionfield field="ProductName" format="${fieldvalue}" groupindex="0" />
</rule>

<rule appid="1500000001" filename="SshClient.exe">

<fieldmatch field="ProductVersion" regex="[1-9]\." />

<fieldmatch field="FileVersion" regex="\.[1-9]*" />

<fieldmatch field="CompanyName" regex=" ("Ssh) ($Sh)" />

<fieldmatch field="LegalCopyright" regex=" (Comm)" />

<releasefield field="CompanyName" format="${fieldvalue}" groupindex="1" />
<versionfield field="CompanyName" format="${fieldvalue}" groupindex="2" />
</rule>

<rule appid="1500000001" filename="ssh2.exe">

<fieldmatch field="ProductName" regex=" ([ssh])" />

<fieldmatch field="ProductVersion" regex="[1-9]" />

<releasefield field="ProductName" format="${fieldvalue}" groupindex="1" />

<versionfield field="ProductVersion" format="${fieldvalue}" groupindex="0"

</rule>

<rule appid="3904" filename="iftlsnr.exe">

<fieldmatch field="ProductVersion" regex="([0-9]\.[0-9])" />

<fieldmatch field="FileVersion" regex="([0-9]\.[0-9]\.[0-9])" />
<fieldmatch field="ProductName" regex="${appname}" />

<releasefield field="ProductName" format="${fieldvalue}" groupindex="0" />
<versionfield field="FileVersion" format="${fieldvalue}" groupindex="1" />
</rule>

</rules>

</sai>
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Teaching Using Recognition Objectives

In This Section

e Introduction to Recognition Objectives on page 392
e What is a Recognition Objective? on page 392
e How to Use Recognition Objectives on page 395

Introduction to Recognition Obijectives

In an ideal world, it would be feasible to make sure that every file on every machine in the
population was recognized. However, the effort involved in ensuring 100% recognition is
normally so large that this is not practical or economical, and less idealistic goals have to be
set.

Recognition Objective Goals

Recognition Objectives are designed to ensure that the following can be achieved with the
least amount of effort:

¢ No machine has a large percentage of unrecognized files on it.
e Files that occur often in the population are recognized.
e Files that occur only on a few machines may not be recognized.

Based on this principle, Recognition Objectives help you set achievable goals for the
recognition process, measure how far you are from those goals, and provide assistance in
achieving them.

The objectives engine allows you to define as many objectives as you need. By default, only a
single objective for the entire enterprise is defined, although this can be extended by setting
up objectives that apply to subsets of the population as well.

Further Information

You can find further information about using Recognition Objectives in the Analysis
Workbench Chapter.

What is a Recognition Objective?

An objective relates to a set of machines, and has two criteria associated with it:
e Machines Criteria
e Files Criteria

Based on these criteria and the scan files loaded, you can determine whether the objective is
met or not.

Machines Criteria

The Machines criteria defines the following goal as a simple percentage that is applied to each
machine (that is, Scan file) in the objective.

392 Chapter 7



No machine has a large percentage of unrecognized files on it.

In the default case it has a value of 80%. When the objective is evaluated, machines with at
least 80% recognized files are considered to meet the objective. For the objective to be met, all
machines must meet the criteria.

Files Criteria
The Files criteria defines the following goals and is more complicated, as it is evaluated based
on the frequency of the files that occur on the machines related to an objective.
e Files that occur often in the population are recognized.
e Files that occur only on a few machines may not be recognized.

For this criteria you can choose one of several predefined shapes of the ‘unrecognized/
frequency’ graph.

Ranging from easy to achieve to hard to achieve, the predefined shapes available are:

e All

e Very Relaxed
¢ Relaxed

e Standard

e Strict

e Very Strict
e None

The shape of the Standard graph is shown in the following screen shot:
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This graph shows that the Allow % unrecognized bars are at 100% at the left of the chart
where Files occur on % of machines is low, but drop to 0% when Files occur on % of machines
is 100%.

To demonstrate the difference, the Strict graph looks similar to the following:

Aoy 2% unrecognized

0 0 20 30 40 S0 6O YO0 &0 90 100
Files occur on % of machines

This shows that the Allow % unrecognized bars is at 90% at the left of the chart, but drops to
0% where Files occur on % of machines is 50%.

Application Teaching 393



394

An

This means that when this criteria is applied, all files that occur on more than half the
machines must all be recognized for the objective to be met.

When evaluating the Files criteria, each file is categorized by the number of machines on
which it occurs. The number of unrecognized files in each category is then divided by the total
number of files in the category. If too many unrecognized files occur on many machines, the
objective is not met.

Example

To understand how this works, assume that 10 machines have been loaded.
Of the files loaded:

e 9 files are found to occur on 4 of the machines (the rest of the files will be ignored for this
example).

e 2 of those 9 files are not recognized.
In other words, 2 of 9 (22%) of the files that occur on 4 of 10 (40%) of the machines are

unrecognized.

If the Standard Criteria Is Applied:

From the Standard file criteria chart, you can see that for files that occur on 40% of the
machines (4 of 10), fewer than 30% of them have been allowed to be unrecognized.

That is:
e TFiles occur on % of machines value = 40
¢ Allow % unrecognized value = less than 30

Because the unrecognized value is 22%, this falls within the limit and the Objective has been
met.

gt . Within the limit
C &0 o R T 4 S A
g TS SN SN D2 N N O S
Less than £ T R TS B T
80% of files _ _2 *0 7T
are allowed z 20
to be Z 0

File= ocelir on % of mechines
I

Files that occur on
40% of the machines

If the Strict Criteria Is Applied:

If the Strict criteria had been applied, the Recognition Objective would not have been
achieved. Because the category being looked at is files that occur on 40% of the machines, the
Strict criteria allows only less than 5% of them to be unrecognized.

That is:
e Tiles occur on % of machines value = 40

e Allow % unrecognized value = less than 5
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Because the unrecognized value is 22% the allowed limit has been breached and the Objective
has not been met.

© 100 ' .Over the limit
=
8 EI:I --------------------------------
Less than S I A
5% of files S 40
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to be "B %’ 0

0 10 20 30 40 S0 BO 7O 8O 90 100
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|
Files that occur on
40% of the machines

) For purposes of calculating recognition objectives, Unrecognized files are files with a
recognition status of Unknown or CheckVer.

How to Use Recognition Objectives

There are three steps to using Recognition Objectives.
e Step 1: Define an Initial Set of Objectives

e Step 2: Load Scan Files

e Step 3: Use the SAI Teaching Wizard

Step 1: Define an Initial Set of Objectives

Start by defining objectives that are achievable with the resources you have available. This
means that your initial set of objectives may not match the ideal, but at least can be met with
a reasonable amount of effort.

After the first set of objectives have been met, you will be in a much better position to decide:
e  Whether more work needs to be done.
e  Where it is worth applying the most effort.

e How realistic it is to do.

Step 2: Load Scan Files

After the entire organization has been scanned, it is a good idea to load all of the scan files
into Analysis Workbench to get an overview of the situation. Use this initial load to
determine:

e How many unrecognized files there are in total.

e How many of these are common to a large percentage of the population.
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After the objectives have been defined, it is not practical to have the scan files for the entire
organization in memory if the population is larger than a few hundred machines. If too many
scan files are loaded, calculating the objectives may take significant time.

Focus on a subset of machines no larger than at most a few hundred, and use the SAI
Teaching Wizard to help achieve the objective associated with this group of machines.

However, Recognition Objectives make most sense if at least 20 scan files are loaded. If fewer
than 20 machines are loaded, the File criteria results may unexpectedly change quite a lot if
another few machines are loaded.

Step 3: Use the SAI Teaching Wizard

The SAI Teaching Wizard is an assistant that helps automate the selection of files to teach. It
performs this selection based on the Recognition Objectives defined, and always chooses those
unrecognized file(s) that will have the greatest impact on the objective.

The Wizard is primarily an aid to teaching applications that occur on multiple machines and
consist of a set of files. If you get to the stage where all of the unrecognized files appear on just
a single machine, the Wizard is not suitable and the teaching will probably have to be done
manually.

At this stage, the unrecognized files are likely to consist of unusual applications, device
drivers, orphaned files, etc. The teaching of these types of files can be very time consuming.
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